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Overview of the A & A Planning Application 

-
Scope and Objectives 

The Acquisition & Assistance (A&A) Planning Application is a Client-Server Application that uses 
an Oracle database and is the first module of the A&A Business Area. The other modules of A&A 
are Small Purchases, Award Formation, Award Administration, and Support. It is an agency-wide 
automated paper-less tool that provides detailed information identifying what Resources are 
needed to support specific Activities. As the Resources become definite, details of cost, timing, 
agents, vendor, instruments, and competition type are refined. The Request is consolidated into 
other Resource Requests or existing awards and assigned to a contracting spei:falist. 

The objective of this task is to streamline and standardize the A&A Planning process. 

Accessing the New Management Systems 

You must be authorized to logon to the New Management Systems (NMS) in order to use the 
A&A Planning application. The data in the A&A Planning Application is protected by Oracle and 
the application. Access to the database IS protected by the Server, and by user accounts on the 
database. A legitimate A&A user first has to logon to the Banyan network with a valid account and 
password, and then logon to the Application with an Oracle User ID and password. 

A&A Planning is accessed through·the NMS Logon. The Logon box provides a security 
mechanism to enSUre that only authorized users may log on to NMS Applications. For causes of 
logon failure, see Logon Procedure and Problems, page 1 of the Appendix. 

Logon 

I!IffiIl3 
~ 

Double-click on the USAID icon 'i'i'i'J'iI'I in your Windows Program Managerio access the NMS 
applications. If you are not sure where to find this icon, oryou have problems· logging on, contact 
your supervisor or System Administrator. The following common logon screen will appear: 
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Enter your user ID and password and click on the Logon button to continue (or click on the Cancel 
button to extt). The buttons for applications to which you have access will be highlighted in bold 
type. Other buttons available to you on this screen include: 

Click on this button to enter a new password, which must be at least 
eight characters long. • 

Click on this button to set various preferences, including how often to 
delete temporary files and which applications to load automatically. 

Click on this button to return to the previous screen. 

Click on this button to completely exit the NMS logon procedure. 

After selecting the appropriate application button at the top of the screen, a screen will appear with 
buttons representing the modules available in the application you selected. The following screen 
illustrates the modules in the Acquisition and Assistance application: 
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USAID 

Click on the button for the module you wish to access, or click on the Go to Main button to return 
to the previous logon screen. 

Starting the A&A Planning Application 

The Requestor Role can edit and view most of the data in the application. The Roles of 
Contracting Officer, Negotiator, and Program Manager primarily can view data in the application, 
but have limited modification rights. 

After you have accessed the A&A Application click the A&A Planning button and the main screen 
shown below will be displayed. 
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USAID Acquisition & Assistance (Planning) __ ' 

The AM Planning title appears on the top line. The pull-down menus are listed on the menu bar, 
which is the second line. The toolbar appears below the menus. There are three application 
message panels displayed at the bottom of the window. The left panel tells you if the application 
is connected to the server and displays status messages as processing occurs. The center panel 
tells who is logged in and in what Role. The right panel provides brief definitions of the toolbar 
buttons when the mouse is placed over the button. 

Role Box 
This is a drop-down box that displays the roles for the duties that you can perform when you log 
on. It is only displayed if you have been assigned more than one Role in this application. 
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Use the II Change Role button or select Change Role from the Database Menu (ALT+ D, 0) to 
display the Select Role box. The box defaults to the User's first listed Role in the box. If the Role 
shown is correct, click on the OK button. Click on the ARROW button or·use the ARROW keys to 
select a different Role. 

Note: To return to the role box later, close any· open tabs and click on the Role·button or press 
ALT+ D, R. 

Staffing Alert Screen 
The Staffing Alert Screen indicates that there are items that have been made available to you 'for 
action or review. You can go directly to an item by double-clicking the item with the mouse or by 
highlighting the item using the ARROW keys and pressing ENTER or clicking'on the Select button 
with the mouse. 

At the top of the screen are the following buttons: 

All - The All button will· bring up a completed list of items that have been staffed to you including 
those that you have already acknowledged. To select the All button, click on it using the mouse or 
key ALT+A. . 

Not Acknowledged' - The Not Acknowledged button will provide a list of items that have not yet 
been acknowledged. To select this button, click on it using the mouse or key ALT+N. The records 
that appear in the Staffing Alert screen by default are those that have not been acknowledged. 

Select - This button is for selecting one of the items to work on or to view. First you must 
highlight the item, then click on Select, or key ALT+S. 

This screen lists the items that have been staffed to you. It is important to acknowledge items 
promptly so that they·can be made available to other staff members according to their staffing 
order (Priority). . 

You can print the entire list by clicking the Print button on the tool bar. 
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The definitions of the fields are: 

Activity 10 
This pre-filled number is the unique identifier for an Activity. 

Request 10 
This pre-filled number is the unique identifier for a Request. 

Status 
This field indicates whether or not receipt of the item has been acknowledged by the staff 
member, and whether their response was to Concur or Disagree. 

Staffed From 
This field indicates the individual who made the item available to another staff member. 

Date Staffed 
This field gives the date the Request was staffed. 
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Using the A&A Planning Application 

How to Use Help 
Help topics can include graphics and text that link to other Help topics or to more i~formation about 
the current topic .. The Help text is highlighted in green and underlined. Help text· contained in a 

Graphic is invisible. When the pointer is directed to the text, it changes to a ~ h~nd icon. Then 
you can click the left mouse button for additional information. 

To choose a topic using the keyboard, press TAB until the topic is highlighted, and then press 
ENTER. 

F1 (HELP) 
For immediate Help on a specific field, place the cursor on the field and press the F1 key. The 
definition of the field appears on the screen, unless the field is non-editable or a date field. 

FINDING A SPECIFIC HELP TOPIC 

At the top of the Help Contents page and on every main Help topic is a Search button.I~:eiiti>~'!1 
Press this button to search alphabetically for a specific topic or keyword. 

BROWSING MAIN HELP TOPICS 

At the top of the Help Contents page and on every main Help topic are Browse buttons. 

It,~*<t',,:.,I(\\';:'.';->':;); .. d Use them to move forward or backward through the m~jor Help topics. 

On-Line Help 
Windows-style On-Line help is available in this application. On-line help may be accassed 
through the Help pull-down menu or with the Help button: 

On-line help is available throughout the application, unless dialog boxes are displayed. A dialog 
box'is a window with OK and CANCEL buttons. None of the menus on the menu, bar or buttons on 
the toolbar are available when a dialog box is displayed. If help must be consulted before 
continuing, leave the dialog box by using the CANCEL button. Access the Help through the Help 
pull-down menu. 

Context-sensitive help is available throughout this application. Place the mouse on a specific field 
and press the Fl key. The application will display the most relevant help screen. For instructions 
on how to use Windows-style on-line help, select Help on Help from the Help Menu. 

January 2, 1996 7 



A&A Planning User's·Guide 

Menus 

Pull-down menus are located on the menu bar, the second line in the A&A Planning window. 

file Edit Database .Qptions Window' Help 

A menu can be activated by clicking on a menu title with the mouse or by pressing ALT + the 
accelerator key, moving to a menu title with the right and left ARROW keys, then pressing the 
ENTER key. Select a menu option from the pull-down menu by either clicking on the option or by 
moving to the option using the up and down ARROW keys, then pressing the ENTER key. 

Clicking on the word file brings the following menu. 

Open 
!;.Iose Ctrl+F.Il 
Jiave Ctrl+S 
J2elete 

Print Setup ... 
Erint... Ctrl+P 

E~t 

For more information on the menus, see Appendix B, page 59.) 

Note: When a Menu Item appears in gray lettering, the topic is not active for the form 
that you are using. Items displayed in black are active for the form that you are using. 

Toolbar 
The Toolbar contains a group of buttons that display icons, or symbols, representing commands. 
They can be accessed quickly with the mouse as an alternative to using the pull-down menus. 
Here is a list of the buttons and the mode panel on the Toolbar menu. 

lm. 
Buttons outlined in black are active for the form that you are using. Buttons that are not presently 
available will be "dimmed." Clicking on a dimmed button will have no effect. The tool bar may be 
turned on and off with the Options pull-down menu by selecting Toolbar. The function of each 
button is displayed in the right message panel at the bottom of the screen when the mouse is 
placed over it. 

The buttons on the toolbar are as follows: 
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11/ Open file button 

lin Save button 

'Il Print button 

If$! Cut button 

I~I Copy button 

I~I Paste button 

lral Previous button 

I!JJJ Next button 
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: Allows you to create a new Request or add a Staffing 
assignment. This function can be accomplished by choosing 
New in the File Menu (AL T + F, N), 

: Opens the Open Request form, You can open a Request 
from this form, This function can be accomplished by 
choosing Open in the File Menu (ALT+ F, 0). 

: Saves the current Request or Staffing assignment. This 
function can be accomplished by choosing Save in the File 
Menu (ALT+ F, S), 

: Prints the Request. This function can be accomplished by 
choosing Print in the File Menu (AL T + F, P), 

: Removes selected text and puts it in the Windows Clipboard, 
This function can be accomplished by choosing Cut in the 
Edit Menu (AL T + E, C). 

: Copies selected text to the Windows Clipboard, This function 
can be accomplished by choosing Copy in the Edit Menu 
(ALT+ E, 0). 

: Inserts a copy of the text, in the Windows Clipboard, at the 
insertion point. It overlays any existing text in the field, This 
function can be accomplished by choosing Paste in the Edit 
Menu (ALT+ E, P). 

: Moves back one record in the database, This function can 
be accomplished by choosing Previous Record in the 
Database Menu (AL T+ D, P), 

: Moves forward one record in the database. This function 
can be accomplished by choosing Next Record in the 
Database Menu (AL T + D, N), 

: Shows you the record mode, This is an informational panel 
only. The panel displays either: 

: This mode appears when either a new Request has not 
been saved yet, or the User is Adding a Staffing assignment. 

: You can make changes to the Request providing you have 
proper access to non-blue fields, 

: You can look at the Request, but either another user has the 
Request locked for editing, or your role does not allow 
editing of the Request. 
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IIWtI Note button 

1!Ill Alert button 

.. Query button 

100 Search button 

~ Report button 

IlfJ Change Role button 

@ 
~ Help button 

Tab Folders 

: Opens the Sticky Note form. This is an open field to write 
comments to be attached to the current Tab. Use the paper 
clip button to attach it to the Tab. This function can be 
accomplished by choosing Attach Note in the Options Menu 
(AL T + 0, N). See Page 50 of the User's Guide for 
instructions on how to use the Note form. 

: Displays the A&A Planning Staffing Alert box with the Tasks 
that have been Staffed to you and require your attention . 

: Opens the COTS (,commercial off the shelf quel)' tool). See 
the Help in COTS for Instructions on how to use it. This 
function can be accomplished by chOOSing Query in the 
Database Menu (AL T + D, Q). 

: Opens the Search form. This allows you to search for 
records that contain specific information from the database. 
This function can be accomplished by choosing Search in 
the Database Menu (ALT+ D, S). See Page 50 of the User's 
Guide for instructions on how to use the Search form. 

: Opens the Create Reports form. This allows you to create a 
report from the records in the database. This function can 
be accomplished by choosing Reports in the Database Menu 
(ALT+ D, R). See Page 53 of the User's Guide for 
instructions on how to use the Create Reports form. 

: Displays the Change Role form. This allows you to change 
your role according to the duties you will perform. This 
function can be accomplished by choosing Change Role in 
the Database Menu (ALT+ D, 0). See Page 4 of the User's 
Guide for instructions on how to use the Change Role form. 

: Accesses the A&A Planning Help system. This function can 
be accomplished by choosing Contents in the Help Menu 
(ALT+ H, C). 

The A&A Planning application handles the Procurement Planning process. II has been created for 
Requestors throughout the Agency. The application allows you to plan Requests for Commodities 
and Technical Services, as well as Inter-Agency Agreements and Assistance. In this application a 
Request is shown as a folder and, based on the Request category, certain Tabs on the folder 
become available. The Request is also centralized and, based on your role and the stage of the 
Request, certain approvals are required. Each Tab represents a different form that addresses 
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specific information needed about the goods and/or services to be used for the Request. The 
current Tab folder's caption is shown in red letters. The Staffing Tab is highlighted in yellow 
because it can be used by anyone to staff a Request. Fields highlighted in blue are protected. 
The information contained in protected fields may only be viewed. 

Certain tabs and fields can only be filled in by persons carrying out certain Roles. 
You do not need to close a tab unless you are going to work on a different record. To close a tab, 

click on the control box at the upper left (same line as the title bal') and 
select Close. -Alternately I a rapid double click on the control -box will close - -
the form. To close using the keyboard, press CTRL+ F4. 

NOTE: The edit mode does not apply to the Staffing Tab. You will be allowed to staff anytime, 
unless the Request is·being edited by another person. 

To change Tabs, move the mouse to the desired Tab and click the left mouse button or use the 
ARROW keys on the keyboard to move to another Tab. 

Activity 
The Activities' are structured tasks or set of tasks that further the objectives of USAID. The 
Agency undertakes vanous Activities to achieve its mission. To complete these Activities, goods 
and/or services are acquired. ProcuremenfPlanning begins when the Requestor identifies an 
Activity dependent upon a Resource for which a Request must be made. 

Request • 

Requests are the foundations of the purchases of the specific goods and/or services. The 
Request provides each Requestor with a vehicle to collect information about the project. The 
information is used to determine the type of action to be performed; type and amount of resources 
needed; and who will provide the resources. 

There are four types of Requests that this application supports. They are New Request, 
Incremental Funding, Award Modification and Delivery Order. New Hequests are new 
procurement ideas. Incremental Funding is increasing the funding of line items on an existing 
award. Award Modifications and Delivery Orders allow the Requestor to change or add 
information to an existing award. 

Line Items 

The application requires that each line item to.be acquired for a Request be funded from a specific 
Funding Control Account The line Items Tab provides the area to list each item, amount 
needed, and price. It provides access to apply the funding for each item. 

Overview of a Request 

There are standard procedures to follow in creating and processing a Request for New Award, 
Incremental Funding, Award Modification or Delivery Order. The procedures below are the 
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recommended ways for making the Requests. Not all Requests will follow these steps in the 
given order. 

New Award 

It is determined that there is a need for a Request to support an existing activity. The Requestor 
logs into the Planning application. If you have multiple roles, you must select the Requestor Role. 
The Requestor Role is the only role that can create a Request. 

The Requestor selects New from the File drop-down menu or clicks the New Record button on the 
Toolbar. The New Request form is displayed. The Requestor first selects the Activity that the 
Request will support and enters the Request Title, then selects.the Request for New Award option 
button. The DeSCription Tab and Other Information Tab are prefilled and protected with 
information from the Selected Activity. 

The New Request Tab form is displayed, and prefilled with the New Request for Activity 10, 
Activity Status, Request Title, Requestor name, and the Created on date fields pre-filled and 
protected. The Worksheet, Estimated Value, Bureau Priority and Office Priority fields and the 
Request Category·section are displayed with their default values. 

The Requestor completes as much of the Initial Tab as possible. At a minimum, the Requestor 
needs to enter the Request Title, Estimated Value, and Date Award Needed fields and select a 
Proposed Award Action Type in order to save the Request. 

The Requestor selects the individual who will act as the Program Manager for this request by 
selecting their name from the Program Manager list box. This list is comprised of names of all 
A&A users who have been assigned the role of Program Manager. 

After completing the information on the Initial Tab, the Requestor saves the Request using the File 
Menu or clicking the Save button. Next, using the Staffing Tab, the Requestor may staff the Initial 
Request to all persons who need to review the Request. See Page 46 in the User's Guide for 
additional information on completing the Staffing Tab. 

The Program Manager determines and assigns the Contracting Officer by selecting their name 
from the Contracting Officer list box on the Initial Tab. 

The Contracting Officer will assign a Negotiator, upon receiving and reviewing the Request, by 
selecting their name from the Negotiator list box. 
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Once the Program Manager, Contracting Officer or Negotiator is assigned, the request will show 
in the Open Request box of each role. 

The ReqtJestor selects 
the Activity the ReQuest 
su arts. 

The Requestor 
completes the 
Initial Request Tab. 

The Requestor selects 
the Program Manager. 

The Contracting Officer 
assigns a Negotiatorto . 
the Request 

r 

If the Program Manager 
concurs. he selects the 
ContractinCl Officer 

Processing a New Request 

" 

Once the Requestor receives the Manager's concurrence, the Requestor needs to work with the 
assigned Negotiator to complete the detailed information for the Request. All Requests need to 
have at least one line item to be able to commit funding. Each Request should have a Program 
DeSCription, Statement of Work, or Product Description outlining the Request. . Complete the rest 
of the Tabs as needed for each Request. See the section on each Tab in the User's Guide for 
more details on the completion of each tab. 

The Requestor should enter the Program Description, Statement of. Work, or Product.Description 
for the Request on the Documents Tab. See Page 29 of the User of the User's Guide for 
additional information on how to complete the Documents Tab. 

The Requestor needs to add any line items to the Request on the Line Items Tab. See Page 32 
of the User of the User's Guide for additional information on how to complete the Line Items Tab. 

Once all the Tabs are complete, the Request needs to be staffed to all persons who need to 
review and clear/approve the Request. Use the Staffing Tab to staff the completed Request. 

The Program Manager will review the complete Request. Once the Program Manager is ready to 
approve the Request, then click the Commit Funding button and key the Program Manager's 
password. Through electronic signature, funds will.be committed electronically . .This will change 
the Mode box from Edit to View. 
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The Negotiator sends the completed Request to Award Formation by clicking the Accept Request 
button on the Timeline Tab. 

The Requestor The Negotiator sends 
receives conCurrence the completed Request 
from the Program to Award Formation by 
Manager. clicking the Accept 

Request button. 

The Manager reviews 

The Requestor completes the Request and either 

the needed Tabs with the Commits the Funding 

help of the Negotiator. or sends the Request 
back to the Requestor. 

Incremental Funding 

Creating an' Incremental Funding 
It is determined that there is a need to add funding to partially funded line items in an existing 
award. The Requestor logs into the Planning application. If you have multiple roles, you need to 
select the Requestor role. The Requestor role is the only role that can create a Request. 

The Requestor selects New Request from the File drop-down menu. The New Request form 
appears. The Requestor Selects and Activity from the drop-dollYn box, enters the Request Title, 
then selects the Incremental Funding option button, and the Award in which the line item funding 
is to change. The Requestor then selects the OK button. 

The Requestor completes the Initial Tab. At a minimum, the Requestor needs to enter the 
Request Description field, select a Proposed Award Action Type, and Award Needed by Date in 
order to save the Request. 

After completing the information on the Initial Tab, 'the Requestor saves the request, using the. File 
Menu or by clicking the Save Button. When the request is saved the only tabs that will be enabled 
are the Items, Timeline, Funding and Staffing. 

Since the Requestor is only providing additional funding to an already existing award, there are 
only certain limited fields that the Requestor may edit. The remainder of the information is carried 
forward from the Award. 
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The Program Manager determines and assigns the Contracting Officer by selecting him or her in 
the fields on the Initial Tab. The Contracting Officer assigns the Negotiator by selecting him or her 
in the Initial Tab. 

-The Program Manager 
The Requestor selects Concurs with the The Program Manager 
the Award that the Incremental Fundmg selects the cognizant 
Incremental Funding will Request or Disagrees Contra~ing Officer. 
be applied to. and returns it to the 

1 
Requestor. 

/ The Requestor The Contracting Officer 

completes the assigns the Negotiator. 

Initial Request Tab. 

The Requestor selects 
the Program Manager. 

Processing an Incremental Funding Request 
Once the Requestor receives the Manager's concurrence, the Requestor can add the additional 
information to the Line Items Tab. The line items will be pre-filled from the Award. The Requestor 
selects the overall Object Class code for the request. The Requestor may only edit the funding 
information. See Page 32 of the User's Guide for additional information on completing the Line 
Items Tab. 

Once the Tabs are complete, the request needs to be staffed to the Manager and all persons who 
need to see the request. Use the Staffing Tab to send the completed Request. 
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When the Negotiator receives the committed Request from the Contracting -Officer, the Negotiator 
sends the Request to Award Formation by clicking the Accept Request button on the Timeline 
Tab. 

-
The Requestor 
receives the 
concurrence from 
the Manager 

1 
The Requestor can 
add additional 
information to the 
line Items Tab. 

The Negotiator sends the 
completed Request to 
Award Fonnation by 
clicking the Accept 
Request Button. 

r 
The Program Manager 
reviews the Request 

____ and either Commits the 
Funding or sends the 
Request back to the 
Reauestor 

Award Modification 

Creating an Award Modification 
It is detenmined that there is a need to modify an existing award. The Requestor logs into the 
Planning Application. If the person has multiple roles, they need to select the Requestor role. 
The Requestor role is the only role that can create a request. 

The Requestor selects New Request from the File drop-down menu. The Select Activity form is 
displayed. The Requestor then selects the activity that the request will support, the Award 
Modification option button, and the Award in whi9h the line item funding is to change. This 
process allows modifications to most of the information in the award. The Planning Request Tab 
folder is displayed with the Activity Id, Activity Title, Created On, Contracting Officer, Negotiator, 
and Requestor name fields pre-filled and protected. The Worksheet, Bureau Priority and Office 
Priority fields and the Request Category section arl? displayed with their default values. 

The Requestor completes as much of the Initial Tab as possible. At a minimum, the Requestor 
needs to enter the Request Title, Estimated Value, and Award Needed by date fields and select a 
Proposed Award Action Type in order to save the Request 

After completing the infonmation on the Initial Tab, the Requestor saves the Request using the File 
Menu or the clicking the Save Button. 

The Requestor can staff the Initial Request to all of the persons who need to see the Request 
using the Staffing Tab. See Page 46 of the User's Guide for additional information on completing 
the Staffing Tab. One of the persons who should be included in the staffing of the Initial Request 
is the Program Manager who is to Concur or Disagree with the Request. 

Upon receiving the staffed Request, the Program Manager reviews the information. Ifthe 
Program Manager concurs with the Request, the Manger selects Concurfrom the Status list box 
on the Staffing Tab. Otherwise, the Program Manger selects Disagree and staffs the Initial 
Request back to the Requestor for revisions. The Program Manager can enter comments in the 
Comments cell. 
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The Program Manager determines and assigns the Contracting Officer by selecting him or her in 
the field on the Initial Tab. The Contracting Officer assigns the Negotiator by selecting him or her 
in the field on the Initial Tab. The Program Manager may also select a different approver on the 
Initial Tab. 

The Requestor selects The Manager Concurs 
the Award that the with the Incremental The Program Manager 

,".-~'~",,", Y'''''"'-"'' selects.the Contracting 

will be applied to. Disagrees and returns It Officer. 

! to the Requestor. 

The Requestor -
completes the 
Initial Request Tab. 

1 The Contracting Officer 

The Requestor selects 
assigns the Negotiator. 

the Program Manager. 

Processing an Award Modification Request 
Once the Requestor receives the Program Manager's concurrence, the Requestor can add the 
additional information to the tabs. Complete the rest of the Tabs as needed for each individual 
request. See the section on each Tab in the User's Guide or contact the Negotiator assigned to 
this request 

The Requestor should erter the Program Description, Statement of Work, or Product Description 
forthe~request on the Documents Tab. See Page 29 of the User of the User's Guide for 
instructions on how to complete this tab. 

The Requestor can modify existing line items or add new line items to the Request on the Line 
Items Tab. See Page 32 of the User's Guide for instructions on how to complete this tab. 

Once all. of the Tabs are complete, the Request needs to be staffed to all persons who need to 
see the Request. Use the Staffing Tab to send the completed Request to all persons who need to 
see it. 

The Program Manager will review the completed Request, if it is not complete it will be directed 
back for the additional information. When the Program Manager is ready to commit funds for the 
Request, Click the Commit Funding button and key in personal password. This will change the 
Mode box from Edit to View. 

The Program Manager then staffs the Request to the Negotiator. When the Negotiator receives 
the committed Request, the Negotiator sends the Request to Award Formation by clicking the 
Accept Request button on the TImeline Tab. 

January 2, 1996 17 



/!<&A Planning User's Guide 

The Requestor should select the Program Manager for the Request from the drop-down list box 
on the Initial Tab. This list is comprised of names from the Staffing Tab who have approval 
authority. 

Once the Tabs are complete the Request needs to be staffed to all persons who need to see and 
clear or approve the request. Use the Staffing Tab, to send the completed Request to all persons 
who need to see it 

The Program Manager will review the completed Request. If it is not complete, it will be directed 
back for the additional information. If the Manager wants to approve the Request, click on the. 
Commit Funding button and key in their password. This will change the Mode box from Edit to 
View. 

Once the Request is funded and the Negotiator IS ready to accept the Request into Award 
Formation, the Negotiator clicks the Accept Request button on the Timeline Tab. 

The Program Manager 
reviews the Request 
and either Commits the 
Funding or sends the 

. ,. 

The Requestor 
receives the 
concurrence from the 
Program Manager. 

The Requestor staffs 
the completed 
Request to the 
Program Manager to 
commit fundinQ. 

Request back to the The Negotiator sends 
Requestor for additional the c::ompieted ReqUEst 
information. to Award Formation by 

1 
clicking the Accept 
Request Button. 

The program Manager 
commits funds and staffs 

r.;:;:-:-The=Req=uesto-, --'1/ 
modifies the tabs I 

to the Negotiator. 

Procedure for Completing a Request 
There are standard procedures to follow in creating and processing a new request, incremental 
funding, award modification, and delivel)' order. The procedures below are the recommended 
ways for making the requests, but not all requests will follow these steps in the given order. 
These procedures are a guide for making requests to support activities. 

Creating a New Request 
Once the goods and/or services, in support of an Activity have been identified, the initiating office 
generates a New Request addressing the specific information conceming the goods and/or 
services needed to perform the Activity. Only the Requestor can initiate a New Request. 
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To create a New Request, select New from the File Menu (ALT F, N) or click the IIDI Prepare 
New Record button. The New Request form will appear: 

1000000006 

Proiect Education 2000 (v20 testdata) 

Note: If you have been using another request, close it before selecting New record. 

Select Activity 
The term Activity is used here to refer to a category in line with USAID's Strategic Objectives. 
Activities are used to logically group Requests. 

From the drop-down list, select the Activity group that shows how the Request will further the 
objectives of the Agency. 

Request Title 
This is a 52 character alphalnumeric field. Enter the title for the Request 

Select Award To Modify 
This field is enabled only when the option button for Incremental Funding, Award Modification or 
the Delivery Order is selected. From the drop-down list, select an existing fund or award to 
modify. 
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The Request type option buttons are: 

Request for New Award - a new procurement has been detemnined to be needed 
Incremental Funding - a need to increase funding for an existing award. 
Award Modification - a need to modify an existing award. 
Delivery Order - issue a Delivery Order against an existing Acquisition 

instrument. 

The Tabs.titled Description, Strategic Objective and Budget all have-protected and pre-filled fields 
with data supporting the selected Activity. You are unable to edit these fields. 

Click the option button Request for New Award, then click OK. 

Activity 10 
This is a pre-filled and protected field that is the unique identifier for an Activity. The application 
generates the number and pre-fills the field when the ActivitY'is created and added to the system. 

Activity Title 
This is a pre-filled and protected 52 character alpha/numeric field. This title comes from the 
Select Activity field when the Activity is created. 

Parent Activity 10 
This is a pre-filled and protected 8 digit numeric field that is the unique identifier for a Request. 
The application generates the number based on the Selected Activity and pre-fills the field when 
the Request is saved. • 
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Open Request 

To modify an existing Request, select Open'in the'File Menu (ALT+ F, 0) or click the ~ Open 
File button. The Open Request box will appear: . 

2968800207 j 00000054 

This box provides you with a listing of the Requests you have Pending and as personal 
Worksheets. Select the Pending request or personal Worksheet you need. To select one with 
the left mouse button, either double click on it or click once and Click the Select button. To select 
one with the keyboard, using the ARROW keys, highlight the line and hit ENTER. The A&A 
(Planning) screen with the Tabs will be displayed with ali the data that had previously been 
entered. The Tabs contain·ali the Tabs to make, process, and approve a funding Request. The 
top Tab displayed is the Initial-Request tab. 

y ~ _ :t 

When the Planning screen is displayed, check the Mode Box ~:!:ll;(_ :i. If it reads EDIT, you 
can add to or change the information on the tabs. If it reads VIEW, another person is working on 
the Request and you can only view the information. 

If you make any changes to the Activity, click the J!U Save button or Save from the File Menu, 
(ALT+ F, S), to update the record. 
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New Request For Activity 

The A&A Planning New Request for Activity screen WITh Tab folders will display. The application 
. i" V'VAti@'?:~': . 

will change to the 19,~, ,0., .'" .. b., .. ".', Add mode. The Tab folders contain all the forms to make, 
process, and approve a funding Request. 

Capping ~ Sanitization 

RequeSt Title 
This'is a 52 character alpha/numeric field that is pre-filled from the NewHequest form. You can 

edIT this field (Le.,.change tHle name). Click the. Save button or select Save from the File 
Menu (ALT + F, S). This will enter your new Request TITle into the system. 

Status 
This is an application-generated, pre-filled and protected field. It provides the status of the 
Request (Pending or Approved). 

You must enter the Request Category, Estimated Value, and the Award Needed by date. 

Select one of the three Request·Categories. The application defaults to Acquisitions and 
displays the Acquisition drop-down list box when the Request is created. The list box contains 
two types of AcquisITions: Technical and CommodITies. If AcquiSITion is not selected, the list box 
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is not displayed. The Request Category selected determines the Proposed Award Action Types 
to be displayed in the drop-down list box and the tabs to be completed . 

... * 
Save the Initial Request. Click the .Ill! Save button or select Save from the File Menu (ALT + F, 
S). This will enter your new Request into the system. 

Tabs 

Tabs are the labels for the various forms that are filled out during the A&A Planning process. 
Each tab has fields that are filled in either by a user or by the application. Certain tabs and fields 
can only be filled in by persons carrying out certain Roles. 

Initial Request Tab 

The Initial Request Tab is an advanced plan for goods and services. It allows the Requestor to 
establish a Program Manager for the Request for funding. 

The Requestor is the primary Role to create-or edit the Initial Request Tab. The Requestor role 
can edit all the fields on this Tab, except for the Contracting Officer and Negotiator fields. The 
Program Manager can edit both the Program Manager and Contracting Officer field. The 
Contracting Officer Role can edit the Contracting Officer and Negotiator fields. The Negotiator is 
unable to edit any ofthe fields on this-Tab. • 

Afterthe Request has been created or opened, the Initial Request Tab will be the first Tab 
displayed. 
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The definitions of the fields are: 

Worksheet 
This check box is used to keep the Request as a Worksheet until it is ready to be made available 
to the Manager for-approval and assignment of a Contracting Officer. When the box is checked, 
the Request is a worksheet. When the box' is not checked, the Request is available to the 
Manager, Contracting Officer and Negotiator. The application defaults to a checked box. 

Request Description 
This is a 500 character alpha/numeric field. Enter a two or three sentence description of the 
goods and/or services required. This must be as complete and descriptive as possible. This field 
is to be used to post on the INTERNET advance notices of the Agency's future requirements, so 
the Request Descnption should be as helpful as possible. 

Request Category 
This box allows you to select the type of Request. The type of Request selected determines the 
Award Action Types displayed in the Proposed Award Action Type list box. See Appendix A for 
the list of Award Action Types. The application defaults to Acquisitions. Place the pointer on the 
option for which the Request is being made and click the left mouse button. Wrth the keyboard, 
use the arrow keys to select the option. This field is required to create a New Request. 

Acquisitions 

Assistance 

Inter-Agency Agreement 

Proposed Award Action Type 

: There are two types of Acquisitions: Technical and 
Commodities. Select the type of Acquisition in the drop
down list box next to Acquisitions. This list box is 
removed if a different Request Category is selected. 

: There are two types of Assistance: Grants and 
Cooperative Agreements. Their purpose is to provide 
financial support for a program in a cooperating country. 

: There are two types of Inter-Agency Agreements: 
Participating Agency Support Agreement (PASA) and 
Resources Support Services Agreement (RSSA). 

This is a drop-down list box that displays the Award Action Types. The Request Category 
determines the Award Action Types displayed in the list box. Select the Action to be performed 
by this Request. You can key in the first'character of the Action and use the arrow keys to make 
a selection, or click the left mouse button on the down arrow button and use the drop-down list 
box to make a selection. 

Estimated Value 
This is a 14 digit, with two decimal places, numeric field. Enter the independent government 
estimate for the entire award. This field is required to create a New Request. 

Geographic Area 
This is a drop-down list box that displays the list of Geographic Areas. Select the Area where 
the Activity is to take place. You can key in the first character of the Geographic Area name and 
use the arrow keys to make a selection, or click the left mouse button on the down arrow button 
and use the drop-down list box to make a selection. 

country 
This is a drop-down list box that displays the list of Cooperating Countries. Select the Country 
that is benefrting from the activity. You can key in the first character of the Country's name and 
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use the ARROW keys to make a selection, or click the left mouse button on the down arrow button 
and use the drop-down list box to make a selection. 

Office 
This is a drop-dOwn list box that displays the Requesting Offices. Select the Office that is makin.& 
the Request. You can key the first character of the Office and use the ARROW keys to make a 
selection, or click the left mouse button on the down arrow button and use the drop-down list box 
to make a selection. 

Created On " 
This is a pre-filled and protected date field. It is displayed in the following format MMIDD!YYYY. 
It displays the date the Request was entered into the system. 

Requestor 
This is a pre-filled and protected field. It displays the name of the Requestor creating the 
Request. 

Program Manager 
This is a drop-down list box that displays a list of the Agency's Program Managers. Select the 
Manager who is to be assigned to this Request. You can key in the first character of the 
Manager's name and use the ARROW keys to make a selection, or click the left mouse button on 
the down arrow button and use the drop-down list box to make a selection. 

Contracting Officer 
This is a drop-down list box that displays a list of the Agency's Contracting Officers. Select the 
Officer who is to be assigned to this Request. You can key in the first character of the Officer'S 
last name and use the ARROW keys to make a selection, or click the left mouse button on the 
down arrow button and use the drop-down list box to make a selection. This field can be entered 
or edited by the Contracting Officer or Manager Role only. 

Negotiator 
This is a drop-down list box that displays the Negotiators. Select the Negotiator who is to be . 
assigned to this Request. You can key in the first character of the Negotiator's last name and 
use the ARROW keys to make a selection or click the left mouse button on the down arrow button 
and use the drop-down list box to make a selection. This field can be entered or edited by the 
contracting Officer Role only. 

Award Needed By 
This is a date field that is to be entered in the following format MMlDD!YYYY. You can change 
the date when you create a New Request. To change the month, day or year, key in the new 
date, or double click on the field and the calendar will appear: 
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See Page 27 of the User's Guide for instructions on how to use the Calendar. This field can only 
be changed when this is an Initial Request or there are no request line items for the Request. 
This field is required to create a New Request. 

To change the date when there are existing line items, go to the Line Items Tab and remove 
those line items. 

Bureau Priority 
This is a 6 digit numeric field. Key the priority of the assignment to the Bureau or use the arrow 
buttons to select the priority. 

• 
Office Priority 
This is a 6 digit numeric field. Key the priority ofthe assignment to the Project Office or use the 
arrow buttons to select the priority. 
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Calendar 
When you double click an editable date field, the calendar will appear: 

How to fill out Date Fields 

How to use the calendar: Double click on the date 
field or press the F4 key. A calendar will appear, 
displaying the month. day. and year given from the 
field or the current month, day and year. Use the 
arrow buttons on the right and left sides to change 
the year and month accordingly. Click the left 
mouse button on the specific date to change the 
date. To enter the d?te in the field, double click the 
left mouse button on the date or click the OK button. 
The Cancel button does not change the date. 
Date fannat: Month, day and year in eight-digit 
format (MMlDDNYYY). Insert two digits for month, 
two digits for day, four digits for year. Slashes are 
inserted automatically. V\nlen using the calendar 
the following keys have special functions: 

Page Up key - Moves back 1 fuJI year 
Page Down key - Moves forward 1 full year 
Ctrl+ Left Arrow key - Moves back 1 month 
ctrl+ Right Arrow Key- Moves forward 1 month 

Technical Tab 

This Tab is used to state special requirements needed forthe Request, such as, any 
Govemment Furnished Property or Equipment available to the vendor/recipient, and contracts 
and capabilities, 

The Requestor is the primary Role to enter andlor edit all the fields on this Tab, 
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To enter or edit data to this Tab, click the Technical Tab. The following will appear: 

To save the Technical Tab, click the .1 Save button or select Save from the File Menu (ALT+ 
F, S). The definitions of the fields are: 

Authorized Agent 
This is a drop-down list box that displays the Requesting Offices. Select the Office that is making 
the Request. You can.key the first character of the Office and use the ARROW keys to make a 
selection, or click the left mouse button on the down arrow button and use the drop-down list box 
to make a selection. 

Language Requirements 
This is a 30 character alpha/numeric field. Identify the foreign language(s) and the proficiency 
levels required for the Request. 

Duty Post(s) 
This is a 40 character alpha/numeric field. Identify the sites where the services are to be 
performed. 

Access to Classified Information 
This check box is used to indicate whether access to classified material is required. When the 
box is checked, the access is required. If it is not checked, the access is not required. To check 
the box, click the left mouse on the box or strike the space bar. 

Dependent Travel Funded by AID 
This check box is used to indicate whether the travel and support expenses for dependents are to 
be funded by USAID. When the box is checked, USAID funds the expenses. If it is not checked, 
USAID does not fund the expenses. To check the box, click the left mouse on the box or strike 
the space bar. 
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Participant Training Funded by AID 

This Check box is used to indicate whether participant training is to,be funded by USAID, When 
the box is checked, USAID funds the training, If it is not checked, USAID does not fund the 
training. To check the box, click the left mouse on the box or strike the space bar. 

GFP/GFE 
This is an 80 character alpha/numeric field. Enter any Government Furnished Property or 
Equipment that is to be available to the vendor/recipient for the request. After entering an 

instance of GFP press the ~;~1 Add button to add this item to the list To remove an item from 

~ 
the list press the ~ Delete button. 

Contract Recommendations 
Use the option buttons to recommend a Request be implemented through one of the listed 
socioeconomic programs, Click the left mouse button on the option to select a recommendation, 
The Contract Recommendations are only visible when the Request is an Acquisition, 

Relationship/Responsibilities 
This isa 1000 character alpha/numeric field, Enterthe name of the cooperating country, agency 
and/or institution for which the proposed Request is to be provided. Describe the organizational 
structure, Indicate the particular area within the agency and/or institution that is the direct point 
of contact for the Request. State the lines of authority and supervisory responsibility as they may 
affect the Request Identify other national or local agencies and institutions that are to benefJt 
directly or indirectly from the services to be provided, 

Enter the administrative and operational responsibilities of the contractor or participating agency 
and its employees with relation to the mission. 

Documents Tab 

The Document Tab is probably the most important single portion of the Request. It needs to 
clearly document USAID's requirements, It should be written with enough specificity so that 
there is no doubt what is required. It must provide for clear target dates, goals, and objectives for 
a particular project Vague descriptions should always be avoided. 

List all the obligations of the Govemment It is important not to over specify requirements. The 
ideal situation in this regard is to specify the fundamental results intended and to let the 
contractor/recipient develop the best method of achieving them. An item should be included if it 
helps to explain what is to be done and is necessary to determine the outcome. 

Specify the reports·that are required of the contractor, recipient, or participating agency 
indicating: (1) frequency, (2) content and format, (3) language translation requirements, if other 
than English, (4) number of copies, and (5) desired distribution to mission, AIDIW, cooperating 
Country govemment project Manager, and contracting/grant/officer. 

Only the Requestor role can enter and/or edit the fields in this Tab. 
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To enter or edit data to this· Tab, click the Documents Tab. The following will appear: 

, 'Q ' 

Statement of Work, Program Description, or Product 
Description Abstracts 
Every SolicHation has eHher a Statement of Work, Program Description, or Product Description. 
In each case, it is an all-encompassing description of that which needs to be procured. 

Statement of Work applies to: 

Program Description applies to: 
Product Description applies to: 

~ ~ Document Button 

Acquisitions of Technical Services and 
Inter-Agency Agreements 
Assistance 
Acquisition of Commodities & Small Purchases. 

Invokes the application's Word Processor. You can copy and paste text from the Statement of 
Work, Program Description, or Product Description using the Edit Menu items. Enter the 
Program Description, Statement of Work or Product Description in the Abstract field or in the 
Word Processor. You can capture information from other Tabs in the Request and paste it into 
the Word Processor. See Page 54 of the User's Guide for instructions on how to use the Word 
Processor. 

To Save the Abstracts in Word Processing, select Save from the File Menu (ALT + F, Sl. To 
return to the Request, select Exit from the File Menu (ALT + F, Xl. 
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To save the Documents Tab, click the !1iI1 Save button or select Save from the File Menu (AL T + 
F, S). 

U.S. Agency ofIntemational Development (AID) is seeking a qualified organization to !!Sslstin improving 
lfue h".lthstatus of developing counuypopulations by providing technical and .• dvjsoty'setV;.ces to 'create or ' •. 
I>mlpro'7e environmen1a1health programs. Such technical and advisoty sarvices shan include, bUt not be limrt.ed -

improve design, implementatton, and evaluaUon ofilie environmental health activities by developing' , 
Ico_"1 governments and orgacizations; 2) increase skills levels of developing country p!ofessionals7 including I 
Ioc)li"7 makers and staff involved. in enV'11"Onttlental health acb:vities; 3) mtprove operational and cos~eff~ctive 

of <tev"lot)lne: countty 1tlStitutions responslble for environmental health actfvitie's;' 4) increase'- -. ,;, 
educat10n and involvmem, and changes in personal behavior to "reduce enVironmeritru health 

5) improve financial planning for long-tenn operations and maintenance in environmental health 
and; 6) increase private sector involvement AID anticipates the award oftw"o five year coniracts7 a 

contract and arequirements contract with buy-in opportunities for AID mission, for approximately 3000 
~:~:~~~:~ ofeffort.,Requestforproposals Wlil be issuedOIA 15 days from date of this publication. Closi;lg 

II ~~~~d;ate, OIA 15 

The definitions of the fields are: 

Document Abstract 
This is a 1000 character alpha/numeric field. Enter a brief description of the Program Description, 
SOW, or Product Description. 

Waivers and Justifications 
This is a 1000 character alpha/numeric field. Enter a brief description of the Waiver(s) and 
provide the Justification for exception to the standard practice of Request approval. 

The justification must include: 
1. The rule being asked to be waived and description of the transaction in questi()n. 
2. Cite the handbook provisions or delegation of authority under which the official in question is 

empowered to grant the waiver. 
3. What criterion is being relied upon in making the request for the waiver. Quote relevant 

language. 
4. Explain how the situation fits within the criteria selected. 

a) What.will happen if the requested Waiver is not granted? 
b) Why the Waiver is critical to the success of the objectives. 
c) Be detailed and specific. 
d) The person approving the waiver needs an adequate record USAID memorandum to 

defend their decision. 
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Document button 
Invokes the application's Word Processor. You can copy and paste text from Waivers and 
Justifications using the Edit Menu items. Enter Waivers and Justifications description in the Word 
Processor or in the Waioters and Justification field of the Documents Tab. You can capture 
information from other Tabs in the Request and paste it into the Word Processor. See Page 54 of 
the User's Guide for instructions on how to use the Word Processor. 

To Save the Waivers and Justifications in Word Processing, select Save from the File Menu 
(ALT + F, S). To return to the Request, select Exit from the File Menu (AL T + F, X). 

To save the Documents Tab, click the III Save button or select Save from the File Menu 
(ALT+F, S). 

Line Items Tab 

The Line Items Tab records all the Goods and/or Services, by line item, needed to perform the 
activity. The spreadsheet records each item's description, price, and quantity. The application 
adds the totals for each item and presents a grand total for the entire Request. 

The Requestor and Program ,Manager Roles c<1n enter and apply funds in this form. The 
Contracting Officer and Negotiator Roles can only view the information. 

For all Acquisitions types, the Line Items Tab is mandatory. Regardless of the request category, 
the minimum line item is one. Any item beyond one is optional. Only the Requestor role can 
enter and/or edit the fields and cells in this Tab, except for allocating funds to Funding Control 
Accounts with the Total and Account cells. 
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To enter or edit data to this Tab, click on Line Items Tab. 

$214,000.00 

Enter each item needed by line starting with the item's Product Service Code (PSC) through Unit 
of Measure, which are required fields: Enter the Quantity and Price for each line item. The 
application multiplies the Quantity by the Price to get the Total for each line item. 

Click the IIiII Save button or Save from the File Menu (ALT+ F, S), to save the Line Items Tab. 

To set the delivery schedule for the line item, click on the Delivery button. See Page 35 of the 
User's Guide for additional information on the Delivery Schedule. 

To provide shipping or billing requirements, click on the Shipping button. See Page 36 of· the 
User's Guide for additional information on the Shipping form. 

You can allot funds for each line item from the Apply Accounts box. To allocate funds, click on the 
Accounts button. The Account number allocated for each line item is displayed in the Account(s) 
cell. See Page 41 of the User's Guide for additional information on the Apply Accounts Box. 

To save the entire Tab, click the III Save button or select Save from the File Menu (ALT + F, S). 
The definitions of the fields are: 

Product Service Code (PSC) 
This is a 4 character numeric field. Double click the left mouse button on the field to display the 
Code Lookup box. Enter the 4 digit code or enter the description and click the FIND button. The 
Product Code field will display product codes and item descriptions. Use the arrow keys to make 
a selection and click the SELECT. The PSC is displayed in the field once a selection is made. 

Noun 
This is a 30 character alpha/numeric field. Enter the name of the line item. You can change the 
size of the field to show all the characters by placing the cursor on the line, holding the left mouse 
button down, and dragging the mouse to the size you wan!. 

Description 
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This a 250 character alpha/numeric field. Enter a description of the good andlor service. You can 
change the size of the field to show all the characters by placing the cursor on the line, holding the 
left mouse button down, and dragging the mouse to widen the field. 

Object Class Code (OCC) 
This is a 6 character numeric field. Double click the left mouse button on the field to display the 
Code Lookup box. Enter the 3 digit code or enter the description and click the FIND button. The 
OCC field will display product Object Class Codes and descriptions. Use the arrow keys to make 
a,selection and click the SELECT button. The Object Class Code is displayed in the field once a 
selection is made. 

Unit of Measure 
This is a 2 digit alpha field. Double click the leftmouse button on the field to display the Code 
Lookup box. Enter the 2 digit code or enter the description and click the FIND button. The Unit 
Code field will display the measurement unit for the good and/or service (I.e., grams, each, 
blocks). Units must be in metric measurements per USAID Notice A-AAIFA 10/01/91. Use the 
arrow keys to make a selection and click the SELECT button. The Unit of Measure is displayed in 
the field once a selection is made. 

Quantity 
This is a 6 digit numeric field. To enter the quantity of the good and/orservice needed for the 
Request, double click on the Quantity cell. You can change the size of the field to show all the .~. 
characters by placing the cursor on the line, holding the left mouse button down, and dragging the 
mouse to widen the field. 

Price 
This is a 10 digit numeric field. Enter the base price for a single unit of the good andlor service. 
You can change the size of the field to show all the characters by placing the cursor on the line, 
holding the left mouse button down, and dragging the mouse to widen the field. 

Total 
This is a system generated field that multiples Quantity by the Price for each Line Item. You can 
change the size of the field to show all the characters by placing the cursor on the line, holding the 
left mouse button down, and dragging the mouse to widen the field. To allot funds from Available 
Accounts and link to the Line Item, click on the Accounts button. The Associate Accounts box will 
display. 

How to Use the Code Lookup Box 

You can reach code lookup by double-clicking with the mouse or by placing your cursor in the field and 
pressing ENTER. 

Code Lookup offers two fields for finding the correct code: Code and Description. 

To search for a Code, enter the first letter or two letters in the Code field and press the Find button. 

To search for a description, either enter the first letters and use the First Letter Search option, or enter a 
key word in the description field and de-select First Letter Search. Press the Find button to bring up a list 
containing the text you entered. 

Highlight the correct code and description and press the Select button (AL T + S). If the list is long, use the 
scroll bar to reveal more items. 
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Delivery Schedule Form 
The Delivery Schedule form creates the delivery schedule for each line item. It provides the item 
number, description, date the award is needed, unit of measure, quantity needed, delivery 
schedule, date the delivery is to start after the Award, and any,special requirements for the line 
item. 

To access the Delivery Schedule form, highlight the line item and then click the Delivery button. 
The following will appear: 

The Delivery Schedule can be entered two ways. First, You can enter the quantity and delivery 
date in the Deliveries grid. Second, You can select one of the Requirements option. The 
definitions of the fields are: 

Line Item Number 
This is a pre-filled and protected field from the Line Items Tab. 

Description 
This is a pre-filled and protected field from the Line Items Tab. 

Date Award Needed 
This is a pre-filled and protected date field from the Initial Tab. It is the date the Request is 
needed. 

Unit 
. This is a pre-filled and protected field from the line items. It is the measurement unit for the good 

and/or service. 

Quantity 
This is a pre-filled and protected field from the line items!. It proVides the total quantity of goods 
and/or services needed for this line item. 

Deliveries Grid 
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The Deliveries Grid section breaks down each delivery record of the line item quantity. 

Quantity 
This is a 6 digit numeric field. Enter the amount of goods and or/services to be delivered. This 
amount must be equal to or less than the amount in the quantity field of the line item .. 

Planned Delivery Date 
This is a date field and is to be entered in the following format MMIDDNYYY. It is the expected 

. date the delivery of the goods and/or services are to take place. 

You can key in the new date, or double click o.n the field to display t~e calendar. See Page 27 of 
the User's Guide for instructions on how to use the ·Calendar. This field can only be 'changed 
when this is an Initial Request or there are no Request line items for the Request. This field is 
reql!ired to cmate a New Request. 

RequirementS 
The Requirements section sets specific delivery schedules: 

As Required 
This optio.n is used to 'indicate that the delivery schedule is to setas the line items are needed. 
;rhis option is ~he default option. ". : . • < 

Quantity PE1l'D'lIy/Month . . . 
This is a3'djgit numenc field. Tf)is option is used to indicate that the delivery schedule is to qe.set_ 
at a standard quantity to be 'delivered at' a specific interVai of days"or mOliths,. The size of this field .. 
is dependent on the total quantity of goods ana/or services needed for·this line item: Enterthe _ 
number of days or months in the 2 digit numeric field to the right of Every. Use the drop-down list ., 
box to select whether it is in .days or months. 

After Awarded 
This option is used to indicate that the entire quantity of the line item is to be delivered a specific 
number of days or months after the Award is made. Enter the number of days or months in the 
first field, it is a 3 digit numeric field. Use the drop-down list box to select whether delivery is in 
days or months. 

Reschedule Button 
This button resets the delivery schedule grid to match the option selected in the Requirements 
section. It is disabled when the As Required option is selected. 

Shipping Form 

The Shipping Form is accessed by selecting the Shipping button from the Items tab. The 
Shipping form is used to identify actions and locations involved in the shipment, consignment, or 
billing of line items having a delivery schedule. It is required on all USAID-initiated commodity 
purchases for delivery in order to expedite arrival accounting and, in the case of overseas 
deliveries, customs clearance. Before line items can be made available for shipping actions, they 
must have a 35Delivery Schedule established. 

The blank fields in the Shipping form are filled in by the application after Deliverables are 
selected. The top of the form is synchronized with the bottom portion of the screen so that as you 
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move up and down the spreadsheet, the fields at the top display information related to the specific 
shipping item. Each line in the spreadsheet at the bottom of the Shipping form indicates a unique 
shipment. 

Buttons are used to 1 Shipping form·:· If it is in Edit mode, you are authorized to fill.out the 
form. (Note: If you cannot access the form because there are no delivery items found, fill out the 
Delivery Schedule.) 

How to Do Shipping , .. 
1. Click on !I\01§Il,reraDIesBt button or press ALT+ D. 

2. Select the Deliverables and click on the 1f.'j.0@ button. (For illustration of Select 
Deliverables form, see page 38.) You can select a Delivery Item more than once if Bill To and 
Ship To, etc., will be directed to different addresses. 
3. On the spreadsheet at the bottom of the Shipping form, place the cursor on one of the 
items. If the location will be the same for several items, highlight them at the same time. Click on 

l;:.,; ............. -. uilf"ocati6lis; '-J button. 
4. Select the Location and click on the OK button. (For illustration of the Select Location 
form, see page 39.) 

5. Highlight the items and click on !1;6:ad;eot;i:gtliill button. 
6. Select the Address Type and click on the OK button, (For illustration of Address Type 
form, see page 40.) 
7. Complete the fields in the top portion of the Shipping form for each item on the 
spreadsheet. Some will be filled according to Locations data. If they are on a white background, 
they can be edited: 

Office and Contact: Type in additional information, if needed, to identify the office or contact 
person. 
Ship Via Select the shipping method using a drop·down list box. 

January 2, 1996 37 



A&A Planning User's Guide 

Room and Phone Type in any additional information. 
Accept Partial Delivery Fill in the checkbox to indicate that partial delivery can be accepted. 
Shipping Instructions This is a text box for entering any special instructions regarding 
shipping. To reveal additional text, use the scroll bar or press the Page Down key. 

8. Save the Shipping form by clicking on the Save button [il and close the form (ALT+F.S). 

Select Deliverables 

The Select Deliverables form is displayed when the Deliverables button is clicked. Each row on 
the Select Deliverables form describes one delivery of a Single line item. The Select Deliverabh.)s· . 
form will appear as: 

To select a single delivery for assignment to the Shipping form, click on the row containing the 
Delivery to assign. then click the OK button. (Alternate methods: double-click on the row 
containing the Delivery to assign or; use the UP/DOWN ARROW keys to move to the Delivery to 
assign and press the ENTER key.) 

To select two or more deliveries for assignment to 
the Shipping form. use the Shift key or Control key 
as described to the right 
When the OK button is clicked. the deliveries that 
you selected will be added to the list of shipments 
shown on the bottom portion of the Shipping form. 
If necessary, use the scroll bar on the right-hand 
side of the Shipping list to move the other rows into 
view. 

38 

How to Select Multiple Items 

To select multiple items at the same time, either: 
1. Click the first item you want to select. press and 
hold down the SHIFT key while you click the last item 
to select. Then, click the OK button or press ALT+O. 
This selects two or more items in sequence. OR 
2. Press and hold down the CTRL key while you click 
each item you want to select. Click the OK button or 
press ALT+O. This selects two or more items out of 
sequence. 
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Select Location Form 

The Select Location form allows you to specify the location for a delivery or a group of 
deliveries. The Select Location form will appear as follows: 

To select a Location, click on the row containing the Location to assign then click the OK button. 
(Alternate methods: double-click on the row containing the Location to assign or; use the UP/DOWN 

ARROW keys to move to the Location to assign, then press the ENTER key.) 

A different location can be selected for Shipping and Billing. After selecting the Deliverable, 
Location and Address Type, repeat the process with different selections. 
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Select Address Type - ~. 
The Select Address Type form is used to indicate an action such as'ShipTo or Bill To. It can be 
used several times for each deliverable. The Select Address Type form will appear as follows: 

To select an Address Type for assignment to the Shipping· form, click on the row containing the 
Address Type to assign, then click the.OK button. (Alternate methods: double-click on the row 
containing the Address Type to assign or; use the UP/DOWN ARROW keys to move to the Address 
Type to assign, then press the ENTER key.) 

To save information on the Shipping form, click the Save button or select Save from the File Menu 
(ALT+F, s). 

To cancel assigning an Address Type to the Shipping form click the CANCEL button.or.press ALT+C. 
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Apply Accounts Form 

The Apply Accounts screen links the line items to Funding Accounts. The Requestor and 
Manager roles allots funds from the Funding Control Accounts for each line item. 

To access the Apply Accounts box, click on the Accounts button. 

To assign accounts: 

Available Accounts lists the Funding Control Account number and amount available from which 
the line item can be linked. Only the Requestor and Program Manager roles can make selections 
from this box. 

1. For the first line item, click on the applicable account in the Available Accounts section 

and click the1k~119it;f·J Add button. The account number will be displayed in the Used 
Accounts section. Enter in the amount to for that line to be charged to that account. 
Multiple accounts can be used to fund a line item. 

2. Select the next line item number and return to the Available Accounts section to repeat 
the process described above. Continue to repeat the process until all line items have 
·been assigned to accounts. 

Used Accounts 
This is the Funding Account linked to the line item. To unlink the Account, click on the account 

then click the g)fl'l.ii\§~1 REMOVE button. Only the Requestor and Program Manager Roles can 
make selections from this box. 
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Funding Tab 

The Funding Tab allows the Program Manager to make the final determination regarding request 
for funding. . 

To enter or edit data here, click on the Funding Tab. The following will appear: 

Crudup. Janice 

$25.000.00 

The Approver's Name box is pre-filled with the Program Manager's name assigned by the 
Requestor on the Initial Tab. All of the accounts and the amounts allocated for this Request are. 
listed the Commit Funding Grid. The accounts are listed by Funding Account and Object Class 
Code (OCC). An account may be listed more than once, if it is linked to multiple Object Class 
codes. These amounts are carried forward from the accounts screen on the Line Items Tab. If a 
Program Manager wants to change either an account or an amount, he must do so through the 
Line Items Tab. 

When the Request is complete (including assignment of Contracting Officer and Negotiator) and 
ready to be approved, the Program Manager may commit funds. To accept the funding, click the 
Commit Funding button. This displays a box that states this action will create a financial 
transaction. The Program Manager must type in his password to verify the commitment, then 
click the Commit button. 

Once funds have been committed, the Request Status changes from Pending to Funded. 

The definitions of the fields are: 

Approver's Name 
This is a pre-filled protected field. The Approver was established by the Requester in the 
Manager's field on the Initial Tab of the Request. Only the Program Manager can change the 
Approver's name. 
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Approval Date 
This is a protected date field and is pre-filled when the Request is approved. The date is to be 
given in the following format MMIDDfYYYY. 

J 
Commit Funding Button 
This button accepts the Request's funding. When this button is clicked the Commit Funding box 
appears. 

NOTE: If a Negotiator has not been assigned a message to that effect will be displayed 
and the commitment of funds will not be allowed. 

MA Planning System 

A Negotiator must be assigned before you can 
Commit Funding. 

I' 'OK; I .' . 

Commit Funding Grid 
The Funding grid shows the Funding Accounts and the amount of funds allocated to the accounts 
for the Request. 

Funding Account 
This is a pre-filled and protected cell. It list the selected Funding Accounts. 

Object Class Code (OCC) 
This is a pre-filled and protected cell. It provides the Object Class Code from the Line Items Tab. 

Amount Requested 
This is a 9 digit numeric field. Only the Program Manager can edit the amount to reserve from 
each account. 

Comments 
This is a 200 character alpha/numeric field. Enter any remarks regarding the Request. 

The Commit Funding box 
This box creates the financial transaction. To commit funding, enter your password. 

January 2, 1996 43 



A&A Planning_User's Guide 

Logistics Tab 

The Requestor role is the only Role able to enter or edit this Tab. 

The Logistics Tab states who will provide the facilities and/or services required to accomplish the 
Request. 

Logistics support can involve the use of certain.USAIDlWfacilities and/or services. The 
Requestor can also list additional items after the twelve items preset on the Logistics Tab. For 
use of field mission facilities and/or services, the prior approval of the field mission Executive 
Officer is required. • 

USAID policy concerning the provision of logistic support by the contractor, the cooperating 
country, and the mission under a contract as set forth in AI DAR Appendix C. USAID policy 
concerning the provision of logistic support under a grant or'cooperative agreement, as set forth in 
Handbook 13, Appendix 4C, is that the'Grantee's employees shall maintai[1 ~r!vate,statu~ ard . 
may not rely on local U.S. Government offices or facilities for support when employed overseas. 
Exceptions to this policy are considered on a case by case I?asis, f~r ~,d~viatJI?!1 fro!rl a:: '): '::: . 
mandatory provision under Handbook 12, Chapter 1. The informatiori provided here must be - - -',,~. 

reliable as well as explicit for each category, since price estimates and commitments (both-AID 
and the contractor, recipient, or participating ag~ncy) are based upon it. 

To enter or edit data to this Tab, click Logistics Tab. The following will appear: 

To select the items being provided, click theJeft mouse button and type an 'X' in the cell or, double 
click the left mouse button on-the cell. If none of the Items apply, place an 'X' in the box marked 
N/A. 
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To save the Logistic Tab, click the !PI Save button or select Save from the File Menu (ALT + F, 
S). The definitions of the fields are: 

Provisions for Logistical Support 
This is a 100 character alpha field. It indicates any logistic support that either the mission or the 
cooperating country will furnish, or that a contractor is expected to provide or arrange for itself. 
There are twelve pre-filled Line Items that are typically used for all Requests. Add any additional 
line items below the pre-filled Line Items in the Provisions for Logistical Support column. 

Timeline Tab 

The Timeline Tab lists the tasks to be completed by the Negotiator and the approximate time it 
should take to complete based on the Award Action Type highlighted on the Initiai Request Tab. 

Once the Program Manager has reviewed and approved a completed Request, it is ready to go.to 
Award Formation. The Negotiator sends the Request to Award Formation on this Tab.· '. 

The following will appear: 

Definitive Contract (Competitive) 

05/0411995 

This Tab provides for Milestones information only. Considering the Award Needed by date on the 
Initial Tab, the spreadsheet calculates the date this·Request should go to Formation. The Send to 
Award Formation by date is a reasonable date the Requestor expects the Request to go to Award 
Formation. 

The Award Action Type will be pre-filled and protected from the Initial Tab. All the cells will be 
pre-filled by the application. 
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The Award Needed by date creates a proposed timeline for completion of each task by the 
Negotiator. 

The definitions of the fields are: 

Award A~tion Type 
This is a pre-filled and protected field that lists the Request Action Type as stated on the Initial . 
Request Tab. . 

Send to Formation by 
This is a pre-filled and prote·cted date field based· on the start date of the Request. It is displayed 
in the following format MMIDDIYYYY. The rest of the dates are dates by which the Milestones are 
projected to be completed. 

Milestones 
This field lists the tasks that need to be completed by the Negotiator in Award Formation. Not all 
milestones will be applicable to each procurement 

Planned Completion 
This is a pre-filled protected field based on the selection of an Award Action Type and the Date 
Award Needed by field on the Initial Request Tab. This is the estimated completion date for each 

,. milestone necessary to complete each milestone in meeting·the time frame for completing the 
Award. . 

Accept Request Button 
This button sends the Request to the Award Formation application. There.must be at.least one 
line item on the Line Items Tab to send the Request to AWard Formation. Only the Negotiator can 
send a Request to Award Formation. 

Staffing Tab 

The Staffing Tab allows you to make the Request available to others for review. You will be able 
to follow the status of the Request and review comments·through this Tab. 

All Roles can enter or edit this Tab. 

When the Tabs are completed and saved, the Request is ready to be staffed. Remove the "X" 
from the Worksheet field by clicking the mouse on the box or hitting the space bar on the 

keyboard. Click the lliIl Save button or Save from the File Menu (AL T + F, S) to update the 
database and staff the Request. 
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Click Staffing Tab to enter or edit it. The following will appear: 

Enter 1 in the Priority field for-the first person(s) to receive the Request 

To select the Organization double click the left mouse button on the Organization field to display 
the Code Lookup box. Enter the 4 digit code or enter the description and click the FIND button. 
The Organization ID field will display Organization codes and Organization descriptions. Use the 
arrow keys or click on the row to make a selection then click the SELECT button. The Organization 
is displayed in the field once a selection is made. 

To select the person to Staff To double click the left mouse button on the Staff To field to display 
the Code Lookup box. Enter the 4 digit code or enter the description and click the FIND button. 
The Staff To field will display User Ids and Employee Names to receive the Staffing Request Use 
the arrow keys or click on the row to make a selection then click the SELECT button. The Staff To 
name is displayed in the field once a selection is made. 

Repeat steps 1 - 3 for each person to receive the Request. 

You can staff ten Priority #1, or do it sequentially. Change the priority for each person based on 
the order in which they are to receive it. 

When the Request is staffed and the Request is no longer a Worksheet, click the ilill Save 
button or Save from the File Menu (AL T + F, S) to route the Request. The Request will be routed 
to the persons in the Staffing Tab based on their priority. The Staffing Tab will place a message in 
the person's Alert Box that they have this Request to review. 

The definition of the fields are: 

Priority 
This is a 2 digit numeric field. Enter the number which corresponds to the priority of the person to 
whom you are sending the Request. The person(s) with the same priority number must concur 
with the Request before the next priority number can view the Request. 
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Date Staffed 
This is a date that is pre-filled by the application with the date the Request was sent for review. 

Organization 
This displays the list of USAID Organizations. Double click on the line item, select the 
Organization of the person who is to receive the Request. Use the Code Lookup box to make a 
selection. 

Staff to 
This displays the names of the people in the Organization highlighted in the Organization field. 
Use the Code Lookup box to make a selection. 

Status 
This is a drop-down list box that displays status selections. The person who receives the Request 
is to make the selection after they view the Request. Use the ARROW keys to make a selection, or 
click the left mouse button on the down arrow button and use· the drop-down list box to make a 
selection. 

Date Acknowledged 
This is a date field that is pre-filled by the application with the last date the routed information was 
reviewed by the person. It is listed in the following format MMIDDfYYYY. 

Comments 
This is a 200 character alpha/numeric field. Enter the comments regarding the Request. 

Acquisition & Assistance Planning Windows 

The A&A Planning Application IS a Microsoft Windows compatible product. A&A Planning 
windows may be minimized, re-sized, -moved, and closed. A&A Planning windows are displayed 
many times during normal use of the A&A application. 

The Windows pull-down menu, located on the menu bar, can be used to manage multiple open 
windows. The "Tile Vertical" menu option causes all open windows to be arranged one above 
another, so that each window is as wide as the screen, but short enough so that all open windows 
may be displayed. The "Tile Horizontal" menu option causes all open windows to be arranged 
beside one another, so that each window is nearly as tall as the screen, but narrow enough so 
that all open windows may be displayed. The "Cascade" menu options causes all open windows 
to be overlapped, with each window being slightly lower and to the right of the last. The "Arrange 
Icons" option causes all minimized windows, which appear as icons, to be lined up beside one 
another and displayed in the open (not behind an open window). Finally, all open windows are 
numbered and listed in the Windows menu. Selecting a numbered window from the list will cause 
that window to become the current window. 

Dialog windows are windows with OK and Cancel buttons. The tool bar and menu bar are not 
available when a dialog window is displayed. Complete data entry in the dialog window and use 
the OK button or use the Cancel button to leave the dialog window. On-line help and text edit are 
not available when a dialog window is displayed. 
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Text Editing Features 

The A&A application includes some common word processor-like features for text editing. The 
cut, copy, and paste feature act on text that has been highlighted. Text may be highlighted using 
the mouse by positioning the cursor at the beginning of the text to be highlighted, clicking the left 
mouse button on the button, and dragging to the end of the selection. To highlight text using the 
keyboard, position the cursor at the 'beginning of the text to select and hold down the SHIET key. 
Move to the end of the selection using the up, down, right and left arrow keys and release the 
SHIFT key. To cut 'or copy text, either use the cut and copy buttons on the toolbar or select the _ 
appropriate menu options from the Edit pull-down menu. To delete text, press the DELETE key" . 
on the keyboard. 

Since the A&A application is Windows compatible, text that is cut or copied is sent to the Windows 
clipboard. That text can be copied back into the A&A application using the Paste button or menu 
option. Text can also be cut from other Windows compatible applications and copied into the A&A 
application from the clipboard. For example, to import text from a WordPerfect for Windows (or" . 
any other Windows-based word processor) document, minimize the A&A application main window 
by using the down arrow on the upper right-hand corner of the window. Load Wor9Perfect fdr.· 
Windows and open the document containing the text to be imported. Highlight tlie -texi 'ana copy if' 
to the Windows clipboard. Exit WordPerfect, find the A&A Application icon and double click on it 
to restore it. Position the cursor at the location to import the text, then use the Paste button or 
menu option. Text may be exported from the.A&A application in a similar manner. 

Availability of text fields for copying to Windows clipboard: As a rule of thumb you can copy text 
that you entered directly from the keyboard. Exceptions are option buttons, check boxes, text 
selected from drop-down boxes, and text areas filled by selecting a date from the calendar. If in 
doubt as to whether you can copy a particular block of text, highlight the text and press CTRL +C. If 
Windows is able to carry-out the copy command then the highlighted text will be copied to the 
Window's clipboard. ' 

To export numbers from the Line Items Tab spreadsheet, the copy feature may be used. The 
method of selecting the area to be copied and executing the copy action depends on the 
spreadsheefs mode. 

Use the mouse, when editing the spreadsheet, to move from cell to cell. In this mode you can 
select all the cells in the spreadsheet with a single mouse click on the upper left-most spreadsheet 
cell, or, a specific group of cells can be selected by holding down the left mouse button while 
dragging across the cells to be copied. Once highlighted the text can be copied to the Windows 
clipboard by using the Copy button or Copy from the File Menu (CTRL+C). 

When the spreadsheet is presented in a mode where an entire row of cells is highlighted and cell 
to cell navigation is not possible. The current row that is highlighted can be copied by pressing 
(CTRL+C). 

Minimize the A&A application window and enter Lotus for Windows (or any other Windows based 
spreadsheet). Select Lotus's Paste menu option. All the numbers from the highlighted cells will 
be entered into the Lotus spreadsheet. 
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Note Form 

The Note form allows you to attach a message to a specific Tab. To attach a Note, click the III 
Note button or select'Attach Note from the Options menu (ALT+ 0, A). The fOllowing will appear: 

This should be used 'to bring to the attention of the Requestor,any changes needed to fields that " 
only the Requestor has access. This is an open field on which to write comments regarding a 
specific Tab of the Request. Use the paper clip button to attach it to·the 'rab folder. Only one 
note· per tab can be attached. 

Search 

The Search Box allows,You to.search for records that contain specific information from the 

database. To do a Search, select Search from the Database Menu (ALT+ D, S) or use the jil:l 
Search button. The Request Search box will appear: 
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Select the attributes that you know aboutthe Request(s) for which you are searching. The more 
attributes you can determine, the smaller the number of records that will be retumed. Determine if 
you want to search for Partial or Full text. Determine if you want to use and/or for. multiple 
attributes. Click the Search button to initiate the Search. The Open Request box will display all 
the Requests that match the attributes. Select the Request you want and click the Open button. 
The definitions of the fields are: 

Organization ID 
This is a 10 digit numeric field. Enter the number identifying the Request. 

RequestlD 
This is a 8 digit numeric field. Enter the primary key Identifying the Request. 

Title 
This is a 52 character alpha/numeric field. Enter the title for the Request. 

Description 
This is a 500 character alpha/numeric field. Enter key words located in the Request Description 
and click the Partial button. 

Negotiator 
This is a drop-down list box that displays the Negotiators. Select the Negotiator who is to be 
assigned to this Request. You can key in the first character of the Negotiator's last name and use 
the arrow keys to make a selection or click the left mouse button on the down arrow button and 
use the drop-down list box to make a selection. 

Contracting Officer (CO) 
This is a drop-down list box that displays the Contracting Officers assigned to the Contract Office. 
Select the Officer who is to be assigned to this Request. You can key in the first character of the 
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Officer's last name and use the arrow keys to make a selection, or click the left mouse button on 
the down arrow button and use the drop-down list box to make a selection. 

Requestor 
This is a drop-down list box that displays the Requestors assigned to the Project Office. Select 
the Requestor who is assigned to this Activity. You can key in the first character of the 
Requestor's last name and use the arrow keys to make a selection, or click the left mouse button 
on the down arrow.button and use the drop-down list box to make a selection. 

Manager 
This is a drop-down list box that displays the Managers. Select the Manager who is to approve 
this Request. You can key in the first character of the Manager's last name and use the arrow 
keys to make a selection or click the left mouse button on the arrow button and use the drop-down 
list box to make a selection. 

Country 
This is a drop-down list box that displays the list of Countries. Select the Country that is benefiting 
from the activity. You can-key in the first character of the Country's'name and use the arrow,keys 
to make a selection, or click the left mouse button on the down arrow button and use the drop
down list box to make a selection. 

Award Number 
This is a 10 digit numeric field. Enter the uniEfue number for the Request. 

Abstract 
This is a 1000 character alpha/numeric field. Enter key words located in the SOW, Product 
Description, or Program Description to search for. and click the Partial button. 

Request Category 
This box allows you to select the type'of the Request. Place the pOinter on the option for which' 
the Request is being made and click the left mouse button. With the keyboard, use the arrow 
keys to select the option. 

Proposed Award Action Type 
This is a drop-down list box that displays the fund Actions. The Request Category determines 
what Award Action Types are displayed in the list box. Select the Action to be performed by this 
Request. You can key in the first character of the Action and use the arrow Keys to maKe oj 

selection, o~ click the left mouse button on the down arrow button and use the drop-down list box 
to make a selection. 

AndlOr 
These buttons are used in a Search that contains multiple attributes. 

And - returns record(s) that contain all of the attributes selected. 
Or - returns record(s) that contain any of the attributes selected. 

Partial/Full Text Search 
These buttons are used to determine the scope of the Search. 

Partial - Searches for text as first item. 
Full - Searches for given text anywhere in the database. 
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Create Reports 

The Create Report form allows you to create a report for specific data from the records in the 

database. To create a report, click the II:! Reports button or select Reports from the Database 
menu (ALT+ D, R). 
The following will appear: 

Create Reports . 

Select the Report Name for which you want to create a report. The Available Fields box is pre
filled·with the fields contained in the report. To view the entire Report, click the Get Report Data 
button. A grid listing the associated data is displayed at the bottom of the form. If there are a 
large number of records contained in the report, the application will allow you to stop building the 
report so you can set the parameters of your report. To set parameters by fields, select the field 
name(s) in the Available Fields box and move them to the Selected Fields box. To move the field 
name(s), double click on the field name or click and drag the field name to the Selected Fields 
box. To set the parameters by distinct values in the Available fields, select the field in the Selected 
fields box, double Click on the field, a field box is displayed to the right and all the distinct values 
for the field is listed. To specify value parameters: 

a) You can select one value as the parameter for the report by clicking the distinct value you 
want and clicking the Get Report Data button. A grid displaying the report values is 
displayed at the bottom of the form. 

b) You can select a range of distinct values as the parameter for the report by blocking those 
values. This can be accomplished by clicking the left mouse button on the first value you 
want and moving to the last value you wan~ holding the SHIFT key click the mouse. To 
view the Report, click the Get Report Data button. A grid displaying the report values is 
displayed at the bottom of the form. 

January 2, 1996 53 



A&A Planning User's Guide 

c) You can select specific distinct values by repeating step b; holding the CTRL key click the 
left mouse on values you do not want. To view the Report, click the Get Report Data 
button. A grid displaying the report values is displayed at the bottom of the form. 

To print the information in the grid, click the Print button or select Print in the File Menu (AL T + F," 
Pl. You can sort items in the grid by clicking the top row of the column (the row with the field 
name). This highlights the entire column, click the right mouse and the grid will be sort by the 
selected column. 

The definitions of the fields are: 

Report Name 
This is a drop-down list box that displays the names that can be selected to create a report. You 
can key in the first character of the Report name and use the arrow keys to make a seJection or 
click the left mouse button on the down arrow button and use the drop-down list box to make a 
selection. 

Get Report Data 
This button displays the data grid, at the bottom of the form, listing the report values. 

Available Fields box 
This box is pre-filled when you select a Report Name. All the fields in the report are listed in this 
box. To move a field into tlie Selected Fields box, double click on the field name or hold the left "." 
mouse down and drag it to the box. 

Selected Fields box 
This box displays the fields selected from the Available Fields box to make the report. To view the 
distinct values of the Selected Fields, double click it and the name of the field and. the field box 
with the distinct values is listed to the right. 

Distinct Values box 
This box is pre-filled when you double click on a field listed in the Selected Fields box. The data 
listed in this box are all the Distinct Values for the selected field. 
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Word Processor 

This Word Proces.sor allows you to create and print documents within the A&A Planning 
application. The Document can be edited by the Requestor Role only . 

. ~~ 
~~~ 

When you click the , .•.... "'> .. Document button or the w;,;v""'and Justification button, the 
following will appear: 

USAID Acquisition & Assistance [Planning) 

Pull-Down Menus 

The Word Processor pull-down menus are located on the menu bar, the second line in the main 
Word Processor window. A menu can be activated by clicking on a menu title with the mouse or 
by pressing ALT key, moving to a menu title with the right and left arrow keys, then pressing the 
ENTER key. Select a menu option from the pull-down menu by either clicking on the option or by 
moving to the option using the up and down arrow keys, then pressing the ENTER key. 

January 2, 1996 55 



A&A Planning User's Guide 

The menu structure is as follows: 

File Menu 
Save 
Print 
Exit 

Edit Menu 
Cut 
Copy 
Paste 

Search 
Search Next 
Replace 
Insert Picture 

Page Break 

View Menu 
Ruler 

Button Bar 
Status Bar 

Tab Bar 

Layout.Menu 
Page 

Tools Menu 
Repaginate 

Font Menu 
Font 

Normal 

Bold 
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: Saves and attaches the record to the Request. 
: Allows you to print the information. 
: Ends the word processor session. The application prompts you to save 

any unsaved changes in a record. 

: Removes highlighted text and puts it in the clipboard. 
: Copies highlighted text to the clipboard. 
: Inserts a copy of the text, in the clipboard, at'the insertion point. It 

overlays any existing text in the field. 
: Finds a word, phrase, or code in your document. 
: Finds the next occurrence of the text you last searched for. 
: Finds and changes text or codes in your document. 
: Presents a dialog from which you can select the picture to be inserted. 

Note: All graphics types shown in the dialog may not be compatible 
with all video displays in the Word Processor. To view a picture of a 
specific type check the Preview box. When a graphic file is selecte.d. '. 
the picture is displayed on the Preview window. If an image is not . 
displayed on the Preview window then the image is not compatible ' 
and cannot be inserted into the word processing document. 

: Allows you to insert a page break into the document. 

: Displays or hides the horizontal ruler, a bar with a measurement scale 
and markers that enable you to adjust indents, margins, tab stops, and 
table columns. The ruler is part of a document window; you can choose 
to display the ruler in some document windows while hiding it in others. 
See Displaying or hiding the ruler. 

: Quick access to the commands you use most. 
: Located at the bottom of the WordPerfect window, the status bar displays 
information lines (long prompts) that provide a brief synopsis of the menu 
item or option you are currently highlighting. 

: Use the tab bar to change your tab settings qUickly and easily by moving 
any of the triangular tab marker buttons or the button marked with dots, 
located on the ruler. 

: You can change the margins, tabs, and measurements that the word 
processor uses by default. 

: Automatically places page breaks into the document. 

: Applies or removes character formats from highlighted text or from the 
insertion point forward as you type. 

: Returns a document to normal view. It is the default view you will use for 
most word-processing tasks. Normal view shows text formatting, but 
simplifies the layout of the page so that you can type and edit quickly. 

: Lets you add Bold text to your document. 
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Underline 
Strikeout 
Subscript 
Superscript 

Window 

1 
Help Menu 

Contents 
Help on Help 
About 
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: Lets you add Italic text to your document. 
: Lets you add Underline text to your document. 
: Lets you Strikeout text on your document. 
: Text that appears slightly lower than other characters in the line. 
: Text that appears slightly higher than other characters in the line. 

Displays a list of the windows open within the Planning application. 

: Word Processor Help Table of Contents. 
: Win-dows Help System. 
: Information about the Word Processor. 
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APPENDIX A 

AWARD ACTION TYPES 

Request Category - Acquisitions: 

Request for New Award 

Definitive contract (Competitive) 
Definitive Contract (Non-CompetitiVe, Sale source) 
Definitive Contract (Non-Competitive, limited Source) 

Request Category - Assistance: 

Request for New Award 

Cooperative Agreement (Competitive) 
Cooperative Agreement (Non-Competitive) 
Cooperative Agreement (Tech Office) 
Grant (Competitive) 
Grant (Non-Competitive) 
Grant (Tech Office Competition) 

Request Category - Inter-Agency Agreement: 

Request for New Award 

Inter-Agency Agreement (Non-Competitive) 
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Award Modifications 

Administrative Contract Modification 
Award Fee ModHication 
BasIc Ordenng Agreement 
Definitization of Letter Contract 
Letter Contract 
New Work Bilateral Contract Modification 
Option Exercise Modification 
Priced Order (orders under BOAs, IQCs, REQs, DEF QTYs) 
Settle Tenmnation for Convenience 
Settle Termination for Default 
BIlateral Contract Modification 
Termination for Convenience 
Termination for Default 
Unilateral Modification 
Unprlced Order 
Unpriced Bilateral Contract Modification 

Award Modifications 

Administrative Contract Modification 
Cooperative Agreement Modification 
Grant Amendment 
Unilateral Modification 

Award Modifications 

Administrative Contract Modification 
Inter-Agency Agreement Modification 
Umlateral Modification 
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APPENDIX B - Application Features 

Logon Procedure and Problems 

A&A Planning is accessed through the NMS logon, The logon box provides a security mechanism 
to ensure that only authorized users may log on to NMS applications. 

To move from User ID to Password, use the TAB key. As the password is typed, the characters 
will not show on the screen. 

The table below lists possible causes for a logon failure: 

• Cau.se., .. 
Improper User Name or Password. 

The database account has not 
been set up for new users. 
After. an A&A Planning-error ' 
occurs, the system will not logon. 

The database is down. 

Type Correct'User Name ana 
Password and try again. 
Contact DBA- and request an 
Orac:le.accou.nt 
'Exit ana re~enter Windows and 
try again. If the problem persists, 
reboot and try again. 
Contact DBA and report logon' " , 
failure. 

- DBA - Database Administrator 

Menus Topic Definitions 
PUll-down menus are located on the menu bar, the second'line in the A&A Planning window. 

File Edit Database Options Window Help 

A menu can be activated by clicking on a menu title with the mouse or by pressing ALT + the 
accelerator key, moving to a menu title with the right and left arrow keys, then pressing the ENTER 

key. Select a menu option from the pull-down menu by either clicking on the option or by moving 
to the option using the up and down ARROW keys, then pressing the ENTER key. 

New 

Open 

Close 

Save 

January 2, 1996 

: Allows you to create a new Request or add a Staffing assignment (if 
the Staffing tab is currently displayed). 

: Displays a form showing all Requests that the User has created or 
is working on. 

: Closes the active record. If you have not previously saved the 
changes to the record, the Application asks if you want to save the 
record before you close it. If you close a record without saving, you 
will lose all the changes you did not save previously. 

: Saves the active record. 
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Delete 
Print Setup 

Print 
Exit 

Cut 
Copy 
Paste 

Database 
Change Role 

Next Record 
Previous Record 
Query 

Search 

Reports 

Options 
Toolbar 

Application 
Logging 

Panel Help 

Attach Note 

Window 
Cascade 

Tile Vertical 
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: Removes the currently selected record from the database. 
: Displays the Print Setup box to specify' printer settings for your 

printer. The settings you select become the default settings. 
: Prints the Request. 
: Closes the A&A Planning Application and brings you back to the 
Windows screen from which you started the A&A application. 

: Removes highlighted text and puts it into the clipboard. 
: Copies highlighted text to the clipboard. 
: Inserts a copy of the text from the clipboard at the insertion point. It 

replaces any existing text in the field. 

: Displays the Logon Role box. This allows you to select the role for 
the duties that you will be performing. See Page 4 of the User's 
Guide for instructions on how to use the Change Role box. 

: Moves forward one record in the database. 
: Moves back one record in the database. 
: Opens the COTS ('commercial off the shelf query tool). See the 

Help in COTS for instructions on how to use it. 
: Opens the Search form. This allows you to search for records that 
contain specific information from the database. See Page 50 of the 
User's Guide for instructions on how to use the Search form. 

: Opens the Create Reports form. This allows you to create a report 
for specific data from the records in the database. See Page 53 of 
the User's Guide for instructions on how to use the Create Reports 
form. 

: To remove the Toolbar, click the left mouse button on the 'Toolbar' 
topic in the menu. The check mark disappears. To make the 
Toolbar appear, click again and the check mark appears. 

: Tracks the interaction with the database. This helps in 
troubleshooting. When on, the Application Logging icon will appear 
at the bottom of the screen. Double-click the icon to view the log. 

: Turns the Panel Help off and on. Click the left mouse button on the 
Panel Help topic to make the check mark disappear. This turns off 
the Panel Help. Click the mouse again, the check mark appears 
and Panel Help will be activated. 

: Opens the StiCky Note form. This is an open field to write comments 
regarding a specific Tab. Notes may be used to communicate ideas 
between users of the application, such as changes needed to fields 
to which only the owner of the record has access. See Page 50 of 
the User's Guide for instructions on how to use the Note form. 

: Arranges the windows so that they overlap starting in the upper left 
hand corner and the title bar of each window remains visible. 

: Arranges the windows one above the other so that they do not 
overlap. 
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Arrange Icons -
Contents . 

Search For Help 

Help on Help 
About 
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: Arranges the windows next to each other. so that they do not 
overlap. 

: Evenly arranges all Icons in a group window. You can also specify 
that Windows rearranges the program-item icons in a group window 
whenever you change the window's size, add items, or move items-

: Displays the Table of Contents of the A&A Planning Help system,. 
how to use the system, purpose information provioed,:processes 
and field definitions. 

: Displays the Search box with a drop-down list box of topic listed 
alphabetically. 

: Displays the Windows Help system. 
: InformatiOn about the A&A Planning Application. 

Note: When a Menu Item appears in gray lettering, the topic is not active'for the form that you 
are using. Items displayed in black are active for the form that you are using. 

Mouse and Keyboard 

The A&A Planning Application supports·the use of a mouse (or other pointing device) as well as 
the standard keyboard. A mouse is not required for most application features. A mouse is 
commonly used to click on buttons and icons, and to make the pull-down menu bar active. If a 
mouse is not available, the following keys can be used instead. 

TAB key 

SHIFT+TAB Key combo 

Moves among fields and buttons in a window, and pull-down 
menus on the menu bar. 

Pressing the SHIFT key and the TAB key simultaneously will 
move backwards to previous field, button, or menu. 

Up and Down Arrow keys Moves through a list of choices (I.e., through the menu options in 
a pull down menu). 

ENTER key 

ALTkey 

AL T +Down Arrow keys 

~ 

•• 

Selects a button, a menu, or a menu option. 

Moves between menu bar and current window. 

Displays a list of valid choices for a field, when available (I.e., 
Contracting Officer fields). 

How tQ SeleCt from a IJrop;,oown'LisfSox: ., • 
~ " , ~ ," , 

Click the left mouse Dutton on the down arrow butt~n to see the list, ;croll down if you need to see 
. more,. Click o~ yo~r selection, '...' . • . 

iii 

~. " , ,', 

Using' the keyboard, hold down AU + dow~ arrow k.ey to see th'llist. l!~e.up and down arrows to 
.' ". seleel. Press ENTER:.' .•.• .'". '. '. . . .' 
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Using Keyboard Shortcuts 

Ctrl+ S Save 
Ctrl+X Cut (Remove text to clipboard) 
Ctrl+ C Copy (Copy text into clipboard) 
Ctrl+ V Paste (paste text from clipboard) 
Ctrl+ Q Query (Access Query application) 
Ctrl+ E Search (initiate Search) 
Ctrl+ P Print 
Ctrl+ A Attach Note (Create, edit or view note) 
Ctrl+ B Toolbar . (On and Off) 
Ctrl+ F4 Close form 
Ctrl+ F6 Window (Move to another screen) 

Date or Time fields 
F3 Current date or Time 
F4 Calendar 

Mouse and Keyboard - Shipping Form 

The follQwing describes the actions that occur when a specific mouse/key function takes place. 

Mouse/Key Function 

Down Arrow Key· 

. Up Arrow Key 

Delete Key 

Mouse Double Click 

6-4 

Result Action 

When more that one row is displayed moves highlight to the next 
row. • 

When more than one row is displayed moves highlight to the 
previous row. 

Deletes, after confirmation, the highlited row or rows. 

Actions.is based on which column the mouse is pointed towhen 
the double click takes place: 

Item Description column - will present the Select Deliverables 
listing from which you can select one or more Deliveries to 
schedule for shipment. See Page 38 for information on Select 
Dellverables. 

Qty column - no action 

Delivery Date column - no action. 

Location column - will present the Select Location listing from 
which you can select one Location to be assigned to one or more 
shipments. See Page 39 for instructions on Selecting a 
Location. 

Address Type column will present the Select Address Type 
listing from which you can select one Address Type to be 
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SHIFT Key + Mouse Click 

CTRL Key + Mouse Click 

Mouse Click 
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assigned to one or more shipments. See Page 40 of the User's 
Guide fo information on Select Address Type. 

Used to select two or more rows in sequence. Used to highlight 
consecutive rows to be deleted, receive new Location selection, 
or new Address Type selection. 

Used to select two or more rows out of sequence. Used to 
highlight rows to be deleted, receive new Location selection, or 
new Address Type selection 

Highlights the row being pointed to and removes highlighting 
from rows that were highlighted using SHIFT + Mouse Click or 
CTRL + Mouse Click. 

Word Processor Button bar 

The Word Processor toolbar contains a series of buttons that can be'clicked with the mouse as an 
alternative to using the pull-down menus. The Button bar may be tumed on and off with the View .,,-'. 
pull-down menu by selecting Button bar. 

Left Align 
Center Align 

Right Align 
Justify 

Bold 

Italics 

Underline 

Strikeout 

Single Space 

Double Space 

Triple Space 

Subscript (H Button) 

Superscript (T Button) 
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: Aligns text with the left margin, but leaves a ragged right margin, 
: Centers text between the left and right margins or on a specific 

point on a line. 
: Aligns text with the right margin, but leaves a ragged left margin, 
: Aligns text with both the left and right margins, adding or deleting 

space between words as needed. 
: Bolds the highlighted text in the document. This function can be 

accomplished by choosing Bold in the Font Menu (AL T + 0, B). 
: Italicizes the highlighted text in the document. This function can 

be accomplished by choosing Italic in the Font Menu (ALT+ 0, I). 
: Underlines the highlighted text in the document. This function can 

be accomplished by choosing Underline in the Font.Menu (AL T + 
0, U). 

: Strikes out the highlighted text in the document This function can 
be accomplished by choosing Strikeout in the Font Menu (AL T + 
0, K). 

: Sets the line spacing for each line to accommodate the largest 
font in that line. 

: Sets the line spacing for each line to twice that of single line 
spacing. 

: Sets ihe line spacing for each line to three times that of single line 
spacing. 

: sets the line to Subscript - Text that appears slightly higher than 
other characters in the line. 

: sets the line to Supercript - Text that appears slightly lowerher. 
than other characters in the line. 
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To use one of these items, block the text, click either the "H" or"T" on the button: 

Tab Sets_ 
Left Tab set 
Right Tab set 
Decimal Tab set 
Center Tab set 

: Sets Aligned Left Tab. 
: Sets Aligned RightTab. 
: Sets Aligned Decimal Tab. 
: Sets Aligned CenterTab. 

The Word Processor defaults to Left Tab set. To add additional or new Tab stops, click 
the type of Tab on the button that you want, then put the cursor on the point of the Tab 
Bar where you want the Tab and click the left mouse button. 

Show/Hide : Shows all non printed characters, including paragraph marks and 
spaces. 

Font Colors : Displays the Font Color Box. Allows you to choose the color that 
the text appears in the word processor. 

Basics 

Print: 
1. Choose Print from the File menu. 

Save: 
1. Choose Save from the File menu. 

Search: 
1. Place the cursor where you want the search to begin. 
2. Choose Search from the Edit menu. 
3. Type the text you want to find. 
4. Select Forward or Backward from the Direction pop-up list 
5. Choose Search to begin the search. 
6. If you want to find another occurrence of the same s?arch text, choose Search Next from the 

Edit menu. 

Code Lookup Box 
Code Lookup offers a way to fill in a field by using a list with search options. 

Fields with the code lookup feature are displayed with blue lettering (In the Line Items table, 
columns with Code Lookup are titled in bold letters.) You can reach code lookup by double
clicking with the mouse or by placing your cursor in the field and pressing ENTER. 

Code Lookup offers two fields for finding the correct code: Code and Description. 

To search for a Code, enter the first letter or two letters in the Code field and press the Find 
button. 

To search for a Description, either enter the first letters arid use the First Letter Search option, or 
enter a key word in the description field and de-select First Letter Search. Press the Find button 
to bring up a list containing the text you entered. 
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Highlight the correct code and description and press the Select button (ALT+S). If the list is long, 
use the scroll bar to reveal more items. 

Code Lookup box displaying a list of subjects beginning with the letters HA. 
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APPENDIX C 

Waiver Listing 

Abortion Equipment and Services 

Handbook 1 B Chapter 4 Section D4d 

Waivers of the policy set forth in this section may be authorized only by the President in 
accordance with Section 614(a) of the FAA 

Agricultural Commodities 

Handbook 1B Chapter 4 Section C1a(1) 

(1) There is·no provision for waiver of the policy in 4C1a(1) requiring prior approval. -:~." 
(2) Waivers of the policy set forth in 4C1 a(2) may be authorized only by the President in 

accordance with section 614(a) of the FAA A determination made pursuant to 4C1a(2)(C) to 
finance non-U,S, commodities does not require a waiver by the President. A geographic 
source waiver, in accordance with the provisions of Chapter 5 will be necessary if the 
commodity is to be purchased from a countl}' not eligible under the Agreement. 

Assistance Deviations 

Handbook 13 Chapter 1 Section E 

1. Request for Deviations 
a) Deviations from the indicated mandatory provisions contained in the fonnats or actions 

inconsistent with the policy or procedure contained in Handbook 13 will be authorized only 
when essential to effect necessary pertonnance under the grant or cooperative agreement or 
when special circumstances make such deviations clearly in the best interests of the 
Government. 

2. Deviation Request Content 
Each request for a deviation shall contain as a minimum: 
a) Identification of the provision, policy, or procedure from which a deviation is sought; 
b) A full description of the deviation and the circumstances in which it will be used; 
c) A description of the intended effect of the deviation; 
d) A statement as to whether the deviation has been requested previously, and if so, 

circumstances of the previous request; 
e) The name of the recipient and identification of the grant or cooperative agreement affected, 

including the dollar value; and 
f) Detailed reasons supporting the request, including any pertinent background infonnation 

which will contribute to a fuller understanding of the deviation sought 
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Commodities and Services for Support of Police anci Other Law 
Enforcement Activities 

Handbook 1 B Chapter 4 Section 3d 

Waivers of the policy set forth in this Section may be authorized only by the President in 
accordance with Section 614(a) of FAA. 

Competition - Assistance 

Handbook 13 Chapter 2 Section B 

a. Noncompetitive awards must be justified in writing by the technical office. Justification shall be 
based on one of the exceptions in paragraph 2B3 and shall provide sufficient..evidence to 
clearly show that the exception is proper. 

b. The justification shall be submitted to the cognizant grant officer for review (except for a 
justification made under paragraph 2B3e - such justifications are final and are not subject to 
review). If the grant officer rejects the justification, he or she will notify the project office in 
writing, explaining the reasons for rejection. The technical office may appeal any rejection to 

. the responsible Assistant Administrator or Office Director who reports directly to the 
Administrator. The decision of that official shall be final. 

Competition - Negotiation with a Single Source - Commodities 

Handbook 1B Chapter 12 Section 85 

Deviations form requirements of AIDARIFAR and may be authorized by the head of the 
Contracting activity (HCA) in accordance with the FAR 1.4 and AIDAR 701.4 

Types of Justification for Other Than Full and Open Competition defined by FAR 6.302 

1. FAR 6.302-1 - Only One Responsible Source and no other supplies or services will satisfy 
agency requirements 

2. FAR 6.302-2 - Unusual and Compelling· Urgency 
3. FAR 6.302-3 - Industrial Mobilization, or Engineering, Developmental, or Research Capability. 
4. FAR 6.302.4 - International Agreement 
5. FAR 6.302-5 - Authorized or Required by Statute 
6. FAR 6.302-6 - National Security 
7. FAR 6.302-7 - Public Interest 

Requirements for Justification for sole source Acquisitions are defined in FAR 6.303. 

Competition - Other Than Full and· Open - Technical Assistance 

Handbook 14 Section 706.3 

Full and open competition need not be obtained when it would impair or otherwise have an 
adverse effect on programs conducted for the purposes of foreign aid, relief, and rehabilitation. 
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Types of Justification for Other Than Full and Open Competition defined by FAR 6.302 

1. FAR 6.302-1 - Only One Responsible Source' and no other supplies or services will satisfy 
agency requirements 

2. FAR 6.302-2 - Unusual and Compelling Urgency 
3. FAR 6.302-3 - Industrial Mobilization, or Engineering, Developmental, or Research Capability. 
4. FAR 6.302.4 - Intemational Agreement 
5. FAR 6.302-5 - Authorized or Required by Statute 
6. FAR 6.302-6 - National Security 
7. FAR 6.302-7 - Public Interest 

Requirements for Justification for sole source Acquisitions are defined in FAR 6.303. 
Disaster Relief Procurement Authorities and Procedures 

Handbook 8 Chapter 5 Section 

Eligibility of Commodities Determined by Ineligibility of Carrier and Marine 
Insurance 

Handbook 1 B Chapter 4 Section E4 

a. Project Assistance 
The Assistant Administrators who have program responsibility, acting in consultation with GC, 
may waive the application of the policies described in this Section, except for Section 4E1 c, 
which may be waived only by the President in accordance with Section 614(a) of the FAA. 

b. Nonproject Assistant 
MIOP acting in consultation with GC may waive the application of these policies described in 
this Chapter, except for Section E1c, which may be waived only by the President in accordance 
with Section 614(a) of the FAA. 

Eligibility of Incidental Services 

Handbook 1 B Chapter 13 Section B4 

Waivers or determinations affecting the eligibility of incidental services are made by the Director, 
FNOP. 

Fertilizer 

Handbook 1 B Chapter 4 Section C7d 

(1) The Director of M/OP may authorize procurement of non-U.S. fertilizer upon a finding of 
significant price differentials or adverse impact as described in 4C7a(1). Procurement of non
U.S. fertilizer may be authorized for a specified period of time as well as for individual 
purchases. 

(2) When procurement of non-U.s. fertilizer is approved by MIOP a source waiver, in accordance 
with the provisions of Chapter 5B4 is also required. 

(3) The Director of M/OP may waive the February-May restriction on shipment of fertilizer from the 
U.S. as appropriate. 
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Fixed Amount Reimbursement (FAR) 

Handbook 1 B Chapter 20 Section D 

1. Policies th?t pertain to Section A2b of this Chapter are subject to waiver by the Geographic 
Assistant Administrator, acting In consultation with GC. 

2. For waiver authority respecting· policies cited in Section A2c of this Chapter, see Chapter 5, 
"Source and Nationality." 

Grants and Cooperative Agreements for American Schools and Hospitals 
Abroad (ASHA) 

Handbook 1 B Chapter 16 Section A4 

The relevant waiver provisions of the chapters in this Supplement apply to procurement under 
bhr/asha grants. Waivers calling for Assistant Administrator approval shall be submitted to 
AAlFHA, rather than any other Assistant Administrator, since BHR has ASHA program . 
responsibility. 

Intermediate Credit institutions 

Handbook 1 B Chapter 19 Section D 

1. Where this Chapter refers to policies that have their primary statements in other chapters of this 
Supplement, the waiver sections of these other chapters are applicable; e.g., for waiver of 
commodity eligibility, see Chapter 4 of this Supplement. For policies that are peculiar to ICI's; 
e.g., the application of requirements to subloans of a certain size, the Geographic Assistant 
Administrators have waiver authority. 

2. Procurement of imported items from the developed free world sources in excess of the limits 
specified in 19A3c(2) (c)3 may be authorized only by source waivers in accordance with the 
provisions of Delegation of Authority No. 405 and any re-delegations thereunder. 

, 

Local Procurement 

Handbook 1B Chapter 18 Section D 

1. Any waivers of the policies set forth in Section A 1 c of this Chapter which would loosen 
. restrictions on local procurement, may be authorized only on a case-by-case basis under the 

authorities for source and nationality waivers provided by Delegation of Authority 405 and 
subsequent re-delegations. 

2. The Assistant Administrators who have program responsibility, acting in consultation with GC, 
have authority to waive other policies peculiar to local procurement described in this Chapter. 
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Luxury Goods and Gambling Equipment 

Handbook 1 B Chapter 4 Section D5d 

(1) Nonproject Assistance 
(a) It is USAID's general policy not to waive the restrictions on luxury-type goods for 

non project assistance. However, when the intended end use justifies departures from this 
policy; e.g., athletic equipment for schools, the financing of such goods may be al1thorized. 
Departures from this policy are not permitted for the financing of gambling equipment. 

(b) The financing of commodities which are normally considered luxury-type iiellJs may be 
authorized in appropriate situations by the Assistarit Administrator who has program 
responsibility, in consultation with M/OP, or the principal USAID officer at post, in 
consultetion with a Commodity Management Officer. A copy of the approval must be sent 
to the Commodity Support Division, Office of Procurement, as soon as possible to assure 
approval of the form AID II. 

(2) Project Assistance 
In accordance with paragraph 4D5a(2), a determination is made by the Assistant Administrator 
who has program responSibility, in consultation with M/OP, or the principal USAID officer at 
post, in consultation with a Commodity Management Officer, when goods that would normally 
fall within the lUxury category are deemed essential for the completion of a project. Such 
determinations, however, are not considered waivers. 

Metric Specifications 

Handbook 1 B Chapter 4 Section F4 

• 
a. The requirement to use the metric system of measurement may be waived when USAID 

determines in writing that such usage is Impractical or it is likely to cause U.S. firms to 
experience significant inefficiencies or the loss of markets. 

b. The USAID Metric Executive, M/AS; the Contracting/Grant Officer; and the USAID official who 
approved the procurement/grant requirement (by signing a PIO/C, PIOIT, PIL, or equivalent 
document) are authorized to waive the metric requirement for one of the above reasons. The 
USAID Metric Executive is authorized to overrule a decision to grant a waiver or to nUllify a 
blanket waiver made by the other above officials so long as a contractor/grantee's rights under 
an executed contract/grant are not infringed upon. 

c. A blanket waiver for a class of multiple transactions may be issued for a term not to exceed 
three years. 

d. When a waiver will be based upon the adverse impact on U.S. firms, clearance from the USAID 
Metric Executive and the Office of Small and Disadvantaged Business Utilization (OSDBU) will 
be obtained prior to authorization. 

e. The basis for each waiver and any plans to adapt similar requirements to metric specifications 
in future procurements/grants should be documented in the procurement, grant, project, or CIP 
file. 

Motor Vehicles 

Handbook 1 B Chapter 4 Section C2d 

(1) The Assistant Administrators who have program responsibility have been delegated authority 
to waive the requirement that motor vehicles be manufactured in the United States, when 
necessary to carry out the purpose of the FAA. Circumstances which may merit waiving the 
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requirement are (a) inability of U.S. manufacturers to provide a particular type of needed 
vehicles; e.g., light weight motorcycles, right-hand drive vehicles; (b) present or projected lack 
of adequate service facilities and supply of spare parts for U.S. manufactured vehicles; or (c) 
an emergency requirement for vehicles for which non-USAID funds are not available, and 
which can be met in time only by purchase of non-U.S. manufactured vehicles. 

(2) When a waiver is necessary, preference will be given to procurement of vehicles which are 
assembled in the cooperating country or a code 941 country using a substantial number of 
parts and subassemblies manufactured in the United States. Consideration may be given to 
making a blanket waiver for an entire loan or grant agreement or for all projects in a country to 
allow purchase of such locally assembled U.S. model vehicles. Any blanket waivers should be 
reexamined as least annually to see whether the waiver should be continued. 

(3) The Assistant Administrators' waiver authority is included in Delegation of Authority No. 405. 
In accordance with the requirements for authorizing source waivers which are set forth in 
Section 584c, chapter 5 of this Supplement, AIDIW-issued waivers must indicate consultation 
with GC and M/OP. 

(4) Under Delegation of Authority No. 405, Assistant Administrators may redelegate authority up 
to $50,000 (exclusive of transportation cost) to waive the requirement that motor vehicles be 
manufactured in the United States. 

(5) It should be noted that, with the exception of disaster relief authority, the authority to waive 
source, origin, or nationality requirements is contained only in Delegation 405. 

Nationality of Suppliers of Commodities 

Handbook 18 Chapter 5 Section C4. 

a. Changes in the authorized Geographic Code with respect to the nationality of.suppliers of 
commodities are subject to the same requirements as those related to the source of 
commodities set forth in 584. The authorities for granting such waivers are those specified in 
Section 5B4c. 

b. Code changes authorized by waiver with respect to the source of commodities automatically 
apply to the nationality of their suppliers. 

c. A waiver to effect a change in the geographic code only with respect to the nationality of the 
supplier of commodities, but not in the source of the commodities, may by sought if the situation 
requires it. 

Nationality of Suppliers of Services 

Handbook 1 B Chapter 5 Section 04. 

a. A waiver to authorize a different Geographic Code or include additional suppliers must be 
based on one of the following Criteria: 
1) Privately owned Commercial Suppliers 

a) There is an emergency requirement for which non-USAID funds are not available and the 
requirement can be met in time only from suppliers in a country or area not included in the 
authorized geographic code. 

b) No suppliers from countries or areas included in the authorized geographic code are able 
to provide the required services. 

c) Persuasive political considerations. 
d) Procurement of locally available services would best promote the objectives of the foreign 

assistance program. 
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e) Such other circumstances as are determined to be critical to the achievement of project 
objectives. 

2) Government-Owned Organizations . 
In additioQ..or alternatively if a change in the geographic code is not required, a waiver to 
make government-owned organizations described in 5D3, eligible for financing by USAID 
must be justified on the basis of the following criteria: 
a) The competition for obtaining a contract will be limited to host country· firms or 

organizations meeting the criteria set forth in 5D1' or 5D2, above; or 
b) The competition for obtaining the contract wilL be open to firmsJrom countries or areas 

included in the authorized geographic code and eligible under the provisions of Sections 
5D1 or 5D2, but it has been demonstrated through prequalification that no U:S: firm is .' 
interested in competing for the contract; or 

c) The competition for obtaining the contract will be open to firms from countries or areas 
included in the authorized geographic code and it has been demonstrated, through ' 
prequalification or otherwise, that one or more U,S, firms are interested in competing for 
the contract but the foreign policy interests of the United States outweigh any competit(ve 
disadvantage at which U.S, firms might be placed or any conflict of interest that might 
arise by permitting a govemment-owned organization to compete for the contract. 

b, Certification of Changes of the Authorized Geographic Code to codes 899 or 9'35 ' 
Waivers from Codes 000 or 941 to Codes 899 or 935, in addition to meeting one of the criteria 
in Section 5C,1 0,1, must be supported by the following certification: "The interests of the 
United States are best served by permitting the procurement of services from Free World ' 
countries other than the cooperating country and countries included in Code 941. ' 

c. Authority to Grant Waivers of Authorized geographic Code 
Changes in the authorized geographic code with respect to the nationality of suppliers or 
services are subject to the same provisions as those related to the source of commodities set 
forth in paragraph 584c, 

d, Authority to 'Grant Waivers to Make Govemment-Owned Organizations Eligible 
1) Waivers justified on the grounds of United States foreign policy interests under the 

provisions of paragraph 5D,1 O,a(2)(c), must be authorized by the Assistant Administrator 
having program responsibility after consultation with the Deputy Assistant to the 
Administrator for Finance and Administration (DAlFA) and GC, 

ZYWaivers based on the criteria list in paragraphs 5D.10,a(2)(a) or (b) may be granted by the 
Mission Director. 

e. Waiver Control 
1) AIDIW-issued Waivers - All services waivers issued in AIDIW under the authority of USAID 

Delegation of Authority 405 and any redelegation thereunder, including those covered by a 
project paper or project authorization, shall indicate consultation with GC and FAlOP, and a 
copy of every AIDIW-approved services waiver must be sent to FAiPPE. 

2) Mission-Issued Waivers - Copies of all Mission-approved services waivers under the 
authority of USAID Delegation of Authority 405 and any redelegation thereunder, including 
those covered by a project paper or project authorization shall indicate consultation ,with the 
Regional Legal Advisor, if available, and must be sent to FAiPPE, even though prior AIDIW 
clearance is not required, 

Pesticides 

Handbook 18 Chapter 4 Section C4d 

(1) The procedures set forth in USAID Regulation 16 for procurement of pesticides under project 
assistance may be waived under emergency conditions, Emergency conditions are deemed 
to exist when the Administrator of USAID determines in writing that: 
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(a) A pest outbreak has occurred or is imminent; 
(b) Significant health problems (either human or animal) or significant economic problems will 

occur without the prompt use of the proposed pesticide; and 
(c) Insufficient time is available before the pesticide must be used to evaluate the proposed 

use in accordance with the prOVisions of USAID Regulation 16. 
(2) In a very limited·number of circumstances USAID may authorized procurement of pesticides 

under nonproject assistance when the Administrator determines that: 
(a) Emergency conditions as defined in paragraph 4C4d(1) exist; or 
(b) Compelling circumstances eXist such that failure·to provide the proposed assistance would 

seriously impede the attainment of U.S. Foreign Policy objectives or the objectives of the 
Foreign Assistance Program. The term "compelling circumstances" is intended to imply 
only those most serious situations in which no other way exists to provide the pesticide 
except through the Commodity Import program. The decision as to whether such 
circumstances exist will be based, to the extent practicable upon a consideration of the 
factors set forth in Section 216.3(b) (1) (i) of USAID Regulation 16 and the history of 
efficacy and safety goveming the past use of pestiCides in the recipient country. 

Pharmaceuticals 

Handbook 1 B Chapter 4 Section C3d 

(1) The prohibition of off-shore'procurement of pharmaceuticals which infringe on U.S. patents 
may not be waived. 

(2) Exceptions to the general rule that USAID-financed pharmaceuticals must be of U.S. source 
may be made under the authority set forth in Chapter 584 after consultation with the Office of 
Procurement. If Code 941 is the authorized ssurce for procurement under the loan or grant 
agreement, an exception from a Code 941 country would require only the authorization of the 
Office of Procurement. 
(a) Under project assistance, waivers of the U.S. source policy will be considered if: 

1. The pharmaceutical product is essenlial 10 the project; 
2. The product, in the same or substantially equivalent form. is not available from the 

United States, or the delivered price from the United States would be at least 50% more 
than from another source; and 

3. Informalion is available to attest to the safety, efficacy, and quality of the product, or the 
product meets the standards of the U.S. FDA or other controlling U.S. authority. 

(b) Under nonproject assistance, waivers of the U.S. source policy will be considered if: 
1. The pharmaceutical product is essential; 
2. The product. in the same or substantially equivalent form, is not available from the 

United States, and 
3. The product meets the standards of the U.S. FDA or other controlling U.S. authority. 

Procurement Under Commodity Import Program 

Handbook 1 B Chapter 13 Section A4 

A waiver of USAID Regulation 1, in whole or in part, for a CIP may be justified either in the 
Program Assistance Approva[ Document (PAAD), or subsequently if the circumstances 
necessitating the waiver are not known at that time, and may be approved by DANFA. 
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Rubber Compounding Chemicals and Plasticizers 

Handbook 1 B Chapter 4 Section C5d 

The policy may be waived upon specific authorization of the Mission Director. 

Source of Origin of Commodities and Commodity Related Services 

Handbook 1 B Chapter 5 Section B4. 

In some cases it may be necessary to expand the authorized source in order to accomplish 
project or program objectives. This is done by processing a procurement source waiver. When a 
waiver is processed to include a new source, procurement is not limited to the added source, but 
may be from any country included in the authorized source. 

Suspension and Debarment 

Handbook 1 B Chapter 6 Section C4 

DANFA may waive the application ofthe suspension and debarment regulations to individual ~ 
transactions based upon a written finding that such application would not be in the interest of the 
Govemment 

USAID Commodity Eligibility Listing 

Handbook 1B Chapter 4 Section A1c(4) 

Determinations to finance commodities which are ineligible in the "AID Commodity Eligibility 
Listing" are made as described in 4A 1c. If a waiver is sought for part of the :AID Commodity 
Eligibility Listing" which is based upon an eligibility constraint treated in the subsequent sections of 
this Chapter, then the waiver authority given in that section is applicable. Any other waivers 
relating to this section must be approved by the Assistant Administrator who has program 
responsibility for either project or nonproject assistance. 

USAID Geographic Codes 

Handbook 1 B Chapter 5 Section A4 

a. Changes from the geographic code authorized in accordance with paragraphs 5A 1 d(1) and 
5A 1 d(2J can be made only in accordance with the waiver provisions of 5B4 for source and 
origin and of paragraphs 5C4 and 5D10 for nationality of suppliers. 

b. Changes from the policy on sources of procurement or criteria for inclusion in geographic codes 
. as set forth in 5A 1 d can be made only by the Administrator. Changes in the composition of 
geographic codes are made by the Office Director of the Directorate for Policy. 
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Used Equipment 

Handbook 18 Chapter 4 Section C6d -
(1) The policy of requiring special authority for the-procurement of used equipment is not subject

to waiver. 
(2) Waivers of the special conditions applicable.to the procurement of used equipment may be 

granted by the Assistant Administrators who have program responsibility, acting in consultation 
with MOP. 

Weather Modification Equipment 

Handbook 18 Chapter 4 Section D6d 

Departures from this policy must be approved by the Administrator. 
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APPENDIX D 

Oracle Server Error Messages 

Message 
Code 

ORA·00001 

ORA·00054 

ORA·00942 

ORA·01000 

ORA·01017 

Description 

Unique constraint violated 

Cause: A record exists In the database with tl)e same primary key as the 
record you are attempting to add. The current record cannot be saved. 

What to do: Contact your system administrator for assistance. 

Record locked for update 

Cause: Record is being edited by another user. 

What to do: Try to access record later. 

Table or view does not exist. 

Cause: You do not have a valid A&A role. 
Or 

The data tablelview (file) that the application is trying to access either does not 
exist or is not available to you. 

What to do: Application will terminate automatically. Contact a supervisor or 
system administrator for assistance. 

Maximum cursors exceeded 

Cause: A fatal error has occurred in the current routine. The current data may 
not have been saved. 

What to do: Application will terminate automatically. Contact a supervisor or 
system administrator for assistance. 

Invalid user name/password 

Cause: You have entered an invalid user ID and/or password or an Oracle 
account has not been created for you. 

What to do: Retry with correct user name/password. If this error persists 
contact your system administrator for assistance. 

ORA·01031 Insufficient privileges 
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Cause: You have insufficient privileges to perform this database task. The 
current data may not have been saved. 

What to do: Contact your system administrator for assistance. 

. ORA-01924 Role not granted.or doesn't exist 

RA-02291 

ORA-03121 

ORA-06107 

ORA-06122 

3059 

0-2 

Cause: Your default Oracle role is missing or invalid. 

What to do: Contact your system administrator for assistance. 

Parent key notfound . 

Cause: A 'Parent' record is required to save the current record. The Parent 
record could not be found. The current record cannot be saved. 

What to do: Database is corrupted. Contact your system administrator for 
assistance. 

No interface driver connected 

Cause: A SQl *Net TCPIIP error has occurred. Either the SQl *Net " directory is 
not in your PATH= statement in AUTOEXEC.SAT" or there is a problem with 
the ORAClE.lNI file. " 

What to do: Application will terminate automatically. Contact a supervisor or 
system administrator for assistance. 

Oracle network server not found 

Cause: A SQl*NetTCPIiP error has occurred. The SERVICES file is invalid, 
could not be found or is not specified in the ORAClE.lNI file. 

What to do: Application will terminate automatically. Contact a supervisor or 
system administrator for assistance. 

Setup failure 

Cause: A SQl *Net TCPIIP error has occurred. The ORAClE.lNI file is invalid or 
could not be found. 

What to do: Application will terminate automatically. Contact a supervisor or 
system administrator for assistance. 

oose user canceled 

Cause: An OOSC error has occurred. Either the OOSC.INI file could not be 
found, the proper data source is not specified, or the correct driver is not 
specified. 

What to do: Application will terminate automatically. Contact a supervisor or 
system administrator for assistance. 
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Incident Reporting 
Although comprehensive testing has eliminated as many errors as could be found ·and fixed, there 
is a need to report any new errors in a way that is meaningful to the software developers so that 
the errors can be corrected. The forms on the following pages should be used to report these 
errors, Copies of these forms should be made and kept on file for future use. The figures below 
indicate where to find the information needed to fill out the form along with a'definition of the terms 
used on the form. It is important that you and the System Administrator collaborate in the 
response. The System Administrator may be able to resolve some of the errors before the reports 
are seht on to the Help Desk. Include as much detail as you can concerning the error. Remember 
the individuals who will evaluate and fix the error may be a continent away. 

The figure below is a typical screen used in the'Acquisition & Assistance application. The 
information needed to fill out the report will be found in the same general area throughout the 
other modules. 

Figure 2. 

January .. 2,1996 

~~~~~r-:~1APPlication 
,,-.'--.-"..:J Module 

---lMode 

Screen Name CO;; 

Tab Name 

---, Field Name 

Role 

Figure 1, 

The figure below' is the Splash 'screen that is 
·displayed before the application presents itself. 
To review this information at other times, click 
on Help, then click on t',bout when the drop
down menu is presented. 
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Definitions, Incident Report Form 

Incident Number: This number will be assigned by your System Administrator when the Report 
is logged in. The number should include information that will make it unique so that it will 
not conflict with Incident Reports sent in by other sites. This log should be scrupulously 
maintained and inquiries made if a timely response is not received. .' 

IP Address: The IP address is the Internet Protocol address. It is used to uniquely identify a host 
computer on a TCPIIP network. It is set up by the System Administrator of the host 
computer. 

Host Name: The host name is a synonym for the IP address. It is used to uniquely identify a host 
computer on a TCPIIP network. Ifis set up by the System Administrator of the host 
computer. 

Name: The name of the user initiating the Incident Report. 

Organization: Enter the organization code that will help to uniquely identify your installation. 

Location: Enter the location that will help to uniquely identify your installation. 

System Administrator: The name of the System Administrator. It is suggested that the System 
Administrator maintain a file of copies of the reports for future reference. 

Version: The date and version number appearing on the Splash screen. See Figure 2 for an 
example. 

Screen Name: Enter the Screen name. See Figure 1 for an example. 

Tab/Form Name: Enter the name of the Tab or Form. See Figure 1 for an example. 

Field Name: Enter the label or name of the field where the error occurred. See Figure 1 for an 
example. 

Mode: Enter the Mode the application was in when the error occurred, such as ADD, EDIT Dr 
VIEW. See Figure 1 for an example. 

Role: Enter the Role that you were using when the error occurred, such as Requestor, Manager, 
. COTR, etc ... See Figure 1 for an example. 

Description of Problem: Enter as much information·about the sequence of events leading up to 
the problem as you can. The frequency that the problem occurs, intermittently or every 
time, is important and should be noted. 

Actual Error Messages: In some cases the application will trap and display error messages 
generated by Oracle, the Database Management System. There is a list of these 
messages and their codes on page 1. There may be some messages that are not in the 
appendix that are generated by the application or by Windows itself. These messages are 
important to the developers and should be noted. 

All of the entries may not be pertinent but they should be filled in. Use N/A when appropriate. 
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NMS Incident Report Form 

Incident Number: _______ _ IP Address: __________ _ 

Date of Incident: _______ _ HostName: __________ _ 

Name: __________ ___ Organization: _________ _ 

Version: __________ _ Location: ___________ _ 

Application: ________ ___ Screen Name:, _________ _ 

Mode: ____________________ _ Tab Name: __________ _ 

Role: ___________ _ Field Name: __________ _ 

Description of Problem: ________________________ _ 

Actual Error Message: ______ '--_________________ _ 

Suggestions: ___________________________ _ 

System Administrator: ________________________ _ 
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NMS System Administrators 
Incident Log 

Incident Date Date 
Number Reported .Resolved .Brief Description of Problem 
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IRM Help Desk@IRM. 
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Overview of the A&A Award Administration Application 
This USAID-wide application is a client/server system and is the fourth module of the Acquisition & 
Assistance (A&A) suite of applications. The other modules are Planning, Award Formation, Small 
Purchases and Support. 

This application handles the Award Administration process. It has been created for Contracting Officers, 
Negotiators'and Contracting Officer's Technical Representatives (COTRs) throughout the Agency. The 
application allows you to record Award Deliveries, Post-Award Protests, track Correspondence, and 
process Award Administrative modifications, In addition, the application maintains a To-Do list for each 
user and allows users with the proper Role to Close-Out Awards. 

On-Line Help 
Windows-style on-line help is available in the Acquisition & Assistance Award Administration Application. 
On-line help may be accessed through the Help pull-down menu or with the Help icon: 

On-line help is available throughout the Award Administration Application, unless dialog boxes are 
displayed. A dialog box is a window with OK and Cancel buttons. None of the menus on the menu bar 
or icons on the toolbar are available when a dialog box is displayed, If help must be consulted before 

::. contil)uing, leave·the dialog box by using the Cancel button. Access the Help through the Help pull-down 
., menu. 

Context sensitive help is available throughout the Award'Administration Application, To access Help for a 
specific field, secure focus in that field and press the F1 key. The application will display the most 
relevant help screen. 

For instructions on how to use Windows-style on-line help, select Help on Help from the Help Menu. 
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Accessing the A&A Award Administration Application 

Starting The Award Administration Application 

You must be authorized to logon to the New Management Systems (NMS) in order to use the A&A Award 
Administration application. The data in the A&A Award Administration Application is protected by Oracle 
and the application. Access to the database is protected by the SeIVer, an dby user accounts on the 
database. A legftimate A&A user first has to logon to the. Banyan network with a valid account and 
password, and then logon to the Application with an Oracle User 10 and password. 

A&A Award Administration is accessed through the NMS Logon. The Logon box provides security 
mechanisms to ensure that only authorized users may log on to NMS Applications. For cuases of logon 
failure, see Logon Procedure and Problems. 

Logging On 

= 
~ 

Double-click on the USAID icon "l\'fI\'!' in your Windows Program Manager to access the New 
Management Systems (NMS) applications. If you are not sure where to find this icon, or you 'have 
problems logging on, contact your supeIVisor or System Administrator. The following common logon 
screen will appear: 

'. . ... ~ 

-!, - • 

~/ " , :; .,". ':. ).. 

" 

Enter your user 10 and password and click on the Logon button to continue (or click on the Cancel button 
to exit). The buttons for applications to which you have access will be highlighted in bold type. Other 
buttons available to you on this screen include: 
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Click on this button to enter a new password, which must be at least 
eight characters long. 

Click on this button to set various preferences, including how often to 
delete temporary files and which applications to load automatically. 

Click on this button to retum to the previous screen. 

Click on this button to completely exit the NMS logon procedure. 

After selecting the appropriate application button at the top of the screen, a screen will appear with 
buttons representing the modules available in the application you selected. The following screen 
illustrates the modules in the Acquisition and Assistance application: 

, ~, '" <' , . 
. , 

".' 

Click on the button for the module you wish to access, or click on the Go to Main button to retum to the 
previous logon screen. 
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Logon Procedure and Problems 

A&A Award Administration is accessed through the NMS logon. The logon box provides a security 
mechanism to ensure that only authorized users may log onto NMS applications. 

To move from User 10 to Password, use·the TAB key. As the password is typed, the characters will not 
show on the screen. 

The table below lists possible causes for a logon failure: 

Cause Remedy, ".''- , .. 
'. ,~\~, :':~~ 

" .. 
Improper 10 or Password. ' , . Type Correct 10 and password 

'.' 

and try again, 
" - -

For new users, database account "Contract DBA arid request an < 

has not been set up, Or~cle acco~lJt " . 
After an Award Administration error Exit and re-enter Windows and '.' ," 

occurs, the system will not logon. try again. If the problem 
persists, reboot and try.agai~ .. 

The database is down. Contact OBA and report logon 
. , 

failure. 

Setting the Role 
After successfully logging on the Select Role list box will appear if your User 10 is associated with more 

than one Role. Note that only the Roles which have been assigned to your User 10 will appear in the list 
box. If an additional role is desired, new Roles are assigned in the Award Support module of A&A. 

The Select Role list box allows you to select the role for the duties that you will be performing. The box 
defaults to your first listed Role. Click on the arrow button or use the arrow keys to select a different Role. 

If your User 10 is associated with just one Role, the Select Role list box will not appear. After logging on, 
the Award Administration Form will appear and your Role will appear after your Userld on the bottom of 
the screen. 

After the user has selected the desired Role, the user should click the OK button. If approved Awards 
exist for the selected Role and User 10 then the Award Administration Form will pop-up. If no approved 
Awards exist for the User 10 and selected Role. A message will inform the user as such. To find 
approved Awards, the user must select a different Role or log-in as a different user, or approve an Award 
in the Award Formation module. 
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The Initial Icons 

If any item(s) has/have been staffed to'you, the Staffing Alert icon appears minimized ,on the,main 
screen. Select.it (by double clicking with the mouse) to see the Staffing Alert screen .with tasks that 
require your attention. See the section on Award Staffing for more details. . 

v: /1i': 
~~. <:J.' ,~ 
1:-ci Da ('l'i:!~ , 

Irthere are items in your To Do List for the present day, the To Do List icon appears minimized on the 
main screen. Select it (by double clicking with the mouse) to see the To Do List screen with tasks and 
due dates. See the section on To Do List for more details . 

• 
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Using the Award Administration Application 

Pull-Down Menus 

The Award Administration Application pull-down menus are located on the menu bar, the second line in 
the main Acquisition & Assistance Award Administration window. A menu can be activated by clicking on 
a menu title with the mouse or by pressing the ALT key, moving to a menu title with the right and left 
arrow keys, then pressing the ENTER key. Select a menu option from the pull-down menu by either 
clicking on the option or by moving to the option using the up and down arrow keys, then pressing the 
ENTER key. 

File Edit Database .Qptions Window' Help" 

Print :Prints the current record, when available. 

Print Setup :Displays the Print Setup box to specify printer settings for your printer. The 
settings you select become the defautl settings. 

Exit :Closes the Award Administration Application and brings you back to the Main Windows 
screen. 

Database 

Change Role :Opens the Select Role list Box and buttons 

Query :Opens the COTS (off-the-shelf query tooO. See the Help in COTS for instructions on 
how to use it. 

Search :Opens the Award Search form. 

Options 

Toolbar :To remove the Toolbar, click the left mouse button on the 'Toolbar' topic in the menu. 
The check mark disappears. To make the Toolbar appear, click again and the check mark 
appears. 

Application Logging :Click on this option to track interaction with the database. The 
Application Logging icon will appear at the bottom of the screen. Select the icon to view the 
log. 

Panel Help :Click on this option to remove or add the information panel from the lower right 
portion of the screen. 

Attach Note :Opens the Note form. This is an open field to write comments regarding a specific 
Tab. Notes may be used to communicate ideas between users ofthe application, such as 
changes needed to fields to which only the owner of the record has access. 

Window 

Arrange Icons :Evenly arranges all icons in a group window. You can also specify that 
Windows rearranges the program-item icons in a group window whenever you change the 
window's size, add items, or move items. 
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Contents :Displays the Table of Contents ofthe Award Administration Help System, from which 
you can find further information on how to use the application. 

Help on Help :Displays the Windows Help system 

About :Information about the A&A Award Administration Application. 

Too/bar 

The toolbar contains a selies. of buttonsthat can be clicked on with the mouse as an alternative to using 
the pull-down menus. Buttons which are not presently available will be "dimmed," Clicking on a dimmed 
button will have no effect. l'he toolbar may be tumed on and off with the Options pull-down menu by 
selecting Toolbar. The function of the button is displayed in the light message panelon the status bar at 
the bottom of the screen when the mouse is placed over it. 

The buttons on the toolbar are as follows: 

lil Print button 

IiNfl Note button 

Iii Alert button 

[II Query button 

W Search button -

lift I Change Role button 

~ t:.!J Help button 

A&A Award Administration 

: Plints the Record. This function can be accomplished by choosing 
Plint in the File Menu (AL T+F, Pl. 

: Opens the Note form. This is an open field to write comments to be 
attached to the Form. Use the paper clip icon to attach it to the 
Form. 

: Displays the Staffing Alert form with the Tasks that require your 
attention. It lists items that have been staffed to you. 

: Opens the COTS (off-the-shelf query tooO. See the Help in COTS 
for instructions on how to use it. This function can also be 
accomplished by choosing Query in the Database Menu (ALT +D, 
Q). 

: Opens the Search form. This allows you to search for awards that 
contain specific information from the database. This function can 
also be accomplished by choosing Search in the Database Menu 
(ALT+D, S). 

: Displays the Select Role box. This allows you to change your role 
according to the duties you will perform. This function can be 
accomplished by choosing Change Role in the Database Menu 
(ALT+D,O). ALT+D,O is only functional when the Select Role list 
box is not displayed. 

: Accesses the A&A Award Administration Help system. 
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Mouse and Keyboard 

The A&A Award Administration application supports the use of a mouse (or other pointing device) as well 
as the standard keyboard. A mouse is not required for most Award Administration application features. 
A mouse is commonly used to click on buttons and icons, and to activate the pull-down menu bar. If a 
mouse is not available, the following keys can be used instead. 

- TAB key : Moves among fields and buttons in a window, and pull-down menus on the 
menu bar. 

SHIFT+TAB key combo: Pressing the SHIFT key and the TAB key simultaneously will move 
backwards to the previous field, button, or menu. 

Up and Down Arrow keys: Moves through a list of choices (Le. through the menu options in a pull-down 
. menu). 

ENTER key 

ALTkey 

: Selects a button, a menu, or a menu option. 

: Moves between menu bar and current window. 

. AL T +Down Arrow keys : Displays list of valid choices for a field, when available from a Drop-Down 
menu or list. 

• 
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Award Administration Windows 

The A&A Award Administration application is a Microsoft Windows compatible product. Award 
Administration windows behave in the same manner as normal windows. They may be minimized, re
sized, moved, and closed. 

All open windows are numbered and listed in the Windows menu. Selecting a numbered'window from the 
list will cause that window to become the current window. 

When the top-level form of the application is open - the Award Administration Form, all of the buttons on 
the toolbar and the menus on the menu bar are available except for the Sticky Notes button. When any of 
the other Forms are chosen from the Award Administration Form, the Staffing Alert, Search Award, and 
Change Role Buttons and Menus are not available. The Staffing Alert, Search Awa.rd, an..;i Change Role 
Buttons and Menus areonly available from the top-level Award Administration Form. '. . 

Dialog windows are windows with OK and Cancel buttons. The tool bar and menu bar are not available 
when a dialog window is displayed. Either complete data entry in the dialog window and use the OK 
button or use the Cancel button to leave the dialog window. On-line help also is not available when a 
dialog window is displayed. 
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Text Editing Features 

The A&A Award Administration application includes some common word processor-like features for text 
editing. The cut, copy, delete features act on text that has been highlighted. Text may be highlightecr 
using the mouse by positioning the cursor at the beginning ofthe text to be highlighted, clicking the left 
mouse button, and dragging it to the end of the selection. To highlight text using the keyboard, position 
the cursor at the beginning of the text to select and hold down the SHIFT key. Move to the end ofthe 
selection using the up, down, right and left arrow keys and release the SHIFT key. To cut or copy text, 
either use the cut and copy icons on the toolbar or select the appropriate menu options from the Edit pull
down menu. To delete text, press the DELETE key on the keyboard. 

Since the A&A Award Administration Application is Windows compatible, text that is cut or copied is sent 
to the Windows clipboard. That text can be copied back into the application using the Paste button or 
menu option. Text can also be cut from otherWindows compatible applications and copied into the 
Award Administration application from the clipboard. For example, to import text from a WordPerfect for 
Windows (or any other Windows-based word processor) document, minimize the Award Administration 
application main window by using the 'down arrow on the upper light-hand comer of the window. Load 
WordPerfect for Windows and open the document containing the text to be imported. Highlight the text 
and copy it to the Windows clipboard. Exit WordPerfect, find the Award Administration application icon, 
and double click on it to restore the Award Administration application. Position the cursor at the location 
to import the text, then use the Paste button or menu option. Text may be exported from the Award 
Administration application in a similar manner. 

To export numbers from the any spreadsheet glids, the copy feature may be used. Highlight the cells to 
export and use the Copy icon or menu item. Minimize the Award Administration Applicaiion window and 
enter Lotus for Windows (or any other Windows based spreadsheet). Select Lotus's Paste menu option. 
All of the numbers from the highlighted cells will be entered into the Lotus spreadsheet. 
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The Award Administration Process 

Award Administration Form 
The Award Administration form allows you to select the action to be performed for the selected Award. 
After you log on and select your role(if neccessary), the following form is displayed: 

'. 

, ·Request ID/Award Number & Award Title 
This is a drop-down menu or list box that displays 'the' existing Request ID, Award Numbers and Titles 
that correspond to the current user/role logged in. Lise the arrow keys to make a selection, or click the ieft 
mouse button on the.arrow button and use the drop-dow~ menu or list box to select the Award that you 
need. 

Below the Award list box are buttons to conduct Award Administrative processes. The definitions of the 
buttons are: 

Delivery Button 

This button displays the Accept Delivery form. 

Protest Button 

This button displays the Award Protest form. 
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To Do List Button 

This button displays the To Do List·form. 

Action Button 

This button displays the Award Action form. 

,-.,' 

Modify Button 

This button displays the ModifY Award form. 

[IJ"Il"'" ) : ' 
> ' 

• .,-K", 

',$~,<' 
, ,." 

Status Button 

This button displays the Award'Status Tab to Close-Out an Award. 

Exit Button 
This.button closes and signs out of the Award Administration application. 
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Award Search 

Award Search allows the user to pull up a List of Awards satisfying the criteria that the user has specified 
in the Search form. The Search form is displayed below: 

" 

When an searching, user may orthe user 
may be able to Edit the Award. The user's privilege for an Award is stated in the Mode panel on the 
ToolBar. The privilege for an Award is either "VIEW' or "EDIT", 

The Award Search Fields 

Awards Found: 
The number of Awards found by the search. The Awards appear in the Award list on the main 
Administration form. 

Th L - ISh S I ct- '®Afii)~'O'OR~ e oglca earc e e Ion. .... .' .. 
Indicated whether to include a Logical "And" or "Or" between each specified search criterion. 
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," 

, ' 

.... ' 

_ The user can conduct a search using a~y or all of iflese ,~riteri,!, In the, first editable ~eld of the'top criteria 
an "=" sign is already preiieht. This operatpr,specitles an ,exapt match."The 'user can, chan.ge"the '"=" ',-:: "": 
operato/to ">~ or u<,", 'to specify crie,ria "Greater Than' or "Less Than" respectively: .o(,>:tl.i~'u~!lr Gan ' ," 
specifY "like",as an operator,in conjUliQlion with "%"',as,l!j'wlld card. Fpr example, if,the'uset enterS the: 

, '. "like" operator and enters "AA%"'as the Award Title, then the search will find any Awards wHich 'begin ' 
with "AA." ,', . , 

The "Action Type ID" is the code for the type of Award to'be searched fqr. 'For example, it can be 
,"Competitive Grant," or "Cooperative Agreement," or "Inter-Agency Agreenient.'" , 

" " The Award Search,Fonm,B-,*on~" , 
-:: l, ':' '"';;- ~ ''''"'""l£'c"'",",w''lv'<",,-",-,,,,", -<j i ,",,",~~fli.ll' ~ ... _t _ =¥-.. 1 "~' '~ 
~'The functions of,thes!l buttons are 'outlined below, 

'I" (i""'- ""fi"; • ~~'~~:Jlf_~ ! 
Search Button 
This button initiates the Search according to the criteria specified. 

!w-- ~~!~tt,: J 
Default Button 
This button returns the role used'in the Search to the"role that the user originally selected; the 
possibilities being COTR, Contracting Officer or Negotiator. 

" 

, " " 

;~,,,~,j)L',J 

Clear Button 
This button clears any previously·selected search criteria or search roles. Note, that the user needs to 
click on the Search button to refresh the Award list. 

r"'qm~:,J 
Close Button 
This button closes the Award Search form. 
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Award Privileges 

The user has certain privileges to each Form depending on the Role which the user is currently using. 
Users can either possess View or Edit privilege to a Form; or, have no privilege. If a user has edit 
privilege to a Form the Mode Panel will state "EDIT" and all the buttons on the Form will be visible and 
enabled. If the user only has View privilege the Mode Panel will state "VIEW and some of the Form's 
buttons will not be visible or be disabled. If a user has no Privilege to a Form the button. to access the 
Form on the Administration Form will be disabled . 

. Privileges of the Administrative Roles for accessing Forms have been implemented as Follows: 

- Negotiator: 
- Can Modify an Award via the DGS SubSystem; 
- Can Create New Protests; 
- Can Create New Actions and To Do Items; 

- Contracting Officer(CO): 
- Can Modify an Award via the DGS SubSystem; 
- Can Modifty an Award's COTR and Completion Date; 
- Can Create New Protests; 
- Can Create New Actions and To Do Items; 
- Can Close-Out an Award; 

- Contracting Officer's Technical Representative(COTR): 
- Can Create New Actions and To Do Items; 
- Can Receive and AcceplfReject Deliveries; 
- Can Close-Out an Award; 

- WareHouse: 
- Can only Receive Deliveries; 
- Can Create New Actions and To Do Items; 

Below is a Layout of Privileges in Grid Form, "Y" = the Role can Edit the Form: 

ROLE ActionrroDo Protest Recv-Deliv Acpt-Deliv Mod-Awrd Mod-DGS Close-Out 
Negotiator Y Y N N N Y N 
Co Y Y N N Y Y Y 
COTR Y N. Y Y N N Y 
Warehouse Y N Y N N N N 

Accept Delivery 
The Accept Delivery form monitors the status of Award deliveries. This form displays the line items, 
quantities, and delivery schedule information for the selected Award.!t provides the ability to Receive and 
Accept or Reject the delivery Items. 

Only users having the COTR role can Receive and Accept or Reject delivery items. The Warehouse role 
can only Receive deliveries. All other roles only have viewing capabilities. 
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Accept Delivery Form 
To open the Accept Deliver; form, select the Deliver; button on the Award Administration form. The 
Accept Deliver; form appears: 

, 
'~ , 
,,-, ~ ~.~~ :r 
",' . 

" ~. , . 

The Award Number and Award Title fields as well as all Grid fields are pre-filled and protected. To 

access the Schedule Grid, click the I.SclIi.io'!1 Schedule button or double-click on a row in the Line Items 

grid. To access the Status Grid, click the I>~i 1 Status button or double-click on a row in the Deliver; 
Schedule grid. 

The Status Grid is the only grid which can be added to. To add an entr;, click the [)i.i{",:) Add 
button. The Deliver; Status - Add Record form is displayed. Enter the Date, Quantity, and select a 
status. Enter any additional information regarding the deliver; in the Note field. Click OK to continue or 
Cancel to disregard. 

Award Number 
The unique number identifying an Award. 

Award Title 
The unique title of the Award 

Vendor Name 
The Vendor for the Award. 
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Line Item Grid 
The Delivery Grid shows the list of line items to be received for this award. 

Line Item Number 
Lists the line item number. 

Line.ltem Description 
Lists the description for the line item. 

Unit 
- This is the type of delivery being made for a particular line item (Le., each, month, etc.). 

Expected 
States the expected quantity to be received for the line item. 

Received 
States the quantity received to date. The quantity received should equal the accepted and rejected 
quantities. 

Accepted 
States the quantity accepted to date. 

Rejected 
States the quantity rejected to date. 

I~ Schedule Button 
This button displays the Schedule grid. • 

Schedule Grid 
The Schedule Grid shows the delivery schedule for each individual line item. 

Date 
It is displayed in the following format MM/DDNYYY. This is the date the delivery item is scheduled to be 
received. 

Expected 
States the expected quantity to be received for the delivery item. 

Received 
States the quantity received for the delivery item. 

Accepted 
States the quantity accepted for the delivery item. 

Rejected 
States the quantity rejected for the delivery item. 

I' 'St;i~ ,'j 
if" ""' ,« 0 Status Button 
This button displays the Status Grid. 
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Status Grid 
The Status Grid show the actual deliveries. The Actual Date, Quantity, and Note cells are pre-filled and 
protected. Click on any cell to display the row information in the Accept Delivery form. 

Date 
It is displayed in the following format MM/DDIYYYY. This is the date the delivery item is received. 

Quantity 
States the quantity that has been received, accepted or rejected for the delivery Item. 

Status 
States the status of each delivery item. 

Received - Part of the delivery was received. 
Accepted -' Part of the delivered wal'; accepted. 
Rejected - Part of the delivered was rejected. 

I':,' ,li.! ': :1 Add Button 

This button displays the Accept Delivery form. This button allows you to enter the delivery action for a 
delivery item. Enterthe Date and Quantity, and select a status. If any additional information regarding 
the delivery is needed, enter it in the Note field. Click OK to accept or Cancel to disregard. 

,. Ii -fum; t Funds Button 
This button is only enabled when the selected row in the Status grid has a status of Accepted. When a 
row with an Accepted status is selected and this button is clicked, the Accept Delivery Account Form 
appears in Read-Only mode for the user to review which accounts have been selected to pay for the 
Delivery. 

L,,~,J Staff Button 
This button allows you to staff the selected delivery entry from the Delivery Status grid. This will display 
the staff dialog box asking where to staff the Delivery Status item. 

Close Button 
This button closes the form. 

Accept Delivery Information Form 

The Accept Delivery Information form allows you to Receive and Accept or Reject delivery items. Only 
users having the COTR or Warehouse role can access this form. The Warehouse role can only Receive 
deliveries. When the Add button below the Status Grid is.clicked, the form appears: 
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' .. ' , 

" .' 

. 1 0 Widgets as eHpected. 

The definitions of the fields and buttons are: 

: Delivery Item 
: States the delivery item nUTT)ber for a particula~ line item. 

: Line Item Number 
Lists the line item number. 

Date 
This date field is to be entered in the following format MM/DDIYYYY. Enter the date the delivery item is 
received. To change the date, you can key the date or double click the field to display the Calendar to 
help select the date. See the section on Calendar for more details. The field defaults to the scheduled 
delivery date. 

Quantity 
This is a 9 digit number field. Enter the total quantity re?eived for this delivery item 

Note 
This is a 1 ODD-character alpha/numeric field. Enter any notes regarding the delivery item. 

Status 
Select the status of the Delivered Item. It states the status of each delivery item. 
To select a status, place the mouse on the option and click the left mouse button. Or, using the 
keyboard, press the arrow keys to select the option. Incoming deliveries should be processed in the 
following manner:. First, the user should receive the total quantity. Then, the user should Accept or 
Reject the received quantity. The quantity Received should equal the amounts Accepted and Rejected. 
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Calendar 
When you double click an editable date field, the calendar will appear: 

. -. 

This box displays the month, day, and year given in the field or the current month, day and year. Use the 
arrow buttons on the right and left sides to chang.e the year and month accordingly_ Click the left mouse 
button on the specific date to change the date. 

To enter the date in the field, double click the left mouse button on the date or click the OK button. The 
Cancel button will exit the calendar without changing the date . 

• 
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Accept Delivery Account Form 

This form pops-up either in Edit mode or Read-Only mode depending on how it is accessed. When a user 
clicks the Ok button on the Delivery Information Form and has the "Accept" option checked, the user 
must select one or more Accounts from which to allocate obligated Funds. To enable selecting Accounts 
the Accept Delivery Account Form pops up in Edit mode as below: 

one or more Ion' the ap~ropriate r6w:in the grid. Each 
row clicked upon will tum Dark Blue to indicate that it has been selected. 

Altemately, Accept Delivery Account Form pops-up in Read-Only mode when the user clicks on the 
Funds button below the Delivery Status grid. In Read-Only mode the Accept Delivery Account Form only 
has the cancel button enabled, and appears as below: 

• 
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The Accept Delivery Account Buttons 

·1":"Jl~;·: 'I 
• Accept Delivery Ok .Button 

When all Accounts have been'selected, the user clicks this button. 

1i:~clJ 
Accept Delivery Cancel Button 
Cancels the Accept Delivery Account process. The Accept Delivery .Information Form pops back up. 

I""~{' .of 
Accept Delivery Clear Button 
Clears the Accept Delivery Account Grid of all selected rows . 

• 
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Award Protest 
USAID follows the protest procedures in FAR 33.1. An interested party may protest to USAID a 
solicitation issued by USAID for the procurement of goods or services, or the proposed award or the 
award of a contract. This form maintains a list of all post-award protests related to an Award. 

Only the Contracting Officer and Negotiator roles can enter and/or edit the fields in this form. All other 
roles have viewing capabilities. 

Award Protest Form 
To open the Protest form, select the Protest button on the Award Administration box. The Award Protest 
form will appear: 

The Award Number, Award Title and Vendor Name fields as well as the Award Protest Grid are pre-filled 
and protected. The definitions of the fields, cells and buttons are: 

Award Number 
The unique number identifying an Award. 

Award Title 
The unique title of the Award. 

Award Protest Grid 
The Protest Grid lists all protests related to the Award. Source, Receive Date, Stop Work Order, Stop 
Work Date, Response Summary, and Doc cells are pre-filled and protected. 

Source 
It states the origin of the protest. The entries are: 

Agency - The Protest was received via USAID. 
GSBCA - The Protest was received via the General Services Board of Contract Appeals. 
GAO - The Protest was received via the General Accounting Office. 
Courts - The Protest was received via the U.S. Court System. 

Rev Date 
It states the date the protest was received. 
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Stop 
It states whether a Stop Work Order has been issued. Yes means a Stop Work Order has been issued 
and No means a Stop Work Order has not been issued. 

Stop Date 
It states the effective date of the Stop Work Order. 

Response 
It describes the response to the protest. 

Doc 
It describes if a protest Document is available. Double-click to bring up the Document. If a document 
already exists for this Protest an elipse, " .. .", will be present in this field. 

The Protest Buttol).s. . . ..' ' r«, ~~i!,;",;J: !1P~I~ :'L;;,~~,!1LA'~~~!:1 
The functions of these buttons are' outlined below. OnlY,the Contracting Officer and Negotiator roles 
have the privilege to utilize these buttons. These buttons will be invisible to all other roles. 

Add Protest Button 
. This button Adds a new Protest by bringing up the Protest Information form. 

Update Protest Button 
This button Updates or allows editing of an existing Protest by bringing up the Protest Information form. 

Staff Protest Button 
This button staffs a Protest by bringing up the Staffing form. 

illW!imooi:j 
Document Protest Button 
This button brings up the Word Processor to enter documentation concerning the Protest. If 
documentation already has been entered for the Protest, then the button will bring up the correct 
Document in the Word Processor for updating. An ellipse, " .. .", in the Doc column of the Protest Grid 
indicates an existing document. 
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Protest Information Form 

The Protest Infonnation fonn is used to add a new protest to an award. When the Add New Protest 
Button is clicked, the following will appear: 

Select the source or forum of the Protest. Enter the date the Protest is received in the Received Date 
field. To stop work in process by a vendor, check the Issue Stop Work Order box. Enter the effective date 
of the stop Work Order in the Effective Date field, which appears once the Issue Stop Work Order is 
received. Fill-in the Protest Response Summary. Click OK to accept or Cancel to disregard. 

The definITions of the fields and buttons are: 

Protest Source 
Select the origin of the protest. 

Agency - This option states that the Protest was received via USAID. 
GSBCA - This option states that the Protest was received via the General Services Board of 

Contract Appeals. 
GAO - This option states that the Protest was received via the General Accounting Office. 
Courts - This option states that the Protest was received via the U.S. Court System. 

These options can be selected by the Administrator Role only. 

Receive Date 
This date field is entered in the following fonnat: MM/DDNYYY. Enter the date the protest is received. 
To change the date, you can key the date or double click the field to display the Calendar to help select 
the date. See the section on Calendar for more information. The field defaults to the current date. 
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Issue Stop Work Order 
This check box is used to issue a Stop Work Order to the vender of the award. When the box is 
checked, a Stop Work Order is to issued and the Stop Work Date field is displayed. When the box is not 
checked, the Stop Work Order has not been issued. 

Stop Work Date 
This date field is entered in the following, format MMIDDIYYYY. Enter the date the Stop Work Order is to 
be effective. To change the date, you can key the date or double click the field to display the Calendar to 
help select the date. See the section on Calendar for more information. The field·defaults to the current 
date. 

Response Summary 
This is a 250 character alpha/numeric field. EDter a summary of the Protest response. 

, 
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Award Action 
During the period of award administration, correspondence will be generated between USAID and the 
awardee. This form records any actions between USAID and Vendors regarding the Award. 

All roles can enter and/or edit the fields in this form. 

Award Action Form 
To open the Award Action form, select the Action button on the Award Administration main screen. The 
Award Action Log foim will appear:' . .' . 
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The Award Number and Award Title fields as well as the Award Action Grid are pre-filled and protected. 
The definitions of the fields, cells and buttons are: 

Award Number 
The unique number identifying an Award. 

Award Title 
The unique title of the Award, 

Action Log Grid 
This grid shows actions for the award. The Reference Number, Originator, Destination, In/Out, Doc Date, 
Date In/Out, Subject and Doc cells are pre-filled and protected. 

Ref - Reference Number 
An application-generated numerical list of all the actions received and sent for the award, 

Originator 
The person or entity who created the correspondence. 

Destination 
The person or entity to whom the correspondence is directed, 
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In/Out 
States whether the correspondence was generated by USAID (OUT) or an outside source (IN). 

Doc Date 
Lists the effective date of the correspondence. 

Date In/Out 
States the date the correspondence was sent or received. 

Subject 
Provides the description of the correspondence. 

The Action Buttons . _. 

t:~~::];!W!~;:l;;,,!:£t:jit~~ . 
The functions of these buttons are outlined' below .. 

Add Action Button 
This button Adds a new Action by bringing up the Action Information form . 

. :.nt~a~l 
Update·Action Button 
This button Updates.an existing Action by bringing up the Action Information form 

Staff Action Button 
This button staffs an Action by bringing up the Staffing form. 

In~~3 
Document Action Button 
This button brings up the Word Processor to enter documentation concerning the Action. If 
documentation already has been entered for the Action, then the button will bring up the correct 
Document in the Word Processor for updating. An ellipse, •.. .", in the Doc column of the Action Grid 
indicates an existing document. 
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Action Information Form 

The Action Information form allows you to record any correspondence for the award. To open the Action 
Information form, click the Add New Action Button: The following will appear: 

= 
'Enter the Date, Originator, Destination, Subject, Doc. Date, Date In/Out, and whether it is Incoming or 
'. Outgoing. Click OK to accept or Cancel to disregard. The definitions of the fields and buttons are: . 

. Date - In/Out 
This date field is entEl!ed in the following format MM/DDIYYYY. Enter the date on which the 
correspondence is received or sent. To change the date, you can key the date 'or ctotible click the field to 
display the Calendar to help select the ·date. See the section on Calendar for more information. The field 
defaults to the current date. . 

Originator 
This is a 30 character alpha/numeric field. Enter the person or entity who created the action. 

Document Date 
This date field is entered in the following format MM/DDIYYYY. Enterthe effective date ofthe action. To 
change the date, you can key the date or double click the field to display a Calendar to help select the 
date. See the section on Calendar for more information. The field defaults to the current date. 

Subject 
This is an 80 character alpha/numeric field. Enter the subject or a description of the correspondence. 

Incoming/Outgoing 
Select the direction of the correspondence. 

Incoming - The correspondence is received by USAID. 
Outgoing - The correspondence is sent by USAID. 

To select a direction, place the mouse on the option and click the left mouse button. With the keyboard, 
use the arrow keys to select the option. 

Destination - Add Record 
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This is a 30 character alpha/numeric field. Enter the person or entity to whom the action is directed. Note 
that the system defaults to the current user's ID, but the field can be edited. 

The Action Information Form Buttons 

I~ 
Action Document Button 
This button brings up the Word Processor to create a new document concerning the correspondence. 

r ·'-Uk" 'J . 
Action Ok Button 
If all the fields have been filled-in on the Award Aptian form, this button saves the new or updated 
correspondence and returns the user to the Award Action form. The new row can now be viewed in the 
Award Action Grid. 

I.~J . 
Action Cancel Button 
This button cancels the new or updated correspondence and returns the user to the Award Action form. 

' . 
. -

". 
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To Do List 
While administering an award there are many different items to be accomplished. This form records and 
displays the items to be done. 

All roles can enter and/or edit the fields in this form. 

To Do List Form 
To open the To Qo Li~t form, select the To Do List Qutton on the Award Administration box. The following 
form will appear; . 

.. ',,, .. <- ~~, 

.. ,' .. 
;." ~' '; ... 

" '''-,A " 
~.,-LF'~c;.;.~7>-"'--7,:-o.;-4';"';"&i >>;." '.> ~:' ; 

To update information in ttie To Do List Grid, click I'~!. This will display the To Do List - Update 
Record form with the selected row's information pre-filled into the Date and Description fields. Enter the 
changes and click OK to accept or Cancel to disregard, 

To delete information in the To Do List Grid, click I ',!l.dCi,; 1 This will display a dialog box asking if you 
want to delete the entry. Click OK to accept or Cancel to disregard. 

The definitions of the fields, cells and buttons on the To Do List form are: 

To Do List Grid 
The To Do List Grid lists the items to be completed. 

Date 
This is a pre-filled and protected cell. It states the date the item is to be completed. 

Description 
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This is a pre-filled'and protected cell. It states the description of the item to be completed. 

r·~~:. '1 
This button opens the To Do List Information form described below. 

1-,HP~3 
This button displays the To Do List Information form and pre-fills the form with the information from the 
To Do List grid for the row selected. This button allows you to edit the selectee entry. . 

[,·-fiktJi· 'I N~(': .... ,~( 
This button deletes information from the To Do List Grid. 

To Do List - Information Form 
The To Do List Information form is used to Add or Update items on the List. The following will appear: 

__ '.,.' -:- ,'~ ~'-; ... , ~ tv" '~{':\ '.;,. .... ).::..~~, 
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Prepare the Annual Report 

t. 
-(t 

Enter the date the item is to be completed and its deSCription. Click OK to accept or Cancel to disregard. 
The definitions of the fields are: 

Date 
This date field is entered in the following format: MM/DD!YYYY. Enter the date the item is to be 
completed. To change the date, you can key the date·or double click the. field to display a Calendar to 
help select the date. See the section on Calendar for more information. The field defaults to the current 
date. . 

Description 
This is a 100 character alpha/numeric field. Enter the deSCription of the item to be completed. 

The To Do List Information Form Buttons 

WoO, Q)i:"1 
To Do Ok Button 
This button saves the new or updated To Do Item and retums the user to the To Do List form. The new 
row can now be viewed in the To Do List Grid. 

I" .... 1 ;"'~" 
To Do Cancel Button 
This button cancels the new or updated To Do List Item and returns the user to the To Do List form. 
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Award Status 
When the administration of an Award is completed, the Award may be closed-out. To close-out an Award 
the user must first close-out the Technical items pertaining to the Award as well as the Financial Items 
pertaining to the Award. Alter both the Technical and Financial Award Tabs have been reviewed and 
checked, the user may proceed with the Final close-out of the Award on the first Tab. 

The Contracting Officer or COTR roles are the only roles allowed to access the Status Form and close-
~)Ut Awards. . . 

Award Tab 
To open the AWard Status fonm; select the Status button on the Award Administration box. The first tab, 
the Award tab, will appear: '. , 

The Award tab for the Status form contains summary infonmation about the Award including the Award 
Type, the Amount of the Award, the date completed, and Vendor address infonmation. 

Two key buttons are on the Award tab. The ItMt.:~A~!\;;~] button is the Final button used to complete 
the close-out of an Award. This button remains disabled until both the Technical and the Financial Award 
close-outs are completed on the corresponding tabs. It is easy to detenmine if the Technical and Financial 
close-outs have been completed by observing the asterisk on the tab captions. 

The Award tab's other button is itt~ . This button closes the Status fonm and retums to the main 
Award Administration fonm. Note, that this is the only button available to close the Status fonm so the user 
must be on the Award tab to close the Status fonm. 
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Technical Tab 

After clicking on the Technical tab the following window appears: 

:. Included on the Technical tab is the name ofthe Contracting Officer's Technical Representative(COTR), 
and four check boxes. The check boxes confirm that all deliveries have been accepted, all government 
properties have been returned, and that there exist no outstanding objections to the Award . .Directly 
below the frame containing the checks is a grid of the Line Items for the Award. All rows on the grid 
where the quantity Received is less than the quantity Expected, are highlighted to alert the user that all 
expected items have not been received for these Line Items. 

In order to close-out the Technical Award, the user must check all the boxes. When all boxes are 

11 [$)M l;;cl\n,miP 
checked the -', :,1 button becomes enabled and the user can click this button. The form 
below pops-up when clicking the 'Close Technical" button: 

If the user clicks the 'Close-Out" button on this confirmation form the Technical Award is closed. An 
asterisk on the tab caption indicates the Technical close out has been completed. 
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Financial Tab 

After clicking on the Financial tab the following window appears: 

Included on the Financial tab is the name of the Contracting Officer, and two check boxes. The first 
check box asks if Unused Funds remain. If this box is checked, a subsequent check box asks if all th~ 
Unused Funds have been decommitted. The second check box asks if the Final Voucher Payment has 
been received, as well as the date Final Voucher Payment is accepted. Directly below the checks is a 
grid which contains columns to hold dollar amounts forthe Committed, Obligated, Invoiced and Disbursed 
sums for the parent Award and each of its modifications. The Invoiced sums are not yet available. 

When the Final Voucher Payment has been received and confirmed, the I; ~';.fil1l)'l~l.d) button 
becomes enabled and the user can click this button. The form below pops-up when clicking the "Close 
Financial" button: 

If th.e user clicks the "Close-Out" button on this confirmation form the Financial Award is closed. An 
asterisk on the tab caption indicates the Financial close out has been completed. 
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Award Staffing 
A message can be forwarded to another user in Award Administration to alert the user that an important 
event is occurring. 

Staffing Sent 
Three types of items can be staffed; a Delivery Status item, an Action item, or an Award Protest item. 
Staff buttons exist below the grid in each of the corresponding forms. For example, an Action item can 
be staffed by clicking the st;lff button as displayed below; " ." . 

After 1'- :lniiil' ~ I is clicked the staff Send form is displayed: 
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'To send a New staff item, select the Organization and the person to Staff To in the Staff New section of 
,the Staff Send form and fill-in an appropriate comment. Finally, click the Ok qutto'n, 'When the Ok button 
is clicked the user will see confirmation of the Sent Staff item in the Send Log section of the the Staff , 

, Send form. The Send Log section also lists previously sent staff items that have not yet been deleted by 
the user having received the staff item, Note, that if the "Date Rcvd" field is blank in the Send Log it 
indicates that the user has not yet received the item staffed, 

Staffing Received 

In order to review the Staffing items received, the user can click on the Staffing Alert button I iJ on the 
Toolbar or double-click the Staffing Alert Initial Icon, The Staffing Alert form will be displayed as below: 
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The'Staffing Alert Fields 

Date Staff 
The Date that the item was Staffed., 

Source 
The user who sent the Staff.'item. 

, 
Date Rcvd 
The date that the user read the Staff item. 

Message . 
The comment from the user who sent the Staff item. 

Type 
The type of Staff item: An Award Protest, Action or Delivery Status. 

Award ntle 
The Title of the Award to which the Staffed item,belongs. 

To review the item Staffed the user should open up the corresponding Award from the Award Title. After 
opening the appropriate Award the user should proceed to the form matching the particular Type of item 
Staffed; that is, the Protest/Action/Delivery Status form. 
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Award Modification 
Certain kinds of Award Modifications can be done in the Award Administration application. An Award can 
be modified by entering the DGS subsystem (by Contracting Officers or Negotiators), and an Award's 
COTR and Completion Date can be changed (only by Contracting Officers). All modifications create a 
new Award with an Award Number whose modification segment is incremented by one over the Award it . 
modifies. Note, that no modifications of Small Purchases are allowed in the Award Administration 
application. 

Award Modification Form 
To open an Award Modification Form, select the Modification button on the Award Administration box. 
The Award Modification Form appears: 

When a Contracting Officer clicks the IY·:] button to the right of COTR: the Organization and Name 
List Boxes appear as below: 
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To change the COTR, the user must choose a Organization and Name from the List Boxes, and click the 

L~J button to the right of the Edit button. 

When the user has completed any modification to the Date Completed or COTR for an Award, the user 

must now click I~ ':t~~lIif.l' ','I button to enter the D~S system and modify the Award document. The user 
will then make any modifications to the Award through DGS. After finishing DGS modifications and exiting 
the DGS system the user will be presented with a confirmation form as below: 

Create a New Award for your Modified DGS-Contract and 
Modified Completion Date? 

This confirmation form will summarize the changes the user has made to the Award and request 
confirmation. Upon confirming the modifications the user will be presented with a form listing a new 
Award Number. The Modified Award Number form appears below: 

o The Modified Award Number is 100-A-OO-95-0153-05 

After clicking the OK button the modification is complete and the user is returned to the main Award 
Administration Form. The Award Administration Form's Award List Box will automatically drop down to 
show the new Award modification. 

Note that if the user cancels the Award Modification process, a form will pop-up indicating that the Award 
has not been modified, and a new Award has not been created. 
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Word Processor 

This Word Processor allows you to create and~print documents within the Award Administration 
application. 

Pull-Down Menus 

The Word Processor pull-down menus are located on the menu bar, the second line in the main Word 
Processor window. A menu can be activated by clicking on a menu title with the mouse or by pressing 
the AL T key, moving to a menu title with the right and left arrow keys, then pressing the ENTER key. 
Select a menu option from .the pull-down menu by either clicking on the option or by moving to the option 
using the up and down arrow keys, then pressing the ENTER key. 

The menu structure is as follows: 

File Menu 
Save 
Print 
Exit 

Edit Menu 
Cut 
Copy 
Paste 

Search 
Search Next 
Replace 
Insert Picture 

View Menu 
Ruler 

Button Bar 
Status Bar 

Tab Bar 

Layout Menu 
Page 

Tools Menu 
Repaginate 

: Saves and attaches the record. 
: Allows you to print the information. 
: Ends the word processor session. The application prompts you to save any 

unsaved changes in a record. 

: Removes highlighted text and puts it in the clipboard. 
: Copies highlighted text to the clipboard. 
: Inserts a copy of text from the clipboard at the insert point. It overlays any 

existing text in the field. 
: Finds a word, phrase, or code in your document. 
: Finds the next occurrence of the text you last searched for. 
: Finds and changes text or codes in your document. 
: Allows you run another application whose data you can include in your document. 

: Displays or hides the horizontal ruler, a bar with a measurement scale and 
markers that enable you to adjust indents, margins, tab stops, and table columns~ 
The ruler is part of a document window; you can choose to display the ruler in 
some document windows while hiding it in others. 

: Quick access to the commands you use most. 
: Located at the bottom of the word processing window, the status bar displays 

information lines (long prompts). 
: Use the tab bar to change your tab settings quickly and easily by moving any of 
the triangular tab marker buttons or the button marked with dots, located ,on the 
ruler. 

: You can change the margins, tabs, and measurements that the word processor 
uses by default. 

If the document is more than one page long, Repaginate can rearrange the page 
endings to fit. 
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Font Menu 
Font 

Normal 

Bold 
Italic 
Underline 
Strikeout 
Subscript 
Superscript 

Help Menu 
Contents 
Help on Help 
About 

: App[ies or removes charactE)r formats from highlighted text or from the insertion 
point forward as you type. 

: Returns a document to normal view. [t is the default view you will use for most 
word-processing tasks. Normal view shows text formatting, but simplifies the 
layout of the page so that you can type and edit quickly. 

: Lets you add Bold text to your document. 
: Lets you add Italic text to your document. 
: Lets you add.Underline text to your document. 
: Lets you .Strikeout text on your document. 
: Text that appears'slightly lower than other characters in the line. 
: Text that appears slightly higher than other characters in the line. 

: Word Processor Help Table of Contents. 
: Windows Help System. 
: Information about the Word Processor. 

The Word Processor Button bar 

The too [bar contains a series of buttons that can be clicked on with the mouse as an, alternative to using 
the pull-down menus. The Button bar may be turned on and off with the View pull-down menu by 

. selecting Button bar. The buttons on the Button bar are defined in order from ,left to right as follows: 

Left Align 
Center Align 

Right Align 
Justify 

Bold 

Italics 

Underline 

Strikeout 

Single Space 

Double Space 
Triple Space 

Subscript (H Button) 

Superscript (T Button) 

A&A Award Administration 

: Aligns text with the [eft margin, but leaves a ragged right margin. 
: Centers text between the left and right margins or on a specific point on a 

line. 
: Aligns text with the right margin, but leaves a ragged left margin. 
: Aligns text with both the left and right margins, adding or deleting space 

between words as needed. 
: Bolds the highlighted text in the document. This function can,be 

accomplished by choosing Bold in the Font Menu (ALT +0, B). 
: [talicizes the highlighted,text in the document. This function can be 

accomplished by choosing [talic in,the Font Menu (ALT+O, I). 
: Underlines the highlighted text in the document. This function can be 

accomplished by choosing Underline in the Font Menu (ALT +0, U). 
: Strikes out the highlighted text in the document This function can be 

accomplished by choosing strikeout in the Font Menu (AL T +0, K). 
: Sets the line spacing for each line to accommodate the largest font in that 

line. 
: Sets the line spacing for each line to twice that of single line spacing. 
: Sets the line spacing for each line to three times that of single line 
spacing. 

: sets the line to Subscript - Text that appears slightly lower than other 
characters in the line. 

: sets the line to Superscript - Text that appears slightly higher than other 
characters in the line. 
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To use one of these items, block the text, and click either the "H" or "T" on the button. 

Tab Sets 
Left Tab set -
Right Tab set -
Decimal Tab set -
Center Tab set -

Sets a left-aligned tab. 
Sets a right-aligned tab. 
Sets a decimal tab. 
Sets a' center-aligned tab. 

The Word Processor defaults to Left Tab set. To add additional or new tab. stops, click the type 
of tab on the button that you want, then put the cursor on the point of the tab bar where you want 
the tab and click the left mouse button. 

Show/Hide 
Font Colors 

: Shows all nonprinted characters, including paragraph marks and spaces. 
: Displays the Font Color Box. Allows you to choose the color that the text 

appears in the word processor. 

Basics 

Save: 
1. Choose Save from the File menu. 

Search: 
1. Place the cursor where you want the search to begin. 
2. Choose Search from the Edit menu . 

. 3. Type the text you want to find. 
4. Select Forward or Backward from the Direction pep-up list. 
5. Choose Search to begin the search. 
6. If you want to find another occurrence of the same search text, choose Search Next from the Edit 

menu. 
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Message 
Code 

ORA-00001 

ORA-OOOS4 

ORA-00942 

ORA-01000 

ORA-01017 

ORA-01031 

Oracle Server Messages 

Description 

Unigue constraint violated 

Cause: A record exists in the database wuh the same pIimary key as the 
record you are attempting to add. The current record cannot be saved. 

What to do: Contact your system administrator for assistance. 

Record locked for update 

Cause: Record is being edrred by anot~er user. 

What to do: Try to access record later. 

Table or view does not exist . 

Cause: You do not have a valid A&A role. 
Or 
The data table/view (file) that the application is trying to access euher 
does not exist or is not available to you. 

What to do: Application will terminate automatically. Contact your system 
administrator for assistance. 

Maximum cursors exceeded 

Cause: A fatal error has occurred in the current routine. The current data may 
not have been saved. 

What to do: Application will terminate automatically. Contact your system 
administrator for assistance. 

Invalid username/password 

Cause: You have entered an invalid user ID and/or password or an Oracle 
account has not been created for you. 

What to do: Retry wuh correct username/password. I this error persists 
contact your system administrator for assistance. 

Insufficient privileges 

Cause: You have insufficient pIivileges to perform this database task. The 
current data may not have been saved. 

What to do: Contact your system administrator for assistance. 
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ORA-01924 

ORA-02291 

ORA-03121 

ORA-OS107 

ORA-OS122 

3059 

Role not granted or doesn't exist 

Cause: Your default Oracle role is missing or invalid. 

what to do:, Contact your system administrator for· assistance. 

Parent key not found 

Cause: A 'Parent' record is required to save the current record. The Parent 
record could not be found. The current record cannot be saved. 

No interface driver connected 

Cause: A SQL 'Net TCPIIP error has occurred. Either the SQL 'Net" 
directory is not in your PATH= statement in AUTOEXEC.BAT" or 
there is a problem with the ORACLE.INI file. " 

What to do: Application will terminate automatically. Contact your system 
administrator for assistance. 

Oracle network server not found 

Cause: A SQL'Net TCPIIP error has occurred. The SERVICES file is invalid, 
could not be found or is not specified in the ORACLE.INI file. 

What to do: Application will terminate automatically. Contact your system 
administrator for assistance. 

Setup failure 

Cause: A SQL'Net TCPIIP error has occurred. The ORACLE.lNI file is 
invalid or could not be found. 

What to do: Application will terminate automatically. Contact your system 
administrator for assistance. 

ODBC user canceled 

Cause: An ODBC error has occurred. Either the ODBC.lNI file could not be found, the 
proper data source is not specified, or the correct driver is not specified. 

What to do: Application will terminate automatically. Contact your system 
administrator for assistance. 
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Incident Reporting 
Although comprehensive testing has eliminated as many errors as could be found and fixed, there is a 
need to report any new errors in a way that is meaningful to the software developers so that the errors 
can be corrected. The forms on the following pages should be used to report these errors. Copies of 
these forms should be made and kept on file for future use. The figures below indicate where to find the 
information needed to fill out the form along WITh a definITion of the terms used on the form. It is important 
that the user and System Administrator collaborate in the response. The System Administratgr may be 
able to resolve some of the errors before the reports are sent on to the Help Desk. Include as much detail 
as you can concerning the error. Remember the individuals who will evaluate and fix the error may be a 

- continent away. 

The figure below is a typical screen used in the AcquiSITion & Assistance application. The information 
needed to fill out the report will be found in the salJ1e gener1j1 area thro}lghouUhe qther module~. . .... . 

Mode ". 

:;~;; ==1== Illi!m!:~;~~~~i~Bt~ Screen N~nw . 
; .' '0Ie<l .. 

~' ~U~'~f 
-:.: $~~fn 
,), ~ n, , •. ,' 

Tab Name 

a5i:~---j Field Name 

Role 

":' 
Figure 1. 

The figure below is the Splash screen that is displayed before the application presents ITself. To review 

Figure 2. 

A&A AWard Administration 

this information at other times, click on t[elp, then 
click on 6bout when the drop-down menu or list is 
presented. 
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Definitions, Incident Report Form 

Incident Number: This number will lie assigned by your System Administrator when the Report is 
logged in. The number should include information that will make it unique so that it will not conflict 
with Incident Reports sent in by other sites. This log should be scrupulously maintained and
inquiries made if a timely response is not received. 

IP Address: The IP address is the Internet Protocol address. It is used to uniquely identify a host 
computer on a TCP/IP network. It is set up by the System Administrator ofthe·host compllter. 

Host Name: The host name is a synonym for the IP address. It is used to uniquely identify a host 
computer on a TCP/IP network. It is set up by the System Administrator of the host computer. 

Name: The name ofthe user initiating the Incident Report. 

Organization: Enter the organization code that will help to uniquely identify your installation. 

Location: Enterthe location that will help to uniquely identify your installation. 

System Administrator: The name ofthe System Administrator. It is suggested that the System 
Administrator maintain a file of copies of the reports for future reference. 

Version: The date and version number appearing on the Splash screen. See Figure 2 for an example. 

Screen Name: Enter the Screen name. See Figure 1 for an example. 

Tab/Fonm Name: Enter the name of the Tab or Form. See Figure 1 for an example. 

Field Name: Enter the label or name of the field where the error occurred. See Figure 1 for an example. 

Mode: Enter the Mode the application was in when the error occurred, such as ADD, EDITor VIEW. See 
Figure 1 for an example. 

Role: Enter the Role that you were using when the error occurred, such as Requestor, Manager, COTR, 
etc ... See Figure 1 for an example. 

Description of Problem: Enter as much information about the sequence of events leading up to the 
problem as you can. The frequency that the problem occurs, intermittently or every time, is 
important and should be noted. 

Actual Error Messages:' In 'Some cases the application will trap and display error messages generated 
by Oracle, the Database Management System. There is a list of these messages and their 
codes on page 46. There may be some messages that are not in the appendix that are 
generated by the application or by Windows itself. These messages are important to the 
developers and should be noted. 

All of the entries may not be pertinent but they should be, filled in. Use N/A when appropriate. 

" 
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NMS Incident Report Form 

-
Incident Number: ___________ _ IP Address:. ___________ __ 

Date of Incident. ___________ _ Host Name: ____________ _ 

Name: _________________ __ Organization:. ____________ _ 

Version: ________________ __ Location: ______________ _ 

Application: _____________ _ Screen Name:. ____________ __ 

Mode: ________________ _ Tab Name: __________ ~ __ 
, ' , 

.'Role: _______________ _ Field Name:. ___________ _ 

Description 6f Problem: _____________________________ _ 

Actual Error Message:. ______________________________ _ 

" 

Suggestions: ________________________________ _ 

System Administrator:, ______________________________ _ 
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Introduction 

Overview 
The Acquisition and Assistance (A&A) Support application enables users to develop and maintain_ 
information related to A&A functions in the global USAID Oracle database. This application is 
used as a tool to maintain profiles and information on employees and vendors. ThiS USAID-wide 
application interfaces with the other A&A applications: Planning, Award Formation, Small 
Purchases, and Award Administration. 

A&A Support contains four groups of forms which are listed below. 

Employee Maintenance Module: A&A Support provides the A&A Administrator with a means to 
assign "user roles" to employees. This module provides for maintenance of employee recqrds 
within the A&A database. The user can create, delete and edit employee records and can assign 
or revoke any of the 11 A&A roles. A four-element database query function (based on employee 
role, location, organization and 'last name .begins with") enables creation of lists of employees 
with shared attributes. Finally, the Employee module provides for both temporary and permanent 
reassignments of employee tasking. This enables continuous task coverage in spite of vacation, 
sick leave, travel or termination. 

Organization Location: A&A Support maintains the address list of USAID Organizations for all 
A&A applications. The user can create, edit, or delete location data (providing that the user is 
logged on in an authorized role). Phone number, fax number, and E-Mail information are also 
tracked on this form. 

Vendor Maintenance Module: A&A Support provides the overall procurement team with a 
means to keep current on the status of each of the vendors by maintaining a global USAID Oracle 
database of Vendor Capabilities, Performance, Locations (including contact information) and 
Experience. The program maintains information with full read/write capability about special 
qualifications, such as vendors who qualify as.woman-owned under the Gray Amendment. 
Vendor capabilities (such as a small business or 8a firm) may be checked by the OSDBU Small 
Business Advisor and may be read by all users of the module. The vendor module can also 
operate as a query application in which the user enters vendor requirements into the system and it 
creates a list of all vendors that satisfy the requirements. 

Shipping Location: A&A Support maintains the address list of USAID shipping addresses for all 
A&A applications. The user can create, edit, or delete location data (providing that the user is 
logged on in an authorized role). Phone number and Point of Contact are also recorded on this 
form. 
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Loading the A&A Support Application 
You must be authorized to logon to the NMS applications in order to use the A&A Support 
application. Instructions for logging on can be found in the appendix, along with causes of logon 
failure. 

Provided that you are eligible for more than one role, a second Logon box will appear. Select a 
role from the drop-down list box, which allows you to select the role for various duties you will be 
assigned to perform. Click.on OK. 

Note: To return to the role box later, close any open tabs and click on the Role button or press 
ALT+ D, R. 

The A&A Support Main Screen 
Once you log on, the A&A Support Function dialog box appears. At the top of the screen are the 
menu and the toolbar, described on pages 6-7. Large buttons will be displayed representing the 
modules of the application. 

To access one of the modules, click on the appropriate button. To access the File Menu, press 
the ALT key plus F. (To exit the program, press ALT+ F, then X.) 

Three message boxes are shown atthe bottom of the screen. The left box tells you the status of 
the connection to the server. The center box tells who IS logged on and in what Role. The right 
box shows the status of the application and processing. 

l~ir~~;~r~~~.connec~eaan~ataO'~::§~~1U~@;"?iijnOaj:NegotiafOr~<k~1t~m~l~~'Rea§Y~~'-;~~ 
Status Bar 
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How to Use Help 

On-line Help is available for the application in general and for specific fields. :["0 see the listing of 
main help topics, press the ALT key plus H. 

Help topics can include graphics and text that link to other Help topics or to more information about 
the current topic. The Help text is highlighted in green and underlined. Help text contained in a -
Graphic is invisible. When the pointer IS directed to the text, it changes to a hand icon. ~ 
Then you can click the left mouse button for additional information. 

To choose a topic using the keyboard, press TAB until the topic is highlighted, and then press 
ENTER. 

F1 (HELP) 

For immediate Help on a specific field, place the cursor on the field and press the F1 key. The 
definition of the field appears on the screen, unless the field is a date field or non-editable (on a 
blue background). 

FINDING A SPECIFIC HELP TOPIC 

At the top of the Help Contents page and on every main Help topic is a Search button.I~"ilat$tl 
Press this.button to search alphabetically for a specific topic. 

BROWSING MAIN HELP TOPICS 

At the top of the Help Contents page and on every main Help topic are Browse buttons. 

U;;' .. ~<~:h'j~>2'L~1 Use them to move ;orward or backward through the major Help topics. 
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_O_v_e_rv_i_e_w_o_f_t..;..h_e_A...;&_A_ . ...;$,;;.. .. U..:.,P..:.,P..;,;9 .... rt_A.-;..P:.,..pl_ic_a..,t,...io..,n_S_c_r_e_e_n ...... _......;.;.... . .e 
Toolbar -The tool bar contains a group of buttons, each displaying an icon, or symbol. Each button initiates... 
a command. 

a Creates a new record 
Ii<' 3)iOD'i"irr . 
,,.;,., "'"., I Displays processmg mode 

1m Opens an existing record m Searches for vendor record with .. options 
Updates a record 

UI I!I Searches for a record 
Prints a form 

m ~ Accesses the report option. 
Cuts text to clipboard 

~ ~ Changes the user logon role 
Copies text to clipboard 

11 ~ Accesses the Help File System 
Pastes text from clipboard 

When a button is outlined in black, the command is available for the form you are using. When a 
button is outlined in gray, it is inactive at this time. 
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Menus 
The pull-down menus are located on the menu bar, the second line in the A&A Support window. 

File Edit Database Options Wi~dow ···Help. . .. 

A menu can be activated by clicking on a menu title with the mouse or by pressing the ALT key 
plus the underlined letter in the menu name. (Note: If there is a hot key on the same screen with 
the same underlined letter, use the mouse to open the menu.) Once the menu item is highlighted, 
move to a different menu title with the right and left arrow keys, then press the ENTER- key. Select 
a menu option from the drop down menus by either clicking·on the name of a command or by 
moving to that command using the up and down arrow keys, then press the ENTER key. 

Example: Clicking on the word Eile brings up the following menu. 

Qpen 
&Iose 
.liave Ctrl+S 
Delete 

Print Setup ... 
Erin!... Ctrl+P 

For more information on the menus, see Appendix, page A-S. 

Note: When a Menu Item appears in gray lettering, the topic is not active for the form 
that you are using. Items displayed in black are active for the form that you are using. 
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Employee Mainten~nce Module 

To access the Employee Maintenance Module, click on the Employee button in 
the A&A Support Menu dialog box. The A&A Administrator can perform functions 
and access three tabs in the Employee Maintenance Module. The Program 
Manager and Contracting Officer can access Setup Picklist and the TDY Actions 
tab. All other roles can only access the Setup Picklist tab. 

The Employee Maintenance Module will display the tabs that your role can use. 

(Example of Selected tab) 

Setup Picklist Tab 
The Setup Picklist tab has two main areas: Filters (in the upper left) and the picklist itself, which is 
the table on the bottom of the screen. The Picklist remains visible for all four tabs in the Employee 
module. 

The Setup Picklist Tab is used to create a list of employees that is of manageable size for use by 
each of the other three tabs of the Employee Module. The Picklist filter has access to all of the 
employees of USAID. If no filters were used, the picklist would contain thousands of names. The 
picklist filter allows the user to select categories like "All Negotiators in Egypf or' All Contracting 
Officers." It also assists when attempting to locate an employee from incomplete or partial 
information, such as • An employee whose last name begins with'S' and who is a contract 
officer." The filter for the employee name can be searched by the same methods used in the 
Search Options (see page 15). 

The Setup Picklist screen and fields are listed below. 

Role Filter: Check this box and pull the drop-down list box to select a role to use as a filter in the 
employee picklisl. 

Org 10: Check this box and pull the drop-down list box to select an organization identification 
number to use as a filter in the employee picklist. 
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Location Filter: Check this box and pull the drop-down list box to select a location to use as a 
filter in the employee picklist. 

Last Name Filter: Check this box and enter all or part of an employee's last name to use as a 
filter in the employee picklist. 

How to Create a Picklist Using Filters 

The filter setup area (upper left part of the screen) enables setting the criteria to select employees 
to appear on the picklist. It contains four boxes. Role, Location, and Org Code are combo boxes 
(with drop-down lists), Last Name is a text box. 

To the left of each combo or text box you will see a check box and a clear button. ![t1f) An 'X" in 
the check box means that its associated information will be considered in creating the picklist. No 
"X" means that the information will be ignored .. For example, if the location box happens to be set 
to Egypt and the box is checked, then the employees that will appear on the picklist will be those 
whose location code is Egypt If it is unchecked, then no location sort will be performed and the 
picklist will include employees from all around the world. The clear button is clicked to delete 
information from the box. 

If you have checked Role, Location, andlor Org Code, you will be using the drop-down lists. 

"' •• 

How to Select from a Drop-down List Box 

II Clicktheleft mouse button on the dawn'arrow button or on thedisplaywindowta seethe list. 
Scroll dawn if you needta see more, ortype the frrS! letter. Click on your selection. ,Or, 

, , , 
Using the keyooard, hold down ALT ~ down arrDW key to see the list. Use up and down aimws or 
typejhefirst'le\t~[of,th~y;ord(le~ed.'PressENISR :',' ., .... , ',,' ':,',.', L' 

If you are searching for a particular employee by name, type the name or'the first letters ~f th'e ' 
name in the Last Name field. The name filter is not case sensitive: Smith = smith = SMITH = 
sMiTh for example. Click on the Load Picklist button to retrieve the data. 

The Load Picklist button !PlIIOaiIlP.lc@i filis the pickUst according to criteria set in the filters. 
The picklist contains the list of employees that the user will be working with in the other employee 
tabs of the application. It combines information from several database tables to make a single 
table containing Employee Last Name, First Name, Location, and Org Code. 

The picklist will be displayed on other tabs of the Employee Module so that you can select an . 
employee record to view or edit. To select a record from the list, double click on it, or highlight it 
using the arrows and then press ENTER. (Also, in some cases, you can drag and drop an item 
from the picklist to a particular field.) 
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Employee Role Tab 
The Employee Role tab is visible and accessible from the Employee Maintenance Module. It is 
used to assign roles to employees. It is accessible only to employees with.the appropriate Oracle 
role, which is currently the A&A Administrator. 

The Administrator can' use this tab to assign or delete roles. The current roles include one 
general role for most USAID employees, namely View. Other roles are more A&A specific' and 
include Negotiator, Requestor, Contracting Officer, OSDBU SB Advisor, and Clerk. The number 
of roles and the role definitions .reside in the database. 

When·the screen first appears, no data is displayed: Click on an employee name to·select. The 
name and organization will appear in a dark red field' Then click on the Show Roles button. In 
the example below, no roles have been assigned to·the employee. The A&A Administrator will 
assign roles by selecting the roles that apply. 

ConfFacling OfficeJ" 
We;JoJiafor 
FWgratll N""'!f{er 
AM AtfminimaftJf 
View 
C/eJi 
OSOBU'SB Ad?is(Jf 
COTS 
W.:ue.iJouse 
Safes 

The role assignment in the A&A Support system indicates that the employee is qualified .to be 
assigned a particular role on,a procurement. An'employee can therefore be assigned multiple 
roles. 'For example, a given employee could be assigned the dual roles. of Contracting Officer and 
Negotiator. Then, for one particular Request within (for example) the A&A Planning Application, 
that employee could be assigned the role of Negotiator for one requesL Contracting Officer for 
another request and both for a third request. 

All the roles available to the employee are displayed.in.the Available list box. Click on a role.to 
transfer it to the Assigned list box. To revoke a role, click on it in the Assigned list box. It will 
move to the Available list box. (Clicking on either box will transfer the role to the other side.) 

Click the Save Roles button to save the role assignments. 

Before being assigned A&A roles, a new employee must be assigned an Oracle account by the 
DBA. The application checks the database of "AII...:Users" before it allows any roles to be granted. 
If no Oracle account has been issued to the employee, a warning message is displayed and 
further access is denied. 
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Employee Tab 
The Employee tab enables the A&A Administrator to create a new employee record (adding it to 
the database) or to modify text in an existing employee record. The Employee screen and fields 
are listed below. 

There are two parts to the Employee tab. The bottom half of the tab contains the employee 
picklist (which is common to all the Employee Module tabs). The top half of the tab will either 
display basic information on a selected employee or will provide the fields to fill in for a new 
employee, depending on which database action is selected: 

New Emp button: Click this button to create a new employee record. -For instructions on 
creating the record, see page 12. 

Edit Emp button: Click this button to edit an existing record. 

Delete Emp button: Click this button to delete the selected employee record. 

The fields are: 

Last Name: This field contains the employee's last name. 

First Name: This field contains the employee's first name. 

User ID: This fiel.d represents the employee's logon I D. 

Or9 Code: Check this box and pull the drop-down list box to select an organization code. The 
number to the left of the box displays the number of records in the database. 

Location: Check this box and pull the drop-down list box to select a location. 

The button IH to the left of each field will erase the information that is in that field. 
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How to Create a New Employee Record 

To create a new employee record, the A&A Administrator clicks the New Emp button. 

A&A Support 

Please Enter U:erID 

A form will be displayed for entering the new employee's User 
ID num.ber This 10 number is assignEld by th.e database 
administrator for Oracle access. '. 

(as a=gned by DBA) Enter the 10 and click the OK button. The application will 
prompt you if that 10 number is not available.2 

Once the User 10 number is accepted, the Employee tab is 
displayed with the five data entry boxes (which appear on the 
top half of the screen) ready to accept new information. To 
enter the employee data, type the employee last and first 
names in the 1ext boxes provided. Pull the drop-down list 
boxes to select an organization and a location. 

When the data has been reviewed and is error free, click the Save New button to save the 
information. 

How to Modify an Existing Employee Record 

To modify an existing employee record, click on the employee name in the picklist. When the 
name is selected, the data is transferred to five data boxes in the top half of the screen. Click Edit 
Emp to modify data, except the user 10 which remains fixed. To enter the modified data back into 
the database, click on the Save Edit button. (To cancel the editing action, click the Cancel Edit 
button.) 

To delete an employee record, select the name 
and click the Delete Emp button. A dialogue box 
will give you a chance to cancel the deletion. If 
you click OK, the entire record will be deleted. 

TOY Actions tab 

A&A Support Employee Module 

DElETE •.•• fredm ? 

Hit OK IF YOU ARE SURE 
(and you have deleted 
work assignments via TOY) 

The TOY Actions tab lists duty assignments for USAID employees. It is used for temporary or 
permanent reassignment of employee tasking. This enables continuation of tasks in spite of 
vacation, sick leave, travel or termination. 

The TOY Actions tab can be used by these roles: Administrator, Contracting Officer, and 
Program Manager. The Administrator can see'all permanent and all temporary assignments and 
make any reassignments except for permanent reassignment of COTR. The Contracting Officer 
can only see and make assignments related to projects for which he is the CO. The Program 
Manager can temporarily reassign himself and either temporarily or permanently reassign the 
Requestor. In addition he can temporarily reassign the COTR. 

2 There are two occasions when a new User 10 will be rejected: if that User 10 is already in the 
database or if the new User ID does not yet have an Oracle account. 
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To see the assignments for an employee, select his or her name on the Picklist by double-clicking. 
(If you prefer, you can drag and drop the name using the mouse.) The employee's name will 
appear at the top of the tab. Then, click on the Show PERM button. Permanent assignments will 
be displayed. Also, additional buttons will become available. 

Abbreviations To reassign an activity" use the Picklist·to locate another employee. (You 
may have to return to the Setup Picklist tab to make a new picklist. When 
you return to the TOY Actions tab, the new picklist will Temain on the·bottom 
of the screen.) Using the mouse, drag and drop the name or user ID to the 
appropriate space on the right of the screen. To save the reassignments, 
select the appropriate button depending on whether the action is temporary 

in Headings 
A,IO: Activity'IO 
RIO: Request 10 

or permanent. If temporary, as in a case where the employee is going on leave, click the Save 
TEMP button. If permanent, click the Save PERM button. 

When temporary reassignments have been made, they can be undone when the employee 
returns. To see them, click on the Show TEMP button. To return all of them to the employee, 
click on the Fill frm TOY button. Click on Save PERM to save the restored assignments. 

Hint: To save time on TOY Actions, take full advantage of the filters on the Setup Picklist tab. 
For instance, if reassignments are going to be made to several employees with the same role and 
organization code, use Role and Org Code as filters and do not use the last name as 
a filter. Your picklist will display all the employees under those criteria; thus, you will 
not have to return to the Setup Picklist tab to build a new picklist. 

The buttons on the TOY tab are summarized below. 

Clear ALL Clears table including the name at the top. 

Show TEMP Displays temporary assignments for the employee named at the top of the tab. 

Show PERM Displays permanent assignments for the employee named at the top of the tab. 

Save TEMP Stores reassignments in temporary status so they can be reversed later. 

Save PERM Saves reassignrnents permanently. 
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Fill frm Pick Reassigns duties to name highlighted on picklist. 

Clear Clears names from reassignment columns. 

Fill frm TDY Retrieves temporary reassignments from TOY records in database. 

Organization .Location 

The form is used to update USAID location data. It is accessed by pressmg the 
Org Location button on the main screen. 

Current locations are listed in a table on the bottom of the form. Use the scroll 
bars to reveal more. 

Click on the record that you want to update. The following fields will be filled in 
except for ones that are blank. 

Organization Name, Address, City, State, Postal Code, Country, Phone Number, Fax 
Number, E-Mail, Internet. . 

If your role is Administrator or Negotiator, the mode box at the top of the screen will display the 
word EDIT. You can change the fields that are displayed in white. 

To add a new location, click on the new button. [iBJ A blank record will be displayed. Type in the 
Address fields, except for State and Country, which you select from the drop-down list. Type in 
the Phone. Number, Fax (Facsimile machine) Number, E-Mail address and Internet address if 
applicable. These fields will roll to allow more data if needed. 

Save the record by pressing the Save button.ltiiI] To close the form, press CTRL +F4. 
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Vendor Module 

Click on the Vendor button in the A&A Support Menu dialog box to access the 
Vendor Module-This module provides the overall procurement team with a 
means to find and view information on vendors that are in the global USAID 
Oracle database. 

If your role is Administrator, OSDBU SB Advisor or Negotiator, you can update or 
create a vendor record. Other roles can only view information, except that Rates can edit the 
Audits tab. There are five vendor tabs: Vendor, Location, Capability, Experience, and Audits. 
You will see these tabs after you select a vendor or initiate the addition of a new vendor. 

When you first enter the Vendor module, the Vendor Quick Find screen will be displayed. Use it if 
you are going to update',! vendor record. If you are going to add a new vendor record"click on 
the New button. See page 16'for instructions on creating a new vendor record. 

Locating a Record with Vendor Quick Find 

If the Vendor Quick Find screen is not disPla~ed. click once on the Search button m on·the 
tool bar. The Vendor Quick Find dialog box appears containing a blank vendor name and vendor 
ID and two search option boxes, shown at the top of the box. Click on the vendor name or'vendor 
ID option to search by that type of record. Type in an exact or partial vendor name or an exact.or 
partial vendor ID and click once on a search option, described below. Click on the Gluick Find 
button to see the results in the picklist at the bottom of the box. 

The picklist is a list of records which meet the criteria that you entered. To select a record f~om 
the list, double click on it, or highlight it using the arrows and then press ENTER .. 

To print the picklist, click on the Report button.I~1 

Search Options 

This function allows you to search a vendor name with a partial or exact text 
search. :rhe system default is partial text search. 

A Partial Text Search displays all the vendor names that begin with your search characters. For 
instance, if 

you type: man 
YOU get· Management Development International, Inc., Man Tech, Inc., 

An Exact text Search displays the vendor name that exactly matches your search characters. 
For instance, if 
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you tvpe: Management Development International, Inc., 
you get: Management Development International, Inc., 

The benefit of a partial text search includes: 
1. Fewer keystrokes required. 
2. Wider final selection available. 
3. More useful search when only limited information is available. 

You can also search for vendors with a certain location, experience, or specialized capability by 
using the Vendor Query feature. 

Locating a Record with Vendor Query 

l~fy"§f@."WiY~f.Yi:l: Vendor Query is a relatively easy method of finding vendor record~ th<;lt me!lt '. . 
criteria such as location, capability or OSDBU qualifications. When yoti click on the Vendor Query . 
button, four Query tabs appear: Vendor Query, Location Query, Capability Query and Experience '. 
Query. Click on a tab name to move back and forth between tab screens. After entering the 
search conditions, click the Query button. The application will display a picklist of records meeting 
the criteria. To select a record from the list, double click on it, or highlight it using the arrows and 
then press ENTER. To print a report from the picklist, click on the Report button. 

, The Vendor Query tabs are described in the appendix. 

How to Update a Vendor Record 

To update an existing vendor, the vendor must be in the database. Use Vendor Quick Find or 
Vendor Query to bring up the record. Once the record is found and sele~ted from the list, you 
can update the existing information if you are in an authorized role. Move from tab to tab by 
clicking on a tab name or using the hot key (ALT+ underlined letter). Click on the Save button 
when you are finished. • 

You can continue in the vendor module or you can exit to the main screen. To exit the record: 
double-click on the hyphen mark in the upper left-hand corner or press CTRL + F4. 

How to Create a New Vendor Record 

In order to add a new Vendor record, you must be in·the Vendor module and you must have an 
authorized role. 

1: lied Click on the New button or press AL T +F, N. The vendor tab screen will be displayed with 
blank fields, scroll down boxes, and check boxes. (See illustration on page 17.) Type the Vendor 
Name in the upper block. If the vendor is known by more than one name, use the additional block 
below. Enter Gov. Agency, Date Established, Tax ID, CEC Number, and Duns Number in the 
provided spaces. 

2: Pull the drop-down Profile Type box to make your selection and fill out other fields as 
applicable. If your role is that of the OSDBU SB Advisor, you can fill in business characteristics 
such as small business and woman-owned. When you have finished entering the data, click on 
the Save button to save the information to the database. The'system will then automatically 
compute a unique vendor identification number. Three additional tabs will become active after a 
vendor has been created. 

3: Complete the Location, Capability, and Experience tabs. Save the record .• To add 
another record, repeat steps 1-3. 

To exit the vendor module, double-click on the hyphen mark in the upper left-hand corner or press 
CTRL + F4. This returns you to the main screen. 
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The five Vendor tabs are described on the following pages. Only the Rates role can use the 
Audits tab. 

Vendor Tab 
The Vendor tab is used to display all existing information pertaining to the vendor, including the 
type of business, type of ownership and other identification information. 

The Vendor fields are listed below. 

Vendor Name: This field must be completed. If the vendor is a corporation or organization, enter 
a full vendor name unless the company has a publicly known abbreviation, for example, ABC 
COMPANY. If the vendor is an individual, enter the first name, middle initial, and last name, for 
example, JOHN M. DOE or SARAH A. SMITH. If the vendor is known by more than one name, 
use the unlabeled field below the Vendor Name field to enter the altemate name. 

Gov Agency: This field names the agency that audits the vendor. 

Vendor 10: After you enter all the required information and click Save, the system automatically 
generates a unique vendor identification number. 

Profile Type: This field contains the profile type of the organization and must be completed. Pull 
the drop-down list box to select a profile type. 
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How to Select from a Drop-down List Box .. 

click !lie'left mouse button on th~ down arr~w button or on the display Window to see the list 
Sqrolt dCllWl if you need to see more;or type the first fetter. Click on yourselection. 9r. 

,,' " , 

, , ",' " ' ' , " .-
Using the keyboa,p, hald down ALT +, down arIOW ,key 10 see the list.' ,Use up and<lown arrows or 
type )hefJrst lette,pfi~'H,!prp,QeE!ded. Press)~:NTER, " 

Economic Type: This field contains the economic type of the organization (such as Federal 
Government Contractor or Private) and must be completed, Pull the drop-down list box to select 
the economic type. . 

Ownership This field contains a list of nationality and minority status and must be completed. 
Pull the drop-down list box to select the field. 

Agency: This field represents the agency that audits the vendor. Pull the drop-down list box to 
select the agency. 

Date Established: This field shows the date the 
organization was established. Using the keyboard, 
press the TAB key to move to the date field. Enter 
the date in MM/DD!YYYY format. Or, access a 
calendar as described to the right. 

Tax 10: This field contains a unique 9 digit 
alphanumeric code used for tax purposes. Enter the 
Tax ID in the 123/45/6789 format. 

CEC Number: This field contains a unique 9 digit 
alphanumeric code that identifies the organization. 

How to use the calendar: Double' 
click· on the date field or press the F4 
key. A calendar will appear, displaying 
the month, day, and year given from the 
field or the current month, day and year. 
Use the arrow buttons on the right and 
left sides to change the year and month 
accordingly. Click the left mouse button 
on the specific date to change the date. 

Duns Number: This field is for the vendor's Dun & 
Bradstreet number, if any. 

. To enter the date in the field, double 
click the left mouse button on the date 
or click the OK button. 

Elec. Commerce: This is a checkbox. Click it to indicate that the vendor uses electronic 
commerce. 

If you are logged in with the. role of OSDBU SB Advisor or Administrator, you are authorized to 
identify the following special .categories: 

OSDBU Registered: Check this box if the organization has been registered with the Office of 
Small and Disadvantaged Businesses. 

The following fields are check boxes that are subsets of the economic fype field. Check the box 
under the 'Y' column if the economic type applies to the vendor, check the box under the 'N' 
column jf it does not apply, or check the NIA box if the·option is not applicable. 

8(a) Firm: Check the "yo button if the organization is certified under the 8(a)·program. 

Small Business: Check the "Y" button if the organization is oonsidered a small business. 

Woman Owned: Check the "Y"'button if the organization is owned by a woman. 

For Profit: Check the "Y" button if the organization is a profit-making organization, 

Gray Amendment: Check the "Y" button if the organization is categorized as a Gray Amendment 
firm. 

AM Support 2.7 18 

,. 



When you have finished entering the data, click on the • Save button to save the information to 
the database. The system will then automatically compute the unique vendor identification 
number (Vendor ID). The remaining vendor tabs become active after this initial vendor tab has 
been created, except that they are restricted to authorized roles. 
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Location Tab 
The Location tab is used to display vendor location information including address, city, state and 
contact person. 

The Location screen and fields are listed below. 

First: This field is for the.first name of the vendor contact person (up to 14 characters). 

Middle: This field is for the middle name of the vendor contact person (up to 10 characters). 

Last: This field is for the last name of the vendor contact person (liP to 14 characters 

Address: Enter the primary vendor address in the upper block of the Address section. Use the 
lower block of the Address section" if the vendor has an additional address. This field must be 
completed and allows 80 alphanumeric characters. 

City: Enter the vendor city in the space provided. This field must be completed and allows 30 
alphanumeric characters. 

State: Pull the,drop-down list box to select the state. description. Using the keyboard, type the 
first letter of the state name or use the arrow keys. Click once on the down arrow to maKe a 
selection. 

Postal Code: Enter the vendor Zip code or postal code in the space provided using hyphens as 
needed. (This field allows 12 alphanumeric characters.) 

Country: Pull the drop-down list box to select a country. Using the keyboard, type the firsrletter 
of the state name or use the arrow keys. Click once on the down arrow to, make a,selection. 

ABA Number The ABA number is typed in this box. 

Account # The account number is typed in this box. 

Phone: Enter the vendor area code followed by the phone number. Use hyphens and 
parentheses as needed. This field allows 15 alphanumeric characters. 

Fax: Enter the fax number using the same format as the'phone field. (Allows 15 alphanumeric 
characters.) . 
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E-Mail: If the vendor has an electronic mail address, enter it in this field (up to 15 alphanumeric 
characters). 

Telex: If the vendor has Telex equipment, enter the telex number in the space provided. This 
field allows 15 alphanumeric characters. 

Internet: If the vendor has an Internet address, enter it in the space provided. (This field was not 
available at publication time. It will allow 15 alphanumeric characters.) 

Location ID: This field is entered by the system when a location record is updated and can not 
be edited by the user. 

How to Add a Location 

If the screen is not in Add mode, click once on the New button liDl to enter a location. Enter the 
data in the spaces provided. When you have finished entering information, you can move to 
another tab or you can save the data. (See How to Update a Vendor Record on page 16.) 

How to Update Location Data 

If you have already retrieved the vendor record, location information is displayed when you click 
on the Location tab. If not, click on the Search button and follow the instructions for finding a 
record (page 15). 

Update the data on the Location tab. (If there is more than one location, click on the one being 
changed on the list at the bottom of the tab. If tab is in View mode, double-click the Location ID 
on the list.) When you have finished entering information, you can move to another tab or you can 
save the data. (See Update Vendor on page 16.) 

Capability tab 
The Capability Tab displays a vendor's capabilities, special qualifications, and language abilities. 
If your role is Administrator or Negotiator, you can edit the capability tab. 

The Capability Screen and fieldS are listed below. 
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Discipline: This button, refers to the services,that the organization can provide. 

Language: This button refers to the language capabilities of the organization. 

SIC: This button refers to the Vendor's Standard Industrial Classification. 

Specialization: This button refers to the organization's area of expertise. 

Select Capabilities: When one of the above ,buttons is selected, ,this box displays a list of 
available capabilities from which to select. It changes depending on which button is filled. 

Existing Capabilities: This field.displays existing and any new capabilities selected. If no 
capabilities have been selected for the category represented by the button, itwill be biank. 

How to Update Capabilities 

'If you are in View mode, click on the New putton.ltII You must be in an authorized' role to edit 
this tab. 

Adding Capability: Using the mouse" click once on the applicable,check box: Discipline, 
Language, SIC, or Specialization. A related list of capabilities will be d'isplayed in tlie Select 
Capabilities list box. You can scroll through the list by usmg the scroll'bar or"by pressing the 
Page Down key. Double-click on a description to select, or tJighlight it and click on the Save 
barl""~'iiti::W.2'i!'<%*""E;;:;"'1. The ~elected.cap~bility·~iII b~ i~~nsferr~d' to the Existing .. . . 
Capabilities list box. 

Deleting Capability: Highlight the description in the Existing Capabilities 'list box that you 
want to delete. Then click on the Trash Can icon. 

When you have finished entering information, you can move to another tab or you can save the 
data. (See Update Vendor on page 16.) 

Experience tab 
The. Experience tab is used to ,record ,project experience in. various countries. A narrative 
summary of each project is available. 

The projects are listed in a grid at the bottom of the tab. Click· on a record in' the grid am;! details of 
that record will be displayed on the upper portion of the tab. 

The Experience tab and fields are listed below. 
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Project Start Date:' This field represents the date the 
project was started. Enter using the MM/DDNYYY 
format, or use the calendar feature described at right. 

Project End'Date: This field represents the date the 
project was completed. Enter using the MMIDDNYYY 
format, or use the calendar feature. 

Contracting Org: This field represents the organization 
requesting the project. 

Contract Value: This field is for the value of the 
contract. 

Contract Number: This field is for the number of this 
contract. 

Country: Pull the drop-down list box and click once to 
select the country. Using the keyboard, key in the first 
character of the country name, or use the arrow keys to 
highlight the name and click once to make your selection . 
This field must be completed. 

Project Description: This field is for a brief summary of 
the project It is limited to 500 characters 

Experience Record: This field is generated by the 
system and'displays the project experience record 
number when a record is updated. 

How to Add an Experience Record 

How to use the calendar: 
Double click on the date field or,press 

F4 key .. A calendar will appear, 
I di,spi;,yillg the month, day, and year 

from the field or the current 
month, day and year. Use the arrow 
buttons on the right and left sides to 
I chan,Ie the year and month 

Click the·left mouse 
button on the specific date to change 

date. To enter the date in the field, 
I Qe)UD"" click the left mouse button on 

date or click the OK button. 

Click once on the liDt New File button if the screen is not in Add mode. Enter the information'in 
the spaces provided. Type a brief summary that describes the project in the scroll-down Project 

Description text box. Click once on the III Save button when you are finished. 

How to Update Project Experience 
First double click on the item that you want to update on the bottom of the form. Make changes or 
additions to the infomation as needed. When you are finished entering the data, click once on 
the Save button to update the record. To exit the record, press CTRL + F4. This returns you to the 
main screen. 
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Audits tab 
The Audits tab records Rates information for a particular vendor. Your role must be Rates or 
Administrator to use the Audits tab. 

The fields are: 

Location The location is selected using the drop-down Iist'box. After data for this' location is 
entered'and saved, another location can be added by clicking on the new bullon. 

Date Entered The current date is inserted by the application when the data is entered. 

Type Type refers to rate type, such as Final or Negotiated. It can be selected from the drop
down list 

Effective Dates The From and To dates can be typed in or selected using a calendar (tJescribed 
on page 23.) 

Rate for Select from the drop-down list: Fringe Benefits, G&A, Overhead or other. 

Value Enter the dollar amount of this rate. 

Notes This is a text box for entering any notes. If text exceeds the display area, the scroll bars 
can be used to reveal additional text. 

There is also a table that is built as the date is saved. 

How to Add an ·Audits Record 

1. Click on the New bullon. I1l 
2. Select the location by clicking on. the arrow and selecting from drop-down list box. 

3. Fill. in. the dates by either typing in month/day/year or by utilizing,the calendar feature (F4). 

4. Filii in the type· by clicking on the arrow and selecting. from drop-down list box. 
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5. Filii in rate by clicking on the arrow and selecting from drop-down list box. If not listed, type it 
In. 

6. Type in the value. 

7. Fill in the notes field, if applicable. There is a scroll bar on the right for revealing additional text. 

8. Save the record. lliill 

How to Update an Audits Record 

1. Select the record that you want to change by double-clicking on it in the grid at the bottom of 
the tab. 

2. Change fields that need to be updated. 

3. Save the record. !IiJI 
To close the form, press CTRL + F4. 
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Shipping Location '. 

The form is used to update Shipping Location records in the database. It is 
accessed by pressing the Ship Location button on the main screen . 

. Current locations are listed in a table on the bottom of the form. Use the scroll 
bars to reveal more. 

Click on the record that you want to update. The following fields will be filled in 
except for ones that are blank. 

Addressee, Address, City, State, Postal Code, Country, Phone Number, Point of Contact, 
Office, Room. 

If your role is Administrator or Negotiator, the mode box at the top of the screen will display the 
word EDIT. You can change the fields that are displayed in white. 

To add a new location, click on the new button. IDI A blank record will be displayed. Type in the 
Address fields, except for State and Country, which you select from drop-down lists. Type in the 
Phone Number, Point of Contact, Office, and Room. These fields will roll to allow more data if 
needed. 

Save the record by pressing the Save button.llliIl To close the form, press ~TRL +F4. 
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How to Logon to the Application 
I!mEl 
~ 

, , 

Double-click on the USAID icon 'lli'ji\'9 in your Windows Program Manager to access the New 
Management Systems (NMS) applications, If you are not sure where to find this· icon, cOAtact your 
supervisor or System Administrator. The following logon screen will appear: 

Enter your user ID and password and click on the Logon button to continue (or click on the Cancel 
button to exit), The buttons for applications to which you have access will be highlighted in bold type. 
Other buttons available to you on this screen include: 
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Click on this button to enter a new password, which must be at least 
eight characters long. (This button is displayed after you logon.) 

Click on this button to set various preferences, including how often to 
delete temporary files and which applications to load automatically. 
(This button is displayed after you logon.) 

Click on this button to return to the previous screen. 

Click on this button to completely exit the NMS logon procedure. 
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After selecting the appropriate applic<ltion button (A&A) at the top of the screen, a screen will appear 
with buttons representing the modules available in the application you selected. The following' screen 
illustrates the modules in the Acquisition and Assistance application: 

Click on the button 13· for the module you wish to access, or, click on the Go to Main button to 
return to the previous logon screen. 

Possible Causes of'a Logon Failure 
The table below lists possible causes for a logon failnre: 

Cause ~ Remedy. 
Improper ID or Password. Type correct ID and password and 

try again. 
For new users, database account·has Contact DBA * and request an 
not been set up. Oracle account 
After an error occurs, the system will Exit and re-enter Windows and trY 
not logon. again. If the problem persists, 

reboot and try again. 
The database is down. Contact DBA and report logon 

failnre. 

* DBA - Database Administrator 
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Shortcut Keys 

Ctrl+E 

Ctrl + F4 

Ctrl + Q 
Ctrl + S 

Ctrl +X 

Ctrl + C 

Ctrl + V 

Fl 

F4 

FlO 

Menus 

File Menu 

New: 
!:;Iose: 
s.ave: 

.!!elete: 
Print s.etup: 
£rint: 
Exit: 

Edit Menu 

!:;ut: 
CQPY: 
£aste: 

Seaoeh (for a vendor name) 

Closes the active window 

Accesses the Query application 

Saves a record 

Cuts text and puts it on the clipboard 

Copies text & puts it on the clipboard 

Pastes text and puts it on clipboard 

Accesses the Help System 

Accesses the Calendar in a date field 

Accesses the menu bar 

Creates a new record. 
Closes the application and returns to the main screen. 
Saves the active record. To quickly save a record, click the Save button on the 
toolbar. 
Removes the currently selected record from the database . 
Formats the printer to print a form. 
.This option is not available at this time. 
Exits the A&A Support application. 

Cuts a text selection and places it on the clipboard. 
Copies a text selection and places it on the clipboard. 
Pastes a text selection and places it on the clipboard. 

Database Menu 

!:;hange Password: 
Change Role: 
Next Record: 
£revious Record: 
Query: 
S.earch: 
Reports ... : 

A&A Support 2.7 

This is not available. 
Returns to the Select Role box. Available from main screen only. 
This option is not available. 
This option is not available. 
Access the AID Query application. 
Find a vendor record. 
Accesses the report screen. Available from Vendor module. 
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Options Menu 

Ioolbar: 
Panel Help: 

Attach Note: 

Windows Menu 

Cascade: 
Tile Vertical: 
Tile Horizontal: 
Arrange Icons: 
1: (Screen name) 

Help Menu 

~ontents: 

Help on Help: 
About: 

A&A Support 2.7 

Click on this option to display or remove the toolbar from the screen. 
Click on this option to remove or add the information panel from the lower right 
portion of the screen. 
This attaches a note to a screen. Not available in this application. 

Not available in this application. 
Not available in this application. 
Not available in this application. 
Not available in this application. 
Identifies windows that are·already open. To move quickly to another screen, click 
on its title using the mouse, OR, key in the number next to its title. 

Displays the contents of the A&A Support Help System. 
Displays the Windows Help System. 
Displays A&A Support version information. 

• 
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Vendor Query 

Vendor Query can locate vendor records using criteria related to the vendor's location or capabilities. To 

access the Vendor Query, click on the Imr"49.!f~~~1 button from the Vendor Quick Find screen. (If you are 

not on that screen, click on the m Search button on the A&A Support toolbar, and then click on Vendor 
Query.) 
There are four tabs in the Vendor Query: Vendor Query, Location Query, Capability Query, and Experience 
Query. (The tab screens correspond to the first four Vendor screens). Click on a tab name to move back and 
forth between the tabs. You can query using one tab or using a combination of tabs. 
Each of the Vendor Query tabs has buttons for selecting full, partial, or exact text search. 

Full Text Search displays all the vendor names containing the letters you typed. 
You type: man . 
You get:: Automation Information Management, Bregman and Company, 

Management Development International, Inc. 
Partial Text Search displays all the vendor names that begin with your search characters. 

You type: man 
You get:: Management Development International, Inc., Man Tech, Inc. 

Exact Text Search displays the vendor name that exactly matches your search characters. 
yfl11.tlpg: Management Development International, Inc., 
you get: Management Development International, Inc., 

An additional feature used in the Query tab screens is the AND and OR connectors. The AND connector is the 
default and is used to find all criteria entered. The OR connector is used to find at least one or more conditions. 
After entering the criteria for your search, click on the Query button or press ALT+ Q. The application will 
display a picklist of records that meet your criteria. 

The picklist is a list of records which meet the criteria that you entered. To select a record from the list, double 
click on it, or highlight it using the arrows and then press ENTER. 

To generate a vendor report, press the Report button. (See page A-9.) 

To exit Vendor Query without searching for a vendor, click on the Close button. 

A&A Support 2.7 A-S 



Initial Vendor Query tab 

Enter the known vendor information in the spaces provided. appropriate bnttons'iind'click on the 
Query button to retrieve records from the database. The fields on this tab are optional. 

Vendor Name: This field is for all or part of the Vendor name. The application will search for the name or 
letters typed. Up to 80 alphanumeric characters can be entered. 
Profile Type: This field is for the profile type of the organization, if known. Pull the drop-down list box to 
select a profile type. 
Economic Type: Pull the drop-down list box to select the economic type (such as Federal Govermnent 
Contractor or Private). 

Click on any buttons that apply to your search: 
Sea) firm, Small Business, Woman Owned, For Profit, Gray Amendment. 
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Location Query Tab 

The Location Query tab uses the same search methods as the Vendor tab. Enter the known vendor information 
in the spaces provided. Select text search method as described on page A-5. Click on Query button to retrieve 
the records in the database. 

The Location Query fields are listed below. 

Address: This field allows 80 alphanumeric characters for the vendor address, if known. 
City: This field allows 30 alphanumeric characters for the vendor city. 
State: Pull the drop-down list box to select the state. Using the keyboard, type the first letter of the state name 
or use the arrow keys. Click once on the down arrow to make a selection. 
Postal Code: This field allows 12 alphanumeric characters for the vendor Zip code, if known. 
Country: Pull the drop-down list box to select a country. Using the keyboard, type the lJrst letter of the name 
or use the arrow keys. Click once on the down arrow to make a selection. 

Capability Query Tab 

The Capability Query tab uses the same search methods as the Vendor tab. Enter the known vendor 
information in the spaces provided. Select text search method as described on page A-5. Click on the Query 
button to retrieve the records in the database. 
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The Capability Query fields are listed below. 

Discipline Code: Select an applicable service from the drop-down list box. 
Language Code: Select a language capability from the drop-down list box. 
SIC Code: Select a Staodard Industrial Classification from the drop-down list box. 
Specialization Code: Select the area of organization expertise from the drop-down list box. 

Experience Query Tab 

The Experience Query tab uses the same search methods as the Vendor tab. Enter the known vendor 
information in the spaces provided. Select text search method as described on page A-5. Click on the Query 
button to retrieve the records in the database. 

The Project Experience Query screen and fields are listed below. 
Contracting Org: This field allows 25 alphanumeric characters. 
Contract Value: This field is for the value of the conttac!. 
Country: Pull the drop-down list box to select a country in which the vendor has project experience. Using 
the keyboard, type the first letter of the country name or use the arrow keys. Click once on the down arrow to 
make a selection. 
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• Reports 
Vendor Reports can be printed or viewed by pressing the Report button 1~lfrom the Vendor Find or Vendor 
Query screen. A box will be displayed for selecting the report fonnat. You can view or print a list ofthe 
vendors on the picklist. 

If you select view, the report will be displayed on the screen . 
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Buttons on the bottom of the screen will allow you to scroll, cancel, zoom, print, export', mail', or close. 

, Export and mail functions not available in this release. 
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Oracle -Server Messages 

Message 
Code 

ORA-OOOOI 

ORA-OOOS4 

ORA-00942 

ORA-OIOOO 

ORA-OI017 

ORA-OI031 

A&A Support 2.7 

Description 

Unique constraint violated 

Cause: A record exists in the database with the same primary key as the record you are 
attempting to add. The current record cannot be saved. 

What to do: Contact your system administrator for assistance. 

Record locked for update 

Cause: Record is being edited by another user. 

What to do: Try to access record later. 

Table or view does not exist 

Cause: You do not have a valid A&A role. 
Or 
The data table/view (file) that the application is trying to access either does not exist 
or is not available to you. 

What to do: Application will tenoinate automatically. Contact your system administrator 
for assistance. 

Maximum cursors exceeded 

Cause: A fatal error has occurred in the current routine. The current data may not have been 
saved. 

What to do: Application will tenoinate automatically. Contact your system admiriistrator 
for assistance. 

'Invalid usernamelpassword 

Cause: You have entered an invalid user ID andlor password or an Oracle account has noi 
been created for you. 

What to do: Retry with correct usemame and password. If this error persists contact your 
system administrator for assistance. . 

Insufficient privileges 

Cause: You have insufficient privileges to perform this database task. The current data may 
not have beeu saved. 

What to do: Contact your system administrator for assistance. 

A-JO 
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ORA-01924 

ORA-02291 

ORA-03121 

ORA-06107 

ORA-06122 

ORA-03059 

A&A Support 2.7 

Role not granted or doesn't exist 

Cause: Your default Oracle role is missing or invalid. 

What to do: Contact your system administrator for assistance. 

Parent key not found 

Cause: A 'Parent' record is required to save the current record. The Parent record could not 
be found. The current record cannot be saved. 
What to do: Contact your system administrator for assistance. Database is corrupted. 

No interface driver connected 

Cause: A SQL 'Net TCPIIP error has occurred. Either the SQL 'Net" directory is not in 
your PATH= statement in·AUTOEXEC.BAT" or there is a problem with the ORACLE.INI 
file. II 

What to do: Application will terminate automatically. Contact your system administrator 
for assistance. 

Oracle network server not found 

Cause: A SQL*NetTCPIIP error has occurred. The SERVICES file is invalid, could not be 
found or is not specified in the ORACLE.INI file. 

What to do: Application will terminate automatically. Contact your system administrator 
for assistance. • 

Setup failure 

Cause: A SQL *Net TCPIIP error has occurred. The ORACLE.IN! file is invalid or could 
not be found. 

What to do: Application will terminate automatically. Contact your system administrator 
for assistance. 

ODBC user canceled 

Cause: An ODBC error has occurred. Either the ODBC.INI file could not be found, the 
proper data source is not specified, or the correct driver is not specified. 

What to do: Application will terminate automatically. Contact your system administrator 
for assistance. 
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Incident Reporting 
Although comprehensive testing has eliminated as many errors as could be found and fixed, there is a need to report any new 
errors in a way that is meaningful to the software developers so that the errors can'be corrected. The forms on the following 
pages should be used to report these errors. Copies of these forms should be made and kept on file for future use. The figures 
below indicate where to find the information needed to fill out the form along with a definition of the terms used on the form. It 
is important that the user.and System Administrator collaborate in the response. The System Administrator may be able to 
resolve some of the errors before the reports are sent on to the Help Desk. Include as much detail as you can concerning the 
error. Remember the. individuals who will evaluate and fix the error may be a continent away. 

The figure below is a typical screen used in another Acquisition & Assistance application. The information needed to fill out the 
report will be found in the same general area throughout the other modules. 

!!I~~-:-:~-iApplica.?on . .' 

Name 

The figure below is a sample of the "Splash screen" that displays information on the version and date. To review this 

FigureB. 

A&A Support 2.7 

information at other times, click on Help, then click on About when 
the drop-down menu is presented. 
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Definitions, Incident Report Form 

Incident Number: This number will be assigned by your System Administrator when the Report is logged in. The number 
should include information that will make it unique so that it will not conflict with Incident Reports sent in by other 
sites. This log slmnld be scrupulously maintained and inquiries made if a timely response is not received. 

IP Address: The IP address is the Internet Protocol address. It is used to uniquely identifY a host computer on a TCP/lP 
network. It is set up by the System Administrator of the host computer. 

Host Name: The host name is a synonym for the IP address. It is used to uniquely identifY a host computer on a TCPIIP 
network. It is set up by the System Administrator of the host computer. 

Name: The name of the user initiatiog the Incident Report. 

Organization: Enter the organization code that will help to uniquely identifY your installation. 

Location: Enter the location that will help to uniquely identifY your installation. 

System Administrator: The name of the System Administrator. It is suggested that the System Administrator maintain a file of 
copies of the reports for future reference. 

Version: The date and version number appearing on the Splash screen. See Figure B for an example. 

Screen Name: Enter the Screen name. See Figure A for an example. 

TablForm Name: Enter the name of the Tab or Form. See Figure A for an example. 

Field Name: Enter the label or name of the field where the error occurred. See Figure A for an example. 

Mode: Enter the Mode the application was in when the error occurred, such as ADD, EDIT or VIEW. See Figure A for an 
example. 

Role: Enter the Rate that you were using when the error occurred, such as Requestor, Manager, COTR, etc ... See Figure A for 
an example. 

Description of Problem: Enter as much infonnation about the sequence of events leading up to the problem as you can. The 
frequency that the problem occurs, intermittently or every time, is important and should be noted. 

p 

Actual Error Messages: In'some cases the application will trap and display error messages generated by Oracle, the Database 
Management System. There is a list of these messages and their codes on page A-IO. There may be some messages that 
are not in the appendix that are generated by the application or by Windows itself. These messages are important to the 
developers and should be noted. 

All of the entries may not be pertinent but they should be filled in. Use N/A when appropriate. 
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NMS Incident Report Form 

Incident Number: _______ _ IP Address: _________ _ 

Date ofIncident: ________ _ HostName: _________ ___ 

Name: ___________ _ Organization: _________ _ 

Version: ___________ _ Location: ___________ _ 

Application: _________ _ Screen Name: _________ _ 

Mode: __________ _ Tab Name: _________ _ 

Role: ___________ _ Field Name: ________ ~--

Description ofProblem:. ______________________________ _ 

Actual Error Message: ______________________________ _ 

Suggestions: __________________________________ _ 

System Administrator: ______________ _ 

A&A Support 2.7 A-14 



Incident Date 
Number Reported 
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Date 
Resolved 

NMS System Administrators 
Incident Log 

Brief Description of Problem _ 
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Overview of the A&A Small Purchases Applicat!pn 

This USAID-wide application is a client/server system and is a module of the Acquisition and Assistance 
(A&A) suite of applications. The other modules of A&A are Planning, Award Formation, Award 
Administration, and Acquisition Support. 

The A&A SmalLPurchases application provides automated solutions for the processes of making small 
purchases, from formulation of the request through the actual purchase. It features report-generating and 
electronic commerce capabilities. 

Opening the A&A Small Purchases Application 

You must be authorized to logon to the NMS applications in order to use the A&A Small Purchases 
application. For causes oflogon failure, see the appendix, page xi. 

;. 

When you first click on the button to enter Small Purchases, either the Role Box or the main screen will be 
displayed. 

Role Box 
This is a drop-down list box that displays 
the Roles' that you can perform. It is 
displayed when you enter the application 
if your User ID associates you with more 
than one Role. Later it can be displayed by selecting the Change Role button. 

The Select Role box allows you to select the Role for the duties you will be performing during 
this session. If you have been assigned only one Role in this application"this box will not be displayed. 
If the Role shown is correct, click on the OK button. Otherwise, click the left mouse button on the arrow 
button to display the drop-down list box. Click on the Role that you will be performing. Click on OK. 
(With the keyboard use the arrow keys to make a selection. Press ENlER.) 

Note: your Role will be displayed in a status panel at the bottom of the screen in this format: 
"JohnD:Contracting Officer." 

• Roles are brief position titles, such as Requestor, Contracting Officer, Manager,.Negotiator, Clerk. Roles 
are assigned in the A&A Support application. 

A&A Small Purchases Application Security 
The data in the A&A Small Purchases Application'is protected by Oracle and the application. Access to 
the database is protected by the server and by user accounts on the database. A user first has to logon to 
the server with a valid account and password, and then logon to the NMS program group with an Oracle 
User ID and password. 

Access to data also is restricted by Role. Most Roles have the ability to view data in the application, but· 
modification rights vary according to task. 
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The Small Purchases Main Screen 

When a user first enters the application, the main menu is conveniently displayed on the screen. The 
toolbar usually app.ears on the screen also, although the user can remove the toolbar if desired by de
selecting the Toolbar item on the Options Menu. 

If an item has been staffed to you, an Alert Notification list appears on the screen. Otherwise, the 
Assignments screen appears, or, if there are no pending requests, a message states ''No Pending Requests 
Found." 

If the Alert - Notification list is displayed, note the Request ID I)umbers of items so that you can open them 
and respond to the Alert. (To open an item, use the File menu or the Open fIle button and ~ 
open the Assignment screen.) 

Wb,en the Assignments screen is displayed, highlight a request to view or to work on. Then, select a group 
of forms to work on: Request, RFQ, or Award. 

, ' How to Select 
To ,selecian item, «lick 011 itusing the left mouse button. If you pI~ferto use the 
!'eyboardshortcut, ~,ALT + the letter that is ~derlined in the title of the item, 

Each button will display its related form, if available. Tbe three buttons are associated with several forms 
designed to look like fIle folders. These forms are called tabs. 

Certain tabs and fields can only be fiiled in by users performing certain Roles. Your Role will be displayed 
in a status bar at the bottom of the screen. A field with a blue background cannot be edited by your Role at 
this time. 

Status Bar 
There are three status boxes at the bottom of the screen. The left box tells you the status of the connection 
to the server. The center box tells who is logged on and in wbat Role. The right box shows the status of 
the application and all processing. 

How to Use Help 
On-line Help is available for the application in general and for specific fields. To see the listing of main help 
topics, press the ALT key plus H, then C. 

Help topics can include graphics and text that link to other Help topics or to more information about the 
current topic. The Help text is highlighted in green and underlined. 'Help text contained in a Graphic is 
invisible. When the pointer is directed to the text, it changes to a hand icon. 11- Then you can click the left 
mouse button for additional information. 0 

To choose a topic using the keyboard, press TAB until the topic is highlighted, and then press ENTER. 
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FI <HELP) 

For immediate Help on a specific field, place the cursor on the field arid press the FI key. The defmition of 
the field appears on the screen,.unless the field'is non-editable (on a blue background). For non-editable 
fields, you will see an overview of.the application, which can guide you to your topic. 

FINDING A SPECIFIC HELP TOPIC 

At the top of the Help Contents page and on every main Help topic is a Search button .. I$·e.i!fc]l~hress 
this button to search alphabetically for·a specific topic. 

BROWSING MAIN HELP TOPICS 

At the top of the Help Contents page and on every main Help topic are Browse buttons. 

l'ili-;~&tl1~3'~ '1 ~xE =>.""\(i; Use them to move forward or,backward through the major Help topics. 

Toolbar 
The Toolbar contains a group of buttons that display icons, or symbols, representing. commands. They can 
be accessed quickly with a mouse. Here is a list of the icons and the box on the Toolbarmenu. 

!fIT _1!k!J_ New file button 

~ Open file button 

1!1iI1 Save button 

If$) Cut button 

I .. Copy button I. Paste button 

Mode Box 

II@iI Note button 

1M Alert button 

~ m Query button 

.~ Search button 

I~I Report button 

I@I Help button 

When a button is outlined in black, the button is active for the form that you are using. If the outline is 
dimmed, the button is not available at this time. 
For defmitions of the buttons, see Appendix, page viii. 
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Menus 
Pull-down menus are located on the menu bar, the second line in the Small Purchases window . 

.Eile Edit Database Options Window Help 

A menu can be activated by clicking on a menu title with the mouse or by pressing the ALT key plus the 
underlined letter in the menu name. (Note: If there is a hot key on the same screen with the same 
underlined letter, use the mouse to open the menu.) Select a menu option from the drop down menus by 
either clicking on the name of a command or by moving to that command using the up and down arrow 
keys, then pressing the ENTER key. 

-- Clicking on the word File brings up the following menu. 

New -
Open ~ 

.!;.Iose Active Form 
J;!ave Ctrl+S 
D!l.lete 

Print Setup ... 
Erint 

~it 

For more information on the menus, see Appendix, page ix.) 

Note: When a Menu Item appears in gray lettering, the topic is not active for the form that you 
are using. Items displayed in black are active for the form that you are using. 

Tabs 

Many of the forms used in Small Purchases are called, tabs. A tab has a label projecting from the top and is 
associated with other tabs. 

Each tab has fields that are filled in either by a user or by the application. Certain tabs and fields can only 
be filled in by persons carrying out certain roles. 

To close.a tab, press CTRL+ F4. Alternately, double click on the control box 
at the upper left corner of the form (same line as the title bar) . 

The A&A Small Purchase application features the following tabs which are 
part of three main forms. 

REQUEST FORM RFOFORM 
Request IuitialRFQ 
Items RFQItems 
Funding Approval RFQ Response 

Summary 
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AWARD FORM 
Select Veudor 
Award Items 
Other 
Approval 
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Small Purchases: How to Begin 

Getting Started: Requestor 

The requestor can create a request or modify a request that has not been approved. (See below and pages 
8- I 8). He can view the RFQ or the award. 

Getting Started: Manager 

The Manager approves the funding for the request. He reviews the Request including the Accounts (from 
Line Items tab) and fills out the Funding Approval tab, then selects a contracting officer. The tabs are 
explained below - see pages 8-18. 

Getting Started: Contracting Officer 

The Contracting Officer reviews the approved Request and selects the Negotiator (page 8). The 
Contracting Officer can conduct the RFQ, obligate funds and make the Award. See pages 19-21 and 23-
30. 

Getting Started: Negotiator 

The Negotiator wiII review the Request. Either the Contracting Officer or the Negotiator can conduct the 
RFQ and add an Award record. See pages 19-21 and 23-30. 

Creating a New Request 
!!t5I To initiate a purchase for which no request has been created, the Requestor selects File/New 

Request from the menu or uses the New File button on the toolbar. 

The New Request form is displayed with New Request as the active option. Click on the drop-down list 
box to see a list of activities, or press ALT+.j, (down arrow key). Select an activity from the list which 
categorizes the request. 

The application will display a blank fonn for creating a request. The fonn is described below (see page 8). 

The requestor fills out the Request tab and Items tab and then saves the record. To save, click ltliill 
the Save button or press CTRL+ F, S. 
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Request form 

Request tab 
The Request tab provides a basic description of the request. Furtheupecifications will be listed on the 
Items tab. 

The application fills in the following information. (Note: Blue fields are not editable.) 
.Activity ID, Request JD, Requestor, Requesting Office, Date Requested 

The requestor fills in the following fields: 

Request Title A brief title for the request is entered by'clicking on the' text field and then typing the title. 

Description The text box provides space for a brief description of the Request. Up to 52 characters, can be 
entered in this box. 

Date Needed Month, day and year the Request iS,needed in eight-digit 
format (MMDDYYYY). Insert two digits for month, two digits for day, four 
digits for year. Slashes are inserted automatically. (To insert a date using 
the calendar: double click on the date field or press the F4 key. A calendar 
will appear. Go to the date desired and click on OK.) 

Prod net or Service Checkboxes The Requestor indicates here whether the 
,request is for a product or a service. Clicking on the button with the mouse 
wilLfill it (or remove the mark if already fil!ed). To check the button using 

the keyboard, press,the TAB' key to reach the button. Then'press the space bar to insert the mark (or to 
remove the mark if already filled). 

Urgent This is a checkbox which the Requestor marks if the Requisition is urgent ,Clicking on it with the 
mouse will fill it (or remove the X if already filled). 

Source/Origin This optional field is for the Source/Origin. 

Funding Type The Funding Type is selected using the Code Lookup box (see page 9). 
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Justification The Justification text box should explain why the Request is needed and how Urgent it is. 
Up to 1000 characters can be entered in this box. 

Suggested Vendor If a particular vendor is reconunended as a source for the Request, it should be 
identified in this text box. Up to 1000 characters can be entered to fully identifY the vendor. 

Staffing button. Staffing opens a form for directing information to the attention of others. You need to fill 
in the fields Organization and Employee. For detailed instructions on How to do Staffing, see the appendix 
page iv. 

At the bottom of the tab are fields pertaining to approval: 
Date Approved (fiUed in when the request is approved by the manager) 
By (also fiUed in when the request is approved) 
Reviewing CO (named by manager) 
Negotiator (named by contracting officer) 

Note to Reviewing CO: You will review the request after the manager approves it and selects your name 
Select the Negotiator using the Code Lookup box. 

How to Use the Code.Lookup Box 
with the code lookup feature are displayed with titles in blue letters or (in the case of column 

I h~,adiing:s) in bold type. You can reach code lookup by double-clicking with the mouse. . 

Code Lookup offers two fields for finding the correct code: Code and Description. 

To search for a Code, enter the first letter or two letters in the Code field and press the Find button. 

To search for a description, either enter the first letters and use the First Letter Search option, or enter a key 
in the description field and de-select First Letter Search. Press the Find button to bring up a list 

containing the text you entered. . 

I Highliglltthe correct code and description and press the Select button (ALT+ S). If the list is long, use the 
scroll bar to reveal more items. 
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Items tab 

The Items tab provides an order fOl1Il for detailing the request. The application adds up the totals for each 
item and presents a grand total for the entire Request on the final line. 

If not all items are displayed at once, use scroll bars or arrows to see additional data. Rows are added by 
pressing the down arrow key. 

Goods or services for this Request are described in the following columns: 

Item Description This is a narrative description of the goods andlor services. It is a 250 character 
alpha/numeric field. 

Product Code Double click on this cell to bring up a Code Lookup box from 
which to select the Product Code. 

Object Class Code (Ocq The Object Class Code assigns the item to a budget 

Ifuwto Use C-ode Lookup 
is.onpage9. 

category from the OMB Budget Object Class Code Lisruig as supplemented by USAID. To edit this field, 
the user double-clicks to bring up a Code Lookup box from which to select the OCC. 

Quantity This is a six-digit numeric field showing the quantity requested for that line item. The quantity 
refers to the number of units as defined in the Unit column. 

Unit The unit of measure indicates how quantities of the given product or service will be measured. 
Double click on this cell to bring up a Code Lookup box from which to select the Unit. The list confol1Ils 
to standards for electronic commerce. Metric terms are encouraged per USAlD Notice A-AAIF A 
10/01191. 

Price This is a six-digit numeric field that shows the price or cost per unit of a line item. It should be 
estimated at a level that allows for reasonable increases, for the price entered at this stage becomes the 
basis for the obligated amount 

Item Total The application calculates this field by multiplying the Price and the Quantity. This field 
cannot be edited by the user. If the field is incorrect, correct the Price or the Quantity. 

You can change the size of the column to show all the characters 'by placing the cursor on the right border 
of the column header, holding the left mouse button down, and dragging the mouse to the size you want. 
Similarly, a row can be increased to a two or more lines by using the mouse to drag down the lower border 
of the row in the far left header column. 

New rows are added as you complete a row, or if you press the down arrow button. A row can be deleted 
using the Delete key. The bottom row is in yellow and displays the grand total. 

Clone mode can be turned au to copy an entire line. Also, a cell or a group of cells can be copied using _ 
the the Cut, Copy and Paste tools. ,., 
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To enter or view the Statement of Work, click the SOW button. There are also buttons for accessing the 
Delivery Schedule and for assigning items to Accouuts. Those forms will relate to the line item that is 
highlighted in the grid. Shipping Informatiou can be entered by pressing the Shipping button. Complete 
the Delivery Schedule before using the Shipping fonn. 

Statement of Work 
The sow is an overall description of the pr,ocurement. A word processor becomes available for entering 
and editing the Statement of Work. Existing text can be brought in from other applicationsusing the 
clipboard. 

The Word Processor Menu Bar 

File Edit View layout Tools Font Window Help 

This Word Processor offers many features for editing and printing docmnents including: 

Print 
I. Choose Print from the File Menu. 
2. Select your print options in the Print dialog box. 
3. Choose Print. 

Save 
1. Choose Save from the File Menu. 

Search 
I. Place the cursor where you want the search to begin. 
2. Choose Search from the Edit Menu. 
3. Type the text you want to find. 
4. Select Forward or Backward. • 
5. Choose Search to begin the search. 
6. If you wantto find another occurrence oftlie same search text, choose Search Next from the Edit 

Menu. 

Word Processor Toolbar 

See also: Text Editing Features and WP Menn Bar in the appendix page ii. 
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Delivery Schedule 
The Delivery Schedule form provides a delivery, schedule for each line item, To access the Delivery 
Schedule form, click the Delivery butt9n,on the items tab. "" " 

The Delivery Schedule can be created in two ways. You can enter the quantity and delivery date directly 
in the Delivery Schedule grid, or you can select one of the options under Requirements. 

Above these options are the following fields, which are filled in by the application: 
Line Item Description" Date Award'Needed, Total Quantity Needed, Unit of Measure. 

You can enter a Delivery Schedule for each line item. Line Item Number displays the number of the 
current line item. Click on the arrow,to display a different line item. 

Delivery Schedule Grid 

The Delivery Schedule Grid breaks down each delivery of 
the line item into a.quantity and date. (You may save time'by 
filling out the Requirements box first. The second and third 
options under Requirements will create a grid for you, which you can edit.) 

Columns on the grid are: 

Quantity This is a six-digit numeric field. Enter the amount of goods and or/services to be delivered for 
each delivery date. 

Planned Delivery'Date This is the expected delivery date of the goods and/or services. It must be entered 
in the following format MMDDYYYY. You can key in the date, or double-click on the field to display the 
calendar. 

Note: If you edit the Delivery Schedule Grid, use the Save button, not the 
Reschedule button. 

Requirements Section 

The Requirements ,Section provides three methods for arranging delivery schedules. 
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As Required This option is used to indicate that delivery of the good/service varies depending on when 
the line items are needed. This option is the default option. 

Quautity Per Day/Month This option is used to indicate that the delivery schedule consists of a set 
quantity to be d~vered at a specific time intervaL 

Enter the Quantity (6-digit numeric) field. The size of this field is dependent on the Total 
Quantity field of the Line Items tab. 

Enter the number of Days or Months for the interval in !lie 3-digit numeric field to the right of 
Every. Use the drop-down list box to select either Days or Months. , i 

:anter the number of days that will pass between the Award Date and the first delivery. . ~ 

After Award This option is used to indicate that the entire quantity of the line item is to be delivered a 
specific number of days or months after the Award is made. Enter the number of days or months in the 
frrst field. It is a 3-digit numeric field. Use the drop-down list box to select either Days or Months. 

Reschedule Button 
This button resets the delivery scbedule grid to match the option selected in the Requirements section. It is 
disabled for the As Required option. Do not use Reschedule if you have typed data in the Delivery 
Schedule Grid. (Use the Save button.) 
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Shipping form 

The Shipping Form is accessed by selecting the Shipping button from·the Items tab. The Shipping form is 
used to identify actions and locations involved in the shipment, consigmnent, or billing ofIine items having 
a delivery schedule. It is required on all USAID-initiated commodity purchases for delivery in order to 
expedite arrival accounting and, in the case of overseas deliveries, customs clearance. Before line items 
can be made available for shipping actions, they must have a Delivery Schedule established. 
The blank fields in the Shipping form are filled in by the. application after Deliverables are selected. The 
top of the form is synchronized with the bottom portion of the screen so that as you move up and down the 
spreadsheet, the fields at the top display information related to the specific shipping item. Each line in the 
spreadsheet at the bottom of the Shipping form indicates a unique shipment 

Buttons are used to build the Shipping form. If it is in Edit mode, you are authoiized to fill out the form. 
(Note: If you cannot access the form because there are no delivery items found, fill out the Delivery 
Schedule.) 

Itm"l~bl.#iI!Wl'iilb"!io&;"'UfAddre~:*1 

How to Do Shipping 

I. Click on 11:lp~~i~ button or press ALT+ D. 

2. Select the Deliverables and click on the ImIOK~1 button. (For illustration of De live rabIes form, see· 
page 15.) You can select a Delivery Item more than once if Bill To and Ship To, etc., will be directed to 
different addresses. 
3. ,On the spreadsheet at the bottom of the Shipping form, place the cursor on one of the items. If the 
location will be the same for several items, highlight them at the same time (pressing CTRL key as 

described on.page 15). Click on u&r(!o"'c~\j\lf;@ button. 
4. Select the Location and click on the OK button. (For illustration of Location form, see page IS.) e 
5. Highlight the items and click onllfiiif'res£;T;2il'e, button. 
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6. Select the Address Type and click on the OK button. (For illustration of Address Type form, see page 
16.) 
7. Complete the fields in the top portion of the Shipping form for each item on the spreadsheet. Some will 
be filled according to Locations data. If they are on a white background, they can be edited: 

Office and Contact: Type in additional information, if needed, to identify the office or contact person. 
Ship Via Select the shipping method using a drop-down list box. 
Room and Phone Type in any additional information. 
Accept Partial Delivery Fill in the checkbox to indicate that partial delivery can be accepted. 
Shipping Instructions This is a text box for entering any special instructions regarding shipping. To 
reveal additional text, use the scroll bar or press the Page Down key. 

8. Save the Shipping form by clicking on the Save button Ilui and close the form. 

Select Deliverables form 
The Select Deliverables form is displayed when the Deliverables button is pressed. Each row on the Select 
Deliverables form describes one delivery of a single line iteip_ 

Select Deliverables 

To select a single delivery for assignment to the Shipping form, click on the row containing the Delivery to 
assign, then click the OK button. (Altemate methods: double-click on the row containing the Delivery to 
assign or; use the UPIDOWN ARROW keys to move to the Delivery to assign and press the ENTER key.) 

To select two or more deliveries for assignment to 
the Shipping form, use the Shift key or Control key 
as described to the right. 
When the OK button is clicked, the deliveries that 
you selected will be added to the list of shipments 
shown on the bottom portion of the Shipping form. 
Ifnecessary, use the scroll bar on the right-hand 
side of the Shipping list to move the other rows into 
view. 
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How to Select Multiple Items 
To select multiple items at the same time, either: 
I. Click the first item you want to select, press and 
hold down the SHIFT key while you click the last item 
to select. Then, click the OK button or press ALT+O. 
This selects two or more items in sequence. OR 
2. Press and hold down the CTRL key while you click 
each item you want to select. Click the OK button or 
press ALT+O. This selects two or more items out of 
sequence. 
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Select Location form 
The Select Location form allows you to specify the location for a delivery or a group of deliveries. . 

, -' .' " . . '. ',,' .. ~. 
Select Location 

To select'a Location, click on the row ~ontaining the'Locaiion to ""';O'T1cth,en 
(Alternate methods: double-click on the row containing the Location to assign or; use the UPIDOWN 
ARROW KEYS to move to the Location to assign, then'press the ENTER KEY.) 

You can select a different location for Shipping and Billing. After. selecting the Deliverable, Location and 
Address Type, repeat the process with different selections. 

Select Address Type 
The Select Address Type form is used to indicate an action such as Ship To or BiII'To. It can be used 
several times for each deliverable. 

Select Address Type 

A&A Small Pm chas" 

To seiect an Address Type for· assignment to the Shipping form, click on 
the roW containing the Address Type to assign, then click the OK button. 
(Alternate methods: double-click on·the row containing the Address Type 
to assign or; use the'UPIDOWN ARROW keys to move to the Address 
Type to assign, then press'the ENTER key.) 

To save information on the Shipping form, click the Save.button or select 
Save from the File Menu (ALT+ F, 'S). 
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Accounts 

The Accounts screen links the line items to Funding Accounts. The'Requestor and Manager roles can allot 
funds from the Funding Control Accounts for each line item. 

To access this screen from the Request Items tab, click all tl).e Aoccoun.ts ]:mtton. 

How to assign accounts: 

., 

1. For the, firstline item, click on the applicable account in the Available Accounts·section and click the 
Add button. The account number will be displayed in the Used Accounts section. Enter in the amount 
to be charged to that account for that line item. Multiple accounts can be used to fund a line item. 

2. Click on the box at the top labeled Line Item. Select the next line item number and return to the 
Available Accounts section to repeat the process described above. Continue until all line items have 
been assigned to accounts. 
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Funding Approval tab 

The Funding Approval tab is used to specify and approve the amount to be funded. 

The manager fills in the Approver Comments and checks the other information. He approves the funding 
by clicking the Commit Funding button. 

When the manager clicks the Commit Funding button, a box appears. The password is required to commit 
funds. It will not be revealed as it is typed. 

The application fills in the following fields on the Funding Approval tab (upper left): Fuudiug Approved 
On, Funding Approved by and Total Estimated Cost. The manager retoms to the Request tab to assign 
a contracting officer. 

Note: If the Commit Funding button is not available, retom to the Items tab and complete the accounts for 
each line item. 
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Initial RFQ tab 

The Initial RFQ tab facilitates and records the Request for Quotes process. 

Some of the fields will vary according to the RFQ method. Fields and buttons are: 

RFQ Method The RFQ Method is selected using the drop-down 
list box. This selection will influence the rest of the form. 

Date Conducted Month, day and year the RFQ was conducted in 
eigbt-digit format (MMDDYYYY)~ The application will insert 
today's date. 

Commerce 

Cut-Off Date Use standard eigbt-digit date format: insert two digits for month, two digits for d'!y, four 
digits for year. Slashes are inserted automatically. (To insert a date using 
the calendar, double click on the date field or press the F4 key. A 
calendar will appear. Go to the date desired and click on OK.) 

Date Sent and Response Received These fields are enabled after a 
vendor has been selected. 

ID Nnmbers These numbers are retrieved from the database. They are 
displayed in blue to indicate that it cannot be edited ]>y the user. 

RFQ Status The status is displayed by the application. 

SIC Code The Standard Industrial Classification Code is a four-digit code which is used to classify the 
products andlor services being acquired, If the RFQ Method is Electronic Commerce, you need to fill out 
this field. Double-click and use the Code Lookup box (described on page 9). 

Close RFQ This box is enabled after a vendor has been selected. Filling this box will close the RFQ. Do 
not click this box until you are certain that all RFQ tabs are final 

Transmission Error Message This message appears only if electronic commerce is the RFQ method and 
if there is an error in transmission. 
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AID Contact Name of person at USAID to whom the order is being sent 

AID Contact Phone Telephone number of AID Contact Person. 

AID Contact Fax Number for transmitting a document to AID contact via facsimile machine. 

Limited Vendors and Open These are checkboxes to show whether the RFQ is open to all vendors or to a 
few. Click on a checkbox with the mouse to fill it. To check the box using the keyboard, press the TAB 
key to reach the Limited Vendor box. The box will be filled. If you want to select Open, press the right 
arrow key. (Note: Open RFQ is not an available option if the RFQ method is limited, Le., telephone or 
written method.) 

Name to Query If the RFQ is sent to limited vendors, they will be specified on this tab. To insert their 
names, the negotiator or contracting officer fills this field as follows:· Enter the frrst letters of a vendor 
name. Press the Vendor Query button. The Small Purchase application will search the database for 
vendor names beginning with those letters. Select the vendor and close the list. The name will be inserted 
in the text box. 

Message/Comments This is a text field for additional comments. 

Staffing button Staffmg allows the user to make an item available to others. For instructions on How to 
do Staffmg, see the appendix page iv. 

EDI buttons These buttons are displayed after Electronic Commerce is selected as the RFQ Method: 

EDI Data button Press this button to display Electronic Data Interface screens. 

Transmit RFQ button If Electronic Commerce is the RFQ Method, this button is displayed. Click it to 
change the status of the RFQ to Ready to Transmit. -

Cancel RFQ button If Electronic Commerce is the RFQ Method, this button is displayed. To cancel the 
RFQ, click this button. 

ED! Transaction Data 
This form is reached by pressing the ED! Data button. It is needed when the RFQ is conducted by 
electronic commerce. 

Fields appear on the screen with blue titles, red titles, or buttons. A field with a blue title has a list from 
which to make a selection - double click to see the list. A field with a red title is an alphanumeric text field 
- use the keyboard to enter text. A button, when clicked, displays a short form which will help you 
provide the needed information. . 

The EDI screen that you reach from the Line Items tab is different from the screen that you reach from the 
Initial RFQ tab. 

Full documentation on Electronic Data Interchange is available from the following publications: 
Electronic Data Interchange ASC Xl2 Standards, copyrighted by Data Interchange Standards 
Association, Alexandria, VA. 
Federal Implementation Guideline for Electronic Data Interchange, ASC X12, Transactions Sets 
840, 843 and 850. 
USAID Data Elements Transaction Sets 840, 843 anc! 850. 
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RFQ Line Items tap 

This tab lists items and price infonnation for the RFQ. Column headings are displayed in regular type or.in 
bold type. A field with a bold title has a list from which to make a selection - double click to see the list. 
A field with a non-bold title is an alphanumeric text field - use the keyboard to enter text. 

The application wiII display the line items table with the following fields copied from the Request. For 
details?n entering data, see Request Line Items, page 10. 

Item Description This is a narrative description of the goods andlor services. 

Product Code Double click on this cell to select the Product Code. 

Object Code The Object Class Code assigns the item to a budget category from 

How to Use Code 
Lookup is onpage9. 

the OMB Budget Object Class Code Listing as supplemented by USAID. To edit this field, the user 
double-clicks to bring up· a code lookup box from which to select the OCC. 

Quantity This is a six-digit numeric field showing the quantity requested for that line item. 

Unit The unit of measure indicates how quantities of the given productor service will be measured. It 
confonns to standards for electronic commerce. Double-click to select. 

Unit Price This is a six-digit numeric field that shows the price or cost per unit of a line item. This field 
can be edited during negotiations. 

Item Total The application calculates this field by mUltiplying the Price and the Quantity. This field 
cannot be edited by the user. If the field is incorrect, correct the Price or the Quantity. 

ED! Item Data button This button is available only when Electronic Commerce is the RFQ Method. 

Click it to enter Line Item data for electronic commerce. 1~j;IDlil.refiID]ta$llliE§'!':so.WI::lil:i~1 
SOW button Click this button to enter or view the Statement 
of Work. For instructions on editing the SOW, see page 11. 

Note: If right-hand columns are not visible, scroll right using the scroll bar. Alternately, decrease column 
widths by placing the cursor on the right border of a column header, holding the left mouse button down, 
and dragging the mouse to the left. 
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RFQ Response It~m~ tab .... ~ i 

'''. 

This tab is for RFQ Response. It can' display a line item table for every vendor who has responded to the 
RFQ. 

If the vendor responds electronically, the vendor's data will be displayed as transmitted. OtherWise, the 
contracting officer or negotiator will specify the Vendor and enter data in the following fields: 

Vendor Comments This is a !OOO-character field for comments. 

Date Responded This is a date field using the standard date format: MMDDYYYY. 

Quote No. If the vendor uses a quote number, it is entered in this field. 

Telephone No. and Fax No. The numbers are inserted from the database but can be edited. 

Actual Contact This is the name.of the vendor's contact person for this purchase. 

Unit Price The.price is edited by typing over, the estimated price which was entered' on the Items tab. 

Met Delivery Requirements The contracting officer or negotiator checks this box if Delivery 
Requirements are met by this quote. 

,Note: The Delivery Requirements check box must be filled manually even if the other data iS'filled 
electronically. 

Summary tab. 

The Summary tab becomes available after the Response Items tab.is saved to the database. It summarizes 
the Vendors' responses on the following table. 

~ ,,~i Note: To generate a printed report, click on the Report button. 
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Initial tab - Award 

This is the initial tab of the Award fonn. To record a new award, click on the new file button la, or 
select FilelNew from the menno 

The Contracting Officer fills ont applicable fields. • , 
Contracting Office Click on the down arrow to select the office from the drop-down list. 

Select Award This field is blank if no award has been created previously. If an award exists, its number 
can be selected using the drop-down list. Furthennare, if an award (or more) exists, this Initial tab will 
vary slightly from the above illustration. 

Quoting Vendor The vendor is named here for this award. To select the vendor, use the drop-down list 
box. It will display the vendors who participated in the RFQ process. If none of the RFQ vendors are 
selected, fill ant the field below entitled Award To. 

PO Canceled Ignore this field unless the PO is being canceled. If it is, use the standard date format: 
MMDDYYYY. (To access a calendar, double-click on the date field. Highlight the date desired and click 
on OK.) 

Award to and Select Vendor button The button is used in conjunction with the Award to field. After 
entering the first letters of the Vendor's name, click the Select Vendor button. The application will search 
the database for company names beginning with that combination ofIetters. 

Vendor Phone and Vendor Fax. These fields can be edited to update the Vendor's telephone number and 
fax machine number. Changes made here will relate to this record only. If changes are permanent, they 
should be made in the A&A Support application. 

Vendor Contact This field can be edited to rame of the contact person for this particular award. If 
changes are permanent, they should be made in the A&A Support application. 

AID Contact Name of person at USAID to whom the order is being sent. 

. AID Phone and AID Fax Telephone number and fax number of AID Contact Person. 

There is also a button labeled Staffing, explained on page iv (appendix). 
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Items tab - Award' 

The Items tab on the Award fonn is similar to the Request Items tab and the RFQ Items tab. You can copy 
line items from the original request or from the RFQ. Specify the source using 'if~Ji.§jjJ!li~'3t~]' 
Select Line Items Location. This box will disappear from,the screen after it l~ 
is used. Request rterns 

RfQHems 
RFQ Vendor Response Item 

If not all items are displayed at once, use scroll bars or arrows to see additional data. 

For definitions of columns, see RFQ Items on page 21. 

There are Duttons: EDI Line Data, SOW, Delivery, Shipping, and Enter Obligations. Enter 
Obligations is described below. The other buttons are described above - see pages 11 and 12. 
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Enter Obligation form 
On this form, fundiog can be entered by lioe item. Select the lioe item io the Line Number field. Fill in 
the Present Obligation. Enter the dollar amount that you wish to obligate for each line item selected and 
then press the Sa're button. 

Other columns are: 

Funding Source This column lists the Funding Accounts for which funds have been committed for the 
selected line item. 

Total Committed This column shows the total amount committed per Account. 

Committed (Not Obligated) This column will display the difference between the original commitment 
and the subsequent obligation after funds have been obligated for this Award. 
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General tab 

This tab records purchasing infonnation for the award. Further documentation is recorded on the 
Negotiators Memorandum. 

The Contracting Officer fills in these fields: 

Required Source Double-click to bring up a list of SGUrces and select from 
the Code Lookup box. 

Purchase Method Double-click to bring up a list of purchase methods. 

Instrument Double-click in the field to bring up a list for selecting the 
appropriate type of procureIllent instrument. 

liowto mfa fieJdwith:a 
blue-Ietltr label: Double
click on the field to bring up 
the Cod_Lookup box. 
HiZfight your selection.oruse 
theFin!:Ifeature. Seepage9 
for details. 

Discount Terms Double-click to bring up a list of discount tenns. 

Preference Program Doulile-click in this field to bring up a list for specifying the preference program. 

Competition Type Double-click on this field to select the competition status. 

Place of'Performance Double-click in this field to select the country or geographical area. 

Contract Type the Contract number in this field. 

Exp Date Type the Expiration Date in MMlDDIYYYY fonnat Or, double-click to display a calendar. 

Electronic PO Click on this box to place or remove an "X." Also, certain buttons are available only if 
Electronic PO is applicable: Transmit, Cancel, ED! Base Data, and ED! Line Data. 

Negotiators Memorandum button is displayed only after the tab is saved. 
Click on it to view its associated tabs. 
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Negotiators M.emorandum tabs. 
" . ~ - -

These tabs summarize the negotiations and the history of the order. They form an important part of the 
official record. 

Summary tab 
This tab is filled automatically from the database records, except for the textbox for Negotiator's.General 
Comments. This textbox has a scroll bar which· can be used to reveal additional text. 
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FAR CI~use tab 
This tab maintains a list of Federal Acquisition Regulations pertaining to the award. The tab first appears 
with a button labeled'Amend. Pressing that button adds a Iist·to tjle scre.en as shown ~elow. . 

• " • ". •• • ~ £-

Work Hours 
Service Contract Act Of 196'5-(:Oll1lra, 
Service Contract Act Of 

(Apr34) 

Available FAR List This is a list of numbers and titles of Federal AcquisitiO'n Regtiiatiotis: To fuove it 
title to the list for this award, highlight your choice and press the Add button' (ALT+ A). 

Selected FAR List This list is built by selecting reference numbers and titles from the list of available 
Federal Acquisition Regulations. To remove a clause from this list, select it and press the Remove button. 

To add FAR clauses to the available list, press the New button. illS) Type in the number and de~cription 
and press the Save button. III 
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Price Basis tab 
This tab records the basis for detennining that prices were reasonable. 

To fill a checkbox, click on it w$ the mouse, or, tab to it and press the space bar. The textboxes are 
available for typing in details. Each textbox has a scroll bar which can be used to reveal additional text. 

Sources tab 
This tab records the number of sources considered. If fewer than the usual number were solicited, the 
re";S0ns are reported. 
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The Small Purchases application fills in the grid. The contracting officer or negotiator fills in any 
applicable checkboxes. 

To fill a checkbox: click on it with the mouse, or, tab to it and' press the space bar. A textbox is available 
for typing in an explanation. The textbox has a scroll bar which can be used to reveal additional text. 

After completing the Negotiator's Memorandum tabs, close them (CTRL+ F4) to return to the Award tabs. 
From there, you can generate a printed report by clicking on the Report button. 

Approval tab .. , 

The Approval tab records the obligation offtmds for the award. Only, the Contracting Officer is authorized 
to obligate ftmds. 

Before approving ftmds, you must Enter Obligations - see page 25. 
". . '." 

The contracring officer names the COTR who will accept delivery and approves Funding by filling the 
Approved checkbox, entering the Amount Obligated and using the Obligate Funding button. Re
entering the passw.:ord is requir~d to complete the process. 
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The Funding Grid at the bottom of the tab displays all of the accounts and the amounts allocated for this 
Award. The accounts are listed by Account Number and Object Class Code (OCC). An account may be 
listed more than once, if it is linked to multiple Object Class codes. 

The mandatory fields are: 

Approved Click on this checkbox to fill it. 
Amount Obligated Fill in this field in the grid with the amount obligated for each funding account. 
COTR who will accept delivery Double click on this field to bring up a Code Lookup box from which to 
select the COTR. 

There are also date fields to fill out for the date the Purchase Order is sent and the date it is ackuowledged. 
The application fills out the Date Approved but it can be changed. 

See also, Entering Obligation by Line Item. 

The application will fill in the Approver ID and the Obligation Date. This completes the Award form. 

I~l You can generate a printed report. Click on the Report button and select from the list. For more 
information, see the Appendix, page vii. 

Awards to More than One Vendor 

If an award is split among several vendors, both the Award Line Items tab and the Approval tab will differ. 
Revise the line items for the fIrst award to be made and enter the obligations. The Approval tab will reflect 
the changes. 

After saving the award, click the New button I!DI You will then be able to create another Award record 
with different line items. 
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APPENDIX 

Mouse and Keyboard 
The A&A Small Purchases Application supports the use ofa mouse (or other pointing device) as well as the standard keyboard. 
A mouse is uot required for most A&A Small Purchases Application features. A mouse is commonly used to click on buttons 
and icons, and to activate the pull-down menu bar. If a mouse is not available, the following keys can be used instead. 

TAB key : Moves among fields and buttons in a window. 

SIllFT+TAB key combo : Pressing the SlllFT key and the TAB key simultaneously will move backwards to previous field 
or button. 

Up and Down Arrow keys : Moves through a list of choices (Le. through the menu options in a pull-down menu). 

ENTER key : Selects a button, a menu, or a menu option. 

ALT key : Moves between menu bar and current window, or, if there is a hot key (underlined letter), moves 
to that item. 

ALT +Down Arrow keys : Displays list of valid choices for a field, when available. 

How to Select frcm aDrop-down List'Box: :,' " '. '- """ " ",' 

Clickihe left mouse button on the dGWD atTOW button to see the iist, scroll down ify-ou need to s~more. Qick onyourse-lection. 

Using the keyboard, hold ~o:;vn. 4 T +so,wn "'tOY' ,key to s,. $",liSt. Use up and doWl) ;rrr~w~ (0 sellict.. Press ENT.9J1.... if 

Using Keyboard Shortcuts 

Ctrl+ S Save 
Ctrl+X Cut (Remove text to clipboard) 
Ctrl+C Copy (Copy text into clipboard) 
Ctrl+ V Paste (paste text from clipboard) 
Ctrl+Q Query (Access Query application) 
Ctrl+ E Search (Initiate Search) 
Ctrl+P Print 
Ctrl+A Attach Note (Create, edit or view note) 
Ctrl+B Toolbar (On and Off) 
Ctrl+F4 Close form 
Ctrl+ F6 Window (Move to another screen) 
FlO Menu (Access Menu bar) 

Date fields 
F3 Current date 
F4 Calendar 
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How to Use the Code Lookup Box 
with the code lookup feature are displayed with blue lettering. You can reach code lookup by double-clicking with the 

Code Lookup offers two fields for rmding the correct code: Code and Description. 

search for a Code, enter the first letter or two letters in the Code field and press the Find button. 

search for a description, either enter the rITst letters and use the First Letter Search option, or enter a key word in the 
I d"scr;ptiion field and de-select First Letter Search. Press the Find button to bring up a list containing the text you entered. 

Highlight the correct code and description and press the Select button (ALTo!- S). If the list is long, use the scroll bar to reveal 

Text Editing Features 
The A&A Small Purchases Application includes a word processor feature for text editing on the SOW forms. The cut, copy, 
delete functions act on text that has been highlighted. 

If you are authorized to enter orrevise a document, it will appear on a white background. To enter text, type it in using the 
keyboard Or copy it in from the Windows clipboard as described below. To edit, place the cursor at the point where you will be 
making a change. Type in any new text. Delete unwanted text using the Delete key. 

To Save the document, select Save from the File Menu (ALT+F, S). 

Word Processor - Menu Bar 

File Edit View Layout., Tools, Font Help " 

Text may be highlighted using the mouse by positioning the cursor at the beginning of the text to be highlighted, clicking the left 
'mouse button on the button, and dragging to the end of the selection. To highlight text using the keyboard, position the cursor at 
the beginning of the text and hold down the SlUFf key. Move to the end of the selection using the up, down, right and left arrow 
keys and release the SHIFf key. 

To cut or copy text, either use the cut and copy buttons On the toolbar or select the appropriate menu options from the Edit pull
down menu. To delete text, press the DELETE key. 

Since the A&A Small Purchases Application is Windows compatible, text that is cut or copied is sent to the Windows 
clipboard. That text can be copied back into the A&A Small Purchases Application using the Paste button or menu option. 
Text can also be cut from other Windows compatible applications and copied into the A&A Small Purchases Application from 
the clipboard. For example, to import text from any Windows-based word processor, minimize the A&A Small Purchases 
Application main window by nsing the down arrow on the upper right-hand corner of the window. Hold down ALT and TAB to 
see the Word Processing icon. Double click on the WP buttou and open the documeut containing the text to be imported. 
Highlight the text and copy it to the Windows clipboard. Exit Word Processing; press ALT+TAB to rmd the A&A Small 
Purchases Application icon. Double click on it to restore the Small Purchases Application, Position the cursor at the location to 
import the text; then use the Paste button or menu option. Text may be exported from the Small Purchases Application in a 
similar manner. 

To export numbers from the Line Items spreadsheet, the copy feature may be used. Highlight the celIs to export and use the 
Copy button or menu item. Minimize the A&A Small Purchases Application window and enter any Windows-based 
spreadsheet. Select the Paste option. All of the numbers from the highlighted cells will be entered into the spreadsheet. 
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Word Processor Toolbar 

The Word Processor toolbar contains a series of buttons that can be clicked with the mouse: 

Left Align 

Center Align 

Right Align 

Justify 

Bold 

Italics 

Underline 

St~ikeout 

Single Space 

Double Space 

Triple Space 

Subscript (II Button) 

Superscript (T Button) 

Tab Sets 

Left Tab set 
Right Tab set 
Decimal Tab set 
Center Tab set 

ShowlHide 

Font Colors 
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: Aligns text with the left margin, but leaves a ragged right margin. 

: Centers text between the left and right margins or on a specific point on a line. 

: Aligns text with the right margin, but leaves a ragged left margin. 

: Aligns text with both the left and right margins, adding or deleting space between words as 
needed. .--. , -

: Bolds the highlighted text in the document. This function can be accomplished by choosing 
Bold in the Font Menu (ALT+ 0, B). 

. : Italicizes the highlighted text in the document. This function can be accomplished by 
choosing Italic in the Font Menu (ALT+ 0, I). 

: Underlines the highlighted text in the document. This function can be accomplished by 
choosing Underline in the Font Menu (ALT+ 0, U). 

: Strikes out the highlighted text in the document This function can be accomplished by 
choosing Strikeout in the Font Menu (ALT+ 0, K). 

: Sets the line spacing for each line to accommodate the largest font in that line. 

: Sets the line spacing for each line to twice that of single line spacing. 

: Sets the line spacing for each line to three times that of single line spacing. 

: Sets the line to Subscript - Text that appears slightly lower then other characters in the line. 

: Sets the line to Superscript - Text that appears slightly higher then other characters' in the line. 

: Sets a left-aligned tab. 
: Sets a right-aligned tab. 
: Sets a decimal tab. 
: Sets a center-aligned tab. 

: Shows all nonprinted characters, including paragraph marks and spaces. 

: Displays the Font Color Box. Allows you to choose the color that the text appears in the 
word processor. 
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Forms and Features 

Staffing 
E====:: .. Staffing opens a fonn for directing infonnation to the attention of others. The fonn also lists items that'have 

been made available to you for your action. 

Fields on the Staffing fonn are: 

Date Notified and Date Acknowledged The current date is inserted by the application .. 

Organization See How to Selectfrom a Code Lookup Box, page ii. 

Notify Double-click and select the employee from the Code Lookup box. 

Activity ID and Request ID (numbers retrieved from database) 

Status The status is Not Acknowledged until the recipient views the request. 

Comments This is a text box. Enter text using the keyboard. 

Following those is the list of items that have been staffed to you or from you. It has the following columns: 

Notify, Notify from, Request ID, Status. 

How to Notify: 

1. Fill in the fields Organization and Notify. The Comments field is optional. 

2. Click the Save button. 

3. If you need to notify. more than one person, repeat steps 1 and 2. 

4. Then, select the Close button or Close from the File Menu (CTRL+ F4) to leave this fonn. 
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Acknowledging an Alert 
To reach the Staffing screen, either: 

Click on the Staffing button on a tab, or select notification from the File menu. 

From the list on the lower part of the screen, select the item that you are ackoowledging. Use the Status box to confirm receipt 
and indicate Concur or Disagree. Fill in the date or double click on the date field to access a calendar. Type in any comments. 

Selecting Concur on the NotifY form. 

Click the Save button. Then select the Close button or Close from the File Menu (CTRL+ F4) to leave this form. 

How to Enter Dates 
Month, day and year are entered in eight-digit format (MMDDYYYY). Insert 
two digits for month, two digits for day, four digits for year. Slashes are 
inserted automatically. 

To insert a date using the calendar: double click on the date field or press the 
F4 key. A calendar will appear. Page through hy clicking on the arrows at the 
top. Select the date desired by and click on OK. . 
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How to Attach Notes 
The Note box provides an eye-catchiog way to send comments regardiog a tab. Notes may be used to communicate ideas 
between users of the application, such as changes needed to fields to which only the owner of the record has access. 

The text field on the Note expands as comments are entered. 

Using the Clipboard 

There are buttons on the note: 
Save - Save the message and attach to the form 
Delete - Remove an existing note from a form 
Cancel- Return to the form without any changes. 

The Note box can be reached by clicking on the Note button Ilil~~1 or by choosiog 
Attach Note io the Options Menu (ALT+O, A). 

The Clipboard is a Wiodows storage area. You can put text io the Clipboard usiog Cut (CTRL + X) or Copy (CTRL+C). Then you 
can iosert the text ioto another text field usiog Paste (CTRL + V). 

There is a Copy button on your Help screen for copyiog text from Help files ioto the Clipboard. 

Note: Clipboard'is temporary storage. When you Cut or Copy text ioto it, its previous contents will disappear . 

• 

How to Search 

~ The Search button or command opens the Search Screen. This allows you to search for records that contaio specific 
ioformation from the database. A&A Small Purchases allows you to do an advanced search or a simple (express) search. 

Close any open forms before usiog Search. 

How to do a Simple Search: 

1. Select the type of seach from the drop-down list box. 
2. Fill io the date range to search, if known. 
3. If there is a word or phrase to look for, enter the text. 
4. Iflooking for awards of a certaio amount, enter the range. 
5. Click the Search button to ioitiate the Search' (or press ALT+ S). 
6. A list is displayed with all of the Requests that match attributes. Select the Request. 
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How to do an Advanced Search: 

1. When the Search Screen is displayed, select the attributes that you know about the record(s) for which you are searching. The 
" more attributes you can detennine the smaller the number of records that will be returned. 

2. Indicate the Search Area or group offonns you want to search. 
3. Detennine if you want to use andlor for multiple attributes. 
4. Select any other fields that you can fill. 
5. Click the Search button to initiate the Search. 
6. A list is displayed with all of the records that match the attributes you entered. Select the record that you want to see by 

highlighting it and clicking on Select (ALT+ T). 

Reports 

The Contracting Officer or Negotiator can generate printed Reports by pressing the Report button I~l or using the Database 
menu. A box lists the reports that are available at a given point in the application. 
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Click on the repon you want to print and press the Run button to print it. (Alternate 
method for keyboard users, press ALT+ R.) 

If you select Standard Fonn 281, a dialogue box will be displayed from which you can 
select the time period and other infonnation. 

If you need to change your printer setup, change it from your file menu before selecting 
Report. 
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Toolbar Buttons 
The toolbar contains a series of buttons that can be clicked on with the mouse as an alternative to using the pull-down menus. 
Buttons which are not presently available will be "dimmed." Clicking on a dimmed button will have no effect. The toolbar 
be turned on and off with the Options pull-down menu by selectiug Toolbar. 

The buttons on the toolbar are"l!S follows: 

IfDl New button 

~ Open button I. Save button 

~Cutbutton 
III Copy button 

I. Paste button 

Ilu~1 Note button 

ADD
EDIT
VIEW--

I!II Alert button 

W Query button 

Iml Search button 

~ 
~ Report button 

I;'J!;I Change Role button' 

I@J Help button 

A&A Small Purchase 2.7 

: Allows you to create a new record of the type that is currently displayed. After you 
select this command, the application will change to Add mode. 

: Opens the Assignments form, Alert list, or Notification form. 

: Saves the current record of the type that is currently displayed. 

: Removes selected text and puts it in the clipboard. 

: Copies selected text and puts it in the clipboard. 

: Places the selected text from the clipboard to the point you select in your document. It 
overlays any existiug text in the field . 

. Tells you what mode the currently displayed record is in. This is an informational panel 
only. The panel is in the toolbar. It displays either: 
you are creatiug a new record 
you can make changes to the currently displayed record 
you can view the record, but either another user is working with it or you are not logged 
on in a Role that is authorized to edit this process. 
Note: If you need to change from Edit mode to Add mode, click on the Open New 
button to execute the FilelNew command. 

: Opens the Note form. This is an open field to type comments regarding a specific Tab 
of the form which is currently visible. Use the Save button to attach the Note to the 
current Tab of the form. Notes may be used to communicate ideas between users of the 
application, such as: any changes needed to fields to which only the owner of the record 
has access. 

: Displays the Small Purchases.Alert List with tasks that require your attention. 

. : Opens the external query application, as available in USAID. 

: Opens the Search form. This allows you to search for records that contain specific 
information from the database. 

: Opens the.Reports box. This allows you to create a specific report for the·RFQ or 
Award. 

: Displays the Select Role form. This allows you to change your role, providing that your 
ID associates you with mUltiple roles. . 

: Accesses the AcquiSition and Assistance Small Purchases Help screens. 
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Menu Commands 
The Acquisition & Assistance Small Purchases Application menu bar is the second line in the main Acquisition & Assistance 
Small Purchases window. A menu can be activated by clicking on a menu title with the mouse or by pressing the ALT key, 
moving to a menu title with the right and left arrow keys, then pressing the ENTER key. Select a menu option from the pull
down menu by either clicking on the option or by moving to the option using the up and down arrow keys, then pressing the 
ENTER key. 

Note: options which are not presently available will be "dimmed" to gray print 

File Edit Database Options WindoJII . Help 

File Menu 

New: 

Open: 

Close: 

Save: 

Delete: 

Print Setup: 

Exit: 

Edit Menn 

Cut: 

Copy: 

Paste: 

Allows you to create a new record of the type that is currently displayed.. When the New button is selected,. 
the application will change to Add mode. 

Displays the secondary menu that allows you to display an existing Staffmg Alert, To Do List, or Source List. 

Closes the active form. If you have not previously saved the changes to the record, the Application will ask if 
you want to save the record before you close it. If you close a record without saving, you will lose all of the 
changes you did not save previously. 

Saves the active record. To quickly save a record, click the Save button on the toolbar. 

Removes the currently selected record from the database. 

Displays the Print Setup dialog box to specity printer settings for your printer. The settings you select become 
the default settings. For information about which settings to use with each option, see your printer manual. 

Ends the A&A Small Purchases session. If Exit is selected while a form is in EDIT mode, the application will 
prompt the user to save any unsaved changes in a record. 

Removes selected text and puts it in the clipboard. 

Copy selected text to the clipboard. 

Places the selected text from the clipboard to the point you select in your document. It overlays any existing 
text in the field. 
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Database Menu 

Change Role: Opens the Select Role fonn. This allows you to change your role, providing that your ID associates you with .a 
multiple roles. ,. 

Query: 

Search: 

Reports: 

Options Menu 

Toolbar: 

Opens the external query application, as available in USAID. 

Open the Search fonn to allow you to search for records that contain specific infonnation from the database. 

Opens the Create Reports fonn. This allows you to print a report. 

To remove the Toolbar, click the left mouse button on the 'Toolbar' topic in the Options Menu. The check 
mark and toolbar will disappear. To make the Toolbar appear, click again on the 'Toolbar' topic. The check 
mark and toolbar will appear. 

Additional Messages: To turn off confmnation messages, click this item to remove the check. 

Save Settings on Exit: Once you have changed your options, you can save them so that they will not have to be reset when you 
use the application next time. 

Application Logging: Turn on this feature to track interaction with the database. The Application Logging icon will appear at 
the bottom of the screen. To view the log, click on that icon. 

Attach Note: 

Windows Menu 

·l-l: 

Help Menu 

Opens the Note fonn. This is an open field to write comments regarding a specific Tab. Notes may be used 
to communicate ideas between users of the application, such as changes needed to fields to which only the 
owner of the record has access. 

Open Windows are listed. To move quickly to another screen, click on its title using the mouse, OR, key in 
the number next to its title. 

Contents: Displays the Contents of the A&A Small Purchases Help System. 

Help on Help: Opens the Windows Help system. This is an introduction to the'concepts used throughout standard Windows 
Help files. • 

About: The About item on the Help Menu displays infonnation about the Acquisition & Assistance Small Purchases 
Application: including the current version number and location of the program. 
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Logon Procedure and Problems 
A&A Small Purchases is accessed through the NMS logon. The Logon box provides a security mechanism to ensure that only 
authorized users may log on to NMS Applications. 

I!mEI 
~ 

Double-click on the USAID icon Qi\'iii9 in your Windows Program Manager to access the New Management Systems (NMS) 
applications. If you are not sure where to Tmd this icon, contact your supervisor or System Administrator. The following logon 
screen will appear: . 

Enter your user ID and password and click on the Logon button to continue (or click on the Cancel button to exit). The buttons 
for applications to which you have access will be highlighted in bold type. Other buttons available to you on this screen include: 

Click on this button to enter a new password, which must be at least eight 
characters long. (This button is displayed after you log on.) 

Click on this button to set various preferences, including how often to delete 
temporary files and which applications to load automatically. 

Click on this button to return to the previous screen. 

Click on this button to completely exit the NMS logon procedure. 

After selecting the appropriate application button (A&A) at the top of the screen, a screen will appear with buttons representing 
the modules available in the application you selected. The following screen illustrates the modules in the Acquisition and 
Assistance application: 
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Click on the button , for the module that you wish to access, or click on the Go to Main button to return to the previous 
logon screen. 

Possible Causes for Logon F:ailure: 

" , " Cause , Remedy:' ,<' , , -
Improper ID or Password, Type correct ID and password and try 

, -- again. 
For new users, database account has not Contact DBA' and re'quest an OraCle 

o' • 

been setup. account , 
After an A&A Small Purchases error Exit and re-enter Windows and try again. 
occurs, the system will not logon. If the problem persists, reboot and try 

again. 
The database is down. Contact DBA and report logon failure. , 

* DBA - Database Administrator 

A&A SmaIl Purchase 2.7 xii 



Oracle Server Messages 

Message 
Code 

ORA-00001 

ORA-OOOS4 

ORA-009~2 

ORA-01000 

ORA-01017 

ORA-01031 

ORA-01924 

Description 

Unique constraint violated 

Cause: A record exists in the database with the same primary key as the record you are attempting to add. 
The current record cannot be saved. 

What to do: Contact your system administrator for assistance. 

Record locked for update 

Cause: Record is being.edited by another user. 

What to do: Try to access record later. 

Table or view does not exist 

Cause: You do not have a valid A&A role. 
Or 

The data table/view (file) that the application is trying to access either does not exist or is not available to you. 

What to do: Application will tenninate automatically. Contact your system administrator for assistance. 

Maximum cursors exceeded 

Cause: A fatal error has occurred in the current routine. The current data may not have been saved. 

What to do: .Application will tenninate automatically. Contact your system administrator for assistance. 

Invalid usemame/password / 

Cause: You have entered an invalid user ID andlor password or an Oracle account has not been created for 
you. 

What to do: Retry with correct usemamefpassword. If this error persists, contact your system administrator 
for assistance. 

Insufficient privileaes 

Cause: You have insufficient privileges to perfonn this database task. The current data may not have been 
saved. . 

What to do: Contact your system administrator for assistance. 

Role not granted or doesn't exist 

Cause: Your default Oracle role is missing or invalid. 

What to do: Contact your system administrator for assistance. 
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ORA-02291 

ORA-03121 

ORA-06107 

ORA-06122 

ORA-03059 

Parent key not found 

Cause: A 'Parent' record is required to save the current record. The Parent record could not be found. The _ 
current record cannot be saved. ., 
What to do: Contact your system administrator for assistance. Database is corrupted. 

No interface driver connected 

Cause: A SQL*NetTCPIIP error has occurred. Eitherthe SQL*Net" directory is not in your PATH= 
statement in AUTOEXEC.BAT " or there is a problem with the ORACLE.INI file. " 

What to do: Application will terminate automatically. Contact your system administrator for assistance. 

Oracle network server not found 

Cause: A SQL 'Net TCPIIP error has occurred. The SERVICES file is invalid, could not be found or is not 
specified in the ORACLE.INI file. 

WhaHo do: Application will terminate automatically. Contact your system administrator for assistance. 

Setup failure 

Cause: A SQL 'Net TCPIIP error has occurred. The ORACLE.IN! file is invalid or could not be found. 

What to do: Application will terminate automatically. Contact your system administrator for assistance. 

OOBC user canceled 

Cause: An ODBC error has occurred. Either the ODBC.INI file could not be found, the proper data source is 
not specified, or the correct driver is not specified. 

What to do: Application will terminate automatically. Contact your system administrator for assistance. 
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Incident Reportin,g 

Although comprehensive testing has eliminated as many errors as could be found and fixed, there is a need to report any new 
errors in a way that is meaningful to the software developers so that the errors can be corrected, The forms on the following 
pages should be used to report these errors, Copies of these forms should be made and kept on file for future use. The figures 
below indicate where to fiod the information needed to fill out the form along with a defioition of the terms used on the form. It 
is important that the user and System Administrator collaborate in the response. The System Administrator may be able to 
resolve some of the errors before the reports are sent on to the Help Desk. Include as much detail as you can concerning the 
error .. Remember the individuals who will evaluate and fix the error may be a continent away. 

The figure below is a typical screen used in the Acquisition & Assistance application. The information needed to fill out the 
'report will be found in the same general !!Tea through~ut tb.e 0t1!~r modu!.,,,. 

" . -' '~,' -'.::' .. 
USAIO Acquisition & Assistance (Award Formation) 

Figure 1. 

-,:==z:j Applicatjon , 
'" Module' ' .. 

Mode 

Screen Name 

Tab Name 

Field Name 

Role 

The figure below is an example of the "Splash screen", that is displayed,wh.en, the user selects Help, then clicks on About from 
. --'-<the arop:'down menu" .' , 

Figure 2. 
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Definitions, Incident Report Form 

Incident Nnmber: This number will be assigned by your System Administrator when the Report is logged in. The number 
should include informaiion that will make it unique so that it will not conflict with Incident Reports sent in by other 
sites. This log should be scrupulously maintained and inquiries made if a timely response is not received. 

IP Address: The IP address is the Internet Protocol address. It is used to uniquely identify a host computer on a TCPIIP 
network. It is'set up by the System Administrator of the host computer. 

Host Name: The host name is a synonym for the IP address. It is used to uniquely identify a host computer on a TCPfIP 
network. It is set up by the System Administrator of the host computer. . 

Name: The name of the user initiating the Incident Report. 

Organization: Enter the organization code that will help to uniquely identify your installation. 

Location: Enter the location that will help to uniquely identify your installation. 

System Administrator: The name of the System Administrator. It is suggested that the System Administrator maintain a file of 
copies of the reports for future reference. 

Version: The date and version number appearing on the Splash screen. See Figure 2 for an example. 

Screen Name: Enter the Screen name. See Figure I for an example. 

TablForm Name: Enter the name of the Tab or Form. See Figure I for an example. 

Field Name: Enter the label or name of the field where the error occurred. See Figure 1 for an example. 

Mode: Enter the Mode the application was in when the error occurred, such as ADD, EDIT or VIEW. See Figure I for an 
example. 

Role: Enter the Role that you were using when the error occurred, such as Requestor, Manager, COTR, etc ... See Figure I for an 
example. 

Description of Problem: Enter as much information about the seq1!ence of events leading up to the problem as you can. The 
frequency that the problem occurs, intermittently or every time, is important and should be noted. 

Actual Error Messages: In some cases the application will trap and display error messages generated by Oracle, the Database 
Management System. There is a list of these messages and their codes on page xiii. There may be some messages that 
are not in the appendix that are generated by the application or by Windows itself These messages are important to the
developers and should be noted. 

All of the entries may not be pertinent but they should be filled in. Use ~f A when appropriate. 
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NMS Incident Report Form 

Incident Nnmber: _______ _ IP Address: _________________ _ 

Date ofIncident: _______ _ HostName: __________ _ 

Name: _____________________ _ .organization: _______ -=-__ 
Version: ___________ _ Location: ____________ _ 

Application: _________ __ Screen Name: __________ _ 

Mode: ___________________ __ Tab Name: ____________________ _ 

Role: __________________ _ Field Name: _________________ _ 

Description ofProblem:, _______________________________ ---

AcruaIErrorM~sage: _______________________________ _ 

Suggestions: _____________________________________ _ 

System Administrator: ______________ _ 
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Budget Ql:Ie.ry Applic~tion, - Overview 

The Query Application is designed to support USAID'senior managers and budget analysts in 
producing timely policy guidance with appropriate budget parameters for use in strategic planning. 
The Budget applications support the distribution, tracking, and allocation of funding, the analysis 
of the relationships between activities and funding, and their relationships to organizations and 
geographic areas. 

The Query Application enables the user to deSign queries of Budget data for analysis and 
evaluation by providing several formats and parameter definitions. Queries may be defined by 
geographical distinctions, Fund and Fund Accounts information, fiscal years, strategic objectives, 
activities, and organizations. Because of the range of selections possible, queries can be as broad 
or as sharply focused as needed to meet the needs of managers and analysts in planning and 
decision making. 
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How to use Help 

- m 1. The Query Application Help system can by accessed by clicking on the Help Button~. To-
access the Help system from the keyboard, press the ALT key plus the letter H. 
Active Help Topics are shown as green underlined text: either a solid or a dotted line. 

2. When the mouse pointer is placed on a green (active) topic, it changes to a hand.icon ~ 
Click once to reveal additional help information. 
Help topicS are also available through "hotspof' graphics in the Help system. When the 
pointer is placed on an active graphic, it changes to a hand icon. Click once to reveal 
additional help information. 

3. If you are using the keyboard, press the TAB key until the topic is highlighted, then press 
ENTER. 

4. To exit the Help Me!1u, go the File menu and click on the Exit option. 

Active Graphic 
Graphic illustrations of buttons, menus, or screens in Help that function as help topics. These are 
NOT in green; simply place the pointer on an illustration to determine if it is an active topic. 

F1 Key: Context-sensitive help can be accessed by pressing the F1 key while in any field. 
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Accessing the. Application . 

Logon 
I!WllI 
~ 

Double-click on the USAID 'icon \\'ffli9 in your Windows Program Manager to access the New 
Management Systems (NMS) applications, If you are not sure where to find this icon, or you have 
problems logging on, contact your supervisor or System Administrator. The following NMS logon 
screen will ,appear: 

Figure 1: Logon Bol' 

Enter your user ID and password and click on the Logon button to continue,(or,click on the Cancel 
button to exit). The buttons for applications to which you have access will be highlighted in bold 
type. Other buttons available to you on this screen include: 

8 

Click on this,button to enter a new password, which must be at least 
eight characters long. 

Click on this button to set various preferences, including how often to 
delete temporary files and which applications to load automatically. 

Click on this button to retum to the previous screen. 

Click on this button to completely exit the NMS logon procedure. 
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After selecting the appropriate application button at the top of the screen, a screen will appear with 
buttons representing the modules available in the application you selected. The following screen 
illustrates the modules in the Budget application: 

Figure 2: Logon Box-Budget Group 

Click on the button for the module you wish to access, or click on the Go to Main button to return 
to the previous logon screen. 

To access Query, click on 

Once the logon procedure has been executed, the Query application appears on the screen. 
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Menu Bar 
Place the pointer on the topic on the menu bar you wish to view. Click on the topic and the drop
down menu will appear. The menus can be accessed from the keyboard by pressing the AL T key 
plus the underlined letter of the menu name. To view an option in the drop-down menu, type the 
underlined letter in the option. When an option is "greyed", that option(s) is not available for usem 
a selected mode. The etrl + keys can be used to utilize functions from the drop-down menus 
from anywhere in the application without opening the menus, i.e., pressing Ctrl+X will allow the 
user to exit the application from any screen. The Menu Bar in the Query Application is shown 
below. 

File 

Open .•. 
~iose 

File Oueries Windows Help 

§.ave Ctrl+S 
Save 8s ... 

£'.rint... Ctrl+P 
Print Setup ••• 

New: 
Open: 
Close: 
Save: 
Save As: 

Print: 
Print Setup: 
Exit: 

10 

Creates new file (query) 
Opens existing file 
Closes currently active file 
Saves currently active file 
Provides option to name file for saving; also provides option to save a new 
version of an existing file under a new name 
Prints currently active file 
Sets attributes and printer destination for print jobs 
Exits the application - selection of this option produces a dialog box for 
confirmation 
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Queries 

User Queries: 

Query Expert: 

Windows 

!;.ascade 
Tile Horizontal 
Tile yertical 

Cascade: 
Tile Horizontal: 
Tile Vertical: 
Arrange Icons: 

Enables the user to open previously saved queries. Selecting this option 
produces the following pox: ";, .. ' . . •.•. .. . 

Accesses the Budget Expert. This action ·is identical to clicking on the 
Budget Expert button on the toolbar. 

Ctrl+L 
Ctrl+M 
Ctrl+N 

cascades the open windows 
arranges the open windows horizontally 
arranges the open windows vertically 
arranges icons using the minimum required space 
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Help 

Jiearch For Help On ... 

Contents: 
Search for Help On: 
About: 

Lists topics available in the Help system. 
Provides the option to search.for topics by name. 
Identifies the version of the software being utilized. The following box 
appears when this option is selected: 

- ABOUT 

12 

U.S.A-I.D. NMS Project 

Budget Financial Analysis Software 
Compiled: 11/29/95 2:03:06 PM 
Part of New Management System (NMS) 
System Release: 2.0 

BudgetTeam . 

Figure 3: "About" box 
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Query Applicatiot:t. . 

The Query Application allows the user to organize the budget data in several ways. The senior 
manager or analyst can define data selections for queries for a particular organization, geographic 
region, country, fund, fund account, activity, year, or fiscal year range. In addition to selecting 
data based on a combination of criteria, the data can also be aggregated and tabulated by 
directive, earmark, emphasis area, strategic objective, and theme. 

The Query Application has the ability to present the data selections in both a spreadsheet formOit 
and in graph forms. Graphs can be generated in several styles depending on data parameters 
selected; bar graphs, pie graphs, line and area graphs in 3D and 2D are available. 

Toolbar 

The Main Toolbar of the Query application is displayed at alLtimes. 

Bud!l'~t Expert Button: 

Blm1·' ,. ;, 
",,.. __ ; I 

Retrieve Graph: 

Retrieve Spreadsheet: 

I~ 
~ 
View User-Queries: 
~ 
~ 
Help Button: 

Budget-Query Application 

Exits the application. When this button is selected, a 
confirmation dialog box appears to verify the'exit action. 

Loads the Budget Expert. 

Enables ttie user to access previously saved graphs. 

Enables the user to access previously saved spreadsheets. 

Enables the user to access previously saved queries. 

Accesses the Help system. 
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Budget Expert .'. 

The Budget Expert window is used.to select the parameters for a query. To access the Budget 

Expert, click on the Budget Expert button on the toolbar: ., -OR- Click on Queries on the 
menu bar and select Query Expert. The following window will appear: 

Figure 4: Budget Expert window 

There are eight steps available to designing a query, some of which are optional. Each step is 
accessedlhrough the .tabs at the.bottom of the window. Navigation between .the steps is flexible; it 
is possible to move freely through the screens in any order desired. Each step provides a short 
description and instruction for selection procedure. The tabs become highlighted when selected, 
and identify which window is in. view, .i:e., the Main window is in view in this illustration, so the 
Main tab is highlighted. 
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The vertical buttons provide navigational and functional procedures. 

Previous\Next: 
Provides navigational ability between the step windows. Selection of these buttons will navigate to 
the immediate previous·or,next step. 

Help: 

Accesses the on-line Help system. 

Parameters: 

Displays the selected parameters for a user-designed query. Selection of this option produces the 
window below. This window can be positioned anywhere on the screen and left open for reference 
while selections are being made. 

Figure 5: Parameters window 

Cancel: 

Closes the Budget Expert window. Note: Does not exit the application. 

Perform Query: 

Initiates the Query function. Once all the desired parameters have been set, select this button to 
create your query. The initial query will be shown in spreadsheet form. 
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Designing a Q,u,ery " 

The tabs across the bottom of the Budget Expert window enable the user to design a query 
according to specific needs, Each'tab activates a step in the query process, These steps are not 
mandatory; you may design a query with a broad focus, or choose to sharply define your query 
by making a selection in each step, It is also possible to move freely between the steps in any 
order you choose, and to return to steps to edit selections. 

There are eight steps available in query design: Information, Organization, Geographic Area, 
Fund, Fund-Account, Activity, Dates, and Layout. 

The tabs are illustrated below: 

To select a step, place the pointer on the desired selection and click once. The corresponding 
window will open upon selection. 
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Information Categories 

Figure G: Info window 

The Information Categories window, or Step 1 of the Budget Expert, enables the user to initiate 
the query desired under 4 categories listed on the left side of the window. The definitions of these 
categories are listed below: 

• 
Trends 
A view of data over a range of Fiscal Years (FY)., Le., 1993 to 1997. The data is aggregated 
chronologically. 

Summaries 
A view of data over a specific Fiscal Year (FY), Le. FY 1993. A summary focuses on one 
budgetarylfinancial amount. 

Queries 
Detailed information about multiple budgetary/financial amounts. 

Reports 
Produces a printout of query data to satisfy USAID's extemallintemal hard copy reporting 
requirements. 

Selection is made by clicking once on the radio buttons to the left of each category. The button 
becomes darkened, or "filled", when selected. 
Selection of one of the categories defines the contents of the list box on the left. Once a category 
is selected, the query is further defined by selecting one of the types listed in the box. To select a 
type, place the pointer on the name desired and click once. The name becomes highlighted when 
selected. 
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Organization 

BUREAU FOR AFRICA , ., , 
CENTRALACCOUtjTING DIV!SI(jN ," .. ' ,. 
CENTRAL ACCOUNTING DIVISION EXCESS PROP 
Debtor_Billing t .... t 
EXECUTIVE OFACE OF THE PRESIDENT 
Ecuador 
EI Salvador 
lAC 

Figure 7: Organization window 

Selection of this,tab produces Step 2 of the Budget Expert, a selection list of USAID organizations 
on all levels: Agency, Bureau,.Mission, and Division. Organization names or acro~yms with·the 
plus sign to their left indicate that there are lower-level organizations associated with it. Place the 
pointer on the plus sign and click once to reveal those lists, The plus sign will change to a minus 
sign, identifying the organization as the parent organization to the displayed list This organization 
name will automatically scroll to the top of the list box, enabling the user to have the maximum 
space to view the corresponding 'list. Names which have no plus signs'to their left indicate that 
they are the.lowest level organization in that particular hierarchy, 

To select an'organization, place the pointer on the name and click once. The name becomes 
highlighted when selected. 
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Geographic Area 

Figure 8:, Geographical Area window 

Selection of this tab produces Step 3, a list which allows the user to define the geographical 
parameters· for the query. The initial setting is World; the Budget Expert will use this as default if 
the user chooses not to define the Geographic Area: 

Geographic'selections with plus signs to their left indicate that there are additional geographic 
areas associated with that selection. Click once on the plus sign to reveal the list. The plus sign 
will tum into a minus sign. The lists are hierarchical; Regions are listed under World, Country' 
under Region, Missions and Division Offices under Country. Names with no plus signs to their left 
indicate that this.is the, lowest leveL area associatedWith.that particular region. 

To select a Geographical Area, place the pointer on the name and click once. The name will 
become highlighted when selected. 
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Fund Selection 

Figure 9: Fund window 

Selection of this tab produces Step 4, a selection list of Funds. This is an optional step. It is not 
necessary to select,a Fund in order to initiate a query,'however, if a Fund is selected, only 
records associated with that particular Fund will be used for query formulation. . . 
Note: Multiple Funds,may be.selected for a query. Use the scroll bar·to navigate through·the list 
Place the pointer on each Fund acronym desired and click once. The F,und will become 
highlighted when selected. 

The Fund list box has an "Unselecf"button on the top left comer. When·this button is "greyed", it 
is inactive. It becomes active once a Fund is selected, indicated by the change in letter color from 
grey to red. This button is used,to clear selections in the· list· box. 
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Fund Account Selection 

Figure 10: Fund Account window 

Selection of tab produces Step 5, a selection list ot Fund Accounts. This is an optional step. It is 
not necessary to select a·Fund Account in order to initiate a query, however, if a Fund Account is 
selected, only those records associated with that particular Fund Account will be used. 

Note: A Fund Account cannot be selected without first selecting a Fund. Multiple Fund Accounts 
can be selected if desired. Use the scroll bar to navigate through the list The appearance of.a 
scroll bar is determined by the length of the list of available Fund Accounts. Place the pointer on 
each Fund Account desired and click once. The Fund Account will become highlighted. when 
selected. . 

The Fund Account list box has a button' on the left top corner. Its active status is indicated .by the 
color of the letters; when it is grey, it is inactive, when red, it·is active. Initially, this button will·read 
"Load". Selection of this button will load the list of Fund Accounts associated with the Fund 
selected. Once the list is loaded, the button will toggle to "Unselecf. This button is used to clear 
selections in the list. 

Note: Deselection of Funds in the previous step will automatically deselect any Fund Accounts 
selected. If Stap 4 is edited, it will be necessary to reselect Fund Accounts in Step 5. 
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Activity Selection 

est 
Test 2 

ADP Procurement 
AP Test - Disaster Asst 
AP Test - Disaster Asst 
AP Test: Disaster Asst 
AP Test - Disaster Asst 
AP Test·-India 
AP Test- India 

~~~ 

Figure 11: Activity Selection window 

Selection of this tab produces'Step 6, a list box of activities associated with·the 
Organization/Fund/Geographical areas. The contents cif this list is defined by selections made in 
the other criteria list boxes. This list box has an active toggle button on .the upper right-hand 
comer. This button will read "Load" initially; once the list is produced, it becomes "Unload", 
allowing the user to'cancel the list and return to one of the other selection areas to further define 
the query. 

Use the scroll bar to navigate through the list. To select an activity, place.the pointer on the name 
and click once. The name will become highlighted. 

Note: Editing the Fund selection will clear any selections made in Activities. The '!ist in this box is 
defined'by the selection·in Funds. If the Fund selection is changed, this selection will also need 
to be edited. 
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Dates Selection 

Figure 12: Dates Selection window 

Selection of this tab produces Step 7, the option to select a fiscal year (FY) or a range of fiscal 
years to use in defining the query. The appearance of this screen is determined by the selection 
made in the Info window, or Step 1. Selection of Trends or Reports will produce a window with a 
FY range selection, and Summaries and Queries will produce a window with a single FY . 
selection. 

To select a range, place the pointer on the down arrows II and click once to reveal drop-down 
list of dates. Select a date (start and end) by placing the pointer on the date and clicking once. 
The selected date will appear in the appropriate box. 
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Figure 13: 'Dates Selection window-View 2 

To select,a single FY range, place the pointer on the down arrow ~'to reveal the drop-down list 
of available dates. Place the pointer on the desired date and click once. The selected date will 
appear in the box. 

Note: Available-dates are determined by selections made in previous steps_ 
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Layout Selection 

Figure 14: Layout Selection window 

Selection of this tab produces Step 8, a list box that gives the user the option to determine how 
the results of the query are to be grouped and summed. The appearance of the Layout window is 
determined by the selections made in the previous steps. When the s~lections in the list box are 
'greyed", this indicates that variation in layout is not available. 
The selection of Summaries in Step 1 (Info) produces a Layout window that has the option to 
select a Column Heading for cross-tabulation. 

Figure 15: Layout window-View 2 

To make selections in the list boxes, place the pointer on the desired option and click once. The 
option will become highlighted to indicate selection. Use the scrollbar to navigate up and down the 
list as necessary. 
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Reports 
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Figure 16: Reports win!low 

The Report Selection on the Info window enables the user to generate a printout report that 
meets USAID's requirements for extemaVintemal hard copy distribution. At this time, a single 
report type, Technical Notification, is available. Additional report types will be available in later 
versions. 

Once the parameters for the query report have been selected, click on the Perform Query button 
to generate the report. 

Note: Only the Report selection will generate this window. The other selections on the 
Information window will generate a spreadsheet. 

The toolbar on the bottom of the Report Window enables the user to perform functions within the 
window. The arrows provide navigational function through the report. The Cancel button allows 
the user to cancel the report during generation. Once the report.is generated, this button 
becomes "greyed", or inactive. The buttons to the right of the Cancel button allow the user to 
zoom in/zoom out, print, and export the report.· Selection of the Close button will close the Report 
window. 

The bottom toolbar also provides information concerning the size and content of the report. The 
numbers on the left identify the number of pages in the report; the numbers on the right identify 
the number of records. 
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Spreadsheet 

Once all desired selections have been made in the Step windows, click once on the Perform 
Query button to generate the query. 

Figure 17: Spreadsheet window < 

The Spreadsheet window displays the query data in spreadsheet form. 

Spreadsheet Menu Bar 

The Spreadsheet window' has a menu bar specific to its window. Click on the topic and the 
drop down menu will appear. The menus can be accessed from the keyboard by using the 
AL T key plus the underlined letter of the menu name. The etrl + keys and Shift+ keys can 
be used to utilize functions from the drop-down menus from anywhere in the application 
without opening the menus. To select a menu option with the keyboard, type the underlined 
letter in the menu option. Greyed item(s) in the drop down menu(s) are not available to use in 
a selected mode. 

Rle Edit F.!!,rmat Queries Wind.ow. Help 
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File 

.Qpen Spreadsheet Ctrl+O 
Open Graph 
Close 
.:iave 
S.!!.ve As .•• 

Ctrl+S 

Print Ctrl+P 
Page Setup 
Print Setul' 

New: Opens new spreadsheet form 

Open Spreadsheet: Enables user to open previously saved spreadsheets 

Open Graph: Enables user to open previously saved graphs 

Close: Closes active spreadsheet 

Save: Saves active spreadsheet 

Save As: Saves active spreadsheet and enables user to name saved form, or to 
save an additional version of a previously saved spreadsheet under a 
new name. 

Print: 

Page Setup: 

Print Setup: 

Exit Application: 
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Prints the active spreadsheet 

Enables user to set attributes for page 

Enables user to set attributes for print output and select printer 

Exits the Query Application 
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Edit 

!;.ut Ctrl+X 
CQPY Ctrl+C 
easte Ctrl+V 
Clear 

Insert Rows Shift+lns 
insert Columns Ctrl+lns 
D,!;.lete Rows Shift+l)el 
Delete Columns Shift+F11 
Go To Ctrl+G -
Define Name Ctrl+N 

Sort By Fund Acronym 
Sort by Total 
Sort By Base 

Restore Total Col and Row 

Cut: 
Copy: 
Paste: 
Clear: 
Insert Rows: 
Insert Columns: 
Delete Rows: 
Delete Columns: 
Go to: 

Cuts selected range 
Copies selected range to. clipboard 
Pastes copied range from clipboard to selected area in spreadsheet 
Clears selected range 
Inserts rows into selected area of spreadsheet 
Inserts columns into selected area of spreadsheet 
Delete selected rows 
Delete selected columns 
Navigate to selected cell in spreadsheet· 

Define Name: Enables user to bookmark cells or a range of cells for function purposes 
Sort by Fund 
Acronym: 
Sort by Total: 
Sort by Base: 
Restore Total 
Col and Row: 

Sorts query data by Fund Acronym alphabetically 
Sorts query data by totals; greatest to least 
Sorts query data by base; greatest to least 

Restores totals in the Total column and rows to reflect adjustments 
through entries, deletions, functions, or "drag and dropped" columns. 
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Format 

Alignment 
font 
Border 
f!attem 
Jiet Cell Protection 
Protection Enabled 
Number Format r'mask'1 

fixed Rows And Columns 
~olumn Width 
RowH'eight 

Ctrl+T 
Ctrl+B 

Alignment: Enables user to define the horizontal/vertical display of the spreadsheet. 

Font: Enables user to select font for spreadsheet display 

Border: Enables user to design border. for spreadsheet 

Pattern: Enables user to design background pattern and color for spreadsheet 

Set Cell Protection: Sets cell protection as either "locked" or "hidden" 

Protection Enabled: Enables or disables cell protection as a toggle; a checkmark .,J. will 
indicate when protection is enabled. 

Number Format: Selection of number formatting for spreadsheet display 

Fixed Rows and 

Columns: 

Column Width: 

Row Height 

Enables user to define fixed rows/columns 

Enables user to design column widths 

Enables user to design row height 

Note: In order to utilize the above options in the Format menu, the spreadsheet must be selected 
first. This does not apply to the Show menu below. 

Show: Selection of this option produces the following menu: 

.,J Grid Lines 

.,J ~olumn· Headings 

.,J Row Headings 
formulas Ctrl+F 

.,JZero Values 

The options in this menu design the display of the spreadsheet. The selection is show/hide; 
options with the checkmark next to them are shown in the spreadsheet, those without a 
checkmark are hidden. These operate as toggles; click once on the option to switch between 
show and hide as desired. 

30 Budget-Query Application 



Queries 

Query Expert 
User Queries 
£ave this 

Query Expert: 
User Queries: 

Save this Query: 

Windows 

Cascade 
Tile Horizontally 
Tile Vertically 
Arrange Icons 

1 Budget Expert 

Executes the Budget Expert window 
Produces the User-defined Query window, enables user to access 
previously saved queries. 
Enables user to save current query under user-defined name 

2. Queries - Budget Formulation 

"J. 

Cascade: 
Tile Horizontally: 
Tile Vertically: 

Arrange Minimized: 

Cascades the open windows 
Arranges the open windows horizontally 
Arranges the open windows vertically 
Arranges the open windows using the least amount of space 

The lower section lists the open windows. The check mark identifies the currently active (on top) 
window. 

Help 

~ontents 

£earch For Help On ••. 

Contents: 
Search for Help On: 
About: 

Lists topics available in the Help system. 
Provides the option to search for topics by name. 
Identifies the version of the software being utilized. 
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The Menu Bar will display an additional option once the spreadsheet, or an area of the 
spreadsheet, is selected/highlighted for graphing. This option is graph, shown below: 

File Edit Graph! Format Queries Window Help 

This option is an action button; selection of Graph! will generate a graph of the columns/rows, or 
entire spreadsheet, depending on the area selected. 

Spreadsheet Toolbars 
The spreadsheet has two toolbars with functions specific to this window. The initial toolbar 
appears below: 

Once the spreadsheet, or an area of the spreadsheet, is selected/highligh~d, additional icons 
and functions appear on the toolbar related to the graphing function. This toolbar is shown below. 

Following are definitions offunctions: 

Save spreadsheet: 

Print spreadsheet: 

Cut selected range: 

• 
Enables user to save current spreadsheet. This button produces 
a FilelDirectory screen for naming the spreadsheet and selecting 
the directory in which to save it. 

Prints the current spreadsheet. 

Cuts selected columnslrows from spreadsheet 

Copy selected range: Copies selected columns\rows to clipboard 

Paste: 

Im£I~WH 
Formatting text buttons: 

III 
Format text in 
"highlighted cells: 
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Pastes copied columnslrows from clipboard 

Formats text in spreadsheet according to selection, i.e., Bold, 
Italics, or Underlined 

Formats text in selected columnslrows 
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View a saved spreadsheet 

in Lotus 1-2-3: 

IU 
Graph highlighted cells: 

II 
Drag and Drop 

highlighted column: 

View parameters 

of last query: 

Functions: 

~ 
Drag and drop 

a function to the grid: 

JJj 
Adds a ] and ends 

editing a cell: 

Budget-Query Application 

Enables user to view a previously saved spreadsheet in 

Lotus 1-2-3 format 

Produces graph of data in selected columns\rows 

Enables user to' "drag and drop" selected column. To utilize this 
option, first select column. Next, place pointer on button and 
hold down the left mouse button while dragging column to 
desired position. The selected column will displace any 
existing ,column and neposition it to the right of the column. 

Opens the Parameters window 

Drop-down list-box of spreadsheet functions available for users in 
the spreadsheet. To select a function, place the pointer on the 
desired name and click once. Note: The selection made in this 
box functions with the following button. It does not produce a 
function on its own. 

"Drags and drops" function in previous selection to cell in 
spreadsheet. To utilize this function, place pointer on button and 
hold down left mouse button while dragging to desired cell. 

Used to finish formula cells 
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Saving Spreadsheets 

'Spreadsheets may be saved for future viewing by either: 

Selecting the Save Spreadsheet button on the toolbar III_OR-
by selecting Save or Save As in the File drop-down menu. 
These actions will produce the follOWing screen: 

<. 

This screen enables the user to assign a name for the saved spreadsheet and to choose a 
directory \drive in which to save the file. 

Enter name and extension of spreadsheet in File name box. 

Select drive and directory for file storage. 

Click on the OK button to save the spreadsheet and return t6 the spreadsheet window. 

Note: Spreadsheets are saved with data·that is available at the time it is saved. To generate a 
saved query with current data, see View User Queries. 
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Creating Graphs 

Once the Query parameters have been defined and a spreadsheet generated, it is possible to 
create a graph of the Query data. Bar graphs, line graphs, area graphs, and pie charts can be 
made with data from all columns and rows in the spreadsheet 
Note: It is necessary to select the column(s) and/or row(s) first before a graph can be 
created. 

Select the desired columns and rows by either: 

1. Clicking on the heading of the column -OR- on the title of the row. 

2. Clicking in the heading of the beginning of a range of columns\rows and "dragging" to 
select the desired area. 

3. Clicking on the heading of the Totals column, the heading of the row titles column, or the 
upper left-hand cell in the spreadsheet to select the entire spreadsheet 

Once the desired query data has been selected, a graph can be generated by clicking on the 

Graph! option on the Menu bar -OR- by clicking on the graph button I'iitl on the spreadsheet 
tool bar. 
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Graphs 

The Graph window displays the query data in a graph form. There are several selections of graph 
types available dependent on the type and scope of the analysis. Line, area, bar, and pie graphs 
are available in various formats. Below is an example of a 3D bar graph: -

! ' 

, , 
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Figure 18: 3D Bar Graph 
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·e Below is an example of the Pie Graph in 3D and the Line Graph in 3D: 

TOTALS 

Figure 19: 3D Pie Graph 

Figure 20: 3D Line Graph 

Budget-Query Application 
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Graph Menu Bar 
The Graph window has a menu bar specific to its window. Click on the topic and the drop 
down menu will appear. The menus can be accessed from the keyboard by using the AL T 
key plus the underlined letter of the menu name. The Ctrl + keys and the Shift+ keys can be 
used to utilize functions from the drop-down menus from anywhere in the application without 
opening the menus. To select a menu option with the keyboard, type the underlined letter in 
the menu option. Greyed item(s) in the drop down menu(s) are not available to use in a 
selected mode. 

File 

Write BMP 
.$.ave 
Open Spreadsheet 
New Spreadsheet 
Open Graph 
~Iose 

Print Setup 
frint 

Write Metafile 

WriteBMP 

Save 

Open Spreadsheet 

New Spreadsheet 

Open Graph 

Close' 

Print Setup 

Print 

Exit Application 
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Rle Edit jiraph Oueries Window Help. 

Saves the displayed graph as a Windows metafile 

Saves the displayed graph as a bitmap 

Saves the displayed graph as a chart 

Opens a previously saved spreadsheet 

Generates a new spreadsheet 

Opens a previously saved graph 

Closes the displayed graph 

Enables user to set attributes for printing the graph, and selecting printer 

Prints the displayed graph 

Exits the Query Application 
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e· 

Edit 

Ctrl+C 
Easte Ctrl+V 

Copy 

Paste 

Copies displayed graph to the clipboard 

Pastes copied graph 

Graph 

Iranspose Axes 
llimensions 

Footnote 
Title 

Bar 
Horizontal Bar 
Line 
Area 
Pie 

StacklUnstack 

Transpose Axes 

Dimensions 

Footnote 

Title 

Bar 

Horizontal Bar 

Line 

Area 

Pie 

Ctrl+T 
Ctrl+D 

Ctrl+1 

Shift+Fl 
Shift+F2 
Shift+F3 
Shift+FII 
Shift+F5 

Budget-Query Application 

Stacks or unstacks data series in a bar graph 

Transposes the x and yaxis 

Adjusts the display between 20 and 3D view 

Enables the user to apply a footnote to a graph 

Enables the user to apply a title to a graph 

Designs the graph as a vertical bar graph 

Designs the graph as a horizontal bar graph 

Designs the graph as a line graph 

Designs the graph as an area graph 

Designs the graphas a pie chart 
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Title and Footnote produce boxes that enable the user to enter text to appear in the graph 
window. 

What title text? 

What footnote lexl? 

Enter the title or footnote you wish to appear in the graph by typing in the test box. These may be 
edited by utilizing this option as often as you wish; a new entry will automatically replace the 
preceding one. 
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Below is an example of a graph with both a title and a footnote: 

Graph,One 

1e+006~------------------------. 1e+006 

800000 

600000 

400000 

200000 

o 
TOTALS 

, 600000 

400000 

200000 

0 

vertical2D bar graph 

Queries 

Query Expert 

User Queries 

Budget-Query Application 

Figure 21: Graph with Title and Footnote 

Initiates the Budget Expert window 

Accesses previously saved queries 
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Windows 

Cascade 
Tile Horizontally 
Tile Vertically 
Arrange Icons 

1 Budget Expert 
2. Oueries - Budget Formulation 

Cascade: 
Tile Horizontally: 
Tile Vertically: 

Arrange Minimized: 

Cascades the open windows 
Arranges the open windows horizontally 
Arranges the open windows vertically 

Arranges the open windows using the least amount of space 

The lower section lists the open windows. The check mark identifies the currently active (on top) 
window . 

. Help 

jiearch For Help On ... 

Contents: 
Search for Help On: 
About: 
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Lists topics available in the Help system 
Provides the option to search for topics by name. 
Identifies the version of the software being utilized. 
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Graph Toolbar 

-The Graph window tool bar is pictured below. The buttons on the toolbar enable the user to save,_ 
print, copy, and paste as well as design the graph in a variety of displays in 2D and 3D forms. 

Following are descriptions of their functions: 

II] 
Save graph 

IiI Print graph 

II Copy graph 

In Paste 

Saves displayed graph 

Prints displayed graph 

Copies displayed graph to the clipboard 

Pastes the copied graph into selected applications, Le., 
Paintbrush. Note: Copied graphs can be pasted into 
the spreadsheet. Insert rowsfcolumns to allow space for 
graph, then paste graph into the spreadsheet using this 
function on the spreadsheet toolbar. 

The following buttons are used to design the appearance of the graph. The default for graphs is 
2D vertical bar. The display can be modified as desired through selection of these buttons: 

Vertical graph Displays the graph as vertical bars 

Horizontal graph Displays the graph as horizontal bars 

Line graph· Displays a line graph 

Area graph Displays an area graph 
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Pie chart 

StackiUnstack 

Transpose X and Y axis 

3D or2Dview 

Displays the graph as a pie. chart 

Stacks.or unstacks data series in a bar graph. Toggles 
between the two displays. 

Transposes the axis; toggles between ·the two displays. 

Toggles the display between 20 and 3D. 

Note: This will generate a 2D or 3D display of the selected type of graph, Le., if a vertical bar 
graph is generated, a selected display of a vertical bar. graph will be generated, if a pie chart is 
generated, a selected display of a pie chart will be generated, and so on. 
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'e Saving Graphs 
Graphs may be saved for future viewing by either: 

Selecting the Save Graph button on the Graph toolbar Irl_OR_ 
by selecting the Save option in the File drop-down menu. 
These actions will produce the following screen: 

Write First Impression Chart 

lfflif.kiP~ File Harne: Directories: 

1m c:\budapps 

l~rak~~lf,:1 i':i; c:\ 
I2t7 budapps If)<ilt;Fw\$ ~=" ..... _wo , 

D !lead Only 

;:J; 

Saye File as lJope: Driyes: 

le.Ylc) Ir!! lia c: m.-dos 6 1m 
.'. 

, 

., 

This screen enables the user to assign a name for the saved spreadsheet and to choose a 
directory/drive in which to save the graph. 

Enter the name and extension of the graph in the File name,box. 

Select the drive and directory for file storage. 

Click on the OK button to save the graph and to return to the Graph window. 

Note: Graphs are saved with data that is available at the time it is saved. To generate a saved 
query with current data, see View User Queries. 
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View User Queries 

Queries can b84enerated using parameters saved from previous queries. These queries will 
reflect results drawn from current data,. regardless of when the query parameters were saved. 

Saving a Query: 
Once parameters have been selected in the Budget Expert windows and a Query has. been 
generated, it is possible to save the query using the Spreadsheet Menu bar. 
Select the Queries menu option from the Menu bar. 
Select Save this Query from the drop-down menu. This action will produce the following box: 

What Description 

Enter a title in the text box. The query' parameters will be saved under this name. 

Viewing User Queries: 
User queries may' be accessed by either: 

Selecting the View User ~ueries button on the toolbar II~ -OR-

Selecting Queries on the Menu bar and selecting the User Queries option in the drop-down 
menu. 

These actions will produce the following window: 
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The user has the options to view only their own queries or to view>all saved queries. This 
selection is made by choosing one of the radio buttons at the lower section of the window. 

The selection will darken, or "fill" when selected. 

Thewindow has three buttons on the right side that perform specific functions: 

executes selected query from saved parameters 

deletes selected saved query 

,closes the User Queries window· 

User queries titles are displayed'alphabetically in.the list box in the window. 

The name of the author of the original query appears in yellow under the list box. This name will 
corresporld with the selected (highlighted) query in the list box. 

• To select a query for viewing, place the pointer on the desired name and click once. The 
name will become highlighted: Select the Perform Query button to generate the query. 

• To delete a previously saved query;select the desired name in the same, manner. Select the 
Delete button to delete the selected query. 

• To close the User Queries window and return to current window in the application, select the 
Cancel button. 
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Glossary 

Activity 

Agency 

Bureaus 

Division 

Fiscal Year 

Fund 

Fund Account 

Mission 

Queries 

Reports 

Summaries 

Trends 
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Project or task required to carry out a program. the word" Activity"'is 
used for' any activity or unified group of activities, programs, projects, 
types of material assistance or other operations, and refers to both 
project and non-project assistance. 

USAID. All references to agency in this application refer to USAID. 

Second hierarchical level in USAID, responsible for large-scale 
management of operations and administrative activities. Bureaus with 
geographical deSignations overesee Missions/Divisions. 

Managerial offices within Missions. There may be multiple divisions 
within a Mission. 

A twelve month accounting period, without regard to its relationship to a 
calendar year. The fiscal year for the U.S. Government begins October 1 
and ends September 3~. 

A designation of Congressionally appropriated or nonappropriated funds 
used to finance Federal Government work. Budget uses all foreign 
assistance accounts including those of other government agencies. 

Fiscal year financial information for each Fund. Year dates have suffixes 
which signify the duration period of that particular Fund Account Dates 
with the suffix "A" signify annual funds, or funds with a one-year time 
period before expiration. Dates with the suffix "X" signify funds as 'no 
year', or as having no expiration period. Dates listed as yy\YV signify 
funds with a two-year time period before expiration. 

USAID programs\offices defined by geographical locations, i.e., country 
or region. 

Detailed information about multiple budgetary/financial amounts. 

Produces a printout of query data to satisfy USAlD's external/internal 
hard copy reporting requirements. 

A view of data over a specific Rscal Year (FY), i.e. FY 1993. A summary 
focuses on one budgetarylfinancial amount. 

A view of data over a range of Fiscal Years (FY)., i.e., 1993 to 1997. The 
data is aggregated chronologically. 
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Oracle Server Message!; 

Message 
Code 

ORA-00001 

ORA-OOOS4 

ORA-00942 

ORA-Oi000 

ORA-01017 

ORA-Oi031 

Description 

Unique constraint violated 

Cause: A record exists in the database with the same primary key as the 
record you are attempting to add. The current record cannot be 
saved. 

What to do: Contact your system administrator for assistance. 

Record locked for update 

Cause: Record is being edited by another user. 

What to do: Try to access record later. 

Table or view does not exist 

Cause: You do not have a valid Budget role. 
Or 
The data tablelview (file) that the application is trying to access 
either does not exist or is not available to you. 

What to do: Application will terminate automatically. Contact your system 
administrator for assistance. 

Maximum cursors exceeded 

Cause: A fatal error has occurred in the current routine. The current data 
may not have been saved. 

What to do: Application will terminate automatically. Contact your system 
administrator for assistance. 

Invalid username/password 

Cause: You have entered an invalid user ID and/or password or an 
Oracle account has not been created for you. 

What to do: Retry with correct usemame/password. If this error persists 
contact your system administrator for assistance. 

Insufficient privileges 

Cause: You have insufficient privileges to perform this database task. 
The current data may not have been saved. 

What to do: Contact your system administrator for assistance. 
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ORA-01924 

ORA-02291 

ORA-03121 

ORA-06107 

ORA-06122 

Role not granted or doesn't exist 

Cause: Your default Oracle role is missing or invalid. 

What to do: Contact your system administrator for assistance. 

Parent key not found 

Cause: A 'Parent' record is required to save the current record. The 
Parent record could not be found. The current record cannot be 
saved. 

What to do: Contact your system administrator for assistance. Database is 
corrupted. 

No interface driver connected 

Cause: A SQL "Net TCPIIP error has occurred. Either the SQL "Net" 
directory is not in your PATH= statement in AUTO EXEC. BAT .. or 
there is a problem with the ORACLE-INI file. " 

What to do: Application will terminate automatically. Contact your system 
administrator for assistance. 

Oracle network server not found 

Cause: A SQL "Net TCi5I1P error has occurred. The ·SERVICES file is 
invalid, could not be found or is not specified in the ORAClE.lNI 
file. 

What to do: Application will terminate automatically. Contact your system 
administrator for assistance. 

Setup failure 

Cause: A SQL*NetTCPIiP error has occurred. The ORACLE.INI file is 
invalid or could not be found. 

What to do: Application will terminate automatically. Contact your system 
administrator for assistance. 
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3059 OOBC user canceled 

Cause: An ODBC error has occurred. Either the DDBC.INI file could not 
be,found, the proper data source is n9t specified, or the correct 
·driver is not specified. 

What to do: Application will terminate automatically. Contact your system 
administrator for assistance. 
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Incident Reportin.9 

Although comprehensive testing has eliminated as many errors as could be found and fixed, there 
is a need to report any new errors in a way that is meaningful to the software developers so that 
the errors can be corrected. The forms on the following pages should be used to report these 
errors. Copies of these forms should be made and kept on file for future use. The figures below 
indicate where to find the information needed to fill out the·form along with a definition of the terms 
used on the form. It is important that the user and System Administrator collaborate in the 
response. The System Administrator may be able to resolve some of the errors before the reports 
are sent on to the Help Desk. Include as much detail as you can concerning the error. Remember 
the individuals who will evaluate and fix the error may be a continent away. 

Definitions, Incident Report Form 

Incident Number: This number will be assigned by your System Administrator when the Report 
is logged in. The number should include information that will make it unique so that it will 
not conflict with Incident Reports sent in by other sites. This log should be scrupulously 
maintained and inquiries made if a timely response is not received. 

IP Address: The IP address is the Intemet Protocol address. It is used to uniquely identify a host 
computer on a TCPIIP network. It is set up by the System Administrator of the host 
computer. 

Host Name: The host name is a synonym for the IP address. It is used to uniquely identify a host 
computer on a TCPIIP network. It is set up by the System Administrator of the host 
computer. 

Name: The name of the user initiating the Incident Report. 

Organization: Enter the organization code that will help to uniquely identify your installation. 

Location: Enter the location that will help to uniquely identify your installation. 

System Administrator: The name of the System Administrator. It is suggested that the System 
Administrator maintain a file of copies of the reports for future reference. 

Version: The date and version number appearing in the "Abouf' box. 

Screen Name: Enter the Screen name. 

Tab/Form Name: Enter the name of the Tab or Form. 

Field Name: Enter the label or name of the field where the error occurred. 

Mode: Enter the Mode the application was in when the error occurred, such as ADD, EDITor 
VIEW. 

Role: Enter the Role that you were using when the error occurred, such as Requestor, Manager; 
COTR, etc. 
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Description of Problem: Enter as much information about the sequence of events leading up to 
the problem as you can. The frequency that the problem occurs" intermittently or every 
time, is important and should be noted. 

Actual Error Messages: In some cases the application will trap and display error messages 
generated by Oracle, the Database Management System. There may be some 
messages that are not in the appendix that are generated by the application or by 
Windows itself. These messages are important to the developers and should be noted. 

All of the entries may not be pertinent but they should be filled in. Use N/A when,appropriate. 
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NMS Incident Report form 

Incident Number: _______ _ IP Address: _____ _ 

Date of Incident: ___ --' ___ _ Host Name: _____ _ 

Name: ___________ _ Organization: _____ _ 

Version: ___________ _ Location: _______ _ 

Application: _' _________ _ Screen Name: _____ _ 

Mode: _______________ ___ Tab Name: ______ _ 

Role: __________________ _ Field Name: _____ _ 

Description of 
Problem:, _____________________________________________ _ 

Actual Error Message: 

Suggestions: 

System Administrator: ______________ _ 

54 Budget-Query Application 



e NMS System" Administrators Incident Log 

Incident Date Date 
Number Reported, Resolved Brief Description of Problem 

• 
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Overview 

The Results Tracking system provides a means to record performance information - all levels of 
development results, including both planned (Le., target) and actual results. It also provides a 
means to look at results being achieved in other countries or by other United States Agency for 
International Development (USAID) organizations for comparison purposes and so that Agency
wide results can be aggregated. 

All results information in the Agency will be uploaded to Washington on a daily basis, so 
Washington users can access data for any country, or for any Washington-based organization 
which has strategic objectives and intermediate results of its own that it is tracking. In the field, 
data will be kept on those countries for which that location is responsible. Communications 
limttations make it impossible to transfer all results data from every country USAID serves to 
every other country daily. Field personnel wishing to access other organizations' or countries' 
results can initiate a query to the central database in Washington and receive the information 
requested the next day. 

LogOn 
I!l§OlE 

~ 
Double-click on the USAID icon ~ in your Windows Program Manager to access the New 
Management Systems (NMS) applications. If you are not sure where to find this icon, or you 
have problems logging on, contact your supervisor or System Administrator. The following logon 
screen will appear: 

Enter your user ID and password and click on the Logon button to continue (or click on the 
Cancel button to exit). The buttons for applications to which you have access will be highlighted 
in bold type. Other buttons available to you on this screen include: 
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Click on this button to enter a new password, which must be at least 
eight characters long. 

Click on this button to set various preferences, including how often to 
delete temporary files and which applications to load automatically. 

Click on this button to retum to the previous screen. 

Click on this button to completely exit the NMS logon procedure. 

After selecting the appropriate application button at the top of the screen, a screen will appear 
with buttons representing the modules available in the application you selected. The following 
screen 'illustrates the current modules' in the bperations application:' ..., 

Click on the button for the module you wish to access, or click on the Go to Main button to retum 
to the previous logon screen. 
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Help 

Help is available on every screen by either pressing F1 for context-sensitive help, pulling down 

the Help menu from the menu bar or, where available, clicking on the kr::l button. 

If you a~e unable to see all of the help information on your screen, click on the maximize 

button J:EJ in the top light comer of the help window. Use the vertical scroll bar-on the 
right to move dow~ the page if necessary. 

Click on any green text in the help window to "jump" to its explanation. 

For a quick guide to setting up your results framework, pull down the on-line Help menu and 
select How to Get Started or tum to the Appendix at the end of this user's guide. 

The waming "Windows Resources Low, Help Might Not Load" may appear if you don't have 
enough memory to run both the Results Tracking system and the separate help files. Close any 
other applications if they are open or contact your System Administrator for assistance. 

If you choose to run the system without the help files, you may select the option "Disable this 
Message in the Future." The waming message will not appear until the next time you enter the 
system. 

• 
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Results Tracking Main Menu 

This is the first screen you will see after logging in. It gives you access to all Results Tracking 
functions. 

Select an Organization 

In order to enter the Results Tracking system, an organization must be selected. Your current 
home organization, or where you are. physically located, will be displayed by default. If multiple 
geographic areas/countries can be associated WITh your organization, you will also have to select 
the appropriate geographic area/countl)' (see Select a Geographic Area/Countl)' below). 

The organization selection determines the results data that will be available to you after entering 
the system. Note: you can edit results data only for your own organization. You can view, but 
not change, data for other organizations. 

To select a different organization to view, click on the arrow next to the Organization field; this 
causes the following screen to appear: 
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Each organization on the list has a yellow folder in front of fts name. If there is no symbol in front 
of the folder, the organization has no subordinate organizations below ft. 

A folder with a plus sign (+) in front of it indicates the organization has subordinate organizations 
which are not currently being displayed. To display the list of subordinate organizations, click on 
the plus sign. The.subordinate organizations will be displayed below the primary organization 
and the plus sign will change to a minus sign. 

A yellow folder with a minus sign (-) in front of it indicates a primary organization's subordinate 
organizations are displayed below. Click on the minus sign to "roll-up" the subordinate 
organizations into the primary organization; they will no longer be visible on the list and the minus 
sign will change to a plus sign. 

Click on the name of the organization which has th·e data you wish to review and click on the 
Close butlon. The organization you selected will appear in the field on the main menu screen. 
Continue by selecting a geographic area/country if more than one is associated with the 
organization (see below) and then select the Results Tracking option you wish to pursue (see 
below). 

Select a Geographic Area/Country 

If the organization selected in the previous step has more than one geographic area/country 
associated with it, you must select one before proceeding into the Results Tracking system. 
Click on the arrow next to the Geographic Area/Country field; this causes a list of names to 
appear. 

Click on the name of the geographic area/country which has the data you wish to review and then 
select the Results Tracking option you wish to pursue (see below). 

Select a Results Tracking Option 

The last step needed to enter the Results Tracking system is to select one of the following 
options from the Main Menu: 
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Click on the Go to Results Framework button It I to access the results framework for the 
selected organization and geographic area/country. The results framework is a graphic 
illustration of the hierarchy of contributing results that will lead to the achievement of the 
organization's strategic objective. All relevant operations and information can be accessed from 
the results framework. 

Click on the Go Directly to Measures button II to access the screen where measures (Le., 
the numeric values of results) are recorded, without going through the results framework. 

ij 
Click on the Run Reports/Queries button -""" For both Washington and field users, this 
option is the way to select and view results data that crosses organizational lines - for example, 
a query to look at all child survival objectives world-wide. For the field, this option is also the 
means to access data on other countries/organizations for which data is not available locally. A 
query is a request to the central database for information on results that meet selection criteria 
defined by the user. It results in a query dataset which can then be used to generate reports, or 
can be exported to another program (e.g., Lotus 123) for further manipulation. 

~: ~ 
r~'\~~ 
~ , 

To exit the Results Tracking system, click the Exit button ---,-,,-, . 

Main Menu Bar 

Rle Help 

The menu bar'on the Results Tracking Main Menu screen allows you to access the following 
options. Point to the menu item with your mouse and click, or press the Alt key and the 
underlined letter of the option. A drop-down menu will appear displaying available options. A 
menu item that appears gray indicates the topic is not active. An arrowhead to the right of an 
option indicates a second menu is available with additional options. 

ces 

The File option on the menu bar allows you to access the following operations: 

Preferences 

Exit 

8 

This screen allows authorized users, generally the System Administrator, to 
select the home organization (Le., the organization the user belongs to and is 
authorized to create data for) and the geographic areas the home organization 
will use to create results frameworks. Access this screen by selecting File and 
Preferences from the menu bar. 

Closes the Results Tracking main menu and exits the program. 
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~ontents 

jiearch for Help On .•• 
Using Help 
Glossary 
How to Get Started 

The Help option on the menu bar allows you to access the following help topics, including the 
Glossary. . 

Contents Displays a lisl of Help topics related to the Results Tracking system. 

Search for Help On... Displays a screen allowing you to type in a keyword or phrase to 
search for in the Help files. 

Using Help Displays information on how to use the Help function. 

Glossary. Defines Results Tracking terminology. 

How to Get Started Displays step-by-step instructions Jor the most common actions 
performed in the Results Tracking system. 

About Results Tracking Displays system information about the Results Tracking program. 
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Results Framework Screen 

This screen provides the basic graphic orientation showing how results are organized by country 
or organization. Each strategic, or other, objective is shown at the top of a hierarchy of 
subordinate results. Only the first few words of the objective/result name appear in the graphic -
box, due to space limitations. Objectives are arrayed across the screen from left to right. If all 
objectives are not visible, use the scroll bar at the bottom of the screen to move to the right to 
view the others. 

lo.<roKl'H",.~r«i" .. 1 ..... ,. . ..,:;_ ........ 

The results framework defines the critical results (or interrelated changes) which are necessary to 
achieve the selected strategic objective. The framework must provide enough information so that 
it (a) adequately illustrates the development hypothesis (or cause and effect linkages) 
represented in the strategy, thereby assisting in communicating the underlying premise ofthe 
strategy and (b) is useful as a management tool and, therefore, focuses on the key results, which 
must be monitored to indicate progress. 

In addition to strategic objectives, an organization may have resutts not associated with a 
strategic objective of that organization. These special objectives deal with situations such as: an 
activity that responds to a legislated earmark or special interest which cannot otherwise be met, 
an existing project or activity which is being phased out, a pilot activity in a new area, a research 
activity unrelated to the country portfolio, or the country-specific measurement of a regional 
objective. These will appear as resutts not connected to an operating unit strategic objective, 
although they may be shown as resutts hierarchies, i.e., with intermediate results contributing to 
the higher level results. 

10 Operations - Results Tracking 2 0 

. .: 



Results Framework Menu Bar 

File Edit View Options Help 

The menu bar on the Results Framework screen allows you to access the following options. 
Point to the menu item with your mouse and click, or press the Alt key and the underlined letter 
of the option. A drop-down menu will appear displaying available options. A menu item that 
appears gray indicates the topic is not active. An arrowhead to the rightof-an option indicates a 
second menu is available with additional options. 

Jiave 
Erint 
&Iose 

The File option on the menu bar allows you to perform the following operations: 

Save 

Print 

Close 

Exit 

find 
Find 

Saves any changes to the active Jramework. 

Displays the Print dialog box. 

Closes the active record. If changes were made to the framework that had not 
been saved, the system will prompt you to save them. If you choose No, the 
framework will close without saving any changes and the Results Tracking 
Main Menu will be redisplayed. 

Closes the results framework and exits the program. 

Ctrl+F 
F3 

The Edit option on the menu bar will appear gray until you highlight a result or objective. This 
option allows you to perform the following operations: 

Delete Removes the selected result(s). 

Find Displays a window enabling you to search for a specific result or all results. 

Find Next Searches for the next instance of the result specified in the Find window. 
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IextView 
Agency Framework 
.c.ommon Indicators 

The View option on the menu bar allows you to change the appearance of the framework on your 
screen. 

Graphic Format 

Text View 

Agency Framework 

Common Indicators 

Zoom 

Add Objective/Result 
rt~~~ ::.: :;·:"S-~~'hi 
.c.ustomer 
Measures/Indicators 
Drag Object 

Displays the results framework in a graphical format. 

Displays the results framework in a text format. 

Displays Agency goals and objectives in text format. 

Displays the list of Agency-wide standard indicators. 

Displays a second menu with options for changing the size of the 
framework showing on your screen. 

Zoom In Increases the size of the, results framework so that 
it is easier to read, but less of it is visible on your 
screen. 

Fit to Screen Forces the entire results framework graphic to be 
visible on your screen. 

Increase 30% Zooms in on the results framework by 30 percent. 

Increase 50% Zooms in on the results framework by 50 percent. 

Increase 100% Zooms in on the results framework by 100 percent. 

Zoom Out Decreases the size of the results framework so that 
more of it is visible on your screen. 

Unk 

The Options function on the menu bar allows you to perform the following operations. 

Edit Objective/Result 

Add Objective/Result 

12 

Displays the Edit Objective/Result screen, allowing you to edit or 
delete the selected objective or result. 

Displays the Add Objective/Result screen allowing you to add an 
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objective or result to the framework. 

Edit Causality Displays the Causality/Assumptions screen, allowing you to add or 
edit information about the causal link. This option is available only 
when a causal link is highlighted. 

Customer Displays the Target Customer screen, allowing you to add, edit, or 
delete target customer group information. 

Measures/Indicators Displays the Measures screen, allowing you to view and edit 
measures and indicator data for the selected objective or result. 

Drag Object Allows you to move a result from one position on the framework to 
another. Drag Object mode is indicated by a four-pointed cursor. 

Agency Objective Link Displays the Agency Objective Link, allowing you to link or unlink a 
result to Agency goals and objectives. 

~ontents 

liearch for Help On •.. 
Using Help 
Glossary 
How to Get Started 

About Results 

The Help option on the menu bar allows you to access the following help topics. 

Contents 

Search for Help On •.• 

Using Help 

Glossary 

How to Get Started 

Displays a list of Help topics related to the Resu~s Tracking 
system. 

Displays a screen allowing you to type in a keyword or phrase to 
search for in the Help files. 

Displays information on how to use the Help function. 

Defines Results Tracking terminology. 

Displays step-by-step instructions for the most common actions 
performed in the Results Tracking system. 

About Results Tracking Displays system information about the Results Tracking program. 

Editing Text 

The standard Windows functions of Cut, Copy, and Paste are available when a block oftext is 
selected (highlighted) in the Results Tracking system. To perform the function, use the following 
keystrokes. 

Cut Ctrl X . This function removes the selected text from the screen and places it 
onto the Clipboard. The text stays there until you clear the Clipboard, 
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Copy Ctrl C 

Paste Ctr/V 

Status Bar 

cut or copy other text onto it, or quit Windows. 

This function makes a copy of the selected text and places it onto the 
Clipboard, leaving the text in its original position. The text stays on the 
Clipboard until you clear the Clipboard, cut or copy other text onto it, or 
quit Windows. 

This function allows you to insert text from the Clipboard to the place 
where your cursor is located. 

Located just below the menu bar on the Results Framework screen is the status bar. The status 
bar will always show the Geo Area/Country of the framework you are working in. When an 
Operating Unit Objective or its associated intermediate result is selected, that text will be 
displayed. If the objective has been linked to an Agency Goal/Objective, those boxes will display 
the appropriate text. 

The status bar helps to keep you oriented to the Agency Goal/Objective, even when looking at a 
lower-level result. Click on·the Agency Goal, Agency Objective, or Operating Unit Objective to 
see a screen displaying the entire text. 

Agency Goal 
4: Enyironment managed 

f(J[ long-term 

Agency Goal 

Agency Objective 

Operating Unit 
Objective 

Country 

14 

Agency Objective Operati!l9' Unit Ohiecti\!e~ ... .~eo· ~ea/Countrji .. 
4.5: Sustainable natural . Mainlenimee of ,natural forest ..... J:oota'Ripa .. 

resource management habitat • :' .. .. 

A long-term development result in a specific strategic sector to which 
USAID programs contribute. There are currently five Agency goals. 

A significant development result that USAID contributes to, and which 
contributes to the achievement of an Agency goal. Several Agency 
objectives contribute to each Agency goal. 

, 

The most ambitious result (intended measurable change) that a USAID 
operational unit, along with its partners, can materially affect and for 
which it is willing to be held responsible. The strategic objective forms 
the standard by which the operational unit is willing to be judged in 
terms of its performance. The time-frame of a strategic objective is 
typically five to eight years for sustainable development programs, but 
may be shorter for programs operating under short term transitional 
circumstances or under conditions of uncertainty. This field will also 
show the SpeCial, Regional, or Strategic Support Objective, if that is 
selected. 

This field reflects the country whose data is showing on the results 
framework. 
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Toolbar 

The toolbar gives you quick access to several options. To determine the function of each button 
on the toolbar, move your mouse until it points to the button; a yellow tag will display the button's 
function. 

The results framework graphic may eventually become too large to appear on a single screen. 
The two zoom functions and the fit to screen option can be used to change the size of the 
graphic visible on your screen. 

Zoom Out 

Zoom In 

[] Fit to Screen 

~ Print 

[j] Delete 
~ ~I~ ~ 

[i) Help :g" ,-, 

~ Refresh 

r;:;;;;J 
~ 

Exit Results 
Framework 

This option decreases the size of the framework so that you see 
more of it on your screen. To keep a particular result centered 
during zoom functions, highlight it and then click on the zoom button. 
To keep several resutts centered, hold down the left mouse button, 
draw a rectangle around the area (a dotted line will appear around 
the area until you release the mouse button), and then click the 
zoom button. 

This option increases the size of the framework so that you see 
more of it on your screen. To keep a particular result centered 
during zoom functions, highlight it and then click on the zoom button. 
To keep several resutts centered, hold down the left mouse button, 
draw a rectangle around the area (a dotted line will appear around 
the area until you release the mouse button), and then click the 
zoom button. 

This option forces the entire resutts framework graphic to be visible 
on your screen. 

This option displays the Print dialog box, allowing you to print the 
current results framework. 

This option removes the highlighted item(s). 

This option enables you to get help for topics relating to the Resutts 
Tracking system. It is part of the toolbar on the Framework screen 
and, on other screens, appears in the upper right comer. 

This option redraws the framework after checking the database, so 
that both your changes and those of anyone else currently working 
on the framework will be displayed. Some objects (e.g., newly 
created unlinked results) may move when you refresh the screen. 

This option closes the current· results framework and returns to the 
Main Menu screen. 
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Selecting a Result or Causal Link 

When entering the results framework screen for the first time, no result is selected. 

To select a result, click on an objective or result; tt will appear outlined in red. Double click 
on the objective/result to bring up the Edit Objective/Result screen. 

To select a causal link, click on the line connecting two objectives/results; the link will tum 
red. Double-click on the line to access the Causality/Assumptions screen, which further 
defines the nature of the causal link. 

Pop-up Menu 

gdit Objective/Result 
!;.ustomer 
Measures/Indicators 
Qrag Object 
Agency Objective Link 

The pop-up menu is available after selecting (by clicking once) a result in the framework and 
pressing the right mouse button. Pop-up menu options, which are similar to those available from 
Options on the menu bar, consist of operations that can be performed on a specific result from 
within this screen, or via access to other screens which provide additional detailed information. 
Select an option bY'clicking on the menu list with the mouse or by pressing the underlined letter 
ofthe option on your keyboard. 

Edit Objective/Result 

Customer 

Measuresllndicators 
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Click Edit Objective/Result on the pop-up menu or press the letter E 
on'your keyboard to go to the Edit Objective/Result screen. This 
screen' allows you to edit the result level, result name, and 
description. Note: this option is also available from the Options 
menu,on the menu bar or by double-clicking on the result in the 
framework. 

After making changes, select OK to save any changes and return to 
the results framework screen, Cancel to ignore any changes made 
since the last save and return to the results framework screen, Save 
to keep any changes you made and stay on the Edit 
Objective/Result screen, or Delete to delete the result and its 
associated measures and indicators. 

Click Customer on the pop-up menu or press the letter C on your 
keyboard·forthe Target Customer screen. This screen allows you to 
identify the specific customer group targeted by the result, if 
appropriate. Note: this option is also available from the Options 
menu on the menu bar. 

Click Measuresllndicators on the pop-up menu or press the letter M 
on your keyboard for the Measures screen. This screen displays 
result level and name, information about the indicator, and the 
Measures Table containing planned and actual values. Access the 
Indicators screen from the Measures screen by, pressing the 
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Indicator button. Note: this option is also available from the Options 
menu on the menu bar. 

Drag Object Click Drag Object on the pop-up menu or press the letter D on your 
keyboard to restructure the results framework as needed. This 
function allows you to move a selected result to a new place on the 
screen. Drag Object mode is indicated by a four-pointed cursor. 
Hold the left mouse button down with the cursor on the selected 
result and drag it to a new position, then release the mouse button. 
You can move as many results as you wish while in the Drag mode; . 
select another result to drag by moving the cursor to that result. To 
de-select the drag function, double-click the left mouse button on an 
empty part of the screen or de-select "Drag Object" from the Options 
menu on the menu bar. Note: this option is also available from the 
Options menu on the menu bar and by double clicking on an empty 
part of the Framework screen. 

Agency Objective Link Click Agency Objective Link on the pop-up menu or press the letter 
o on your keyboard for the Agency Objective Link screen. This 
screen allows you to identify and link the specific Agency goal and 
objective to which the selected result contlibutes. 

Adding a New Objective/Result 

Click Add Objective/Result from the Options menu on the menu bar for the Add Objective/Result 
screen. Type in the result name and select a result level from the drop-down list box. If not an 
Intermediate Result, the Objective-Specific Dates fields will appear. Type in the dates requested 
in dd mmm yyyy format (e.g., 02 JuI1995). Type in a blief descliption, if desired, and press OK 
to save the information and exit the screen, press Cancel to exit the screen without saving any 
changes, or press Save to save the changes without exiting. The new objective/result(s) will 
appear on the framework screen and can be moved to the appropriate spot using the Drag 
Object function. Or you can link the result (see section 3.7) and ·press the Refresh button on the 
toolbar to have the system automatically move the result to the proper position. Any unlinked 
results will be moved to the light of the framework screen after pressing Refresh. 

Linking Results 

You may link a lower level result and the higher level result to which it contlibutes by positioning 
the cursor on the lower level result, holding down the left· mouse button, and stretching a line to 
the higher level result. The Causality/Assumptions screen will appear, allowing you to further 
define the nature of the causal link just drawn. 

Note: (1) A result can be connected to one or more higher level results under a single objective, 
(2) a result under one objective cannot be linked to a result under another objective, and (3) an 
objective-level result cannot be linked to another objective or to a lower level result. 

Zoom 

The results framework graphic may become too large to appear on a single screen. To see more 
or less of the total results framework, use the zoom functions, available from the View option on 
the menu bar or from the toolbar. 
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From the menu bar, 
• Zoom In increases the size of the framework so that it is easier to read, but you see less of it 

on your screen. 
• Fit to Screen forces the entire framework to be visible on your screen. 
• Increase % zooms in on the framework by 30, 50, or 100 percent. 
• Zoom Out decreases the size of the framework so that you see more of it on your screen. 

From the toolbar, 
• Zoom Out decreases the size of the framework so that you see more of it on your screen. 
• Zoom In increases the size of the framework so that it is easier to read, but you see less of it 

on your screen. 
• Fit to Screen forces the entire framework to be visible on your screen. 

To keep a particular result centered on your screen during zoom functions, highlight the result (it 
will appear outlined in red) and then select the zoom function from either the menu bar or the 

·toolbar. To keep several results centered, hold down the left mouse button and draw a rectangle 
around the area - a dotted line will appear around the area until you release the mouse button 
and the results will be centered. . 

Text View 

You can switch between the graphic representation of the results framework shown on the 
screen and a text version of the same infonnalion, showing the full result names arranged 
hierarchically in outline fonn. Select the desired view by choosing either Graphic Fonnat or Text 
Format from the View menu on the menu bar. Return to the graphic fonnat screen by clicking 
Close. 

File Edit -." ... 

I SO:- 'Maintenance of nalural forest habitat' 

Result Improved management and inte!Jrily of the national park. s'ystem 

Result: legal. market and price environment conducive to sustainable private forestry 

SO: A more streamlined, responsive ... efficient government 

Result: Fis:cal rationalization 

Result Increased operational responsiveness 

Result: Strengthened legislative and iudicial process 

.' , 
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Objective/Result Screen . , 

To access this~sic entry screen for defining a result, highlight the objective or result, press the 
right mouse button, and click Edit Objective/Result on the pop-up menu or press the letter E on _ 
your keyboard. You can also double-click on the result in the framework, or select Add 
Objective/Result or Edit Objective/Result from the Options menu on the menu bar. Add 
Objective/Result allows you to define a newly created result and Edit Objective/Result allows you 
to edit a result selected on the framework. 

Result Name 

Result Level 

This field may contain up to 80 characters (although it is preferable to be 
briefer, for purposes of displaying the name on the screen and on reports) and 
should be defined in terms of a brief statement of the intended result, rather 
than merely as a category, For example, rural vii/ages adopt sustainable 
agriculture production and practices, meets this test; merely stating agricultural 
production practices does not. The system will give you a warning if you 
attempt to create a duplicate objective-level name, but does not check for 
duplicate names at the Intermediate Result level. 

This field allows you to define or change the level of the result. Note: in order 
to change the level of a result that is linked to another result, you must first 
delete the link between the two results. Select one of the following options 
from the drop-down list box: 

Operating Unit Strategic 
Objective 

A strategic objective is the most ambitious 
result (intended measurable change) that a 
USAID operational unit, along with its partners, 
can materially affect and for which it is willing to 
be held responsible. 
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Description 

Intermediate Result A key result which must occur in order to 
achieve a strategic objective, other type of 
objective, or another intermediate result. 

Special Objective Refers to exceptional circumstances under 
which a Mission or Office may wish to include 
activities in its portfolio that could not qualifY as 
strategic objectives due to their limited
development impact, but which meet other US 
Govemment assistance objectives. This 
includes situations such as an activity that 
responds to a legislated earmark or special 
interest which cannot otherwise be met, an 
existing project or activity that needs additional 
time for orderly phase-out, a pilot activity in a 
new area, or a research activity unrelated to the 
country portfolio. 

Strategic Support Objective This objective is intended to capture and 
measure a regional or global development 
objective that is dependent on the results of 
other USAID operating units to achieve the 
objective but to which a global or regional 
program makes an important contribution. 

Regional Objective An objective that captures regional or global 
• strategic results for which the operating unit is 

responSible, but which transcend national 
boundaries. A regional objective may include' 
country-specific results in its framework. 

This field allows you to provide a more complete description of the result, up to 
1500 characters. 

Press OK to save the information and exit the screen, Cancel to exit the screen without saving 
any changes, Save to save the information without exiting the screen, or Delete to delete the 
result entirely. You can also press the Alt key and the underlined letter of the button. 

Objective-Level Results 

The following four fields appear in the Objective-Specific Dates field if the Result Level you 
select contains the word "Objective" (Le., any result level except Intermediate Result). Enter 
dates in dd mmm yyyy format (e.g., 01 Jul1995). Note: if a date is entered incorrectly, the 
system will either automatically convert it to the proper format or prompt you to enter a valid date. 
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Original Date Approved 

Last Date Approved 

Date Submitted 

Latest Date of Update 

The date the objective was first approved. 

The date the objective was approved after modification and 
resubmission. 

The date the objective was formally submitted to USAIDIW for 
approval. If the objective has been revised and resubmitted, enter 
the most recent submission date. 

The date the objective was last modified, if it has not yet been 
formally approved by USAIDIW. 
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Objective-Level Activities 

The Results Tracking system deals with results, as opposed to the activities necessary to 
achieve those results. The pOint of intersection between results and activities in the re
engineered operations system is the objective. That is, an objective (e.g., strategic objective, 
strategic support objective, special objective, or regional objective) is the highest level result for 
which an operating unit agrees to be held responsible. For the new financial systems, an 
objective is also the highest level activity to which the Budget system and AID Worldwide 
Accounting and Control System (AWACS) attribute funds. Therefore, the creation of an 
objective-level result in Results Tracking will automatically trigger the creation of a corresponding 
objective activity in AWACS. Once you have defined your objective in Results Tracking, you can 
then go to AWACS and find the objective, assign funding to it, and create subordinate activities 
for further distribution of the funds. 
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Target Customer Screen 

This screen allows you to define the particular customer group that is the intended beneficiary of 
the result. At a minimum, this must be defined for each objective, although the defined customer 
group may be the entire population. Definition of target customer groups for lower level results is 
optional. 

To access this screen, highlight the result, press the right mouse button, and click Customer on 
the pop-up menu, or select a result and click on Customer from the Options menu; the Target 
Customer screen will appear. 

:;:.;:;;. :';;:; .. :;.;; .. : .. ,.::::" .. : ': ........ :." ...... :: .•.•..... :,. 'farget Customer.~ IS1 ZOllr;.;;·: :':,;: : .. : .. :.;,;.:., .:.;';:; .... :;.; ,:;:::,,,:;:::;,, ;:;::;. 

The screen provides three ways to define customers: by geographic area, customer group, and 
gender. 

Geographic Designation The default selection is the Entire country. Select a particular 
sub-country area by clicking the Sub Country Area button. Type in 
the name of a sub country area or select one from the drop-down 
list box. Since sub-country areas will be unique to each country in 
which USAID operates, no pre-defined choices are provided by the 
system. Selecting sub-country areas which have previously been 
defined by the Mission/Office permits the aggregation of results for 
a particular area. 
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Customer Group 

Gender 

The default selection is All Groups in Selected Geographic 
Designation. Select a particular group by clicking the Group 
Indicated Below button. Type in the name of the customer group 
or select one from the drop-down list box. Customer groups may 
be characterized by ethnic origin, occupation, income, or other 
pertinent factor(s). Since customer groups will be unique to each
country in which USAID operates, no pre-defined choices are 
provided by the system. Selecting customer groups which have 
previously been defined by the Mission/Office permits the 
aggregation of results for a particular group. 

Select a gender designation by clicking the Male, Female, or Not 
Gender Specific button. Identifying a particular result as targeting 
males or females specifically is not the same as measuring the 
result disaggregated by gender. A given result may be targeted at 
both males and females, yet it may still be important to track the 
result on a gender-disaggregated basis; for example, in a program· 
to increase literacy for both men and women, you may still track 
literacy rates separately for each gender. This is done by defining 
separate indicators for each gender. In such a case, the result 
itself would be designated as Not Gender Specific. Alternatively, 
you could define separate results for males and females; in this 
instance, the result would be gender-specific. 

Press OK to save your selections and exit the screen or Cancel to exit the screen without saving 
your selections. You can also press the Alt key and the underlined letter on the button. 

The Delete button removes the entire customer record for the result. 
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Causality/Assumptions.Screen 

This screen allows you to provide details about the causal linkage between results, i.e., the line 
connecting two results on the results framework screen. The screen also allows you to enter a 
description of the Critical Assumptions. 

This screen is accessed (1) when a link is initially drawn, (2) by double-clicking on an existing line 
or (3) by clicking on a line and selecting Edit Causality from the Options menu on the menu bar. 

Editing a Causal Link Definition 

The lower level result is displayed in the left From box and the higher level result in the right To 
box. The nature of the causal link is defined in the large arrow between the lower and higher 
level results. The default linkage definition is causes/contributes to. It is not necessary to further 
define the nature of the causal link, but it is allowed. 

To edit a causal link definition, click on the Edit button located just below the large arrow; 
a text box appears in which further details can be entered. If you enter text here, it will 
appear on the results framework; if you retain the default language, only the line will show on 
the results framework. Click the OK button to return to the Causality/Assumptions screen. 

Critical Assumptions 

You may describe assumptions about the conditions under which the causal link is believed to 
hold true in the Description field at the bottom ofthe Causality/Assumptions screen. These may 
include assumptions about how the USAID intervention will operate, as well as assumptions 
about events beyond USAID's control, such as the activities of other donors. 
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Assumptions are presumed to be true when recorded; however, they may be assessed at some 
subsequent date as having proved to be either true or false. This is indicated by a label Y or N. 
In the Valid· column to the right ofthe description,<click the right mouse button to toggle-between 
Y, .N, and a blank field. 

Press the Save button to save your changes and remain on the screen, Cancel to exit the screen 
without saving your changes, or OK to save your changes and exit the screen. You can also 
press the Alt key and the underlined letter on the·button. 
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Agency Objective Link Screen 

This screen allows you to link an operating unit objective to the higher level goals and objectives 
of the Agency. All objectives must be linked to an Agency goalfobjective, so that the Agency can 
track which objectives in which locations are contributing to the achievement of the Agency's 
goals. 

Access this screen from the results framework by highlighting the objective, pressing the right 
mouse button, and clicking Agency Objective Link from the pop-up menu. Alternatively, you can 
highlight the objective and select Agency Objective Link from the Options menu on the menu bar. 

The Operating Unit Objective Name is displayed at the top of the screen and any previously 
defined links to Agency objectives are listed below. 

Agency Goal refers to the first level of disaggregation of the Agency's mission of sustainable 
development, i.e., the highest level of development results in a specific area to which USAID 
contributes. The five goals are: 

Broad-based economic growth achieved 
Sustainable democracies built 
World's population stabilized and human health protected in a sustainable fashion 
Environment managed for long-term sustain ability 
Lives saved, suffering reduced and development potential reinforced 
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,Wrthin each of these Agency goals, three to five objectives are defined which further break down 
the nature of USAID's development assistance. Agency Objective refers to a significant 
development result that USAID interventions contribute to, and which in tum contributes to 
achievement of an Agency goal. 

Linking to Agency Objectives 

A single primary link is required between each operating unit objective and an Agency goal or 
objective. This primary link is used to aggregate results in summarizing the Agency's,program. 

Additional links are secondary; for example, the objective of increasing contraceptive prevalence 
may primarily support the prevention of unintended pregnancies and secondarily support reduced 
transmission of STD/HIV. 

The designation of a link as "primary" controls what will be displayed on the Status Bar for other 
screens in the system. While you may make multiple secondary links, only the primary link will 
be displayed.on.the Status Bar. 

While more than one Agency objective can be selected, they must all be under the same Agency 
goal. An operating unit objective cannot be defined as r!,lating to two different Agency goals. 

28 

To establish a link, select the appropriate goal from the Agency Goals list box. This will 
cause related Agency objectives to be displayed in the list box'immediately below. Select the 
appropriate Agency objective. Click on the Type of Link (primary or secondary) and click on 
the Link button. If you try to define a primary link where one has already been defined, a 
message appears asking if you want to make the second link the primary. 

To keep the first link as primary, press No; the system will automatically select the 
secondary option for your link. 

To establish the second link as primary, press Yes; the system will automatically change 
the first link to secondary and insert the second link as the primary. 

To remove a link, click on the link in the Existing Links to Agency Objectives box and press 
the Unlink button. 
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Measures Screen 

This is the primary screen for recording target and actual values - i.e., measures - for a result. 
It can be accessed from the pop-up menu on the results framework screen by selecting a 
particular result. It can also be accessed from the Main Menu by clicking the Go Directly to 

Measures button ............ ~. 

If you enter this screen by selecting a result on the resutts framework, you will not be able to 
select a different result. If you enter this screen from the main menu, select the desired result 
from the Result Name drop-down list box. Since a result may have more than one indicator; also 
select the desired indicator from the drop-down list box. Note: indicator names are sorted first by 
whether they are quantitative (these appear first in the list) or qualitative, then alphabetically. 

The Measures screen displays the result name, result level, indicator name, and information 
about the indicator. To see additional information about the result, press the Result •.. button at 
the lower left comer ofthe screen. This will take you to the Results screen, where you can view 
the result information. 

For help, press the 1::;t:1 button in the top right comer of the screen. 
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Indicator Definitions 

The following fields provide information about the indicator. This information can only be viewed 
on the Measures screen. To make changes to the indicator information, press the Indicator 
button at the lower left comer of the screen. This will take you to the Indicators Screen, where 
you can view or edit the indicator information. Press OK if you make any changes to return to 
the Measures screen. 

Indicator Name 

Source Doc 

Source Org 

Proxy/Direct 

,Direction 

This field specifies the particular characteristic or dimension used to 
measure the intended changes. It should include the name, 
definition, and the formula used to calculate the indicator, if 
appropriate. 

This field defines the name of the source document which provided 
data for the indicator. For example, the source document may be 
Table 13 of the Annual Report on XXXXXX, published by the World 
Bank. It is important to provide the specific page or table from which. 
the data was drawn, not just the name of the publication. If the 
source is a local survey undertaken by the operating unit, it is not· 
necessary to define the source organization (e.g., a USAID 
contractor) unless desired. 

This field defines the name of the organization responsible for 
producing the source document; for example, you may have used 
information from the World Bank. If the source is a local survey 
undertaken by the operating unit, it is not necessary to define the 
source organization (e.g., a USAID contractor) unless desired. 

This field shows whether the indicator is a direct measure of the 
resutt or a proxy measure. Generally, direct indicators are preferred 
for defining the resutt. However, in some cases, the direct indicator 
will not be available at the time, or with the frequency desired, for 
measuring performance against the target. For example, a strategic 
objective to reduce infant mortality over five years may define as the 
direct indicator census data published only at the end of each 
decade. In order to measure progress toward the objective, 
additional proxy indicators may be defined, such as percentage of 
children receiving vaccinations. (Of course, this indicator may 
actually be a direct indicator for a lower-level result contributing to 
the strategic objective.) You are not able to change the Proxy/Direct 
designation on the Measures screen. 

This field allows the system to evaluate the actual measures 
reported in comparison to target values, and to make judgments 
about what should be flagged for management attention. You are 
not able to change the Direction designation on the Measures 
screen. 

Higher = Better The desired result is a higher value, e.g., for 
gross domestic product. 

Exact In rare cases, neither a higher or lower value 
than the target is desired, only that the target be 
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-
Expressed As 

Period 

Lower = Better 

met exactly. 

The desired result is a lower value, e.g., for 
infant mortality. 

This field displays the decimal deSignation of ones, thousands, or 
millions. Ifthousands was the selection, for example, a value of 
10,000 would be entered on the Measures table as 10. You are not 
able to change this deSignation on the Measures screen. 

This field displays the designated period, or the planned frequency 
of measurement, which defines the columns on the Measures table. 
You are not able to change this designation on the Measures 
screen. 

Measures Table 

This table, at the bottom of the Measures screen, contains the numeric values, or measures, in 
traditional spreadsheet fonn. The columns reflect the period in which the measures took place. 
The default number of columns is 25, although up to 200 columns can be displayed depending on 
the period type. Use the horizontal scroll bar to see any additional columns not visible on the 
screen. To expand the number of columns incrementally, scroll to the. right edge of the table and 
click on any cell in the last two columns. This will trigger the addition of additional columns to the 
right when you press the Tab key orthe right arrow key. 

Click on the check box at the top of the table to select or de-select the Show Decimals option. If 
checked, the measures will display two decimal places; if not checked, the measures will display 
whole numbers. 

Entering Data 

Notes 

To fill in a value, use the mouse to highlight a field (it will appear with a frame 
around it), and then type in the number. You can enter up to seven integers, 
or five integers plus two decimal places. Use the Show Decimals check box 
to choose the desired display. The system will not allow you to enter actual 
data for future periods. Use the Tab key or the mouse to move to the next 
field. 

You can attach a note to each cell in the measures table by clicking on the 

cell and pressing the Note button Il'~H. A screen will appear allowing you to 
record a note pertaining to that cell, or to view a· previously recorded note. A 
value displayed in bold type will indicate the presence of a note for that cell. 

This cell-specific mode differs from the Assess field at the bottom of the 
column, which is intended to explain how the various values for that period 
(target vs. actual vs. trend) relate to each other. 

Unit of Measure This field displays the element in which the measures for this indicator are 
expressed, for example, "tons of soil" or "number of deaths." This field may 
also be used to record the fonnula for calculating the indicator. 
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Row Definitions 

Six rows are available on the table: 

Actual 

Target 

Hi Target 

This row allows you to enter the actual value observed for the indicator. At least 
the first period's value should be recorded at the time the result is established, as 
this is generally the baseline. You can enter actual data only for the current and 
past periods. -

This row allows you to record the specific, intended measure to be achieved. 
Actual values will be compared against values in this row. 

This row, in conjunction with the lo Target row, is an attemative to using the 
Target row when a range of target values is desired. Hi and lo targets are defined 
literally, Le., the Hi Target must be higher than the lo Target. 

You can define either a Target or a Hi/lo Target range - not all three. To switch 
between Target and HUlo Target, delete the values in the row{s) you do not want 
to use; this will activate the row{s) you do want to use. 

La Target This row, in conjunction with the Hi Target row, is an alternative to using the Target 
row when a range of target values is desired. Hi and lo targets are defined 
literally, Le., the lo Target must be lower than the Hi Target. 

Trend 

Narrative 

You cannot define either a Target or a HULo Target range - not all three. To 
switch between Target and Hillo Target, delete the values in the row(s) you do not 
want to use; this will activate the rsw(s) you do want to use 

This row allows you to enter information about what could be expected to happen if 
USAID did not intervene. This information is not required, but is sometimes useful 
to capture when formulating and explaining the operating unit's planned/target 
values. 

The value for the baseline period in the table, or any prior periods, should be equal 
to the actual value(s) for that period(s). If Trend data has not been entered before 
the baseline is established, the system will fill in this information .with Actual values 
for the baseline and prior periods. 

This row allows you to indicate the presence of an assessment, Le., an explanation 
of the variance between the target and the actual values for that column. You can 
enter a narrative in this cell whether or not there are any values in the other rows 
for that column. 

To enter a value in a cell on the measures table, click on the appropriate cell to highlight it and 
type in the number. You can enter up to seven numbers, or five numbers with two decimal 
places. 

To add or edit a note for any cell,. click on the cell and then on the Note n~:J button. A value in 
bold type indicates a note has been recorded for that cell. Notes can be added only to cells with 
values, except in the Narrative row, where values are not recorded. A note for a Narrative cell 
will be indicated by the word "Note" in bold type. 
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Performance Measures Status 

The s¥stem.will flag variances between target and actual values by color coding the relevant cell. 
If an actual value does not meet the target (either greater or lesser, depending on the Direction 
defined on the Indicator screen), the cell will show a red background if it is a Direct indicator and 
Yellow if it is Proxy. -

If Y9u elect to define a target range, i.e., Hi Target and Lo Target, and the Direction is defined as 
Lower-Better, then you must enter data literally, i.e., the Hi Target will be the higher number, 
even though higher is less desirable, and the lower number mustbe the Lo Target, even though 
this is more desirable. The red/yellow color coding will show only ifthe'actual value is higher 
than the Hi Target. 

Measures Screen Operations 

The toolbar buttons on the right of the screen allow you to perfomn specific operations, 

Note Pressing this button allows you to add or edit a note about the value recorded in a 
specific cell on the the measures table. 

Graph Pressing this button displays the Measures Graph, a color-coded representation of 
the quantitative data in the Measures table. 

Projection Pressing this button takes you to the Projection screen, which allows you to have 
the system calculate future values based on a defined percentage change. If a 
value is not selected in the Measures Table, the system will prompt you to select a 
cell with a value. The system will then project data from that specific value, 

Baseline Pressing this button allows you to define the baseline for a particular series of 
numbers on the Measures screen. 

The command buttons at the bottom of the screen allow you to go to another screen or to 
perfomn specific operations from this screen, Click on the button or press the Alt key and the 
button's underlined letter. 

Result 

Indicator 

Save 

Cancel 

OK 

Pressing this button displays the Objective/Result screen, allowing you to view 
infomnation about the result. 

Pressing this button takes you to the Indicators screen, where you can view and 
edit infomnation for the indicator, 

Pressing this button allows you to save the current data on the screen to the 
database without exiting the screen. 

Pressing this button allows you to close the screen without saving any data you 
may have changed. The system will prompt with a message that data has 
changed, giving you the opportunity to either save the changes or exit without 
saving. 

This button allows you to save data to the database, close this screen, and 
retum to the previous screen. 
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Defining a Baseline 

A baseline is the point used for comparison when measuring progress towards objectives or 
results definedln a results framework. Ideally, the baseline will be the value of the performance 
indicator just prior to the implementation ofthe USAID activity. 

On the Measures Table on the Measures screen, move your cursor to the cell in the Actual row 
representing the starting point for the USAID intervention and press the Baseline button. The cell 
background will change color to light blue to indicateJhe.baseline.designation. Generally,.the 
baseline will be the earliest actual data point, but this may not be the case if you choose to enter 
histOrical data for periods preceding USAID intervention. 
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-Qualitative Measures Screen 

This screen provides an altemative to the quantitative measures screen, to address situations 
where measures of performance cannot be reduced to a number. This is defined on the 
Indicators screen by the Quantitative/Qualitative radio buttons. If you select Qualitative, the 
screen format will change to produce this screen. As with the Measures screen, the top of the 
Qualitative Measures screen displays the result name, result level, and indicator name; the 
middle section provides information about the selected indicator; and the bottom of the screen 
contains the "measures' -- in this case, narrative information about the target and actual. 
performance. 

F~r help, press the !i;ltl button in the top right comer of the screen. 

Qualitative indicators may be ordinal, i.e., one or two word labels such as Completed/Not 
Completed or Good/Fair/Poor, or they may be lengthier, free-form text descriptions. 

The following fields provide information about the indicator: 

Source Doc This field defines the name of the source document which provided 
data for the indicator. For example, the source document may be 
Table 13 of the Annual Report on XXXXXX, published by the World 
Sank. It is important to provide the specific page or table from which 
the data was drawn, not just the name of the publication. If the 
source is a local survey undertaken by the operating unit, it is not 
necessary to define the source organization (e.g., a USAID 
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Source Org 

Select Period 

Proxy/Direct 

Period 

Projected 

Actual 

Target Assessment 
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contractor) unless desired. 
This field defines the name of the organization responsible for 
producing the source document; for example, you may have used 
information from the World Bank. If the source is a local survey 
undertaken by the operating unit, it is not necessary to define the 
source organization (e.g., a USAID contractor) unless desired. 

This field provides a drop-down list box from which you can select a 
period to view/edit in the Projected and Actual fields. 

This field shows whether the indicator is a direct measure of the· 
result or a proxy measure. Generally, direct indicators are preferred 
for defining the result. However, in some cases, the direct indicator 
will not be available at the time, or wHh the frequency desired, for 
measuring performance against the target. For example, a strategic 
objective to reduce infant mortalHy over five years may define as the 
direct indicator census data published only at the end of each 
decade. In order to measure progress toward the objective, 
addHional proxy indicators may be defined, such as percentage of 
children receiving vaccinations. (Of course, this indicator may 
actually be a direct indicator for a lower-level result contributing to 
the strategic objective.) You are not able to change the Proxy/Direct 
designation on the Measures screen. 

This field displays the planned frequency of measurement. You are 
not able to change this designation on the Measures screen. 

This field is the projected, or target, objective of the indicator. 

This is the actual objective achieved, in a narrative format. 

In contrast to numeric values, the system cannot determine whether 
a narrative target is met or not. Therefore, you must enter this 
information after entering the narrative description of what occurred 
during the period. Use the appropriate radio button to signal Target 
Met, Target Missed, or See Narrative. Press the Narrative 
command button to pop up a text window and enter an explanation, 
if desired. Note that this command button is available regardless of 
which radio button is selected. 
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Indicators Screen 

This screen controls display and updates for the indicators tied (through measures) to a specific 
result. It also allows you to define one or more performance indicators for a given result. Access 
this screen from the Measures screen by pressing the Indicator button. The result name, result 
level, and indicator name are displayed at the top of the screen. Note: indicator names are 
sorted first by whether they are quantitative (these appear first in the list) or qualitative, then 
alphabetically. 

For help, press the W button in the top right comer of the screen. 

r
oo
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Maintenance of natural foreSt Costa Rica 

habitat 

To see additional information about the result, press the Result, •• button at the top right comer of 
the screen. This will take you to the Objective/Result screen, where you can view the description 
and any applicable dates. Press Cancel to return to the Indicators screen. 

Since a result can have more than one indicator, click on the Indicator arrow to see a drop-down 
list of other indicators that can be selected. 

Indicator Definitions 

The following fields allow you to define the indicator: 

Indicator Name This field should specify the particular characteristic or dimension 
used to measure the intended changes. It should include the name, 
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Unit of Measure 

Description 

Proxy/Direct 

definition, and the formula used to calculate the indicator, if 
appropriate. If you need more room to provide additional details 
about the indicator, press the Description button to access the 
Indicator Description text field. 

The element in which the measures for this indicator are expressed, 
for example, "tons of soil" or "number of deaths." This field may also 
be used to record the formula for calculating the indicator if it is not 
recorded in the Indicator Name field. 

Pressing this button displays a·pop-up screen, enabling· you to 
provide a more detailed description of the indicator. 

This field defines the indicator as either a direct measure of the 
result or a proxy measure. Generally, direct indicators are preferred 
for defining the result. However, in some cases, the direct indicator 
will not be available at the time, or with the frequency desired, for 
measuring performance against the target. For example, a strategic 
objective to reduce infant mortality over five years may define as the 
·direct indicator census data published only at the end of each 
decade. In order to measure progress toward the objective, 
additional proxy indicators may be defined, such as percentage of 
children receiving vaccinations. (Of course, this indicator may 
actually be a direct indicator for a lower-level result contributing to 
the strategic objective.) Click on either Proxy or Direct to define the 
indicator. • 

Quantitative/Qualitative An indicator defined as quantitative (Le., numeric) is preferred to one 
defined as qualitative (Le., a narrative measure that cannot be 
reduced to numbers). Quantitative measures aid in the consistent, 
accurate aggregation of results. If you identify an indicator as 
Common, the Quantitative designation is automatically selected. If 
you identify an indicator as Local, click on either Quantitative or 
Qualitative. 

Required for Tracking This field is used by the operating unit to reflect specific instructions 
given by USAIDIW in its approval of the strategic objective. The 
results framework may contain many results which can be 
measured, but USAIDIW may wish to stipulate that certain indicators 
must be tracked. Ifthis is stipulated in the approval document from 
USAIDIW, the operating unit should designate these indicators in the 
system by clicking on the check box to -make an "X' appear. 

Common/Local A common indicator comes from the Agency's list of standard, 
approved indicators. Wherever pqssible, use a common indicatono 
aid in the conSistent, accurate aggregation of results. A local 
indicator is used when common indicators are not applicable and will 
always be used when defining an.indicator·as qualitative. Click on 
either Common or Local to define the indicator. 

Expressed As Select the designation (ones, thousands, millions) that will be used 
for the specific indicator. The value you self;lct will then be reflected 
on the Measures screen. 
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Direction 

Period 

Initial Measures Data 
Period 

Source Document Name 

Source qrganization 

This field allows the system to evaluate the actual measures 
reported in comparison to target values, and to make judgments 
about what should be flagged for management attention. You are 
not able to change the Direction designation on the Measures 
screen. 

Higher = Better The desired result is a higher value, e.g., for 
gross domestic product. 

Exact In rare cases, neither a higher or lower value 
than the target is desired, only that the;target be 
met exactly. 

Lower = Better The desired result is·a lower value, e.g., for 
infant mortality. 

Select the period designation (yearly, Quarterly, Monthly) that will be 
used for the specific indicator. The value you select will then be 
reflected on the Measures screen. It will also be reflected on the 
Qualitative Measures screen. 

This field defines the first period for which you intend to record data, 
which may be earlier than the start of your activity. The format for 
the field depends on the Period you selected (Yearly, Quarterly, 
Monthly) and defines the columns in the Measures Table. This 
period must be between the years 1980 and 2100. 

This field defines the name of the source document which provided 
data for the indicator. For example, the source document may be 
Table 13 of the Annual Report on XXXXXX, published by the World 
Bank. It is important to provide the specific page or table from which 
the data was drawn, not just the name of the publication. If the 
source is a local survey undertaken by the operating unit, it is not 
necessary to define the source organization (e.g., a USAID 
contractor or PVO) unless desired. 

This field defines the name ofthe organization responsible for 
producing the source document; for example, you may have used 
information ·from the World Bank. Ifthe source is a local survey 
undertaken by the operating unit, it is not necessary to define the 
source organization (e.g., a USAID contractor or PVO) unless 
desired. 

Indicator Screen Operations 

The command buttons at the bottom of the screen allow you to perform specific functions on this 
screen. Click on the button or press the Alt key and the button's underlined letter. 

Add Pressing this button allows you to add an indicator for the current result; a blank 
Indicators screen will appear. Select either Common or Local and the rest of the 
screen will appear. 
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Delete 

Save 

Cancel 

OK 

To add a Common indicator, press the Common button and choose an 
indicator from the Indicator drop-down list. 
To add a Local indicator, press the Local button. All of the fields will activate, 
allowing you to change the default selections. Once you have defined the 
indicator, press OK to accept and return to the preVious screen. Note: the 
Period field for a local indicator cannot be changed in the Edit mode once 
defined. 

Pressing this button allows you to delete the selected indicator. 

Pressing this button allows you to save the current data on the screen to the 
database without exiting the screen. 

Pressing this button allows you to close the screen without saving any data you 
may have changed. The system will prompt with a message that data has 
changed, giving you the opportunity to either save the changes or exit without 
saVing. 

This button allows you to save data to the database, close this screen, and 
return to the preVious screen. 

Agency Common Indicators 

The Agency has defined a.number of common, i.e., standard, indicators for various objectives, 
with the intent of being able to aggregate results across countries. Unless we are consistently 
counting the same thing in each country, we cannot add up the results, so the use of common 
indicators wherever possible.is highly desirable. However, it is recognized that common 
indicators will not always be applicable, so the option to define a local indicator is also available. 

To define an indicator, use the radio button to select either Common or Local. (A 
qualitative indicator will always be Local.) If you select Common, this will activate the 
drop-down menu containing the approved Agency common indicators. Double-clicking to 
select a common indicator will result in the appropriate fields (discussed below) for that 
indicator being filled in. 

An Agency Common Indicator mayor may not include a designated source. In some instances, 
it is important that we consistently use the same data source so that numbers across the Agency 
are consistent; in other instances, it is critical that each operating unit report on the same 
indicator, but data must be collected locally for that indicator. 

Only the following fields can be edited for Agency Common Indicators: Proxy/Direct, Required 
for Tracking, Source Organization, and Source Document Name. 
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Measures Graph 

Pressing the Graph button on the Measures screen displays a window with a graph of the values 
contained in the Measures Table. The graph title is the indicator name and the two axes ofthe 
graph represent the period and expressed as values. 

The graph can be modified by clicking the right mouse button anywhere on the screen and 
selecting from the following pop-up menu of options. 

General ••• 

PI.!!.t ... 
1!.eries ~ 

~s ~ 

legend ••• 
Iitle ... 
footnote ••• 

~opy 

f!aste 
Print. •• 
Save As ... 
load ••• 

General 

Plot 

Series 

Click the General option to see the Fomnat Chart dialog box with tabs for Options 
and Backdrop. The Options tab allows you to specify the display of the title, 
footnote, legend, secondary Y axis (if appropriate), and text. The Backdrop tab 
allows you to specify the fill type, frame type, and picture size. 

Click the Plot option to see the Fomnat Plot dialog box with tabs for Type, Location, 
Backdrop, Order, and Base and Walls. The Type tab allows you to specify the 
type of chart you wish to create. The Location tab allows you to specify where you 
want the chart located in the window. The Backdrop tab allows you to specify the 
fill type, frame type, and picture size. The Order tab allows you to specify how you 
want the series ordered. The Base and Walls tab allows you to specify the fill and 
outline types. . 

The Series option gives you access to the following additional options: 
Click the Series option to see the Select Data Series dialog box. Highlight one of 
the series in the list (actual, target, hi target, 10 target, or trend) and press the 
Select button. 'The Fomnat Series dialog box will appear with tabs for Options, 
Line, Markers, Statistics, and Guidelines. Select the tab to specify options for the 
display of that item. 

Label Click the Label option to see the Select Data Series dialog 
box. Highlight one of the series in the list (actual, target, hi 
target, 10 target, or trend) and press the Select button. 
The Format Series Label dialog box will appear with an 
Options tab, which allows you to specify the location and 
line style of the chart label. 
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Data Point 

Data Point Label 

Click the Data Point option to see the Select Data Point 
dialog box. Highlight one of the series in the list (actual, 
target, hi target, 10 target, or trend) and the data pOint (the 
period specified on the Measures Table) and press the 
Select button. The Fonnat Data Point dialog box will 
appear with a Markers tab, which allows you to specify the 
look of the data point markers. 

Click the Data Point Label option to see the Select Data 
Point dialog box. Highlight one of the series in the list 
(actual, target, hi target, 10 target, or trend) and the data 
point (the period specified on the Measures Table) and 
press the Select button. The Fonnat Data Point Label 
dialog box will appear with an Options tab, which allows 
you to specify the location and line style of the data point 
·Iabel. 

Axis The Axis option gives you access to the following additional options: 

Legend 

Title 

Footnote 

Copy 

Paste 

Print 
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Click the Axis option to see the Select Axis dialog box. Highlight one of the axes 
listed (X axis, Y axis, secondary Y axis) and press the Select button. The Fonnat 
Axis dialog box will appear with tabs for Options, Grid, Scale, and Ticks. Select 
the tab to specify options for the display of that item. 

Labels 

Title 

Click the Labels option to see the Select Axis Label Set dialog. box. 
Highlight one of the axes listed (X axis, Y axis, secondary Y axis) and 
press the Select button. The Fonnat Axis Label dialog box will appear 
with tabs for Backdrop, Text, Font, and Fonnat Code. Select the tab 
to specify options for the display ofthat item. 

Click the Title option to see the Select Axis dialog box. Highlight one 
of the axes listed (X axis, Y axis, secondary Y axis) and press the 
Select button. The Fonnat Axis Title dialog box will appear with a tab 
for Text, allowing you to· specify title text· options. 

Click the Legend option to see the FonnatLegend dialog box with tabs for 
Backdrop, Font, and Location. The Backdrop tab allows you to specify the fill type, 
frame type, and picture size. The Font tab allows you to specify the style, size, 
and color of the font. The Location tab allows you to specify where the legend will 
appear on the «hart. 

Click the Title 'option to see the Fonnat Title dialog box with tabs for Backdrop, 
Text, Font, and Location. The Backdrop tab allows you to specify the fill type, 
frame type, and picture size. The Text tab allows you to specify,the display ofthe 
title. The Font tab allows you to specify the style, size, and color of the font. The 
Location tab allows you to specify where the legend will appear on the chart. 

Click the Footnote option to see the Fonnat Footnote dialog box with a tab for 
Location, which allows you to specify where the footnote will appear on the chart. 

Click the Copy option to·make a copy of the chart and place it onto the Clipboard. 

Click the Paste option to insert the contents ofthe Clipboard onto the chart. 

Click the Print option to see the Print dialog box with tabs for Print, Page Setup, 
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Save As 

and Pnnt Setup. 

Click the Save As option to save·the chart with another name or in another 
4!irectory. 

Load Click the Load option·to load the chart into another file. 
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Projection Screen 

This screen gives you the option to have the system calculate future target or trend values (but 
not actual values) based on a defined percentage change. It is accessed from the Measures 
screen by pressing the Projection button. 

You must first define the starting pOint for a projection by identifying the value on the Measures 
screen on which the calculations will be based (the system will not accept an empty cell as the 
starting point). Identify the column and row·in the measures table by selecting (Le., highlighting) 
that cell before pressing the Projection button. When you go to the Projection screen, the top 
portion of the screen will display the starting point you have defined. 

: . 
• <;-" 

; , 

.... : .. 

Once you have defined the projection starting point and invoked the Projection screen, you must 
next identify what is to be projected - either Target, Hi Target, Lo Target, or Trend by choosing 
the appropriate radio button. (This may be different than the starting point defined above. For 
example, you may use an·actual value as the starting point to project future target values.) You 
must also identify the number of periods to be projected. 

There are two types of projections possible, linear and non-linear. Use the appropriate radio 
button to choose the desired method. 

Linear Projection 
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Linear projections, or straight line projections, assume the same 
percentage change in each future period. Select the percentage 
change desired by using the spin dial button to change the value in 
the field, or type the desired change directly into the field. 
Percentages are expressed as whole numbers, e.g., an annual 
increase of 5% is shown as 5 not .05. The system assumes a 
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Non-linear Projection 

positive trend unless you indicate negative by typing in a minus sign 
ahead ofthe number, or select a minus number using the spin dial. 

Non-linear projections allow for the possibility that the rate of change 
will vary over time. Enter the rate of change for each period desired 
by typing in the value. As with linear projections, the system 
assumes the change is positive unless a minus sign is typed ahead 
of the number. 

The screen for a non-linear projection is shown below. 

, ' .. 

Defining a Projection Algorithm 

The information in the Starting Point of Projection is provided from the Measures screen. Enter 
the desired parameters on the rest of the screen and press OK to execute the calculation and 
return to the Measures screen, or press Save to execute the calculation and remain on this 
screen. By pressing Save, additional projections can be created; for example, you may have 
projected the trend line and now you wish to project the target values. 

Although it is easy to project data out for a large number of periods, storing all the data may slow 
your system's response time. The system will caution you if you appear to be projecting an 
excessive amount of data. 

When you return to the Measures screen, the projected values will appear in the appropriate 
rows and columns. Projected values can be overwritten in the Measures screen if you wish to 
adjust them. 
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Reports/Queries Sc.reen 

This screen allQllJs you to view and print standard reports, generate a query to the database by 
selecting specific data, and design a customized report. At this time, the Queries and 
Customized Reports options are not available. 

This screen is accessed from the Main Menu by clicking the Run Reports/Queries button 

Click on the name of the report you wish to see and click on the OK button. A screen allowing 
you to define the report will appear. 
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Summary Reports by Agency Goal/Objective 

This report provides totals (Le., a frequency count) of strategic objectives sorted by Agency goals 
and objectives, and by region or country. Three fields allow you to define the desired level of 
detail and scope of the report. 

Field 1 allows you to define the report to show only the Agency Goal level orto show the Agency 
Objectives associated with the Agency Goal. Click on the appropriate button. 

Field 2 allows you to define the report to show all goals/objectives or to show only selected 
goals/objectives. Click on the appropriate button. If you choose "Show only selected 
goal(s)/objective(s)," the following list appears: 

Click on the desired goal/objective. If you select a goal, all of the associated objectives will also 
be selected. De-select any that do not apply by clicking once on the name of the objective. 
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Field 3 allows you to define the report to show all regions or to show only selected regions. Click 
on the appropriate button. If you choose "Show only selected region(s)." the following list 
appears: 

Click on the desired region. 

The Print Report button will send the report to your printer, the Print Setup butt~m allows you \0 
define printer and paper. variables, the View Report button allows you to look at the report o·n
screen without printing, and the Create Export File button allows you to save the report data as 
a text or Lotus 123 file. Cancel returns you to the Reports Menu screen. 
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Results and Measures Summary 

This report provides a listing of key results, indicators, and measures for the selected country, 
organization, or objective. Four fields allow you to define the desired level of detail and scope of 
the report. 

Field 1 allows you to define the report to show one or many organizations OR one or many 
countIies. Click on the appropriate organization or Country button, scroll through the list using 
the arrow buttons, and click on the name of the organizations/countIies you wish to see in the 
report. 

Field 2 allows you to define the report to show all goals/objectives or to show only selected 
goals/objectives. Click on the appropriate button. If you choose 'Only those highlighted below," 
the following list appears: 
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Click on the desired goaVobjective. If you select a goal, all of the associated objectives will also 
be selected. De-select any that do not apply by clicking once on the name of the objective. 

Field 3 allows you to define the report to show objective-level resutts only or to show all resutts in 
the results framework. Click on the appropriate button. 

Field 4 allows you to include any comments recorded in the measures table. Click on.the 
appropriate button. 

The Print Report button will·send the report to your printer, the Print Setup button allows you to 
define printer and paper variables, the View Report button allows you to look at the report on
screen without printing, and the Create Export File button allows you to save the report data as 
a text or Lotus 123 file. Cancel retums you to the Reports Menu screen. 
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Objective Summary 

This report provides a text summary of information relating to selected strategic objectives, but 
not including actual measures. Three fields allow you to define the desired level of detail and 
scope ofthe report. 

Field 1 allows you to define the report to show one or many organizations OR one or many 
countries. Click on the appropriate Organization or Country button, scroll through the list using 
the arrow buttons, and click on the name of the organizations/countries you wish to see in the 
report. 

Field 2 allows you to define the report to show all goals/objectives or to show only selected 
goals/objectives. Click on the appropriate button. If you choose "Only those highlighted below," 
the following list appears: 
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Click on the desired goal/objective. If you select a goal, all of the associated objectives will also 
be selected. De-select any that do not apply by clicking once on the name of the objective. 

Field 3 allows you to define the report to show objective-level results only or to show all results in 
the results framework. Click on the appropriate button. 

The Print Report button will send the report to your printer, the Print Setup button allows you to 
define printer and paper variables, the View Report button allows you to look at the report on
screen without printing, and the Create Export File button allows you to save the report data as 
a text or Lotus 123 file. Cancel returns you to the Reports.Menu screen. 

52 Operations - ResultsTracking 2.0 



Results Status 

This report provides a comparative status of results for one or more organizations or countries, 
based on the most recent actual data available as compared to target measures. Five fields 
allow you to define the desired level of detail and scope of the report. 

Field 1 allows you to define the report to show one or many organizations OR one or many 
countries. Click on the appropriate Organization or Country button, scroll through the list using 
the arrow buttons, and click on the name of the organizations/countries you wish to see in the 
report. 

Field 2 allows you to define the report to show all goals/objectives or to show only selected 
goals/objectives. Click on the appropriate button. If you choose "Only those highlighted below," 
the following list appears: 
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Click on the desired goal/objective. If you select a goal, all of the associated objectives will also 
be selected. De-select any that do not apply by clicking once on the name of the objective. 

Field 3 allows you to define the report to show objective-level resuHs only or to show all resuHs in 
the resuHs framework. Click on the appropriate button. 

Field 4 allows you to include all resuHs, whether or not they met their target, orto include only 
the results that did not meet their target. Click on the appropriate button. 

Field 5 allows you to include any comments recorded in the Narrative row·ofthe measures table. 
Click on the appropriate button. 

The Print Report button will send the report to your printer, the Print Setup button allows you to 
define printer and paper variables, the View Report button allows you to look at the report on
screen without printing, and the Create Export File button allows you to save the report data as . 
a text or Lotus 123 file. Cancel returns you to the Reports Menu screen. 
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straightfOlward measurement characteristic or dimension that is framed at the same level as the 
objective or result for which ft has been defined, grounded in theory and practice, and accepted 
by both skeptics and proponents of the relevant program as a valid indicator of whether the 
objective has been met. 

Hi Target Used.in combination with La Target, as an alternative to defining a single target 
when ft is desirable to define a range. Hi target always refers to the numerically higher value in 
the range, regardless of whether that value is more desirable. Thus, for an infant mortality 
indicator, the hi target represents the minimum desired change. 

Indicator A particular characteristic or dimension used to measure intended changes defined 
by an organizational unWs results framework and results package. Indicators are used to 
observe progress and to assess the-actual result of an activity (group of activities) compared'to 
the expected result. Indicators serve to answer how or whether a unft is progressing towards its 
objective, rather than why/why not such progress is being made. Indicators are usually 
expressed in objective, quantifiable and measurable tenms (numeric values, percentages, scores 
and indices). 

Intermediate Result A key result which must occur in order to achieve a strategic objective 
(or other type of objective). 

Linear Projection A projection of future values for an indicator generated by the software 
using a straight-line calculation, i.e., the percentage rate of change is the same for all periods. 

Lo Target Used in combination with Hi Target, as an alternative to defining a single target 
when it is desirable to define a range. Lo target always refers to the numerically lower value in 
the range, regardless of whether that value is mw-e desirable. Thus, for an infant mortality 
indicator, the 10 target would represent the "stretch" target. 

Local Indicator An indicator defined by the local operating unit to meet its unique 
requirements and the availability of data, where no Agency common indicator exists, or where it 
is not practical to use a standard indicator. 

Measure The measurement value (target or actual) for a result, i.e., for quantifiable indicators, 
the number that results from the measurement process. 

Non-Linear Projection A projection of future values for an indicator generated by the 
software using other than a straight-line calculation, i.e., the percentage rate of change can be 
defined differently for each period. 

Operating Unit USAID field mission or USAIDfW office or higher level organizational unit 
which expends program funds to achieve a strategic objective, strategic support objective, 
regional objective, or special objective. 

Operating Unit StrategiC Objective The most ambitious result (intended measurable change) 
that a USAID operational unit, along with its partners, can materially affect and for which it is 
willing to be held responsible. The strategic objective fonms the standard by which the operational 
unit is willing to be judged in tenms.of, its perfonmance. The time-frame of a strategic objective is 
typically five to eight years for sustainable development programs, but may be shorter for 
programs operating under short tenm transitional circumstances or under conditions of 
uncertainty. 
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Perfonnance Status The designation applied to a comparison of planned or target results vs. 
actual results. Status values include: Target Metrrarget Not Metrrarget Exceeded. The 
performance status can be calculated automatically in the case of a numeric or quantitative 
indicator, or entered manually in the case of a narrative or qualitative indicator. 

Primary Link The principal association of a strategic objective with an Agency objective used 
to trace how the Agency is directing its resources. An objective may have several links with 
different Agency objectives, but only one, the most important, can be defined as the primary link. 
See also secondary link. 

Proxy Indicator An indirect measurement of performance that has a known and predictable 
relationship to the direct indicator it is substituting for. Proxy indicators are most commonly used 
when data for direct indicators are either unavailable, available but at time intervals that are not 
consistent with management needs, or are too costly to .collect. 

Qualitative Indicator An indicator that cannot be expressed in objective, numeric terms, and 
therefore is described in a narrative fashion. These may be expressed as short narrative 
descriptions, or as ordinal categories such as Accomplished/Not Accomplished, or 
ExcellentlGood/Fair/Poor. 

Quantitative Indicator An indicator expressed in objective, quantifiable terms such as 
numeric values, percentages, scores and indices. Quantitative indicators are the preferred 
approach to measuring performance wherever possible. 

Query A request to the central database for information on results that meet selection criteria 
defined by the user. It results in a query dataset which can be used to generate reports, or can 
be exported to another program (e.g., Lotus 123) for further manipulation. 

Regional Objective An objective that captures regional or global strategic results for which the 
operating unit is·responsible, but which transcend national boundaries. A regional objective may 
include country-specific results in tts framework. 

Result A change in the condition of a customer or a change in the host country condition 
which has a relationship to the customer. A result is brought about by the intervention of USAID 
in concert wtth tts development partners. Results are linked by causal relationships, i.e., a result 
is achieved because related, interdependent result(s) were achieved. Strategic objectives are the 
highest level result for which an operating unit is held accountable; intermediate results are those 
results which contribute to the achievement of a strategic objective. 

Result Level categories of results as defined in the Results Tracking system and in Agency 
objectives. The levels are Strategic Objective, Regional Objective, Strategic Support Objective, 
Special Objective, and Intermediate Result. 

Results Framework The results framework is a graphical representation of the cause and 
effect linkages between results. The,framework also establishes an organizing basis for 
measuring, analyzing, a~d reporting results of the operating untt. 

Secondary Link A link other than the principal association of a strategic objective with an 
Agency objective, or to any link between a lower level result and an Agency objective. Used to 
define an association of lesser importance than the primary link. 

Special Objective The result of an activity or activities which does not qualify as a strategic 
objective, but supports other US government assistance objectives. A special objective is 
expected to be small in scope relative to the portfolio as a whole. 
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Strategic Objective The most ambitious result (intended measurable change) that a USAID 
operational unit, along wah its partners, can materially affect and for which it is willing to be held 
responsible. T~strategic objective forms the standard by which the operational una is willing to 
be judged in terms of its performance. The time-frame of a strategic objective is typically five to _ 
eight years for sustainable development programs, but may be shorter for programs operating 
under short term transaional circumstances or under conditions of uncertainty. . . 

Strategic Support Objective Strategic support objectives are intended to capture and 
measure a regional or global development objective which is dependent on the results of other 
USAID operating units to achieve the objective but to which a global or regional program makes 
an important contribution. Therefore, the key differentiation from a strategic objective is that 
there is a recognition that the achievement of the objective is accomplished and measured, in 
part, through the activaies and results at the field mission level. . 

Target The specific and intended result to be achieved within an explicit timeframe and against 
which actual results are compared and assessed. A target is to be defined for each indicator. 

Trend The pattern of values for a particular indicator that would be expected to occur if there 
were no USAID intervention. The trend may be used as a basis for comparison wah the 
expected results if USAID did intervene. 

Unit of Measure The element in which the measures for this indicator are expressed, for 
example, "tons of soil" or "number of deaths.' This field may also be used to record the formula 
for calculating the indicator if a is not recorded in the Indicator Name field. 
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• Appendix -- How To Get Started 
_ - ~ t -., _. • 

Log on to the system using the appropriate user name and password. Contact your supervisor or 
System Administrator if you have questions or problems. 

The Results Tracking Main Menu is the first screen you will see after logon. 

1. seiect an organization by clicking on the II button under Organization to display the list of 
available organizations. Click on the desired organization. 

2. Select a country if your organization supports more than one. Click on the I!I button under 
Country to display the list of available countries. Click on the desired country. 

3. Select one of the following options: 

a) Go to Results Framework (see How to Create a Results Framework) 
b) Go Directly to Measures (see How to Create Measures) 
c) Run- Reports/Queries (see How to Create Reports) 
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How to Move Around the System 

Results Tracking functions can be accessed in several ways. For instance, to zoom in on a part 
of the framework to see it better, you can pull down a command from the menu bar, click on a 
button on the toolbar, or use a variety of keystrokes. Some of these methods can also be used 
together. The following is a description of how each of the primary methods of access works. 

1. Menu bar functions can be accessed in three ways: 

Mouse: Click once on the menu bar option you wish to access. A pull-down menu will 
appear with a list of options. Click on the listed option you wish to access. An option 

followed by an arrow~; indicates another menu is available. An option followed by •.• 
indicates a dialog box will appear, requiring you to provide more information before the 
selected option can be completed. 

Alt key: Press the Ait key on your keyboard to activate the menu bar, then press the 
letter that is underlined in the option you wish to access. For example, to open the View 
menu, press Alt, then press the letter Von your keyboard (abbreviated as AIt+V). To 
make further selections, press only the underlined letter. If you press the Alt key again, 
you will de-activate the menu bar. 

Ctrl key: Press the Ctrl key on your keyboard, then press the letter that is underlined in 
the option you wish to access. For example, to find a result on the framework, press 
Ctrl, then press the letter F on your keyboard (abbreviated as Ctrl+F). The system will 
highlight the requested result. These shortcuts are listed on the pull-down menus to the 
right of the option. 

2. The toolbar is a shortcut to some of the options available on the menu bar. Click once on the 
button representing the function you wish to access. To determine the function ofthe toolbar 
button, move ,Your mouse pointer over the button to display the yellow "tag' description. 

3. A pop-up menu is available when you are on the results framework screen. This menu has 
some of the same options as those on the menu bar under Options. To access the pop-up 
menu, select a result by clicking once on it and then click your right mouse button once. Use 
your mouse to click on the desired option on the pop-up menu or press the option's underlined 
letter on your keyboard. 

4. Many screens have buttons that allow you to perform certain operations, such as save, 
cancel or delete. Click once on the button with your mouse or press the Alt key and the button's 
underlined letter. 

Any reference to a mouse button refers to the left mouse button, unless otherwise stated. 
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How to Create a Results Framework 

A results framework consists of objectives and results, represented by "boxes: and causal links, 
represented by lines connecting the objectives/results. This graphical \/iew of the hierarchy of 
objectives and results can also be \/iewed in a text mode. 

1. On the Results Tracking.Main Menu, click on the Go to Results Framework button 1111. If 
the framework is empty, you will need to add one or more objectives/results (see How to Create 
an Objective/Result). Once the framework has been created, you can add, edit, or delete 
objectives/results as needed. 

2. When the framework contains at least two results that are related in some way to the same 
objective, you will need to create the links that connect them (see How to Create a Causal Link). 

3. To move objectives/results around on the framework screen, see How to Drag an Object. 

4. To update your framework periodically with the'latest database infonnation, see How to 
Update the Framework. 

5. To define the customer for an objective/result, see How to Define a Customer. 

6. To define the indicators that apply to the objective/result, see How to Create an Indicator. 

7. To record the measures that apply to the objective/result, see How to Create Measures. 
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How to Create an Objective/Result 

1. Select ~Add Objective/Result" from the Options menu on the menu bar. The Add 
Objective/Result screen will appear. 

2. Enter the name of the result in the Result Name field. 

3. Click on the Result Level [!j button to display the list of available result levels. Click on the 
desired result level. 

4. If you select any result level except Intermediate Result, the Objective Specific Dates fields 
will appear in the center of the screen. Enter dates as needed. 

5. (OptionaO Enter a detailed description of the result in the Description field. 

6. Press OK to save the result and exit to the framework screen, Cancel to exit to the framework 
screen without saving the result, or Save to save the result and stay on the Add Objective/Result 
screen. You can also press.the Alt key and the button's underlined letter. 

7. The result(s) you created will be on the framework screen when you retum to it. 

8. Link the,result(s) to us higher level result, if appropriate (see How to Create a Causal Link). 

9. Move the result(s) to its proper position on the framework screen (see How to Drag an 
Object). 
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How to Create a Causal Link 

t. On the framework screen, click and hold the left mouse button on a lower level result, drag the 
mouse and the resulting line to its higher level result, and release the mouse button. 

2. The Causality/Assumptions screen appears, allowing you to provide details about the link. 

3. (OptionaQ Click the Edit button to enter a description of the link: 

Click OK to close the description screen. When you return to the framework screen, the first 20 
characters of the description will be displayed on the link. The default phrase 
Causes/Contributes to ... will not appear on the link. 

4. (OptionaQ Enter a description of the critical assumptions being made about the causal link. 
Each critical assumption should be defined in a separate description cell. 

To insert additional cells, press the Insert key on your keyboard. A new cell will appear 
above the cell your cursor is in and the cell numbering will automatically be updated. 

To delete a description cell, click in the cell and press the Delete key. The cell will be 
removed and the cell numbering will automatically be updated. 

The standard Windows text editing functions of cut, copy, and paste can be used to move text 
around in these cells. 

5. (Optional) Indicate the validity of a critical assumption in the column to the right of its 
deSCription. Click the right mouse button to switch between Y (the critical assumption is valid), N 
(the critical assumption is not valid), and a blank field (no statement about the validity is being 
made). 

6. Press Save to save the causal link and stay on the Causality/Assumptions screen, Cancel to 
exit to the framework screen without saving the causal link, or OK to save the causal link and exit 
to the framework screen. You can also press the Alt key and the button's underlined letter. 

Operations - Results Tracking 2.0 5 



How to Drag an Object 

1. Click on a result on the framework screen and pull down the Options menu from the menu 
bar, press your right mouse button to activate the pop-up menu or double-click on an empty part 
of the screen. 

2. Click on Drag Object. The cursor will change to a four-pointed cross. 

3. Place your cursor on the result that is to be moved, hold down the left mouse button, drag the 
result to the desired location, and release the mouse button. 

4. While you are in Drag Object mode, you can place your cursor on any other result and repeat 
step 3. 

5. To exit Drag Object mode, pull down the Options menu from the menu bar and click on Drag 
Object to de-select it, or double-click on a blank part of the framework screen. 

How to Update the Framework 

Other users may be making changes'to the database at the same time you are working on the 
framework. To update the framework wtth the latest database information, click the Refresh 

button 1m on the Toolbar. 
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How to Define a Customer 

1. Click on an objective/result on the framework to select it and pull down the Options menu from 
the menu bar or press your right mouse button to activate the pop-up menu. Click on Customer. 
The Target Customer screen will appear. 

2. Select the customer's geographic designation. If you choose "Sub Country Area,." th~ 
following field will appear: 

3. Click on the I!l button to select from the list of areas, or enter the name of a new area. 

4. Select the Customer Group. If you choose "Group indicated below," the following field will 
appear: 

s. Click on the [!] button to select from the list of groups, or enter the name of a new group. 

6. Select the customer's gender, if appropriate, or select Not Gender Specific. 

7. Press OK to save the customer designation and exit to the framework screen, Cancel to exit 
to the framework screen without saving the customer designation, or Delete to remove the 
customer from the result. You can also press the Alt key and the button's underlined letter. 
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How to Create an Indicator 

An indicator(s) must be defined before you can create and track.measures for a result. Access 
the Indicators screen from the framework by following step 1 below, or from the Main Menu by 

pressing the Go Directly to Measures button ............. on the Main Menu (see How to Get Started). 

1. Click on a result on the framework screen to select it and pull-down the Options menu from 
the menu bar or click the right mouse button to activate the pop-up menu. Click on 
Measuresllndicators. 

If at least one indicator for a result has been defined, the Measures screen will appear. 
Click on the Indicator button to go to the Indicators screen. 

If no indicator has been defined for a result, select the type of indicator, Common or 
Local, and press OK to continue or Cancel to return to the framework screen without 
creating an indicator. 

3. The complete Indicators screen will appear. 

4. The following fields must be completed for the system to accept your indicator: 

Indicator Name 
Direction 
Initial Measures Data Period 

5. The following fields are optional; some appear with system defaults. To change the default 
selection, click the button next to the appropriate designation. 

Unit of Measure 
Proxy/Direct 
Quantitative/Qualitative 
Required for Tracking 
Expressed As 
Period 
Source Document Name 
Source Organization 

6. To provide a more detailed description of the indicator, click the Description button next to the 
Unit of Measure field. After entering a description, press OK to save the data and return to the 
Indicators screen, or Cancel to ignore the changes and return to the Indicators screen. 

7. Press Add to define another indicator for the result, Delete to remove the indicator from the 
result, Save to keep the indicator and remain on the Indicators screen, Cancelto go to the 
Measures screen without saving the indicator, or OK to save the indicator and go to the 
Measures screen. You can also press the Alt key and the button's underlined letter. 
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How to Create Measures 

Access the Me::ures screen from the framework by f0[iIl~~~?9 step 1 below, or from the Main 

JII 
Menu by pressing the Go Directly to Measures button ,~" " (see How to Get started). 

1. Click on a result on'the framework to select it and pull down the Options menu from the menu 
bar, or click the right mouse button to activate the pop-up menu, Click on Measures/Indicators. 

If no indicator has been defined for a result, the' Indicators screen will appear (see How to 
Create an Indicator). You must define an indicator in order to create measures, 

If at least one indicator for a result has been defined, the Measures screen will appear, 

2. To select a different indicator from the one shown in the Indicator Name field, click on the ~ 
button and select the desired indicator from the list. 

3. The data about the indicator is displayed in the center of the screen and is read-only. To 
modify the indicator data, click the Indicator button in the lower left comer to go to the Indicators 
screen. 

4. The Measures Table at the bottom of the screen allows you to enter quantitative data. The 
column labels are determined by the Period and the Initial Measures Data Period you selected for 
the indicator. 

If your measures data cannot be reduced to numbers, define the indicator as qualitative. 
The Qualitative Measures screen will allow you to provide a narrative description ofthe 
target, the actual result, and an assessment of whether the target was met or not (see 
How to Create Qualitative Measures ). 

5. Enter data in the appropriate rows on the Measures Table. Note: the Hi Target and lo Target 
rows allow you to enter a range of target values. However, you can enter data only in the Hillo 
Target rows or in the Target row, not all three. 

6. A graph ofthe measures table data can be displayed by clicking the Graph button (see How 
to Create a Graph). 

7. To create a prOjection offuture target or trend values based on the data in the measures 
table, 
highlight the cell you wish to base your projection on and click the Projection button (see How to 
Create a Projection). 

8. To establish the baseline for the data displayed in the me9sures table, highlight the cell in the 
Actual row that is to be defined as the baseline and click the Baseline button. For more 
information, see How to Establish a Baseline. 

9. Press Save to save the measures and stay on the Measures screen, Cancel to exit to the 
framework screen without saving the measures, or OK to save the measures and exit to the 
framework screen. You can also press the Alt key and the button's underlined letter. 
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How to Create Qualitative Measures 

Access the Measures screen from the framework by follow;nn step 1 below, or from the Main 

Menu by pressing the Go Directly to Measures button ~_ .. (see How to Get Started). 

-
1. Click on a result on the framework to select it and pull down the Options menu from the menu 
bar, or click the right mouse button to activate the pop-up menu. Click on Measuresllndicators. 

2. An indicator that has been defined as qualitative rather than quantitative will produce a 
Measures screen that allows you to enter narrative information rather than specific numeric 
values. 

3. Measures data entered in the projected and actual fields can be one or two word descriptions, 
such as Completed/Not Completed, or can be longer narrative descriptions. 

4. Select the appropriate target assessment and, if desired, enter a longer description by 
pressing the Narrative button. 

• 
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How to Create a Graph 

A graph can be created only if there is data in the measures table on the Measures screen. 

1. Access the Measures screen (see How to Create Measures). 

2. Click on the Graph button at the bottom of the Measures screen. A graph of the.data in the 
measures table will appear. 

3. To change the look of the graph, click the right mouse button anywhere on the Graph scre~n. 
A pop-up menu of formatting options will appear. Each option is further defined by "tabs," which 
allow you to customize the look of your graph. 
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How to Create a Projection 

The system can calculate future target.ortrend values based on a percent change that you 
define. -

1. Access the Measures screen (see How to Create Measures). 

2. Highlight the cell on which you wish to base your projection. This starting point will be 
displayed at the top of the Projection screen. 

3. Click on the Projection button at the.bottom of the Measures screen to go the Projection 
screen. 

4. Select the series, Le., whether you wish to project a target or trend value. 

5. Select the number cif periods you wish the projection to cover. 

6. Select a linear or non-linear projection: 

If you select a linear projection, which assumes the percent change will notyary over the 
projected period, you must also select the amount of percent change. 

If you select a non-linear projection, which allows for the percent change tg v1jry ov.er tb.e 
projected period, a· table appears on the screen. Enterthe percemt cha'nge"for' each . 
period. . 

7. Press Save to create the projection, Cancel to ignore ~ny changes and exit the screeen, or 
OK to save the projection and exit the screen. You can also press the All key and the button's 
underlined letter. 
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How to Designate a Baseline 

A baseline is the starting point used for comparing progress toward, an objective or result. 

1. Access the Measures screen (see How to Create Measures). 

2. On the measures table, highlight the cell in the Actual'row that you wish to define as the 
baseline. 

3. Press the Baseline button. The cell in the measures table will change to blue. 
. ~ 
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How to Create Reports 

[i
A,,~C~:S the Reports Menu from the Main Menu by pressing the Run Reports/Queries button 

~. 
,~.,-.~,: (see How to Get started). The Reports Menu will appear. 

1. Select the report you wish to create from the four listed'in the Standard Reports box: 

Summary Reports by Agency Goal/Objective 
Results and Measures Summary 
Objective Summary 
Results Status 

2. Press OK to go to the screen for that report or Cancel to exit the Reports Menu and return to 
the Main Menu, You can also press the Alt key and the button's underlined letter. , 

Note: the Queries and Customized Reports options are not available at this time. 

3. The report sCfeens contain fields that allow you to define the level of detail and scope of the 
report. 

4, The buttons at the bottom of the screens allow you to define printer and paper variables, look 
at the report on-screen, export the report in various formats, and print the report. 
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Activity - Application Overview-

Activity Overview 
The Activity screen records related information about activities. Activities are planned 
undertakings to be accomplished, produced, or constructed. Activities can only be created 
and updated by users with appropriate authorization. AWACS determines your authorization 
based on the user ID entered and the level of security assigned to that ID. Based on the type 
of transaction entered, AWACS will update the appropriate. The transaction information will 
be available to other programs, within funds management and for other AWACS modules, 
which rely on funds information. 

AWACS - The Activity Function 

AWACS Logon Screen 
Within the Windows application on your PC computer is an ICON labeled NMS. This ICON 
represents the group of applications related to AWACS. To open up this window, Double
click on the NMS ICON. 

The first screen displayed in the NMS application is the NMS Logon screen. Every user must 
have a User Id and a Password (logon) assigned by the AWACS System Administrator. 
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Activity Logon 

To logon to the Activity application: 

I. Enter the UserId. 

2. Enter the Password. 

3. Select the Logon button; or 

5. Select the Cancel button, if you do not wish to enter the application. (The user wilJ be 
returned to the window's Program Manager screen). 

If all security checks pass, the application wilJ open, nniquely identifying the user to 
'the system for the purpose of defining which screens the user has authorization to 
review and/or update. (Note: The current status of the A WACS Activity Logon is 
displayed at the bottom of the Logon Screen). 

6. Select OPS. 

7. Select Define Activity. 
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Potential Logon Problems 

If the application does not open, first review the potential problems listed below. If still 
'unable to enter the system, please notifY your system administrator. 

Incorrect Logon Identifiers 

VerifY that the User Id and Password entered are correct. Incorrect attempts to logon will 
display an error message, however three consecutive failed logons will automatically abort 
the application, returning the user to the window's Program Manager. This security measure 
prevents an unauthorized user from accessing the application. 

Currently Gpen AWACS Session 

Check to see if you have previously logged into the system, and have not yet terminated the 
previous AWACS session. 

LAN Server Temporarily Down 

Check to see if anyone else who may use the system is also having difficulty in logging into 
the system. (If so, this could possibly mean that the LAN server is temporarily down, in 
which case the system administrator should be advised.) 

Activity Menu Options 

Menu Options 

When the application opens the drop·down menu options will appear across the top of the 
Activity screen. If the ICON is applicable to the current screen being displayed, then the 
ICON will be in full color; ICONS which are disabled for use are gray. . 

Activity Tool Bar 

The following describes the function of these ICONS, starting at the left: 

ADD - Add the current record to the database. 

• MODIFY - ModifY the current record in the database. 

DELETE - Delete the current record from the database. 

CUT - Delete the highlighted data and place it on the system clipboard. 

• COpy - Make a copy of the highlighted data and place it on the system clipboard .. 

• PASTE - Copy the system clipboard to the highlighted field. 

UNDO - Return the screen to the state it was in prior to the last action. 

QUERY - (This function is not available to the Activity function). 
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• REFRESH - Clears the screen of all current displays of infonnation. 

• NEXT - (This jUnction is not available to the Activity jUnction). 

• PRIOR - (This jUnction is not availqble to the Activity jUnction). 

• PRINT - Produce a snapshot of the screen as it looks at that moment in time. 

EXIT - Exit the AWACS Funds Management application. This will return the user to 
the window's AWACS Program Group of the window's Program Manager. Any 
changes made to the current record that have not been saved will be lost. 

Activity Drop-down Menu 

The following are the available drop-down functions within the Activity system. 

Activity Drop-down Menu - Item DeSCription 

FILE - This is an alternate way of accessing the ICONS available within the toolbar. All 
toolbar ICONS, with the exception of Undo, Cut, Copy, and Paste, are located in this list. 

EDIT - Within this drop-down list are the remaining ICONS not included within the FILE 
drop-down list. These are Undo, Cut, Copy, and Paste. 

PROCESS - A drop-down sub-menu will be displayed when the Process menu option is 
selected. This sub-menu lists primary processes that can be executed for the Activity 
Function.· The only process listed for this activity is 'Define Activities'. 

WINDOW - This allows the user to specify how to arrange the various windows on the 
current system. The options are: Cascade, Arrange ICONS. The Window drop-down menu 
also allows the user to switch from window-to-window. AIl windows that are currently open 
are put into a numbered list at the bottom of the Window drop-down menu, below the bottom 
dividing line (e.g., I Objective/Activity). 

HELP - This feature allows the user to retrieve assistance on how to run the Activity function 
by looking at the Contents of the help file, or doing a Search on various character strings. 
(The entire user's manual for the Activity function is accessible via HELP). 
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Activity - Screen Overview 

Screen Overview 
The Activity function is comprised of one screen. It allows a user to either Add a sub-activity 
to a specified parent activity, or Update an activity. This section will describe the Activity 
screen and its various components, as well as how to perfonn both Activity adds ~d updates. 

Define Activities 
A user initiates the Activity function by seIecting Process from the main menu of the Activity 
screen and then selecting Define Activities from the drop-down Process menu. An authorized 
user can add sub-activities to a parent activity or modifY an existing activity. 
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Activity Screen 

Activity Screen Data 

Parent Activity - This field is used to reflect, if applicable, the Parent Activity of the Activity 
currently being accessed. (Display Only) 

Organization/Activity - A planned undertaking to be accomplished, produced, or 
constructed. The user must select an Activity from the Activity Listing. 

To display a list of activities and sub activities: 

• 

• 

Click on the square cascade button to the left of the Activity field: 

Click on the plus sign next to USAID and choose appropriate line. This will cause data 
related to the activity selected to be moved to the screen, filling up the appropriate 
fields. 

Click on the Create Subactivity button to move the selected Activity to the Parent 
Activity field on the screen so the user can manually enter information for the Sub
Activity. (Mandatory) 

Country - If applicable, choose a country from the drop-down list of countries that appears 
when you Click on the arrow to the right of the Country field. (Optional) 

Managing Org - This represents the Bureau, Mission, or Office managing the Activity. To 
fill this field, select the applicable Managing Org. from the Organization Table. If the 
Activity currently being accessed has a parent, the Managing Org. of the parent activity is 
moved to the Activity screen, and the Managing Org. field is disabled from being modified 
for the current Activity. (Mandatory) 
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e. To display the Managing Org table (this process can also be used for Organization/Activity): 

a) Click on the cascade button to the left of the Managing Org. field 

b) Click on the plus (+) sign next to 'USAlD'. 

c) A folder refers to a higher level Managing Org. A folder with a plus (+) sign next to it 
represents a closed folder with a lower sub-level of selections present. Open a folder to 
view the contents of the lower level( s) by clicking on the plus sigu. 

d) A folder with a minus (-) sigu next to it represents an open.folder. To close a folder, 
collapse the list of sub-groups listed below it by clicking ~n the minus sigu. 

e) The only Managing Orgs. available for fmal selection does not have a sign preceding it. 
Clicking on any other line will only open or close that specific folder. 

f). To select a Managing Org., Click on the name of an organization (without any sign next 
to it). This will move the selected organization to the screen, and then remove the list 
from the screen. 

Acronym - A five'(5) character field in which the user can specify an acronym for the 
Activity. (Optional) 

Planned Start Date - If entered, the Planned Start Date must be in DD-MMM-YYYY 
format. (Mandatory) 

Planned Completion Date - If entered, the Planned Completion Date must be in DD-MMM
YYYY format. The Planned Completion Date must be greater than the Planned Start Date. 
(Optional) 

Description - A 250 character field in which the user can key a description of the Activity. 
(Optional) 

Create'Sub-Activitv button - If it is desired to define a Sub-Activity or change information 
previously entered, click on this button to either refresh or clear the current information. 

ActivitY Tvpe radio buttons - Click on one of the following radio buttons which relate to the 
various types of Activities that exist: (Mandatory) 

• Administration 

• Cash Transfer 

• CIP (Commodity Import Program) 

• PD&S (Program Development & Support) 

• Other - If none of the other Activity Types are applicable. 

Classification radio buttons - Click on one of the following radio buttons which relate to the 
classification of the Activity: (Mandatory) 

• Bi-Lateral - If the parent activity is Bi-lateral, the activity classification must also be Bi
lateral, in which case the classification button is automatically set. 

• Other - If the parent activity is Other, the sub-activity may be either Bi-lateral or Other. 
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Activity Functionality 

Adding a New Activity 

To Create a new Activity: 

L Click on the Cascade button to the left of the Objective/Activity field to display the list of 
available Objective/Activity. Select an Activity under which the Sub-Activity is to be 
created. The system will move the data associated with the Activity to the screen. 
(Mandatory) 

2. Click the "Create Sub-Activity" button. 

3. Type the name of the Sub-Activity being created into the Objective/Activity field. 
(Mandatory). 

4. Select a Country. Click on the name of the country desired to move it into the Country· 
field. (Mandatory) 

5. If the Managing Org. field is not populated after the Objective/Activity is selected, Click 
on the Managing Org Cascade button to display the list of available Managing 
Organizations Activities. The system will move the data associated with the Managing 
Org. to the screen. . 

6. Enter an Acronym. (Optional)* 

7. Enter a Planned Star! Date. (Mandatory) 

8. Enter a Planned Completion Date. (Optional)* 

9. Enter a Description. (Optional)* 

10. Click on the appropriate Activity Type radio button. (Mandatory) 

II. Click on the appropriate Classification radio button. (Mandatory) 

12. Click the ADD ICON in the tool bar. The system will verilY that the new Activity does 
not already exist. If the Activity does not already exist the specified Activity will be 
added and a unique Activity ID generated. (The Activity ID is a 10 digit number. The 
first 5 digits represent the Org. Code of the user creating the Activity. The last 5 digits 
are generated by the AWACS system.) 

*Enter any non-mandatory data which is known at the time the Activity is created:Acronym, 
Planned Completion Date and Description. Data for non-mandatory fields can be added at a 
later time by updating the Activity. 
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I Updating an Activity 

To update an Activity: 

1. Select the Activity for modification. (Mandatory) 

2. ModifY any of the following fields: Objective/Activity, Country, Acronym, Planned Start 
date, Planned Completion date, or Description. 

3. Note: The Parent Objective/Activity and the Activity Id·can not be modified. No fields 
on a reserve activity can be modified. If-a Parent Objective/Activity is Bi-Lateral the 
classification cannot be modified. 

4. Click the MODIFY ICON in the tool bar to save any changes made. 

Deleting an Activity 

An Activity may be deleted if (a) it has no children and (b) it is not a reserve activity. 

To delete an Activity: 

1. Select the Activity for deletion. (Mandatory). 

2. Click the DELETE ICON in the tool bar to save any changes made . 

• 
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Glossary of Terms 

Activity 
Any planned undertaking to be accomplished, produced, or constructed. 

AWACS 
An acronym which stands for 'AID Worldwide Accounting and Control System' 

GIL 
The General Ledger 

ICON 
An image or graphic that symbolizes a system function. A program item ICON is an 
unopened application in a program group that, when selected, will begin the execution of the 
application it symbolizes. An application ICON is an application that has been opened for 
execution and minimized prior to termination of the application, which remains in the same 
state as when the user minimized it. A document ICON is a document that has been 
minimized, representing to the user that the document remains open and immediately 
accessible upon being maximized. 

Menu Bar 
The area directly below the title bar of a window that contains the options available to a user 
in a given system. Depending on which screen is currently in use, the system may deem 
certain functions in the menu bar inappropriate, and disallow their corresponding function for 
that screen usually by displaying the selection in gray. 

Password 
The Password is a security provision which is used in conjunction with the User ID to access 
AWACS, preventing unauthorized access to the AWACS system. 
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12 • Glossary of Tenns 

Program Group 
A program group is a group of related applications represented by an ICON and associated 
label. When a user double-clicks a program group ICON with the left mouse button, a small 
window opens up to display a set ofICONS representing the various applications that have 
been grouped together under the Program Group ICON. 

User Guide 
A reference source which accompanies a product or software application designed to 
demonstrate to a.user the various features of a system and how to best utilize them. 

User 10 
A security provision consisting of a kique ~lphanumeric string of characters, which is 
assigned to an authorized user of the A WACS system in order to prevent unauthorized access 
to the system. A User ill uniquely identifies the user to the system and defines the extent to 
which interaction with the AWACS system can occur. 

Windows Program Manager 
The segment of Microsoft Windows responsible for the organization and management of 
applications which are designed to execute in a windows environment 
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